OpenEdge® Getting Started: Developing BPM Applications with Developer Studio
Notices

© 2015 Progress Software Corporation and/or its subsidiaries or affiliates. All rights reserved.

These materials and all Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. The information in these materials is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear therein. The references in these materials to specific platforms supported are subject to change.

Business Making Progress, Corticon, DataDirect (and design), DataDirect Cloud, DataDirect Connect, DataDirect Connect64, DataDirect XML Converters, DataDirect XQuery, Deliver More Than Expected, EasyI, Fathom, Icenium, Kendo UI, Making Software Work Together, OpenEdge, Powered by Progress, Progress, Progress Control Tower, Progress RPM, Progress Software Business Making Progress, Progress Software Developers Network, Rollbase, RulesCloud, RulesWorld, SequeLink, Sitefinity (and Design), SpeedScript, Stylus Studio, TeamPulse, Telerik, (Telerik (and Design), Test Studio, and WebSpeed are registered trademarks of Progress Software Corporation or one of its affiliates or subsidiaries in the U.S. and/or other countries. AccelEvent, AppsAlive, AppServer, BravePoint, BusinessEdge, DataDirect Spy, DataDirect SupportLink, , Future Proof, High Performance Integration, Modulus, NativeScript, OpenAccess, Pacific, ProDataSet, Progress Arcade, Progress Pacific, Progress Profiles, Progress Results, Progress RFID, Progress Progress Software, ProVision, PSE Pro, SectorAlliance, Sitefinity, SmartBrowser, SmartComponent, SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame, SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, WebClient, and Who Makes Progress are trademarks or service marks of Progress Software Corporation and/or its subsidiaries or affiliates in the U.S. and other countries. Java is a registered trademark of Oracle and/or its affiliates. Any other marks contained herein may be trademarks of their respective owners.

Please refer to the Release Notes applicable to the particular Progress product release for any third-party acknowledgements required to be provided in the documentation associated with the Progress product.

The Release Notes can be found in the OpenEdge installation directory and online at:

For the latest documentation updates see OpenEdge Product Documentation on Progress Communities: (https://community.progress.com/technicalusers/w/openedgegeneral/1329.openedge-product-documentation-overview.aspx).

October 2015

Last updated with new content: Release 11.6.0
# Table of Contents

Preface.........................................................................................................................17
  About this documentation..........................................................................................17
  Information on Documentation..................................................................................17
  Conventions Used in this Manual..............................................................................18
  Product support contact information.......................................................................19

Chapter 1: OpenEdge Business Process Server overview.................................21
  Business Process Server components....................................................................22
  How Business Process Server works.......................................................................24
  Business Process Server user types.........................................................................26

Chapter 2: Introduction to Progress OpenEdge BPM Designer.........................27
  Supported platforms.................................................................................................28
  Functions..................................................................................................................28
    File types..............................................................................................................29
  Terminology.............................................................................................................29

Chapter 3: Getting started with Progress Developer Studio for OpenEdge........31
  Opening Progress Developer Studio for OpenEdge.................................................31
  Exploring Progress OpenEdge BPM Designer.......................................................32
    Using the menubar.....................................................................................................35
      Using Eclipse menu commands.............................................................................35
      Using commands....................................................................................................36
      Using the Tasks pane.............................................................................................37
    Using shapes...........................................................................................................39
    Using the palette......................................................................................................40
  Using keyboard shortcuts..........................................................................................41
  Configuration parameters..........................................................................................42
  Localizing Progress Developer Studio for OpenEdge................................................42

Chapter 4: Developing BPM projects.....................................................................45
  Project facets.............................................................................................................45
  Project facet properties............................................................................................46
  Creating a BPM project.............................................................................................46
  Creating a Business Process......................................................................................48
Chapter 5: Performing additional operations.............................................73
  Publishing an application .................................................................73
  Managing pages..................................................................................76
  Generating 360 degree view...............................................................77
    Opening a subprocess......................................................................79
  Printing the process template............................................................80
  Exporting the process template..........................................................81
    Generating a process summary.........................................................82
    Viewing process summary...............................................................83
  Managing phases................................................................................85
    Creating a phase............................................................................86
    Resizing a phase...........................................................................87
    Performing additional phase operations.........................................87

Chapter 6: Rollbase Integration..............................................................89
  Rollbase as a presentation type for OE BPM.........................................89

Chapter 7: Designing a process template diagram.................................91
  Creating a process template diagram..................................................91
  Changing shapes...............................................................................95
  Connecting worksteps.......................................................................96
  Using multiple connectors.................................................................98
    Using multiple incoming connectors to worksteps..........................98
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Managing gestures</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>Using mouse gestures</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>Creating custom gestures</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>Using the Gesture Editor</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>Designing gestures</td>
<td>106</td>
</tr>
<tr>
<td></td>
<td>Guidelines for gestures</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>Saving custom gestures</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>Using custom gestures</td>
<td>108</td>
</tr>
<tr>
<td>9</td>
<td>Working with the Overview page</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Introducing the Overview page</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Reviewing the Overview page</td>
<td>110</td>
</tr>
<tr>
<td></td>
<td>Managing tasks</td>
<td>112</td>
</tr>
<tr>
<td></td>
<td>Adding a task</td>
<td>112</td>
</tr>
<tr>
<td></td>
<td>Performing other operations</td>
<td>114</td>
</tr>
<tr>
<td>10</td>
<td>Introducing Path Analysis</td>
<td>115</td>
</tr>
<tr>
<td></td>
<td>Using the Path Analysis view</td>
<td>115</td>
</tr>
<tr>
<td></td>
<td>Exploring the Path Analysis view</td>
<td>116</td>
</tr>
<tr>
<td>11</td>
<td>Defining process properties</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Setting process properties</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Setting preferences</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>Using the Activity page</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>Using the Application page</td>
<td>123</td>
</tr>
<tr>
<td></td>
<td>Using the Diagram page</td>
<td>123</td>
</tr>
<tr>
<td></td>
<td>Using the Export page</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Using the Form page</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Using the Publish page</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>Using the Simulation page</td>
<td>126</td>
</tr>
<tr>
<td>12</td>
<td>Defining and assigning performers</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>Reviewing the Performers tab</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>Default performers</td>
<td>131</td>
</tr>
<tr>
<td></td>
<td>Defining performers</td>
<td>131</td>
</tr>
<tr>
<td></td>
<td>Defining a user as a performer</td>
<td>132</td>
</tr>
</tbody>
</table>

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio
Chapter 13: Using dataslots ...........................................................................................................147

Reviewing the Datascot tab..............................................................................................................148
Supported datascot types ..................................................................................................................149
Using system datascots .....................................................................................................................151
Creating user-defined datascots .........................................................................................................152

Dataslot properties ..........................................................................................................................153
For a CHARACTER datascot ..............................................................................................................153
For an INTEGER and INT64 datascot ..............................................................................................154
For a LOGICAL datascot ....................................................................................................................155
For a DATETIMETZ datascot ..............................................................................................................155
For a DECIMAL datascot ....................................................................................................................156
For a Document datascot ...................................................................................................................156
For a List datascot ............................................................................................................................157
For a Number datascot .......................................................................................................................157
For a Rowid datascot .........................................................................................................................158
For an Object datascot .......................................................................................................................158
For a Business Object datascot ........................................................................................................159
For a Map datascot ............................................................................................................................159
For a Table datascot ..........................................................................................................................160
For a Dataset datascot .......................................................................................................................160
For a LongChar datascot ....................................................................................................................161

Defining the datascot description .....................................................................................................163
Defining the datascot format ..............................................................................................................163
Format types for CHARACTER or LongChar datascot ...................................................................164
Specifying validation at the datascot level .......................................................................................166

Setting the datascot access ..............................................................................................................167
Exporting and importing datascots ....................................................................................................168
Exporting datascots ..........................................................................................................................168
Importing datascots ..........................................................................................................................170
# Chapter 14: Setting workstep properties

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About worksteps</td>
<td>174</td>
</tr>
<tr>
<td>Workstep properties</td>
<td>175</td>
</tr>
<tr>
<td>Defining properties of Start workstep</td>
<td>176</td>
</tr>
<tr>
<td>Specifying general properties of Start workstep</td>
<td>176</td>
</tr>
<tr>
<td>Using the Fields tab of Start workstep properties</td>
<td>177</td>
</tr>
<tr>
<td>Adding dataslots</td>
<td>177</td>
</tr>
<tr>
<td>Modifying dataslots</td>
<td>178</td>
</tr>
<tr>
<td>Using the Messaging tab of Start workstep properties</td>
<td>179</td>
</tr>
<tr>
<td>Using the Advanced tab of Start workstep properties</td>
<td>179</td>
</tr>
<tr>
<td>Defining properties of Activity worksteps</td>
<td>180</td>
</tr>
<tr>
<td>Specifying general properties of Activity workstep</td>
<td>180</td>
</tr>
<tr>
<td>Defining a Loop condition</td>
<td>182</td>
</tr>
<tr>
<td>Using Fields tab of Activity workstep properties</td>
<td>184</td>
</tr>
<tr>
<td>Defining collaboration tasks</td>
<td>184</td>
</tr>
<tr>
<td>Using Advanced tab of Activity workstep properties</td>
<td>186</td>
</tr>
<tr>
<td>Before workstep activation</td>
<td>186</td>
</tr>
<tr>
<td>On workstep activation</td>
<td>188</td>
</tr>
<tr>
<td>On workstep completion</td>
<td>189</td>
</tr>
<tr>
<td>Adding overdue actions</td>
<td>189</td>
</tr>
<tr>
<td>For the last overdue action</td>
<td>192</td>
</tr>
<tr>
<td>On workstep error</td>
<td>192</td>
</tr>
<tr>
<td>On workstep recovery</td>
<td>192</td>
</tr>
<tr>
<td>Excluding a performer</td>
<td>193</td>
</tr>
<tr>
<td>Defining properties of Adapter worksteps</td>
<td>194</td>
</tr>
<tr>
<td>Specifying general properties of Adapter workstep</td>
<td>194</td>
</tr>
<tr>
<td>Using the Dataslots tab of Adapter workstep properties</td>
<td>195</td>
</tr>
<tr>
<td>Mapping dataslots in an adapter workstep</td>
<td>196</td>
</tr>
<tr>
<td>Using the Advanced tab of Adapter workstep properties</td>
<td>197</td>
</tr>
<tr>
<td>Defining properties of Subprocess worksteps</td>
<td>198</td>
</tr>
<tr>
<td>Parent Process: Subprocess interaction</td>
<td>198</td>
</tr>
<tr>
<td>Specifying general properties of Subprocess workstep</td>
<td>199</td>
</tr>
<tr>
<td>Using the Dataslot tab of Subprocess workstep properties</td>
<td>200</td>
</tr>
<tr>
<td>Mapping dataslots in a subprocess workstep</td>
<td>200</td>
</tr>
<tr>
<td>Mapping document dataslots in subprocess worksteps</td>
<td>201</td>
</tr>
<tr>
<td>Using the Advanced tab of Subprocess workstep properties</td>
<td>202</td>
</tr>
<tr>
<td>Defining properties of Message worksteps</td>
<td>203</td>
</tr>
<tr>
<td>Specifying general properties of Message workstep</td>
<td>203</td>
</tr>
<tr>
<td>Using the Dataslots tab of Message workstep properties</td>
<td>204</td>
</tr>
<tr>
<td>Using the Messaging tab of Message workstep properties</td>
<td>204</td>
</tr>
<tr>
<td>Other Message workstep properties</td>
<td>205</td>
</tr>
<tr>
<td>Defining properties of End worksteps</td>
<td>205</td>
</tr>
<tr>
<td>Using the Messaging tab of End workstep properties</td>
<td>206</td>
</tr>
</tbody>
</table>
Defining Rollbase presentation.................................................................................................243
Defining GUI presentation........................................................................................................244
Defining Tablet presentation.....................................................................................................245
Defining Other presentation......................................................................................................247
Defining workstep presentations for Web applications......................................................248
Using the Auto-generated presentation....................................................................................249
Using the custom presentation.................................................................................................249
Customizing presentation pages..............................................................................................249
  Specifying hyperlinks between Presentation pages..........................................................249
  Creating multiple command buttons in web applications....................................................250
Preserving customization after process reinstall......................................................................251
Using the Form presentation.....................................................................................................252

Chapter 17: Using alerts........................................................................................................253
  Reviewing the Alerts tab........................................................................................................253
  Defining an alert...................................................................................................................254
  Associating an alert with a workstep....................................................................................256
    Associating an alert with an overdue action.................................................................257

Chapter 18: Using the Form Editor.......................................................................................259
  Opening the Form Editor......................................................................................................260
  Using a form template..........................................................................................................262
    Setting form properties......................................................................................................263
  Using the Layout tab............................................................................................................264
  Defining the form's layout......................................................................................................265
    Adding a table....................................................................................................................265
      Defining table properties..............................................................................................266
      Defining table cell properties......................................................................................266
    Adding a tabbed pane........................................................................................................267
    Adding a Field Set.............................................................................................................268
    Adding a divider...............................................................................................................269
    Adding a Panel..................................................................................................................270
    Adding an Include layout...............................................................................................271
  Assigning a style..................................................................................................................271
  Defining the form's controls..................................................................................................272
    Setting attributes.............................................................................................................274
    Using data binding..........................................................................................................277
      Using a defined service.................................................................................................279
      Using dataslot..............................................................................................................279
      Using adaplets.............................................................................................................282
      Specifying static data...................................................................................................282
      Creating a cascading combo box with Tree service....................................................283
    Applying validation...........................................................................................................284
Chapter 19: Working with Graphical Event Logic tool.................................309

Benefits........................................................................................................309
Exploring the GEL tool..................................................................................310
Using the GEL tool in BPM projects...............................................................311
  GEL Actions in BPM projects........................................................................312
  Adding data operations................................................................................312
  Adding value expressions............................................................................313
     Value expressions in web applications......................................................314
  Adding control structures and custom script..............................................315
     Adding Conditions.................................................................................317
Using JSTools API..........................................................................................320
Using the GEL tool in Form Editor.................................................................323
  GEL Actions in Form Editor........................................................................323
  Adding Expressions....................................................................................323
  Adding Conditions.....................................................................................326
Other GEL tool operations..............................................................................331
  Adding information to action blocks.........................................................331
  Customizing GEL Actions.........................................................................331
     Action script tags..................................................................................336
## Chapter 20: Using the Servers view

- Creating a server .......................................................... 341
  - Adding server runtime environment ........................................ 343
- Creating a Business Process Cluster Server ............................... 345
  - Adding server runtime environment ........................................ 346
- Opening Servers view ....................................................... 348
  - Copying modules ............................................................ 349
  - Publishing project modules ................................................ 350
  - Republishing project modules .............................................. 350

## Chapter 21: Configuring and running simulation

- Designing a simulation ..................................................... 354
  - Adding a process .......................................................... 355
  - Simulation constraints .................................................... 355
- Exploring the Progress OpenEdge BPM Simulation perspective ........ 356
- Configuring a simulation scenario ......................................... 357
  - Adding a scenario .......................................................... 358
  - Modifying simulation settings for a scenario .......................... 358
  - Importing and exporting a scenario ....................................... 359
    - Exporting a scenario .................................................... 359
    - Importing a scenario ..................................................... 359
  - Configuring simulation parameters for a process ..................... 362
    - For worksteps ............................................................. 364
    - For connectors ............................................................ 366
    - For paths ................................................................. 367
    - Setting the probabilities ................................................ 368
  - Managing performers ...................................................... 369
  - Managing resources ....................................................... 372
  - Defining objectives ......................................................... 373
  - Setting calendar ............................................................ 375
  - Performing other operations ............................................. 375
    - Choosing a randomization method .................................... 376
    - Specifying a date .......................................................... 377
  - Validating the simulation project ........................................ 377
  - Running a process simulation ............................................ 379
    - Viewing process information ............................................ 382
    - Viewing project information ............................................ 385
  - After completion of simulation .......................................... 388
    - Generating a simulation report ........................................ 389
    - Viewing simulation report details ..................................... 391
      - Process simulation result ............................................ 391
      - Resource usage results ............................................... 393
Chapter 27: Managing business objects

Using the Business Object Manager

Importing business objects

Importing a business object from Business Object XML file
Importing a business object from an XSD file
Importing a business object from a Java Bean file

Exporting a business object

Generating business objects

Using business objects in applications
Using business objects in a link
Using business objects in a form
Configuring a BO Collection widget
Using business objects in scripts

Chapter 28: Using Managed Adapter Browser

Using the Managed Adapter Browser

Preconfiguring managed adapters

Chapter 29: Defining rules with Rule Wizards

Accessing Rule Wizards
Using the New Rule wizard
Using the Schedule Rule wizard
Using the Process Path Rule wizard
Using the Time-Out Rule wizard
Using the Monitoring Rule wizard
Using the Business Metric Rule wizard
Using the Decision Counter Rule wizard
Using the Task Assignment Rule wizard
Using the Process Control Rule wizard
Using the File Poller Rule wizard
Chapter 30: Managing changes in Business Processes ....................... 513
Managing changes through Process Refresh ................................................................. 513
Criteria for changes in Process Refresh ................................................................. 515
  Process properties criteria .................................................................................. 515
  Workstep properties criteria .............................................................................. 516
  Dataslot properties criteria .............................................................................. 519
Preface

For details, see the following topics:

• About this documentation
• Information on Documentation
• Conventions Used in this Manual
• Product support contact information

About this documentation

This guide provides documentation for Progress OpenEdge BPM Designer.

BPM Designer provides a graphical, integrated development environment where business executives, solution providers, IT professionals and Web designers can collaboratively create executable processes.

Information on Documentation

This documentation contains information for the following types of Progress OpenEdge Business Process Server users. In the following table, we recommend the guides that are most relevant to each type of user.

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio
Table 1: Documentation

<table>
<thead>
<tr>
<th>If you are the ...</th>
<th>Read the ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application User</td>
<td>BPM Studio User’s Guide</td>
</tr>
<tr>
<td></td>
<td>BPM Events User’s Guide</td>
</tr>
<tr>
<td></td>
<td>Terminology Guide</td>
</tr>
<tr>
<td></td>
<td>Tutorial Guide</td>
</tr>
<tr>
<td>Application Developer</td>
<td>Application Developer's Guide</td>
</tr>
<tr>
<td></td>
<td>BP Server Developer’s Guide</td>
</tr>
<tr>
<td></td>
<td>Customization Guide</td>
</tr>
<tr>
<td></td>
<td>Managed Adapters Guide</td>
</tr>
<tr>
<td></td>
<td>Web Services Developer’s Guide</td>
</tr>
</tbody>
</table>

For the latest documentation updates, see OpenEdge Product Documentation on PSDN.

Conventions Used in this Manual

This document uses the following conventions and terminology notations to distinguish elements of text:

Table 2: Conventions in this Manual

<table>
<thead>
<tr>
<th>Convention (styles and terms)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Indicates titles of command buttons, checkboxes, options, lists, dialog boxes and portal page names.</td>
</tr>
<tr>
<td><strong>bold italic</strong></td>
<td>Represents notes that alert you on specific Business Process Server elements and similar advisory information.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Indicates folder paths, file names and book titles.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Represents code segments or examples.</td>
</tr>
<tr>
<td><strong>backward slash (/)</strong></td>
<td>Indicates the path in a Windows environment. For UNIX, a forward slash is used.</td>
</tr>
<tr>
<td><strong>OEBPS_Home</strong></td>
<td>Represents the installed folder of Business Process Server that contains essential components and files. The default location is C:\Progress\OpenEdge\oebmp\server.</td>
</tr>
<tr>
<td>Convention (styles and terms)</td>
<td>Purpose</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Studio_Home</td>
<td>Represents the installed folder of BPM Designer that contains essential components and files. The default location is C:\Progress\OpenEdge\oebpm\studio.</td>
</tr>
<tr>
<td>Workspace_Home</td>
<td>Represents the Workspace folder of Progress Developer Studio for OpenEdge. The default location is C:\Users&lt;user_name&gt;.&lt;user_domain&gt;\Progress\Developer Studio 3.7\workspace.</td>
</tr>
</tbody>
</table>

## Product support contact information

If the product documentation does not provide a solution to your specific issue, or if you need clarification on the issue, then contact our Product Support team. You can contact the team through the Internet, telephone, or postal mail, as per the details provided in the following table.

**Table 3: Product Support Contact Information**

<table>
<thead>
<tr>
<th>To contact by</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web site</td>
<td><a href="http://progresslink.progress.com/supportlink">http://progresslink.progress.com/supportlink</a></td>
</tr>
<tr>
<td></td>
<td>If you are an existing customer, then you can log in to the above site for product support. If you are a first time user, then you need to create an account first.</td>
</tr>
<tr>
<td>Telephone¹</td>
<td>1-781-280-4999 for US, Latin America and Canada</td>
</tr>
<tr>
<td></td>
<td>1-781-280-4543 for the Product Support Fax Line</td>
</tr>
<tr>
<td>Postal Address¹</td>
<td>Progress Software Corporation</td>
</tr>
<tr>
<td></td>
<td>14 Oak Park Drive</td>
</tr>
<tr>
<td></td>
<td>Bedford, MA 01730, USA.</td>
</tr>
</tbody>
</table>

To enable us to quickly answer your questions, please provide the following information:

- Your name, installation site address and the license key for Business Process Server software.
- Your Business Process Server version and build number.
- Your operating system, application server and browser, with version and service pack details, if any.
- Your database management system and version, and information on JVM and JDBC used.

¹ For support telephone numbers and offices in your region, visit the support web site above. This contact information is for customer support only.
OpenEdge Business Process Server overview

Progress Software Corporation is a leading global provider of automated business process management solutions. The company’s product, Progress OpenEdge Business Process Server (henceforth referred to as Business Process Server or BP Server), is a comprehensive business process management platform, which enables companies to quickly transform their business processes into flexible and manageable Web applications, distributed over intranets, extranets, and the Internet.

Business Process Server addresses every stage in the business life cycle: define, integrate, publish, monitor, analyze, improve, and control. By adopting an end-to-end approach, Business Process Server incorporates all the key elements required to meet the ever-changing demands of e-business while ensuring e-business success. By providing integrated management tools, Business Process Server lets you monitor operations proactively, modifying automated processes dynamically based on changing external operations online. An overview of a typical automated business process management solutions is shown in Figure 1 on page 22.
For details, see the following topics:

- Business Process Server components
- How Business Process Server works
- Business Process Server user types

Business Process Server components

Business Process Server is a suite of integrated components that enables you to easily build intranet, extranet, and Internet applications and manage your e-business. Business Process Server consists of the following components as in Figure 2 on page 23:
Table 4: Business Process Server components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Portal Home</td>
<td>The Home module of Business Process Portal is the primary interface for application users, enabling them to interact with Business Process Server applications. Users can complete entries to various tasks and applications, and link to the support infrastructure required to complete these tasks.</td>
</tr>
<tr>
<td>Business Process Portal Management</td>
<td>The Management module enables managers to query, report on, and control processes and resources, visible only to the managers.</td>
</tr>
<tr>
<td>Business Process Portal Administration</td>
<td>The Administration module enables Business Process Server Administrators to modify configuration parameters, manage user or group access control, and install or uninstall Business Process Server applications.</td>
</tr>
<tr>
<td>Web services</td>
<td>This component allows application developers to: publish their applications as Web services, and find and convert other available Web services on the Internet into Business Process Server applications.</td>
</tr>
<tr>
<td>BPM Webflow</td>
<td>This component provides a framework for developing and implementing Web-enabled workflow applications.</td>
</tr>
</tbody>
</table>
## How Business Process Server works

The following figure provides an overview of the interaction between Business Process Server components.

**Figure 3: How Business Process Server works**
The following explanations correspond to the labels shown in the above figure, and describe how the components operate.

1. Progress Developer Studio for OpenEdge and Business Process Modeler provide an integrated development environment (IDE) for Business Process Server, where you can design and publish business processes. The application developer designs a process template (with the ".spt" or ".swt" extension) in the IDE that reflects the business flow and other business process requirements. Business rules for the process template can be defined using the Rule Editor, a BPM Events component that is launched with Progress Developer Studio for OpenEdge.


3. Once the process template is defined, Business Process Server Administrators use the Administration module to install the business process on the BP Server. Administrators can also configure Business Process Server components, manage user or group access control, and publish Business Process Server applications as Web services. Once installed, users access applications through servlets that pass the requests over an RMI/IIOP connection to the BP Server within an EJB Container.

4. The EJB Container provides a runtime environment that executes and manages Java-based program components that run on the server side of a client/server network. Within the EJB Container are the BP Server and BPM Events server.

5. The BP Server writes events to event tables in the database. Each Business Process uses JDBC to connect to database server as well as store events in the database. Within the BP Server, BPM Process Store uses JDBC to connect to the database server process and retrieve the events deposited by the BP Server process. BPM Process Store interprets the events and populates the process tables. These populated tables are used by Business Process Portal modules.

6. Once the process template is installed as a Business Process Server application, application users can use the Home module to do the following:
   - Access applications
   - Obtain information to perform their tasks
   - Launch the application to start process instances from the BP Server

7. Once the process template is installed as an Business Process Server application, managers can use the Management module (if they have access privileges) to monitor execution of process instances and create reports. Servlets receive requests from managers and pass them onto the BP Server over an RMI/IIOP connection. Managers use the Report Builder to define management reports that retrieve information through JDBC to the database server.

8. BPM Events is a rule-based event or message processing server that loads application rules and executes them against the BP Server and/or external events or messages. This server persists data in the database for recovery and with the help of JDBC connects to the database.

9. Managed Adapters exchange information between Business Process Server applications and external applications by converting Business Process Server-specific protocol to the protocol of an external system such as a database or ERP system. When users add a Managed Adapter to a work step, they can define complex mapping between Business Process Server dataslots and adapter inputs or outputs of the external application. At runtime when the work step is executed, the Managed Adapter sets the adapter inputs and configuration, and maps the outputs to the appropriate output dataslots.
10. BPM Webflow is a run-time component that executes the presentation flows. This component provides a Model, View, Controller (MVC) paradigm for developing presentation flow-based applications and executing them in a Web container.

11. Business Process Servers Web services component allows BP Server applications to be published as Web services.


Business Process Server user types

There are four user types within Business Process Server, Application users, Managers, Application developers, Business Process Server administrators.

User types

Each Business Process Server user type is defined below:

• Application users — Application Users use Business Process Server applications to coordinate specific business tasks with another department within their company, with another company within their organization, and/or with a business partner in another organization. The Home module in Business Process Portal serves as the primary interface in which Application Users run Business Process Server applications.

• Managers — Managers are typically experts in a particular business domain, such as quality assurance or human resources. They might need to work with managers from other groups in automating some of the business procedures that these groups share. The Management module in Business Process Portal serves as the primary Business Process Server interface for business managers to coordinate and integrate business processes, enabling them to exchange information with one another, and to share functionality over such standard communication channels as the Internet or e-mail.

• Application developers — Application developers are responsible for analyzing business processes and developing interfaces associated with creating tasks or processes. Application developers are often not domain experts themselves, but work closely with Managers to define business processes and determine the requirements of an application. Application developers use Progress Developer Studio for OpenEdge or Business Process Modeler to define the business process; the resulting process template file is tested, simulated, published, and run as a Business Process Server application.

• Business Process Server administrators — Business Process Server administrators are responsible for configuring Business Process Server components, managing user or group profiles and access control, and installing or uninstalling Business Process Server applications. The Administration module in Business Process Portal serves as the primary interface for Business Process Server Administrators to administer applications.

All Business Process Server user types can communicate by using one or more Business Process Server applications. They can also communicate with external applications.
Introduction to Progress OpenEdge BPM Designer

This chapter introduces OpenEdge BPM Designer in Progress Developer Studio for OpenEdge (henceforth also referred to as BPM Designer or Progress Developer Studio for OpenEdge), which enables you to develop process templates and publish them as Business Process Server applications, without exiting the development environment.

BPM Designer uses the Eclipse-based Integrated Development Environment (IDE), a comprehensive cross-platform environment which provides stable, universal platform for application development. This open, scalable, and standards-based development environment reduces the time spent in application development and supports a user’s choice of version control system and application server. The current version of BPM Designer is based on the Eclipse Foundation SDK (version 3.6.0) integrated development environment.

BPM Designer enables you to integrate the various files contained in a typical project, and to develop an entire project within a single development environment. After developing your project, use the Publish wizard to install it on the Business Process Server, to provide a connection with Web services and other Business Process Server users.

Note: Progress Software Corporation also provides the Business Process Modeler, a more basic version of Progress BPM Designer. For more information, see the Business Process Modeler User’s Guide.

For details, see the following topics:

- Supported platforms
- Functions
- Terminology
Supported platforms

BPM Designer has been extensively tested on the platforms, tools, and applications supported by Business Process Serve. Table 5 on page 28 provides the supported platforms.

Table 5: Supported Platforms

<table>
<thead>
<tr>
<th>Category</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Server</td>
<td>This Progress Developer Studio for OpenEdge version is designed to work with Business Process Server components.</td>
</tr>
<tr>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>Operating Systems</td>
<td>MS Windows 2000/Vista/XP Professional SP2/ SP3 and Windows 7</td>
</tr>
</tbody>
</table>

Functions

Progress Developer Studio for OpenEdge enables you to perform a variety of functions without exiting the Eclipse environment. For example, you can:

- Design a business process using the worksteps, connectors and other process template elements provided in the BPM Designer user interface. A process template must contain a Start workstep, intermediate worksteps that can include Activity, Adapter and Subprocess worksteps, and one or more End worksteps.
- Define performers and resources for the new process. These process-level performers and resources are available for each instance of the process.
- Assign performers and resources to worksteps. Types of performers include the following:
  - Individual users, groups of users, or queues that perform activity worksteps.
  - Adapters that perform Adapter worksteps.
  - Other processes that act as performers of Subprocess worksteps.
- Define the information flow for the new process by creating dataslots that can provide information into (input) or out of (output) worksteps.
- Define the presentation (look and feel) for Start and Activity worksteps through the Form Editor.
- Configure and run simulations of the process to analyze performer and resource usage, to identify repetitive loops and inefficient bottlenecks, and to predict process performance. BPM Designer also enables you to generate a report on the simulation results in HTML format.
- Define common resources, including business objects, customized adapters and stylesheet files, which can be accessed from and used in all BPM Designer applications.
- Generate rules for a selected workstep or process by either creating new rules, using the Rule Editor, or using Rule Wizards provided by BPM Designer that you can use as templates for building your own rules.
- Save the process to your local server after completing process design.
• Publish a process as an installed application on the Business Process Server.

## File types

To integrate Business Process Server file editors with the Eclipse-based IDE, Progress Developer Studio for OpenEdge provides the following new file types:

- SPT - Use this Business Process Template (.spt) extension when you can create a BP Server application by defining a process template that is designed to automate a business process.
- SWT - Use this Business Webapp Template (.swt) extension when you create a Web application that defines a Web-enabled business process.
- BPS - Use this BPM Events Source (.bps) extension when you want to create a rule file in the Rule Editor in BPM Designer.

## Terminology

Before starting application development in Progress Developer Studio for OpenEdge, familiarize yourself with basic terms and concepts, provided in Table 6 on page 29. See the Glossary for additional definitions of commonly used terms. For the complete list of Business Process Server terminology, see the *OpenEdge Business Process Server: Terminology* guide.

### Table 6: Business Process Server Terminology

<table>
<thead>
<tr>
<th>Concept or Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process</td>
<td>A business process involves multiple worksteps in the form of operations, interactions, and notifications performed by a human user or group of users; an external adapter or a script; or other processes.</td>
</tr>
<tr>
<td>Business Process Server Application</td>
<td>A Business Process Server application is an installed, executable business process template that automates a business flow.</td>
</tr>
<tr>
<td>Process Template</td>
<td>A process template is a model of business flow that includes worksteps, connections, and dataslots. The process template describes the information and data flow of a business process. Process template files are stored in SPT, SWT or XML format. After being published and installed, the process template files are available as Business Process Server applications.</td>
</tr>
<tr>
<td>Business Logic</td>
<td>The control and information flow among worksteps that define a business process.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Control Flow</strong> - The sequences of worksteps and workstep conditions, as defined in the process template.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Information Flow</strong> - The definition of process dataslots and the addition of information from dataslots of a workstep.</td>
</tr>
<tr>
<td>Concept or Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Process Instance** | A running instance of a Business Process or a Web application. A process instance is created every time you run an application. A process instance has the following characteristics:  
  - Each instance is a self-contained unit and can be modified dynamically at runtime without modifying the process template.  
  - Each instance is uniquely identified by a name within the system.  
  **Note:** Multiple instances of the same application are created by running the application several times. |
| **Subprocess** | A process template referenced in a parent process template. Any process template can be included as a subprocess within another process template by using a Subprocess workstep. |
| **Workstep** | A step in a business process that can have human or computer performers; or it can be a subprocess. Worksteps in BPM Designer include **Start**, **Activity**, **Adapter**, **Subprocess**, and **End** worksteps. |
| **Connector (or Link)** | A connection between two worksteps used to describe the control flow of a process. |
| **Performer** | An entity that executes a workstep. Depending on the workstep type, the performer can be a User (a human performer or a group of human performers), an Adapter (an external application or system), or a Subprocess. |
| **Dataslot** | A data placeholder that persists through the entire process, used to define the information flow of the business process. Dataslots are associated with processes, where they can add information into (input) or out of (output) worksteps. |
| **Adapter** | A Java class that integrates remote, third-party classes and actions with Business Process Server. An adapter can automate certain functions or tasks performed by a remote server or an external system. |
Opening Progress Developer Studio for OpenEdge

Progress Developer Studio for OpenEdge enables you to use an Eclipse-based Integrated Development Environment (IDE) to create business processes, which are administered as BPM project files. The IDE project includes all Business Process files (SPT files), Web application files (SWT files), and rule files (BPS files), as well as the folder structure containing those files, their paths, settings, and required resources.

These files and resources are used to load, save, build, or run a project. The project is an organizational tool: the files you open in a project can be in any folder. Restructuring a project tree has no effect on a folder tree, providing independent control of projects and folder structure.
To open Progress Developer Studio for OpenEdge:

1. From the Start menu, select Programs > Progress > OpenEdge > Progress Developer Studio 3.7 for OpenEdge.
2. Use the Workspace Launcher dialog box to select a workspace which you can use to create or modify business processes.

Figure 4: Workspace Launcher

a) Click Browse to open the Select Workspace Directory dialog box that enables you to locate another workspace folder. Click Make New Folder to create a new workspace folder at the selected location.

b) Select the Use this as the default... checkbox to automatically launch the workspace displayed in the Workspace list and to make it the default workspace. Selecting this check box prevents this dialog box from appearing the next time you start Progress Developer Studio for OpenEdge. If you want to re-activate the Workspace Launcher dialog box, click Preferences from the Window menu, and select General > Startup and Shutdown > Workspaces > Prompt for workspace on startup checkbox.

c) Click OK to open Progress Developer Studio for OpenEdge in the workspace shown in the Workspace drop-down list. Once you have selected a workspace, you can later open the Workspace Launcher dialog box by selecting File > Switch Workspace.

After you have selected your workspace, the Welcome page appears if you are opening Progress Developer Studio for OpenEdge for the first time.

Exploring Progress OpenEdge BPM Designer

This section describes the OpenEdge BPM Designer user interface including its panes, menus, and toolbars. Figure 5 on page 33 displays a sample blank process template created for a BPM Project.
Figure 5 on page 33 identifies the commonly used views and components in the OpenEdge BPM Designer interface, and these are further described in the following table.

Table 7: OpenEdge BPM Designer Window Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu bar</td>
<td>The Menu bar provides access to both Eclipse and OpenEdge BPM Designer development functions. For details, see Using the menubar on page 35.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>The Toolbar contains icons providing shortcuts to commonly used functions. The Toolbar includes both Eclipse and OpenEdge BPM Designer toolbar commands.</td>
</tr>
<tr>
<td>Project Explorer View</td>
<td>The Project Explorer View displays the contents of active projects. It consists of a hierarchical view of all the files that make up the active project.</td>
</tr>
<tr>
<td>Palette</td>
<td>The bar above the Content pane contains icons for selecting, connecting, grouping, and moving the elements in the process template diagram. For details, see Using the palette on page 40.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Outline View</td>
<td>The Outline view provides the following options to view the current process. Click the drop-down list provided and then select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Process</strong>, which lists the worksteps in the current process template.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Performers</strong>, which displays the performers assigned to each activity and adapter worksteps.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Rules</strong>, which displays the rules assigned to the process or to worksteps in the process displayed in the Content pane.</td>
</tr>
<tr>
<td></td>
<td>You can use the adjoining <strong>Search</strong> box to search for a process, workstep, performer, or rule.</td>
</tr>
<tr>
<td>Tasks pane</td>
<td>The Tasks pane contains seven options: Select and Change Layout, Create Phases and Swim Lanes, Draw Shapes, Connect Shapes, Assign Participants, Create Rules, Create Annotations. These options help you in the design of a process template. For details, see Using the Tasks pane on page 37.</td>
</tr>
<tr>
<td>Content pane</td>
<td>The Content pane contains the main work space in which the selected project or file is displayed. The Content pane also contains:</td>
</tr>
<tr>
<td></td>
<td>- <strong>File tabs</strong>, located at the top of the pane, which shows active files in the current project. Click on a File tab to display the file in the Content pane.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Content pane tabs</strong>, located at the bottom of the pane, which include the <strong>Diagram</strong> tab, displaying the process template; the <strong>Overview</strong> tab, which displays the process elements in a tabular format; the <strong>Path Analysis</strong> tab, in which you can perform process path analysis; the <strong>Dataslots</strong> tab, in which you can define process dataslots; the <strong>Performers</strong> tab, in which you can define performers at the process level; the <strong>Alerts</strong> tab to define and manage Alerts; and the <strong>Logic</strong> tab, which contains the Graphical Event Logic (GEL) tool to configure defined events.</td>
</tr>
<tr>
<td></td>
<td>- An arrow, at the bottom right corner of the Content pane, provides a bird's eye view of the entire process template in a 3x3 grid. You can drag the purple box (showing the current process view) to navigate to a specific process view location.</td>
</tr>
<tr>
<td>Properties View</td>
<td>Click your cursor in a blank spot in the diagram to view process properties. You can also click a workstep to view the properties of any selected workstep.</td>
</tr>
</tbody>
</table>

**Note:** All views can be moved to various locations within the user interface. Click the view's tab and drag it to a location you want to move it to.
Using the menubar

This section describes the frequently used menu commands.

Using Eclipse menu commands

Eclipse menu commands that are frequently used in Progress Developer Studio for OpenEdge are shown in Table 8 on page 35. Other menu items in this Eclipse-based environment operate in the standard Eclipse manner, and are not covered in this document. Refer to the Eclipse tutorials or Help topics provided in the Help menu in the Toolbar, or documentation available at the Eclipse Web site (http://www.eclipse.org/) for more details on their usage.

Table 8: Eclipse Menu Commands Used in Progress Developer Studio for OpenEdge

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon and Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>File &gt; New &gt; Project</td>
<td>Opens the <strong>New Project</strong> dialog box. Expand the <strong>BPM</strong> node and click the appropriate options for BPM Project, Business Process, or BPM Simulation Project.</td>
</tr>
<tr>
<td>Open</td>
<td>File &gt; Open File</td>
<td>Opens the <strong>Open File</strong> dialog box, where you can select the process or project file you want to open.</td>
</tr>
<tr>
<td>Save</td>
<td>File &gt; Save</td>
<td>Saves the changes made to the active project and files since the last Save. Click File &gt; Save All to save changes made on all open projects.</td>
</tr>
<tr>
<td>Print</td>
<td>File &gt; Print</td>
<td>Opens the <strong>Print</strong> dialog box, enabling you to print the process template and define its printing properties.</td>
</tr>
<tr>
<td>Build All</td>
<td>Project &gt; Build All</td>
<td>Runs an incremental build on all projects in the Eclipse workspace, modifying only those resources that have been changed since the last build.</td>
</tr>
<tr>
<td>Build Project</td>
<td>Project &gt; Build Project</td>
<td>Builds the currently selected project. This is an incremental build, meaning that the builder analyzes the changes since the last build and minimizes the number of changed files.</td>
</tr>
<tr>
<td>Open Perspective</td>
<td>Window &gt; Open Perspective</td>
<td>Opens a new perspective in Eclipse.</td>
</tr>
</tbody>
</table>

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio
Using commands

In addition to Eclipse menu items, Table 9 on page 36 describes the commonly-used commands available in the OpenEdge BPM Designer perspective.

**Table 9: Progress Developer Studio for OpenEdge Commands**

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon and Shortcut</th>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import</td>
<td></td>
<td>File &gt; Import</td>
<td>Imports external projects and extracts archive files.</td>
</tr>
<tr>
<td>Process</td>
<td>ALT + ENTER</td>
<td>File &gt; Properties</td>
<td>Enables you to define the current process properties.</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL + Z</td>
<td>Edit &gt; Undo</td>
<td>Undoes or recreates the last action performed in the Content pane, up to 100 levels. Supports lane, shape, connector and cut/copy/paste operations, as well as Align, Space and Collapse operations. You can perform Undo and Redo operation in the Form Editor as well. Caution: If an operation that cannot be undone is performed, the undo queue is cleared and the previous operations cannot be undone.</td>
</tr>
<tr>
<td>Redo</td>
<td>CTRL + Y</td>
<td>Edit &gt; Redo</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
<td>Edit &gt; Copy</td>
<td>Copies a selected item to the clipboard. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL + V</td>
<td>Edit &gt; Paste</td>
<td>Pastes the clipboard items in the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
<td>Edit &gt; Cut</td>
<td>Cuts a selected item from the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Show a View</td>
<td></td>
<td>Window &gt; Show View</td>
<td>Select one of the listed options to show the view.</td>
</tr>
<tr>
<td>Build Module</td>
<td></td>
<td>Project &gt; Build Module</td>
<td>Build the currently selected process (or module) in a BPM project. This is useful if you want to build and publish a single module in a project with multiple processes,</td>
</tr>
<tr>
<td>Build Modules</td>
<td></td>
<td>Project &gt; Build Modules</td>
<td>Builds multiple processes (or modules) contained in a single BPM project or across multiple BPM projects.</td>
</tr>
<tr>
<td>Publish</td>
<td></td>
<td>Project &gt; Publish</td>
<td>Publishes the current project on the Business Process Server.</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td>Project &gt; Properties</td>
<td>Displays the properties of the active project.</td>
</tr>
<tr>
<td>Name</td>
<td>Icon and Shortcut</td>
<td>Menu</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Widgets</td>
<td>Tools &gt; Widgets Configuration Tool</td>
<td>Enables you to define, copy, or modify widgets that are used in Business Process Portal.</td>
<td></td>
</tr>
<tr>
<td>Form Data</td>
<td>Tools &gt; Form Data Designer</td>
<td>Enables you to design services for controls (or widgets) in the Form Editor.</td>
<td></td>
</tr>
<tr>
<td>Users</td>
<td>Tools &gt; Users</td>
<td>Enables you to add and manage users, groups, and queues.</td>
<td></td>
</tr>
<tr>
<td>Calendars</td>
<td>Tools &gt; Calendars</td>
<td>Enables you to define an organization-level calendar.</td>
<td></td>
</tr>
<tr>
<td>Channels</td>
<td>Tools &gt; Channels</td>
<td>Enables you to create, import, export, or modify channels.</td>
<td></td>
</tr>
<tr>
<td>Messages</td>
<td>Tools &gt; Messages</td>
<td>Enables you to create, import, export, or modify messages.</td>
<td></td>
</tr>
<tr>
<td>Business Objects</td>
<td>Tools &gt; Business Objects</td>
<td>Enables you to create, import, export, or modify business objects.</td>
<td></td>
</tr>
<tr>
<td>Managed Adapters</td>
<td>Tools &gt; Managed Adapters</td>
<td>Manages various configurations on out-of-the-box and user-defined managed adapters.</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>Help &gt; Help Contents</td>
<td>Launches Eclipse Help which assists you with application development in Progress Developer Studio for OpenEdge.</td>
<td></td>
</tr>
</tbody>
</table>

### Using the Tasks pane

The Tasks pane contains primarily the Design Tasks panel, which lists the links used when designing your process template diagram. Clicking any of these links displays the associated panel; for instance, the Layout Tasks panel and the Description panel for the Select and Change Layout link.
Figure 6: Tasks pane

Note: To hide the Tasks pane, click the adjoining Hide icon (►). To view the Tasks pane again, click the Show (◇) icon. You can also expand (and then collapse) any of the panels. To expand a panel, click the Expand (.expand) icon. To collapse a panel, click the Collapse (出台了) icon. Alternatively, you can expand (or collapse) a panel by clicking the panel header.

• **Select and Change Layout**. Enables you to align and space process template elements and apply auto-layout. For more information, see Aligning and spacing worksteps on page 220.

• **Create Phases and Swim Lanes**. Enables you to add a phase or swim lane to the process template diagram. For more information, see Creating swim lanes on page 142. This option is not available for Web applications.

• **Draw Shapes**. Lists the worksteps and other process template elements (Start, Activity, Decision, Or-Join, End, etc.) that you can drag into the Content pane to create the workflow for your process. For more information, see Using shapes on page 39.

• **Connect Shapes**. Enables you to draw connections between process template elements. The Connect Tasks panel show three types of connectors - Normal flow, Compensation flow, Timeout flow - that you can use to connect worksteps. If the connection is not valid, the connection cursor is displayed in red. Once you select a connector type, you can continue to make connections. To discontinue connecting, click any other Tasks pane link. For more information, see Connecting worksteps on page 96.

• **Assign Participants**. Displays the performers grouped under 4 categories: Users, Adapters, Sub-Processes, and External. By default, performers include organization-level users and a predefined user, “Creator” for a Business Process, as well as a group of predefined managed adapters and a custom adapter. You can use this link to add, delete or modify the properties of a performer. For more information, see Defining performers on page 131.

• **Create Rules**. Displays a series of predefined rule wizards. Expand a folder to view its rule wizards. Assign a predefined set of rules to a workstep or a process by dragging the rule wizard icon to the selected target. For more information, see Accessing Rule Wizards on page 469. This option is not available for Web applications.

• **Create Annotations**. Enables you to add an Annotation, Sticky Note, or a Group notation to the process template diagram. For more information, see Adding notes on page 100.
Using shapes

The table below provides information about the Shapes listed when you click the **Draw Shapes** link in the Tasks pane. These shapes follow standard **Business Process Modeling Notation** (BPMN) and include Activities (represented by a rounded rectangle); event objects such as Start or End (represented by a circle); and Gateways (represented by a diamond) that indicate a change in the workflow, such as the joining, merging, splitting, or deciding of the flow’s direction.

Table 10: Shapes in Tasks Pane

<table>
<thead>
<tr>
<th>Shape</th>
<th>Represents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Start" /></td>
<td>Start</td>
<td>An event object that specifies the beginning of a business process. Each process must have only one Start workstep.</td>
</tr>
<tr>
<td><img src="image" alt="Activity" /></td>
<td>Activity</td>
<td>This activity represents the basic unit of work that you can assign to one of the following performer types: User (a valid human performer or group), Adapter, or Subprocess.</td>
</tr>
<tr>
<td><img src="image" alt="Decision" /></td>
<td>Decision</td>
<td>This gateway represents a decision point in the process flow. If the specified condition is not met, the default branch is taken.</td>
</tr>
<tr>
<td><img src="image" alt="Exclusive Or-Join" /></td>
<td>Exclusive Or-Join</td>
<td>This gateway enables the process flow to proceed only once from multiple previous worksteps to a next workstep, and terminates any other human-performed previous worksteps. This shape is not available for Web Applications.</td>
</tr>
<tr>
<td><img src="image" alt="Or-Join" /></td>
<td>Or-Join</td>
<td>This gateway connects multiple predecessor worksteps and one successor workstep. The successor workstep is performed if any of the predecessor worksteps have been completed.</td>
</tr>
<tr>
<td><img src="image" alt="And-Gateway" /></td>
<td>And-Gateway</td>
<td>This gateway can act as an And Join or as a Split (or And-Fork). When it connects multiple predecessor worksteps to a single successor workstep, it acts as an And-Join. When it connects one predecessor workstep to multiple successor worksteps, it acts as a Split (or And-Fork). The successor worksteps are performed in parallel and only if the predecessor was completed. This enables you to synchronize the completion of multiple predecessor worksteps. This shape (gateway) is not available for Web applications.</td>
</tr>
<tr>
<td>Shape</td>
<td>Represents</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Message icon]</td>
<td>Message</td>
<td>An intermediate workstep in a process, indicating that the workstep is waiting for a message or will send a message when it is activated. Messages can also be assigned to the Start or End of a process.</td>
</tr>
<tr>
<td>![End icon]</td>
<td>End</td>
<td>An event object that signifies that the application has come to a normal end. You can add multiple End worksteps in a process.</td>
</tr>
</tbody>
</table>

### Using the palette

The palette (as shown in Figure 5 on page 33) contains the following utilities:

- **Select shapes** (or **Select**) icon: Use this icon to select an Activity or other shape in the process template diagram to perform operations including copying, moving, and resizing shapes.

- **Pan the diagram** (or **Panning**) icon: Use this icon to move a portion of the diagram into the viewing area. Once you select the Panning icon, the cursor in the Content pane is displayed as a "hand". The Panning mode persists until you select another mode.

- **Show Gestures** icon: Use this icon to display the list of mouse gestures, which you can use to quickly add shapes, layouts, and perform common process-related actions. For more information, see Using mouse gestures on page 103.

- **Color** icon: Use this icon to apply color to a selected shape, swim lane, or note. Click the icon to display a color palette, from where you can select one of the listed colors, or click **More** to display more color options.

- **Zoom In** icon / **Zoom Out** icon: Use these icons to zoom in or zoom out the view of the current process template in the Content pane. You can select a pre-defined magnification levels (200%, 100%, 75%, 50%, or 25%) or enter a value in the Magnification combo box.

- In the case of Business Process templates, the drop-down list provided displays the current process. This is useful in the case of inline subprocesses (see Defining an inline subprocess on page 137. Click the **One Level Up** icon or select the parent process or higher subprocess from the adjacent drop-down list.

- **Check Diagram** icon: Enables you to verify if the process template diagram is correct.

- **Show 360° View** icon: Enables you to generate the 360° view for the current process template. For more information, see Generating 360 degree view on page 77.

- **Preview All** icon: Enables you to view all the presentation forms that are defined for the process and are developed in the Form Editor.

- **Print Preview** icon: Enables you to preview the current process template before printing it. For more information, see Printing the process template on page 80.
• **Export** ( Export icon: Enables you export the current process template as a Web page (HTML), an SVG or a JPEG file. For more information, see Exporting the process template on page 81.

---

**Using keyboard shortcuts**

Table 11 on page 41 lists the keyboard shortcuts you can use to facilitate application development.

**Table 11: Keyboard Shortcuts**

<table>
<thead>
<tr>
<th>Keys</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + Enter</td>
<td>File &gt; Properties</td>
<td>Enables you to define the current process properties.</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Edit &gt; Select All</td>
<td>Selects all items in the Content pane.</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Project &gt; Build All</td>
<td>Enables you to run an incremental build of all your active applications.</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Edit &gt; Copy</td>
<td>Copies a selected item to the clipboard to enable pasting of the item into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Project &gt; Publish</td>
<td>Publishes the current project to a specified server.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Edit &gt; Find/Replace</td>
<td>Enables you to find a specified item within displayed text in any text frame.</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Search &gt; Search</td>
<td>Enables you to search for a specified file, Java string or plugin.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td></td>
<td>Enables you to create a new project, by selecting one of the Business Process Server wizards.</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>File &gt; Print</td>
<td>Enables you to print a selected item.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>File &gt; Save</td>
<td>Enables you to save the changes you made to your active project.</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>File &gt; Save All</td>
<td>Enables you to save the changes made in all open projects.</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Edit &gt; Paste</td>
<td>Pastes the clipboard item (cut or copied) into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>File &gt; Close</td>
<td>Closes the current process template diagram.</td>
</tr>
<tr>
<td>Ctrl + Shift + W</td>
<td>File &gt; Close All</td>
<td>Enables you to close all open projects.</td>
</tr>
</tbody>
</table>
### Configuration parameters

BPM Designer contains the default extensions for opening template files:

- **SPT** (for Process Template), used for files for new Business Processes.
- **SWT** (for Web application Template), used for files for new Web applications.
- **SST** (for Simulation Template), used for files for new Simulation projects.

For rule files, the default extension is `.bps` (for BPM Events Source).

**Note:** To configure classpath settings to use an external class in any of your rules, see the Classpath settings for Rule Editor section.

### Localizing Progress Developer Studio for OpenEdge

You can adapt Progress Developer Studio for OpenEdge to a language of your choice. For instructions on how to localize menus, titles of windows, labels of controls, messages, and other displayed text in a specific language, see Chapter 11: “Localizing Business Process Server” in the Customization Guide.

Progress Developer Studio for OpenEdge uses “UTF-8” encoding for all saved files. In case you are not using the Eclipse bundled with Progress Developer Studio for OpenEdge installation, you must ensure that your Eclipse installation uses “UTF-8” file encoding.

**To set "UTF-8" encoding for Eclipse::**

<table>
<thead>
<tr>
<th>Keys</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + X</td>
<td>Edit &gt; Cut</td>
<td>Cuts and copies the selected item to the clipboard to enable pasting of the item into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Edit &gt; Redo</td>
<td>Recreates the last action performed in the workspace.</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Edit &gt; Undo</td>
<td>Removes the last action performed in the workspace. The Undo/Redo commands support lane, shape, connector and cut/copy/paste operations, as well as Align, Space, and Collapse operations. Caution: All other actions (for example, entering process property information in Properties dialog box) cannot be undone. If an operation that cannot be undone is performed, the undo queue is cleared and the previous operations cannot be undone.</td>
</tr>
<tr>
<td>Alt + F7</td>
<td>Check diagram</td>
<td>Checks the active diagram and verifies its validity.</td>
</tr>
</tbody>
</table>
1. Exit Progress Developer Studio for OpenEdge, if running.
2. Right-click your Eclipse installation shortcut, then click Properties.
3. From the Properties dialog box, ensure that the file.encoding parameter (in the Target box) value is set to UTF-8.
4. Click OK and start Progress Developer Studio for OpenEdge.
Developing BPM projects

This chapter describes how to create projects using Progress Developer Studio for OpenEdge. For details, see the following topics:

- Project facets
- Creating a BPM project
- Exporting BPM applications
- Importing BPM applications
- Managing multiple processes
- Importing a process file
- Generate OpenEdge JSDO Catalog
- Using a process file as a template
- Using a project as a template
- Creating a simulation project

Project facets

Progress Developer Studio for OpenEdge implements the Faceted Project Framework, which enables you to create a BPM project. A BPM project comprises of units of functionality (or facets) that can be easily added or removed.
A facet represents a unit of functionality in a BPM project. By default, you can create a BPM project with any of the following facets:

- **Process**: to create a BPM project with a Business Process facet.
- **Web Application**: to create a BPM project with a Web application facet.
- **Common Resources**: to create a BPM project with a common resources facet.

Progress Developer Studio for OpenEdge allows you to view project facet properties for any BPM project, as well as apply a facet. For more information, see Project facet properties on page 46.

**Note:** The compiler compliance level for BPM projects is JDK/JRE 1.6. Progress Developer Studio for OpenEdge cannot publish BPM projects with compliance level greater than 1.6. Progress Developer Studio for OpenEdge is installed with Eclipse with JDK/JRE 1.6. However, if you have installed Eclipse with JDK/JRE 1.7, you can use Progress Developer Studio for OpenEdge to create and publish BPM projects with JDK/JRE 1.6 compliance level.

## Project facet properties

Progress Developer Studio for OpenEdge enables you to view the project facet properties for an added BPM project in the Properties page. Additionally, you can apply a facet to the project.

You can view the Properties page by selecting the created BPM project in the Project Explorer view and clicking File > Properties. You can view the list of the following project facets from the Project Facets page:

- **Java**: This facet is locked by default. You cannot remove this facet.
- **JavaScript**: This facet is selected for a BPM Project. For this facet, the jsNature is also applied to the project.
- **Process**: This facet is selected if the BPM project contains a Business Process.
- **Web Application**: This facet is selected if the BPM project contains a Web application.
- **Common Resources**: This facet is selected if the BPM project contains common resources.

You can apply a facet to the project by selecting the respective checkbox and clicking Apply. You can restore the default facet properties by clicking Revert.

## Creating a BPM project

Progress Developer Studio for OpenEdge opens in the selected workspace, and in an Eclipse integrated development environment (IDE) and displays the OpenEdge BPM Designer perspective.

**To create a BPM project:**

1. From the File menu, select New > BPM Project to launch the BPM Project wizard.
Note: Alternatively, right-click in the Project Explorer view, then select New > BPM Project to launch the BPM Project wizard.

2. From the first page of the BPM Project wizard, enter the name of the new project in the Project name box. The name can contain only alphanumeric characters, and must not contain blank spaces or special characters, except underscores ("_"). Project name must start with an alphabetic character.

Note: The maximum length of the project name is 26 characters.

Figure 7: BPM Project Wizard, Page 1

3. By default, the project is stored in the default workspace folder. To choose another location, clear the Use default location checkbox, and then click Browse to choose another location.

4. From the Project type configuration drop-down list, select the type of configuration (or facet) to be associated with this project. The available options are:

   - **Process**: to associate a Business Process facet with this project.
   - **Common Resources**: to associate a common resource facet with this project.
   - **Web Application**: to associate a web application facet with this project.

5. Click Next to continue. The remaining pages of the BPM Project wizard varies according to the project type configuration selected. To complete the BPM Project wizard, refer to the appropriate section provided in the following table.

Table 12: Types of projects

<table>
<thead>
<tr>
<th>Project Type</th>
<th>See</th>
</tr>
</thead>
</table>
Creating a Business Process

You can use the BPM Project wizard (Figure 7 on page 47) to create a Business Process.

To create a Business Process:

1. From the first page of the BPM Project wizard, select Process from the Process type configuration drop-down list.
2. Click Next to open the BPM Process page.

If you want to use an existing process as a template to design a new process, from the Template section, select one of the following options:

- Use an existing file from file system as template, then click Browse to navigate to an existing file (of type SPT, XML, or XPDL) that you can use as a template for your new application. For more information on using a template to create an application, see Using a process file as a template on page 66.
Tip: We recommend using an existing SPT file as a template for creating the new process. The SPT file contains the process template and all associated forms. The XML file is a basic version that does not contain associated forms.

- **Use an existing process from workspace as template** option, then click **Browse** to select an existing project that is available in the Project Explorer that you can use as a template for your new application. For information on using an existing project as a template, see **Using a project as a template** on page 68.

- **Use a Microsoft Project file as template** option, then click **Browse** to navigate to a Microsoft Project file (*mp*), which you can use as a process for your application.

**Note:** You can also import existing projects or extract from an archive file using the **Import** functionality. For more information, see **Importing a process file** on page 64.

3. Click **Next** to open the **BPM Process Properties** page, in which you can modify the application name and enter the relevant process information in the respective boxes.

The following table describes the application information fields.

**Table 13: Application properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>(Optional) The label is the title of the application that users see in Business Process Portal. For example, it is listed in the Administration module under <strong>Applications &gt; BP Server</strong>, and the Home module in Business Process Portal displays this name together with its Description in the installed applications listed under the Applications tab. If no label is entered, the entry in the Name box is shown in Business Process Portal.</td>
</tr>
<tr>
<td>Version</td>
<td>(Optional) Use this box to add (or edit) the version number of the application.</td>
</tr>
<tr>
<td>Manager</td>
<td>(Required) Displays @CREATOR as the default manager. You can specify another manager, if required. The manager, either a single user or a user group, serves as a back-up performer if the originally assigned workstep performer is not available. If an individual is entered in the Manager box, then any tasks assigned to an unavailable performer are assigned to that user. If a group is entered in the Manager box, then any tasks assigned to an invalid performer are made available to the members.</td>
</tr>
<tr>
<td>Group</td>
<td>(Optional) Indicate which group of users is allowed to view and execute this project. You can only specify one group.</td>
</tr>
<tr>
<td>Duration</td>
<td>(Required) To specify the length of time you estimate is required to complete the process, use the appropriate <strong>Duration</strong> boxes to specify the duration in terms of days, hours, minutes, and seconds. The specified duration is used to determine the due date. After the due date you specified is passed, the process instance becomes overdue.</td>
</tr>
<tr>
<td>Category</td>
<td>(Optional) Use this box to differentiate between different types of projects.</td>
</tr>
</tbody>
</table>
### Chapter 4: Developing BPM projects

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subcategory</td>
<td>(Optional) Use this box to further differentiate between projects in the same category.</td>
</tr>
<tr>
<td>Author</td>
<td>(Optional) Identifies the application developer who created the process template.</td>
</tr>
</tbody>
</table>

4. Click **Next** to open the **Add BPM Process module to Business Process Server(s)** page of the BPM Project wizard. You can use this page (optional) to add the Business Process Servers and configure the publishing settings of the Business Process module. For more information regarding publishing project modules, see Using the Servers view on page 341.

**Figure 9: Add BPM Process module to Business Process Server(s) page**

```
Figure 9: Add BPM Process module to Business Process Server(s) page
```

a) To publish the Business Process as a module on any connected Business Process Server from the **Servers** view, select the server (if defined) from the **Available Business Process Server(s)** section.

b) In the **Default Publishing Style** section, select the default option for publishing the process module to the selected server. For more information, see Republishing project modules on page 350.

c) To publish the Business Process as a Web service, select the **Publish as web service** checkbox.

d) If you want to publish the Business Process with the user permissions you defined in the previous version of the same process, then select the **Inherit ACL** option.

5. Click **Next** to open the **BPM Process Description** page of the BPM Project wizard, in which you can enter the description of the Business Process. This is optional.

6. Click **Finish** to complete the creation of the Business Process.

### Creating a Web application

You can use a Web application to:

---

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio

50
Develop a process that can be integrated as an individual workstep into a complex BPM process. For instance, an approval process that requires several levels of management review and approval, can be defined as a Web application. It can be then used as a single workstep in a process template: thus you can save development time and computer overhead.

Develop a stand-alone process that may include adapters to access BP Server and other external sources.

Replace the Start workstep in a process template.

You can use the BPM Project wizard (Figure 7 on page 47) to create a Web application.

To create a Web application:

1. From the first page of the BPM Project wizard, select Web Application from the Process type configuration drop-down list.
2. Click Next to open the Web Application page.

Figure 10: Web Application page

If you want to use an existing process as a template to design a new process, from the Template section, select one of the following options:

- **Use an existing file from file system as template**, then click Browse to navigate to an existing file (e.g., BS_SVBSurvey.swt) located in your workspace folder that you can use as a template for your new application. For more information on using a template to create an application, see Using a process file as a template on page 66.

  **Tip:** We recommend using an existing SWT file as a template for creating the new process. The SWT file contains the process template and all associated forms. The XML file is a basic version that does not contain associated forms.

- **Use an existing web application from workspace as template**, then click Browse to select an existing Web application in the Project Explorer that you can use as a template for your new process. For information on using an existing project as a template, see Using a project as a template on page 68.
- **Use a Microsoft Project file as template**, then click **Browse** to navigate to a Microsoft Project file (*mp*), which you can as a process for your application.

3. Click **Next** to open the **Web application properties** page, in which you can modify the name of web application, and enter optional information like label, category, sub-category, and author in the respective boxes. For details regarding this information, refer to Table 13 on page 49.

4. Click **Next** to open the **Add Web Application module to Business Process Server(s)** page of the BPM Project wizard.

   **Figure 11: Add Web Application module to Business Process Server(s) page**

   ![Add Web Application module to Business Process Server(s) page](image)

   If you want to publish the Web application as a module on any connected Business Process server from the **Servers** view, select the server (if defined) from the **Available Business Process server(s)** section. This step is optional.

5. Click **Next** to open the **Web Application Description** page of the BPM Project wizard, in which you can enter the description of the Web application. This is optional and is similar to **Creating a Business Process** on page 48.

6. Click **Finish** to complete the creation of a Web application.

**Using common resources**

You can create a BPM Project (with common resources) in the Eclipse integrated development environment (IDE) of Progress Developer Studio for OpenEdge. These common resources can be accessed from and used in all Progress Developer Studio for OpenEdge projects, and can include folders for:

- **Business Objects** - Java sources available to both EJB and Portal servers. Java files in this folder will be compiled into a hidden classes folder. Business Objects of the BPM Project (with common resources) are copied to the `OEBPS_HOME\ebmsapps\common\bo\classes` folder for use in Business Processes and to the `<App_Server>\WEB-INF\classes` folder for use in Web applications.
Note: <App_Server> refers to the path of the OEBPS folder for a specific application server. For the value of this configuration parameter, refer to the oebps.webappdir parameter in the OEBPS_HOME\conf\oebps.conf file.

- **Adapters** - customized adapters for common Business Processes and Web applications. Adapters in Business Processes are copied to the OEBPS_HOME\ebmsapps\common\lib folder and adapters in Web applications are copied to the <App_Server>\WEB-INF\lib folder.

- **css** - Stylesheet files. These stylesheet files are copied to the OEBPS_HOME\ebmsapps\common\css folder and Web applications are copied to the <App_Server>\WEB-INF\css folder.

- **External Business Objects** - include compiled Java classes, XML resources, and custom dataslots. These are copied to the same location as Business Objects.

- **Images** - Common image files are copied to the OEBPS_HOME\ebmsapps\common\images folder and images used in Web applications are copied to <App_Server>\ebmsapps\common\images.

- **Javascripts** - include common javascript files. JavaScripts used in Business Process Portal applications are copied to OEBPS_HOME\ebmsapps\common\javascript whereas the ones used in Web applications are copied to <App_Server>\ebmsapps\common\javascript.

- **lib** folder contains JAR files generated by compilation of files in the src folder or pre-existing JAR files. Common JAR files used in Business Process Portal applications are copied to OEBPS_HOME\ebmsapps\common\lib whereas the ones used in Web applications are copied to <App_Server>\WEB-INF\classes.

You can also use a BPM Project (with common resources) to publish common bpmportal resources. However, you must specify the target for the resources in a file that you create called dir.map, which should be included as a part of the project. For example, it is possible to publish some of the bpmportal resources such as css and javascripts, as part of a BPM Project (with common resources).

For example, assume your project contains a folder called bpmportal. It is possible to publish the content of the bpmportal folder in the project to the <App_Server>\bpmportal folder by adding a dir.map file to the project with the following entry:

```
  bpmportal = __sbmweb_archive/bpmportal
```

(NOTE: a double underscore (__)) is used to begin the equation)

Other available mappings that can be used in dir.map are:

- "__ebmsapp_archive" to map content of the folder to OEBPS_HOME\ebmsapps.
- "__webapps_archive" to map content of the folder to OEBPS_HOME\bpmebflow.
- "__sbm_archive" to map content of the folder to OEBPS_HOME.
- "__sbmweb_archive" to map content of the folder to <App_Server> folder (example, for Pramati, pramati...\public_html\sbm).

**Creating Common Resources**

You can use the **BPM Project** wizard (Figure 7 on page 47) to create Common Resources.
To define Common Resources:

**Note:** See Chapter 8 in the *Tutorial Guide* to review the FormsDemoCommon (a BPM Project with common resources) and the FormsDemo sample application that together demonstrate the use of Business Objects in an application. For a more general overview, see Chapter 5: Developing Business Objects in the *Application Developer's Guide*.

1. From the first page of the BPM Project wizard, select **Common Resources** from the **Process type configuration** drop-down list.
2. Click **Next** to edit (if required) the Common Resource name. By default, the Common Resource name is the same as that of the BPM project.
3. Click **Next** to open the **Add Common Resources module to Business Process Server(s)** page of the BPM Project wizard.

**Figure 12: Add Common Resources module to Business Process Server(s) page**

If you want to publish the BPM Project (with common resources) as a module on any connected Business Process Server from the **Servers** view, select the server (if defined) from the **Available Business Process server(s)** section. This step is optional. Depending on the application requirement, select one of the following adapter types from the **Adapter Type** section:

- **BP Server Adapter**: to publish the adapter files in Common resources to `OEBPS_HOME\ebmsapps\common\lib` folder, for use in Business Process.
- **Web Application Adapter**: to publish the adapter files in Common resources to `<App_Server>\WEB-INF\lib` folder, for use in Web applications.

4. Click **Finish** to complete the creation of Common Resources.

Your BPM Project (with common resources) appears in the Project Explorer view in the Progress Developer Studio for OpenEdge user interface.
Exporting BPM applications

You can use the Export BPM Applications wizard to export a BPM project and its associated artifacts from the current workspace to a compressed ZIP format.

This wizard enables you to export the following artifacts of a BPM project:

- Business Objects
- Managed Adapters
- Users
- Messages
- Channels
- Form fragments

To export a BPM project and its associated artifacts:

1. Open the Export BPM Applications wizard by doing one of the following:
   - Right-click the BPM project that you want to export and select Export > BPM Applications on the context menu in the Project Explorer view.
   - Select File > Export from the main menu bar to open the Export wizard, and then click the Progress OpenEdge > BPM Applications node.

The Export BPM Applications window appears as shown:
2. Select the **Automatically select dependent project** check box to select dependent artifacts from other associated BPM projects.

   For example, if you select a business process that uses another business process from a different BPM project as a subprocess for an activity, the dependent artifact such as the subprocess (business process from another BPM project) is automatically selected to export.

3. Select the BPM project from the **Projects** section.

   **Note:** By default, the artifacts associated with the selected project are selected in the **Artifacts** section.

4. Select from the **Artifacts** section the artifacts of the project that you want to export.

   **Note:** The artifacts associated with the selected project are automatically selected. Clear the check box of an artifact you do not want to export.

5. Click the **Select All** button to select all the projects and its artifacts.

   **Note:** Click the **Deselect All** button to clear your selection of all the projects and its artifacts.

6. Click the **Browse** button to select the directory in which you want to export the selected resources.

   You can specify the directory path as the export location for the ZIP file, as shown:
7. Click **Finish**.

The selected BPM project and its artifacts are exported and saved in a ZIP file in the selected directory.

You can then use the Import BPM Applications wizard to import the ZIP file to copy the exported BPM project and its artifacts into another workspace.

## Importing BPM applications

You can use the **Import BPM Applications** wizard to extract BPM projects and its artifacts from a ZIP file into the current workspace.

**Note:** You can export the BPM projects and its artifacts to a compressed ZIP file using the Export BPM Applications wizard.

The **Import BPM Applications** wizard enables you to import the following artifacts of a BPM project:

- Business Objects
- Managed Adapters
- Users
• Messages
• Channels
• Form fragments

To import the BPM projects and its associated artifacts:

1. Select **File > Import** from the main menu bar. The **Import** wizard appears.
2. Expand the **Progress OpenEdge** node and select **BPM Applications**.

The **Import BPM Applications** wizard appears as shown:

**Figure 16: Import BPM Applications wizard**

3. Click the **Browse** button to select the compressed ZIP file that contains the BPM projects and artifacts.

The BPM projects and its artifacts are extracted from the selected ZIP file and appear in the **Projects** and **Artifacts** section, as shown:
4. Use the following options to select the BPM projects and its artifacts to import into the current workspace:
   - **Projects** — To select the BPM projects
     
     **Note:** You cannot import the project that already exists with the same name in the current workspace. By default, such project appears as disabled in the **Projects** section.

   - **Artifacts** — To select the artifacts of the selected projects
   - **Select All** — To select all the projects and its artifacts
     
     **Note:** Click the **Deselect All** button to clear your selection of all the projects and its artifacts. You can then choose individual resources to import.

5. Select the **Overwrite resources without warning** check box to overwrite the selected resources which already exist in the current workspace.

6. Click **Finish**.

The selected BPM projects and its artifacts are imported into the current workspace. You can view the projects and its associated artifacts in the **Project Explorer** view.
Managing multiple processes

In Progress Developer Studio for OpenEdge, you can create multiple Business Processes or web application modules within an existing or (new) BPM project. In the Project Explorer view, all the resources or files pertaining to a process or a web application module are stored in a folder with the same name as the process within the project directory.

**Note:** You can also add a single common resources file to a BPM project.

For instance, if you create a BPM project, "project1" (as discussed in Creating a BPM project on page 46), a default process, "project1" is created. You can add additional processes (for example, "process1" and "process2") to this project. After adding, you can view the files of the added processes in separate folders within the "project1" project folder in the Project Explorer view, as shown in the following figure.

**Figure 18: Project Explorer - added processes**

With multiple process support in a BPM project, each new process acts as a separate project module, and all the properties related to a particular process are stored within the module definition.

You can create any number of processes (within Eclipse capability) in a BPM project. You can also delete added processes from a project. Deleting a process deletes all the resources associated with that particular process from the project directory.

Adding a new Business process

You can create a Business Process and add it to an existing BPM project.

1. From the **File** menu, select **New > Other** to launch the **New** wizard.
2. Select **Progress OpenEdge > BPM > Business Process** and click **Next**. The **BPM Process** wizard appears.

   **Note:** Alternatively, right-click the BPM project in the Project Explorer view, then select **New > Business Process** to launch the **BPM Process** wizard.

3. In the **Project name** box, you must specify the BPM project to which you want to add this Business process.
a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.

b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.

4. Complete the rest of instructions in the **BPM Process** wizard, as described in **Creating a Business Process** on page 48.

On completion of this wizard, the new process is added and displayed in the specified BPM project folder structure in the Project Explorer view, as shown in **Figure 18** on page 60.

### Adding a new Web application

You can create a Web application and add it to an existing BPM project.

1. From the **File** menu, select **New > Other** to launch the **New** wizard.

2. Select **Progress OpenEdge > BPM > Web Application** and click **Next**. The **Web Application** wizard appears.

3. In the **Project name** box, you must specify the BPM project to which you want to add this Web application.
   a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.
   b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.

4. Complete the rest of instructions in the **Web Application** wizard, as described in **Creating a Web application** on page 50.

On completion of this wizard, the new Web application is added and displayed in the specified BPM project folder structure in the Project Explorer view, as shown in **Figure 18** on page 60.

### Adding new Common Resources

You can create a Common Resource and add it to an existing BPM project.

1. From the **File** menu, select **New > Common Resources** to launch the **New Common Resources** wizard.

Note: Alternatively, right-click the BPM project in the Project Explorer view, then select **New > Common Resources** to launch the **New Common Resources** wizard.

2. In the **Project name** box, you must specify the BPM project to which you want to add this Business Process.
   a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.
   b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.
3. In the **Common Resource Name** box, specify the name of the Common Resource.
4. Click **Next** to complete the rest of instructions in the wizard, as described in Creating Common Resources on page 53.

On completion of this wizard, the new process is added and displayed in the specified BPM project folder structure in the Project Explorer view, as shown in Figure 18 on page 60.

### Converting single process BPM projects

You can use a BPM project (with a single process) in the current release. In order to do so, Progress Developer Studio for OpenEdge allows you to convert these single process projects to a multiple process BPM project.

**To do so:**

1. Import the BPM project from the previous release to your current workspace. For information regarding importing, see Importing a process file on page 64.
2. In the Project Explorer view, right-click the BPM project, then click **Progress OpenEdge > Move and Convert to a Multiple Process BPM Project**. The **Move To Multiple Process Project** dialog box appears.

   ![Move To Multiple Process Project](image)

   **Figure 19: Move To Multiple Process Project**

   **Note:** To convert multiple BPM projects from previous versions, you must import and select these project folders in the Project Explorer view, and then perform the above step.

3. You can convert and add the selected projects to a new (or existing) BPM project in the current workspace.
   - To use an existing project, select the **Existing project** option. Type the name of the existing project in the **Project name** box or click **Browse** to open the Select an existing project dialog box, which lists the existing BPM projects in your workspace. Select the project and click **OK**.
   - To use a new project, select the **New project** option. Type the name of the new BPM project in the **Project name** box.

4. In the **Single process project(s)** section, you can specify additional single process projects (if required) to be converted and added to the BPM project specified in the **Project name** box.
• To add projects, click **Add** to open the **Select a single process project** dialog box, which lists the existing single process BPM projects in your workspace. Select the projects to be added and click **OK**. The added projects are listed in the **Single process project(s)** section.

• To remove any project from the **Single process project(s)** section, select the project and click **Remove**.

5. Before converting the specified single process BPM projects, you can create a backup of the projects in the current (or different) workspace. By default, Progress Developer Studio for OpenEdge creates a backup of the projects in the default workspace. To specify a different workspace folder, click **Browse** and select the folder where you want to create the project backup.

6. Click **Finish** to start the conversion operation.

On successful completion, the **Move and convert: Successful** dialog box appears. The converted project is added as a process version and displayed in the specified BPM project folder structure in the Project Explorer view, as shown in Figure 18 on page 60.

### Navigating multiple processes

For a BPM project containing a large number of processes, navigating all the processes and artifacts in each process can be time-consuming and cumbersome. For easier navigation, you can implement the following methods for all the projects listed in the Project Explorer view.

- **Filtering**: to show (or hide) all the Business Processes and Web applications added to BPM projects in your workspace.

- **Content filtering**: to filter the artifacts in your Project Explorer view on basis of content namely, BPM elements.

- **Sorting**: to sort the multiple processes added to BPM projects on basis of name or process type.

**To apply filtering:**

1. In the Project Explorer view, click **View Menu () > Customize View**. The **Available Customizations** dialog box appears.

2. From the **Filters** tab (left image, Figure 20 on page 63), you can implement filtering on basis of project type.
a) To hide all the Business Processes in your Project Explorer view, select the **BP Server Processes** check box.

b) To hide all the Web applications in your Project Explorer view, select the **BPM WebFlow Processes** check box.

3. From the **Content** tab (right image, Figure 20 on page 63), you can implement filtering on basis of content namely, BPM elements. By default, the Project Explorer view displays Java (and JavaScript) elements and Progress Developer Studio for OpenEdge resources. Use the **BPM Elements** check box (by default, selected) to display each process type in the BPM project with its distinct icon.

**Note:** You can also clear the other selected checkboxes in the **Content** tab to display only BPM elements in your Project Explorer view.

All Business Processes in your Project Explorer view are denoted by the icon and all Web applications are denoted by the icon. You can identify and open process templates, based on the displayed icon.

4. Click **OK** to apply the filtering changes.

You can also sort the list of processes in each BPM project on basis of name or process type. By default, all processes in each BPM project are sorted alphabetically by name. To sort by process type:

- In the Project Explorer view, click **View Menu** > **BPM Sort** and then select the **by type** option. Expand any BPM project in the Project Explorer to view all the Business Processes in the project first, followed by all the Web applications in the project.

---

**Importing a process file**

Progress Developer Studio for OpenEdge provides the **Import** feature, which enables you to import external projects into your current workspace. You can also extract an archive file as a project into your workspace.

**To import a process file:**

1. From **File** menu, click **Import** to launch the **Import** wizard.
2. Select **General > Existing Projects into Workspace** and click **Next**.
3. To navigate to existing projects, click **Browse** beside the **Select root folder** option to open the **Browse for Folder** dialog box.
   
   Alternately, click the **Select archive file** option and click **Browse** to navigate to any of the supported archive files to import. Click **OK**, to return to the **Import** wizard.

4. From the **Projects** section, select all (or one) of the projects to be imported into your workspace.
5. Select the **Copy projects into workspace** check box (available only for **Select root folder** option) to create a copy of the external projects in your workspace.

6. Click **Finish** to start importing.

The application appears in the Project Explorer View. Expand the application folder to reveal the SPT or SWT file in the `processtemplates` folder, and double-click the file to display it in the Content pane.

---

**Figure 21: Import Projects**

![Import Projects dialog box](image)

---

### Generate OpenEdge JSDO Catalog

You can now generate an OpenEdge JSDO catalog from the Project pane. This OpenEdge JSDO catalog then facilitates the Rollbase Developers to create application objects in Rollbase. The JSDO Catalog feature currently supports only primitive datatypes.

To generate an OpenEdge JSDO Catalog:

1. In the Project pane, right click on the project module that you want to generate a JSDO catalog for.

2. Select **Progress OpenEdge > Generate OpenEdge JSDO Catalog**.

   The **Generate OpenEdge JSDO Catalog** -Select Location dialog box opens.

3. Select the location where you want to save the **OpenEdge JSDO Catalog** and click **OK**.

   A .json file is created in the selected location. Refer to Rollbase documentation for more information.
Using a process file as a template

You can reduce process development time by using an existing process file as the template for your new process in Progress Developer Studio for OpenEdge. You can browse to a specific location (example, your workspace folder) that contains Progress Developer Studio for OpenEdge projects; or you can retrieve a process file which was created in earlier releases of Progress Developer Studio for OpenEdge. The following section describes how to use an existing process file as a template to create a new process.

**Note:** We recommend that you do not use the File > Open File command to create a new process template, because associated folders within the project are not created.

Using a process file from recent releases

You can use a process file from a previous release as template to create a new process in Progress Developer Studio for OpenEdge:

1. In the second page of the BPM Project wizard (Creating a Business Process on page 48 for Business Process and Figure 10 on page 51 for Web application), enter the name of the new project in the appropriate box.
2. To use an existing process file as a template, select the **Use an existing file from file system as template** option, then click **Browse** to open the **Select File** dialog box, which displays the existing process files.
3. Browse to the SPT within any of the process folders that you can use as a template for your new process.
   
   After you select a process file from your **Workspace_Home** folder and click **Open**, the process template name (for instance, Assignment) and its path is shown in the File box, and a number in the Version box is automatically inserted that is one increment higher than the selected process file. The process template name and version is entered in the remaining read-only fields.
   
   a) You can change the project name, or change or delete the version number. Specify the duration in the appropriate **Duration** box.
   b) Click **Next** to continue.
   c) After entering the description (optional), click **Finish** in the BPM Project wizard.

   A new project folder is listed in the Project Explorer View, along with the process template file with an SPT extension.
4. Select **File > Save All** to save changes to all open projects and files. You can now publish the new application. For information on publishing, see Publishing an application on page 73.

Importing a process file from earlier releases

The BPM Studio library is a user library that is automatically generated every time a new application is created in Progress Developer Studio for OpenEdge. This library acts as a reference point for the JAR files required for process applications that is independent of the location of the JAR files.

Using this library, Progress Developer Studio for OpenEdge applications can be easily shared among different users who may have different installation roots for their Progress Developer Studio for OpenEdge installation.
For applications that were created earlier and then imported to the more recent Progress Developer Studio for OpenEdge releases that have the library feature, you must replace their hard-coded JAR files with BPM Studio library references.

To do so, perform the following steps:

1. After importing a pre-6.5SP2 application (see the Using a process file from older releases topic), click the process name in the Project pane. From Project menu, click Properties, then click Java Build Path > Libraries.

2. Remove the following four JAR files—bpmwebflow.JAR, bpsclient.JAR, bpsmisc.JAR, and j2ee.JAR—by selecting each JAR file and clicking Remove.

3. Click Add Library, select User Library and click Next, and select BPM Studio Library and click Finish.

The BPM Studio library is now in the Libraries tab. Click OK.

Note: You can also get the same results by manually editing the classpath file under the application folder and replace the four JAR files (classpathentry kind="lib" path="<path_name>/bpmwebflow.JAR"/>, <classpath...../bpsclient.JAR"/>, <classpath...../bpsmisc.JAR"/>, and <classpath...../j2ee.JAR"/>) with the following entry: <classpathentry kind="con" path="org.eclipse.jdt.USER_LIBRARY/BPM Studio Library"/>

Importing XPDL files

Progress Developer Studio for OpenEdge supports the XML Process Definition Language (XPDL), which is a standardized format used for interchanging business process definition between different workflow products.

Progress Developer Studio for OpenEdge allows you to import process templates, which conform to XPDL version 2.1 specifications only.

XPDL enables an efficient exchange of BPMN diagrams by:

- Storing all aspects of a BPMN diagram, including graphical information such as the X and Y positions of the nodes, as well as the executable aspects required to run a process.
- Including extensions to handle the new BPMN 1.1 constructs and clarification of conformance criteria for implementation.

Note: Progress Developer Studio for OpenEdge does not support importing process templates, containing vendor-specific information. For information regarding vendors and product versions supporting XPDL version 2.1, contact our Product Support team.

To use an exported XPDL file as a template to create a new process:

1. From the first page of the BPM Project wizard (see Figure 7 on page 47), select the Use an existing file from file system as template option, then click Browse to open the Select File dialog box.

2. From the Files of type drop-down list, click the *.xpdl option, then browse to the XPDL file that you can use as a template for your new process.

3. Complete the instructions as detailed in Using a process file as a template on page 66, to use the XPDL file as a template for your new process template.
You can also export process templates to XPDL format, as described in Exporting the process template on page 81.

Using a project as a template

You can significantly reduce process development time by using an existing BPM project as the template for your new project. If you use this option, you can choose to import not only the process file, but also all associated interfaces, rules, and adapters. You can only use this option for existing project files that are displayed in the Project Explorer view.

To use an existing project as template to create a new process:

1. In the second page of the BPM Project wizard (Creating a Business Process on page 48 for Business Process and Figure 10 on page 51 for Web application), enter the name of the new project in the appropriate box.
2. To use an existing project as a template, select the Use an existing process from workspace as template option (for Business Processes) or the Use an existing web application from workspace as template option (for Web application), then click Browse to open the Select project dialog box, using which you can select the project to be used as a template for your new application.
   The process template name (for instance, Assignment) is shown in the Project box, and a number in the Version box is automatically inserted that is one increment higher than the selected process file. The process template name and version is entered in the remaining read-only fields. You can change the project name, or change or delete the version number.
3. Click Next to continue.
4. After entering the description (optional), click Finish in the BPM Project wizard.

   A new project folder is listed in the Project Explorer view, along with the process template file with an SPT extension.

Creating a simulation project

Progress Developer Studio for OpenEdge provides the Simulation project, which supports all simulation functions, and allows for easier integration of additional features in future releases.

To create a Simulation project:

1. From the File menu, select New > Project to launch the New Project wizard.
2. From the Progress OpenEdge > BPM node, click BPM Simulation Project, then click Next.
3. In the first page of the New Simulation Project wizard, enter the name of the simulation project in the Name box. The name can contain only alphanumeric characters, and must not contain blank spaces or special character, except underscores ("_"). Ensure that the project name starts with an alphabetic character. If required, enter a label and description in the respective boxes.
4. By default, the project is stored in the default workspace folder. To choose another location, clear the Use default location checkbox, and then click Browse to choose another location.

5. Click Next to open the second page of the New Simulation Project wizard (Figure 23 on page 69), in which you can define the simulation properties of this project.

Figure 23: New Simulation Project wizard, Page 2

a) From the Start Simulation section, click one of the following options to define when to start to start the simulation:

- **At current system time** option to activate the simulation at the current time of the system.
- **At time** option to activate the simulation at a predefined time other than system time. After clicking this option, you need to specify a date and time. To do so, click the adjoining ellipsis button. For details, see Specifying a date on page 377.

b) From the Stop Simulation section, click any of the following options to define when to stop the simulation:

- **On completion of process instances** option to stop the simulation when all the instances of the processes in the simulation project are completed.
• **At time** option to stop the simulation at a predefined time. You can use this option only if you have selected the **At time** option in the Start Simulation section. You need to specify a stop time later than the simulation start time. To specify another date and time, click the adjoining ellipsis button. For details, see Specifying a date on page 377.

• **After duration** option to specify a relative end time for simulation, in terms of duration. You can specify the duration in terms of hours, minutes, and seconds by entering values in the respective boxes.

6. Click **Next** to open the third page of the New Simulation Project wizard (Figure 24 on page 70), in which you can define the project calendar settings for this simulation project.

**Figure 24: New Simulation Project wizard, Page 3**

You can use the **Project Calendar** page to define the default calendar settings for your simulation project.

a) From the **Work Days** section, select (or clear) the appropriate checkboxes for the work days.

b) The **Sessions** section table displays the default time segments. The default work-hours are 9:00 - 13:00 and 14:00 - 18:00.

   • To add a session, click **Add** opening the **Session** dialog box. Specify the start time (hours and minutes) and the end time (hours and minutes) of the session in the respective boxes. Click **OK** to add the session to the **Sessions** section table.

   • To edit any of the listed sessions, select the session, then click **Modify** to open the **Session** dialog box, where you can modify the start and end time.

   • To remove any of the listed sessions, select the session, then click **Delete**. Progress Developer Studio for OpenEdge prompts you for confirmation. Click **OK** to remove the session.

   c) Click **Next** to continue.

**Note:** The settings defined here are applied to the “default” scenario in your simulation project. You can modify these settings for the default scenario, as well as for any added scenarios in the Simulation perspective, after creating the simulation project. For details, see Modifying simulation settings for a scenario on page 358.
7. In the fourth page of the New Simulation Project wizard, you can add the processes that you want to include in this simulation. You can also configure the simulation settings for each added process.

**Figure 25: New Simulation Project wizard, Page 4**

a) To add a process to the simulation project, click the **Add** icon in the **Select** section, to open the **Required Project Selection** dialog box. From the list of current processes, select the process to be added then click **OK**.

The added process is displayed in the **Select** section. You can add as many processes, as required.

**Note:** To remove a process from the simulation project, select the process, then click the **Remove** icon.

For each added process, you can configure the simulation start settings (available only for multiple processes), the instance count, and the type of randomization.

b) From the **Start** section, select the **At time** option to set an absolute time and date, as described in Step 4a. The start time for a process must be later than the absolute start time (if specified) for the simulation project. Alternatively, select the **After duration** option to specify a relative start time (in terms of duration) for the process simulation, as described in Step 4b.

**Note:** You cannot set an absolute time and date for the process if you have set the simulation start time to system time.

c) Use the **Count** section to specify the number of process instances. You can either keep the instance count unlimited or specify a maximum value in the **Limited To** box. You cannot specify an unlimited instance count if you have selected the **On completion of process instances** option in the third page of the wizard.

d) From the **Type** drop-down list in the **Distribution** section, choose a method to randomize the duration of each interval between process instances in the simulation. For information regarding randomizing methods, see **Configuring and running simulation** on page 353.
8. Click **Finish** to complete creating the Simulation project.

9. If you are currently not in the **Progress OpenEdge BPM Simulation** perspective, Progress Developer Studio for OpenEdge prompts you to switch to this perspective. Click **Yes** to open the simulation project in the **Progress OpenEdge BPM Simulation** perspective. Alternatively, click **No** to open the simulation project in your current perspective.

   If you select the **Remember my decision** check box, Progress Developer Studio for OpenEdge does not display any prompt and executes the selected command the next time you create or open a simulation project file (SST). For further details regarding configuring and running a simulation, see [Configuring and running simulation](#) on page 353.

---

**Note:** You can modify the above selected configuration for opening the **Progress OpenEdge BPM Simulation** perspective using the **Simulation > UI** page in the **Preferences** dialog box. For information, see [Using the Simulation page](#) on page 126.
Performing additional operations

This chapter describes how to use Progress Developer Studio for OpenEdge for performing additional operations.

For details, see the following topics:

- Publishing an application
- Managing pages
- Generating 360 degree view
- Printing the process template
- Exporting the process template
- Managing phases

Publishing an application

Progress Developer Studio for OpenEdge provides a Publish wizard to facilitate application publishing. The Publish wizard allows you to complete the following tasks:

- Retrieve the project file as input and pack all the referred files into an archive file.
- Connect to the web service on the specified server and upload the package (that is, send the user name and password, verify if the application is already installed; and if yes, prompts you to replace the existing application).
- Send the archive to the Web server and instructs the server to unpack and install the application.
• Display the result of publishing (success/failure).

**Note:** Alternatively, you can use the Servers view to publish processes as modules on the connected Business Process Server. For more information, see Using the Servers view on page 341.

**Note:** To successfully publish an application, you must ensure that JDK/ JRE 1.6 build path is installed with Eclipse.

All existing applications are archived in JAR file. Progress of publishing and error messages are shown in a dialog box.

**Note:** Make sure that all active instances for an application (and its subprocesses) are completed before publishing (or republishing) the application.

**To publish an application:**

1. From the Project Explorer view, select the project to be published.
2. From the **Project** menu, click **Publish**, to open the **Publish Wizard**.

![Publish Wizard: Page 1](image)

**Note:** All project components must be valid in order to publish it. To determine the validity of the application, click or right-click in a blank area of the main frame and select **Check Diagram** option. If you have correctly defined the application, “The diagram is complete” message appears. Click **OK**.

3. From the options displayed in the **Server** drop-down list, select the server to which you want to connect the project, or modify the default server path. The URL you enter here for example, `http://localhost:port/ sbm/deployment`— is where SOAP can be found as part of the Web application.
4. Enter your **User name** and **Password** and then click **Next** to go to the next page.

**Note:** You can configure target server options from the **Publish** page in **Preferences** dialog box. For details, see Using the Publish page on page 125.

The Publish wizard now attempts to connect to the server you selected.
a) If you are publishing the process template for the first time, the second page of the Publish Wizard displays the **Web services** section. Select the **Publish as web service** checkbox to publish the process as a Web service.

**Figure 27: Publish Wizard: Options page for an Uninstalled Application**

b) If you are publishing a process template that has been published previously, the second page of the Publish Wizard now displays the options described in Table 14 on page 75.

**Figure 28: Publish Wizard: Options Page for a Previously Published Application**

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reinstall</td>
<td>Reinstall the process template</td>
</tr>
<tr>
<td>Refresh process template</td>
<td>Apply simple changes in process flow to running processes and associated instances. You don't have to create a new version or, migrate instances. For example, select this option (as is shown in the figure above) if you only want to change the format of a few HTML/JSP forms in the application. If the application cannot be refreshed, the Refresh Process Template option is not enabled, and a message appears with a link that will open a window listing the issues preventing a refresh.</td>
</tr>
<tr>
<td>Copy files to server only</td>
<td>Copy any updated files to the connected server.</td>
</tr>
</tbody>
</table>
You can select the **Publish as web service** checkbox to publish the process as a Web service. This checkbox is enabled even if the application was previously installed. If the application had previously been published, reinstalling or refreshing the template automatically republishes the application and this checkbox is not displayed.

c) If you are publishing a process template, which is a version of a previously published application, the second page of the Publish Wizard displays the following options.

- Select the **Inherit ACL** checkbox to retain any user permissions in the version of the application you are creating that are associated with the parent application. By selecting this option, you ensure that when you publish this version on Business Process Portal, it will have the same user permissions that the original application had.

- Select the **Publish as web service** checkbox to publish the process as a Web service.

**Note:** For Business Process Server installed with **https** enabled, ensure that a valid certificate is added to your JDK. Otherwise, this publish operation using Web services will fail. For information on how to add a certificate, refer JDK documentation.

d) Click **Next** to continue.

5. The last page of the Publish Wizard displays the “Application published successfully” message if the application has been successfully published. You can select the **Go to Business Process Portal** checkbox to automatically open Business Process Portal login page (with address as specified in the adjoining box) in your Web browser when you click **Finish**.

**Figure 29: Publish Wizard: Final Page**

If the Publish Wizard encounters problems in publishing the application, an **Error** window appears. Click **Details** to obtain information about any publishing problems.

**Managing pages**

Progress Developer Studio for OpenEdge provides a default number of 9 pages (in a 3x3 grid) in the **Diagram** tab to design your process template diagram. Progress Developer Studio for OpenEdge automatically adds pages if your process template diagram does not fit into the 3x3 grid.

You can now add and manage pages in the **Diagram** tab. This enables you to control the page size more efficiently.

**To generate the print preview:**
From the Diagram tab, right-click a blank portion of your process template diagram, point to Pages option, then select one of the following options:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to right</td>
<td>Adds a page to the right. For the default 3x3 grid, this operation extends the grid size to 3x4.</td>
</tr>
<tr>
<td>Add to bottom</td>
<td>Adds a page to the bottom. For the default 3x3 grid, this operation extends the grid size to 4x3.</td>
</tr>
<tr>
<td>Fit to process</td>
<td>This is a useful option when you want to print a process template and save paper. Click this option to reduce the page count to fit the process template diagram.</td>
</tr>
</tbody>
</table>

**Generating 360 degree view**

Progress Developer Studio for OpenEdge provides the 360° view, which is a multi-layered Chart view of the current process template diagram. You can generate the 360° view especially for complex process templates, which consist of multiple activity (and adapter) worksteps and complex workstep traversal paths.

**To generate the 360° view:**

From the palette (see Using the palette on page 40), click the Show 360° View icon to launch the 360° View of the current project.

Alternatively, you can open the 360° view of the current project by right-clicking the name of the current project (SPT or SWT) file in the Project Explorer, then clicking Open With > 360° View option.
The 360° view diagram consists of color-coded sections, each representing a workstep. Each section displays the label of the workstep along with the estimated time (in days, hours, and minutes) when the workstep will be activated. The estimated time is calculated from the beginning of the process. If the process includes multiple paths, each path is depicted as a sub-section in the chart.

**Note:** The estimated start time of each workstep can be calculated only when the duration of the preceding worksteps are set in absolute values (in days, hours, minutes, or seconds). The estimated start time cannot be calculated when workstep duration is bound to a INTEGER dataslot. For setting workstep duration, you can use the Overdue in box in the General tab of the Activity workstep’s Properties view (as discussed in Specifying general properties of Activity workstep on page 180).

The 360° view displays each workstep type with the following color code.

**Table 15: 360° view color code**

<table>
<thead>
<tr>
<th>Workstep Type</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity (including external activity and adapter worksteps for a monitoring process)</td>
<td>Blue</td>
</tr>
<tr>
<td>Adapter</td>
<td>Violet</td>
</tr>
<tr>
<td>Start / End / Gateways</td>
<td>Brown</td>
</tr>
<tr>
<td>Inline Subprocess</td>
<td>Orange</td>
</tr>
</tbody>
</table>

You can perform the following operations in the 360° view.
Table 16: 360° view operations

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan the diagram</td>
<td>Drag your mouse.</td>
</tr>
<tr>
<td>Zoom in (or out) on the diagram OR view all workstep labels.</td>
<td>Use your mouse scroll wheel.</td>
</tr>
<tr>
<td>Rotate the diagram around its center point.</td>
<td>Drag your mouse with the right button.</td>
</tr>
<tr>
<td>Open the subprocess in the 360° view.</td>
<td>Click the subprocess workstep section. For additional information, see Opening a subprocess on page 79.</td>
</tr>
<tr>
<td>Calculate a traversal path duration.</td>
<td>Move your mouse over the diagram to highlight the selected path. The estimated duration of the selected path is displayed in the Path Length box.</td>
</tr>
</tbody>
</table>

The 360° view also includes the following icons:

- **Show/Hide Loops** ( ) icon - For any process containing loops, the default 360° view does not include the worksteps encountered after a loop is executed. You can click this icon to display these worksteps in semi-transparent state. In this case, the worksteps gradually progress with fading color.

- **Timeline View** ( ) icon - Click this icon to switch to the Timeline view, which displays the thickness of each workstep corresponding to the time it is likely to take to complete.

The worksteps in the Timeline view with increased thickness require more time to execute. As Activity worksteps are performed by humans and are likely to take the maximum time to complete as compared to the other workstep types, the Timeline view shows Activity worksteps with higher degree of thickness. You can zoom in on the diagram to view the other workstep types in detail.

**Note:** You must click the individual icons again to return to the previous view.

Opening a subprocess

You can also view an inline subprocess in the 360° view, by clicking the subprocess workstep section of the parent process diagram. For information regarding an inline subprocess, see Defining an inline subprocess on page 137. The 360° view of the parent process is replaced with that of the subprocess.

**Note:** This feature is not available for Web applications, as it does not support an inline subprocess.

Progress Developer Studio for OpenEdge supports an inline subprocess within another inline subprocess. You can use the breadcrumb trail in the 360° view to track the process hierarchy.
Figure 31: Breadcrumb trail

You can click the process name button in the breadcrumb track to reload the 360° view of the parent process in the hierarchy.

Note: The Breadcrumb trail does not include external subprocesses, rules, phases, swimlanes, and annotations.

Printing the process template

You can generate a print preview of a process template diagram before printing it.

To generate the print preview:

1. Open the process template to be printed.

2. From the palette (see Using the palette on page 40), click the **Print Preview** icon to view the process diagram in the Print Preview mode.

In the Print Preview mode, the Tasks pane displays the print-related functions and other options.

Figure 32: Print Preview mode

3. To enlarge (or reduce) the image scale for printing, increase (or decrease) the scaling percentage in the **Scaling factor** box in the **Options** panel.

   Alternatively, select the **Fit to width/height** option in the **Scale Mode** drop-down list, then enter the width (and height) in pages in the adjoining boxes to set the image scale to fit to the specified pages.

4. If required, define the page setup for printing by clicking **Page setup** link from the **Print Preview Tasks** panel, opening the **Page Setup** dialog box.

   The dialog box which appears depends on the type of printer you are using. Select the size of the printed document —Letter (8.5 x 11 inches), Legal (8.5 x 14 inches), 11 x 17 inches, etc.—, its source, and whether it has a Portrait or Landscape orientation. Use the fields in the Margins panel to adjust the page’s margins.
5. Click the **Print this diagram** link to print the displayed process template.

   The **Print** dialog box opens, in which you can select a number of printing options, including number of copies and page range. The dialog box which appears depends on the type of printer you are using. If you are using Windows, click **Properties** to define additional print properties.

6. To exit the Print Preview mode, click the **Exit print preview** link.

---

### Exporting the process template

You can export the process template in the following formats:

- Web Page (**HTML**)
- SVG image
- JPEG image
- XPDL file
- Microsoft Project file
- Process Summary in PDF or MS Excel format

You can even export large process template diagrams as a single file.

**Note:** You can use the **Export** page of the **Preferences** dialog box to change the default width and height of the JPG image. For details, see Using the Export page on page 124.

---

**To save the process template’s file and export it in a supported format:**

1. Open the process template that you want to export.

2. From the palette (see Using the palette on page 40, click the **Export** (🔴) icon.

   The Tasks pane displays the Export Tasks panel which includes the following links.

**Table 17: Links**

<table>
<thead>
<tr>
<th>Links</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as a single JPEG image</td>
<td>To export the process as a JPG image.</td>
</tr>
<tr>
<td>Generate a Web page</td>
<td>To export the process as an HTML web page.</td>
</tr>
<tr>
<td>Save as a SVG image</td>
<td>To export the process as a SVG (Scalable Vector Graphics) image.</td>
</tr>
<tr>
<td>Generate XPDL</td>
<td>To export the process as an XPDL file. You can use the exported XPDL file as template for creating a new process. For more information, see Importing XPDL files on page 67.</td>
</tr>
</tbody>
</table>
### Generating a process summary

Progress Developer Studio for OpenEdge enables you to generate a process summary in PDF and MS Excel formats. The process summary presents a summary of the worksteps and other process features for the selected process template.

**To generate the process summary:**

1. Open the process template for which you want a process summary.
2. From the palette (see *Using the palette* on page 40, click the Export icon.
3. From the Export Tasks panel, click *Save as Process Summary* to open the Document Generation dialog box.

**Figure 33: Document Generation**
4. Choose the appropriate checkboxes to specify the Optional Sections in the process summary.
5. From the Output drop-down list, select the format in which you want to generate the process summary output. The available formats are PDF and Excel.
6. Click Generate to generate the process summary.

Viewing process summary

Figure 34 on page 83 displays the process summary in PDF format. The generated process summary in Excel format includes the same information as that in the PDF format.

Figure 34: Process Summary Document in PDF Format

Note: Process summary files are saved directly under the application folder; for instance, if you generate a PDF summary for the Assignment application, the PDF file (summary.pdf) and the process diagram file (report.jpg) are located in the Workspace_Home\Assignment folder.

The first page displays a Process Properties section, including data on General properties, Attributes, and a History of the process (that is, when it was created, saved, checked in, etc.). From the Process Diagram section, you can click the Click here to view process diagram in a different window link to open the process diagram file.
Note: Process summary reports for Web applications do not include all the sections that are displayed for Business Processes. This is because features that are not supported in Web applications, such as the Simulation section, are not shown in process summary reports for Web applications.

1. The bookmarks on the left provide links to Worksteps, Links, Performers, and Dataslots sections. Alerts and Notes sections are also displayed, if Alerts or Notes are present in the process. Expand the bookmarks and then click each of these bookmarks to open the corresponding section for a specific workstep, or to view performers, dataslots, or alerts (if any) available in the process. You can view or print the process summary PDF document, select data in it, or copy data from it.

Figure 35: Process Summary in PDF Format, Workstep Page

2. To view the process summary for a specific workstep, expand the Worksteps bookmark and then click the workstep name to display the following information:

- Workstep details (Step Figure 35 on page 84) including its general properties (including Loop and Skippable conditions if present) in the General section.
- Information about dataslots assigned to the workstep in the Fields section. Click the View All User Dataslot Properties link to navigate to the Dataslots section.
- Information about workstep collaboration (if any) in the Collaboration section. This information is displayed only if you have selected the Collaboration checkbox in the Document Generation dialog box (Figure 33 on page 82).
- Information about custom presentation forms or rollback points assigned to the workstep in the Advanced section.
For Subprocess worksteps, click the **Click here to view <AppName> subprocess document** link under the Subprocess Document heading to open the process summary document for the nested process.

3. Click **Links** bookmark to view all the connectors in the process, along with the source and target worksteps for each connector, and associated conditions (if any).

4. Click **Performers** bookmark to open the Performers section, which lists information about all the performers assigned to the process.

**Figure 36: Process Summary in PDF Format, Performers Page**

5. You can also click **Dataslots, Alerts** (visible when the process contains alerts), or **Notes** (visible when the process contains notes) to view the respective data.

6. Click **File > Exit** or the **Close** button ( ✗ ) to exit the process summary PDF document.

---

### Managing phases

A phase is a set of tasks, which signifies the completion of a project segment. You can use the Phase function to divide all the tasks in a process into sets of tasks (or subtasks). For example, in a typical Sales process, all subtasks which help achieve Customer Prospecting can be considered a phase.
Phases are represented by vertical lines and are similar to implementing Swim lanes (as discussed in Using swim lanes on page 142. You can define a Phase and its worksteps in the Diagram tab. In the Overview tab, you can view the phase to which a particular task belongs.

**Note:** Phases are not supported in Web applications.

## Creating a phase

You can create a new phase for a Business Process in the Diagram tab.

**To create a phase:**

1. Open the Business Process (SPT) in the Diagram tab.
2. From the Tasks pane (Figure 6 on page 38), click the **Create Phases and Swim Lanes** link in the Design Tasks panel, and then click the **Phase** ( ) icon to open the Phase Properties dialog box.

   ![Phase Properties dialog box](image)

   **Figure 37: Phase Properties dialog box**

   **Note:** You can also use the ‘P’ gesture to add a phase. For details, see Using mouse gestures on page 103.

3. Enter the ID and Name of the new phase in the respective boxes.
4. Click **OK** to add a new phase to the process template diagram. Move all the worksteps that belong to this phase into the added phase, as seen in the Figure 38 on page 87.

   **Note:** You cannot move a phase.
Resizing a phase

You may need to resize a phase either to add a shape to the phase or to quickly move a shape into (or out of) this phase.

- To increase the width of a phase, select the **Move shapes when resizing phases** checkbox, before resizing the phase. Shapes, adjacent to the phase, move as you resize the phase.

- To make the adjacent shapes a part of this phase or to remove a shape from this phase, clear the **Move shapes when resizing phases** checkbox, before resizing the phase. Shapes, adjacent to the phase, do not move as you resize the phase.

To resize a phase, position your cursor over the space between two phase headers, then use the slider to adjust the width to the left or to the right.

Performing additional phase operations

You can perform additional operations on a phase by right-clicking the phase header (see the popup menu in Figure 38 on page 87). Additional operations include changing the phase header display, modifying existing phase properties, and removing a phase.

- To change the phase display header, from the **View** menu (Figure 38 on page 87), select either Name or ID to display your selection in the header of each phase.

- To change the properties of the selected phase, click **Phase Properties** to open the **Phase Properties** dialog box (Figure 37 on page 86), in which you can modify the current phase properties.

- To remove the selected phase, click **Remove Phase**.
Rollbase Integration

You can now use Rollbase as a presentation type similar to using BPM forms to ensure that BPM forms can be displayed in Rollbase which includes completing the task and other actions. Using this feature, users can export BPM process data as an OpenEdge service object and import it into Rollbase. This is done using the feature, Generate JSDO catalog from a BPM process from within the BPM Studio. Once the JSDO object is created, you can use it as a Rollbase object similar to Creating Page, Enable Workflow etc. For more information, refer to Rollbase Documentation.

This chapter explains the process that you need to follow to integrate OE BPM and Rollbase.

The following are the prerequisites:

- Rollbase 3.1 or above(On Premise) should be installed on your machine
- SPA and SSO should be enabled for BP Server

For details, see the following topics:

- Rollbase as a presentation type for OE BPM

Rollbase as a presentation type for OE BPM

To use Rollbase as a presentation type for OE BPM, the following actions must be performed.

To use Rollbase as a presentation type for OE BPM:

1. In BPM Studio, import the OEBPM-Rollbase project available at <dlc>\OEBPM\Studio\JSDO_Support.
2. Modify the security settings of the imported project to enable OE preauth filter.
3. Change the presentation type to Rollbase in BPM Studio.
4. Specify the edit page value as metadata for Rollbase presentation type.
5. Add a presentation type to activity1 and specify the metadata as edit page value.
6. Save and publish the application.
7. From PDSOE, generate the OpenEdge JSDO catalog by right clicking on the process.

**Note**: For more information, refer to Rollbase Documentation.

8. Log into Rollbase.
9. Change **Authentication Type** to OpenEdge in the Administrator setup page.

**Note**: For more information, refer to Rollbase Documentation.

10. Create a Rollbase application from **External Data** and choose **Import from OpenEdge service**.
11. In the next page, provide the JSDO catalog generated from PDSOE in step 8.

**Note**: For more information, see Rollbase

---

Chapter 6: Rollbase Integration
Designing a process template diagram

This chapter describes how you can design a process template diagram in Progress Developer Studio for OpenEdge.

**Note:** Alternatively, you can design a process template without the knowledge of BPMN shapes. For details, see Working with the Overview page on page 109.

For details, see the following topics:

- Creating a process template diagram
- Connecting worksteps
- Adding notes

Creating a process template diagram

**Developing BPM projects** on page 45 describes the procedure of using appropriate wizards to create the project files for Business Processes and Web applications. This section describes how to design a process template for either projects and the differences between them.

When you complete the **New BPM Project** (Creating a BPM project on page 46) or the **New Web application** (Creating a Web application on page 50) wizard, the **OpenEdge BPM Designer** perspective is launched, with the new process template displayed in the Content pane. It is displayed as a project folder in the Project Explorer and Outline views (these two views are automatically displayed when you use the OpenEdge BPM Designer perspective).

**Figure 39** on page 92 displays the BPM Designer interface for a Business Process.
If you do not use the Template section in the wizards, the project opens to a blank process template (SPT or SWT) file in the Content pane, as shown in Figure 39 on page 92. If you use the Template section, the process you select as a template appears in the Content pane.

The BPM Designer interface contains the Project Explorer and Outline views on the left side, the Content pane in the middle, and the Tasks pane on the right side. The Project Explorer and Outline views list the files and structural elements in the process template. The Tasks pane provides Shapes, Performers, and other elements available for the selected process. The name of the current process template is displayed above the Content pane. The Content pane tabs at the bottom enable you to view the template diagram, dataslots, and performers for the process.

A process template typically consists of a single Start workstep, one or more Activity worksteps, and at least one End workstep. The following procedure describes how to create a process template by adding shapes, connectors, and other component templates to the Content pane.

To save the process template’s file and export it in a supported format:

1. From the Tasks pane, click the Draw Shapes link and then drag any of the shapes available, into the blank Content pane, beginning with the Start shape (☐).

   a) Select an Activity shape (☐) to represent worksteps performed by a human user (applicable only for Business Processes), an adapter or a subprocess and drag them into the Content pane. Add more Activity Shapes as required.

   b) Add an End workstep (☐). The process template must include at least one End workstep.

   **Note:** You can add the rest of the Shapes depending on your process template requirements.

2. From the Tasks pane, use the Connect Shapes link to connect the worksteps. For more information on connecting worksteps, see Connecting worksteps on page 96.

   **Figure 40** on page 93 displays a sample process template for a Business Process. The Outline view displays the structure of all the worksteps and performers in the template.
You can now perform the following operations to complete the process flow diagram.

Table 18: Completing a Process Flow diagram

<table>
<thead>
<tr>
<th>To . . .</th>
<th>See . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define dataslots</td>
<td>Using dataslots on page 147.</td>
</tr>
<tr>
<td>Add workstep performers</td>
<td>Defining and assigning performers on page 129.</td>
</tr>
<tr>
<td>Define an alert</td>
<td>Using alerts on page 253.</td>
</tr>
<tr>
<td>Add process simulation parameters.</td>
<td>Configuring and running simulation on page 353</td>
</tr>
<tr>
<td>Define workstep properties</td>
<td>Setting workstep properties on page 173</td>
</tr>
<tr>
<td>Define workstep presentation</td>
<td>Defining workstep presentation format on page 233</td>
</tr>
</tbody>
</table>

3. From the palette, click the **Check Diagram** (✔️) icon to determine the validity of the process. If the new process template is not valid, invalid items are listed in the Problems pane; and a pop-up message is displayed indicating the items that are not valid. If you correctly defined the process template, “The diagram is complete” message appears. Click **OK**.

4. To save changes to all open projects and files, from the **File** menu, click **Save All**.

Figure 41 on page 94 displays the BPM Designer interface for a blank Web application.
The major differences between editing functions for a Business Process and a Web application are listed below:

- There are fewer options in the Tasks pane. Unlike in a Business Process, creating phases and swim Lanes are not supported in Web applications.
- There are fewer Shapes available for a Web application. The AND Gateway and Exclusive Or-Join shapes are not supported.
- The Rules feature is disabled as rules are not generated in Web applications.
- The **Alerts** tab is not present as this feature is not supported in Web applications.

You can create a process template for a Web application, similar to how you do for a BPM process. Figure 42 on page 95 shows a sample Web application.
BPM Designer allows you to change the shapes after adding them to your Content pane. That means you need not delete an inappropriate shape and drag the correct shape to the Content pane. Table 19 on page 95 lists the valid shapes that you can change to for each process template element.

Table 19: Changing Shapes

<table>
<thead>
<tr>
<th>Shape</th>
<th>Change to (in the case of a Business Process)</th>
<th>Change to (in the case of a Web application)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>All other shapes, except End</td>
<td>All other shapes, except End</td>
</tr>
<tr>
<td>Activity</td>
<td>All other shapes, except Start and End</td>
<td>All other shapes, except Start and End</td>
</tr>
<tr>
<td>Decision</td>
<td>Activity, AND Gateway, Message</td>
<td>Only Activity</td>
</tr>
<tr>
<td>XOR Join</td>
<td>All other shapes, except Start and End</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>OR Join</td>
<td>All other shapes, except Start and End</td>
<td>All other shapes, except Start and End</td>
</tr>
<tr>
<td>AND Gateway</td>
<td>All other shapes, except Start and End</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Message</td>
<td>All other shapes, except Start and End</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>End</td>
<td>All other shapes, except Start</td>
<td>All other shapes, except Start</td>
</tr>
</tbody>
</table>

To change a shape:

1. Right-click the shape that you want to change, and then point to the Change To option.
2. BPM Designer displays the list of valid shapes that you can change to. Click the shape that you want to change to from the options provided, to view the altered shape element in the Content pane.
Connecting worksteps

You can use the **Connect Shapes** link in the Tasks pane to connect the several Shapes or process template elements in your process template. The connections (or connectors) between the process elements determine the workflow of the process. Each shape contains up to 12 points of connection, using which you can make multiple connectors to worksteps and shapes. You will notice that when you click the **Connect Shapes** link, the Tasks pane displays three types of links - Normal flow, Compensation flow, Timeout flow - that you can use to connect worksteps.

**Figure 43: Tasks Pane with Connector Mode selected**

Table 20 on page 96 describes these connector types and how they appear when used on a template workstep.

**Table 20: Types of connectors**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (Default)</td>
<td></td>
<td>The Normal ( Default ) connector type provides standard connectors to worksteps. In the case of a workstep with multiple outgoing connectors, the default connector indicates a connector with no condition.</td>
</tr>
<tr>
<td>Normal (Conditional)</td>
<td><img src="Image" alt="Diagram" /></td>
<td>In case of a workstep with multiple outgoing connectors, this conditional connector indicates a connector with a condition. The workflow selects this connector path if the condition is satisfied.</td>
</tr>
</tbody>
</table>
Indicates that compensatory steps will be taken in the event of an Error occurring during the running of the process or a Recovery. The connector from the source workstep of a Compensation flow is indicated by a icon. When you add the Compensation flow to a diagram, the target workstep of the Compensation flow automatically becomes a Rollback Point (see Defining a Rollback on page 216). Worksteps with a Compensation icon ( يكن are either Rollback Points or have script (or compensation) defined in the On Recovery tab in the Advanced tab of the workstep’s Properties view.

Indicates the direction of a workflow after Overdue Actions have been executed and the Last Overdue action is completed. Add the Timeout flow connector to the diagram, the source workstep of a Timeout Flow is marked with a . When you add the Timeout flow to a diagram, the Activate timeout flow checkbox in the Overdue Actions tab of the Advanced tab of the target workstep’s Properties view is automatically activated. For more information, see Defining a Timeout in worksteps on page 218.

**Note:** Keep the Optimize connectors when moving shapes checkbox clear to maintain the point of connection to the shape when you move the connected shape. Alternatively, if you select this checkbox, the shortest path between shapes is used for the connection. For example, if the position of “Activity2” in the process diagram is closer to “Activity1” than the position of “Activity3,” then any connector from Activity1 is joined to Activity2.

When you choose one of the above flow types, the representation of the cursor in the Content pane changes to indicate the type of flow you selected. Table 21 on page 97 indicates the type of links that can be used with typical process template components and the number of links (single, multiple, or none), which are allowed to originate from each element.

**Table 21: Shape and Output Link Matrix**

<table>
<thead>
<tr>
<th>Shape/Workstep</th>
<th>Default</th>
<th>Conditional</th>
<th>Compensation</th>
<th>Timeout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Decision</td>
<td>One allowed</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Split</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>And-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Or-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Xor-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Activity workstep</td>
<td>Multiple allowed</td>
<td>Multiple allowed</td>
<td>One allowed</td>
<td>One allowed</td>
</tr>
</tbody>
</table>
Using multiple connectors

You can use multiple incoming and outgoing connectors for a workstep without using an intermediary Or-Join, AND, or Decision. In addition, BPM Designer supports multiple outgoing connectors for Start worksteps; and multiple incoming connectors for Decisions and End worksteps.

The following restrictions apply to workstep connections:

• You cannot have more than one connector of the same type with the same source and target worksteps.

• A connector cannot originate from and terminate at the same workstep.

• The Or-Join and XOR-Join gateways can have only one outgoing connector. When an AND gateway has multiple incoming connectors, it acts as an And-Join and can have only one outgoing connector.

Note: Even though you can now design a business process without using the Or-Join or Decision gateways, these worksteps are still available for users who want to add them to processes to clarify or highlight areas of the process’s workflow.

Using multiple incoming connectors to worksteps

You can add multiple incoming connectors to worksteps, as shown in Activity 3 in Figure 43 on page 96. You can also add multiple incoming connectors to Decision, Or-Join and End worksteps. These multiple incoming connectors are the equivalent of an Or-Join shape and, in this case, indicates that Activity 3 will be performed when either Activity 1 or Activity 2 is completed.

Figure 44: Process Diagram with Multiple Connections
Using multiple outgoing connectors from worksteps

You can add multiple outgoing connectors to worksteps, as shown by the connectors out of Activity 3 in Figure 43 on page 96. You can also add multiple outgoing connectors from Decision, Or-Join and Start worksteps. With this type of connector, you can add conditions that will direct the process flow.

**Note:** All connectors are default connectors unless you clear the Default checkbox in the Link Properties dialog box (for more information, see Figure 134 on page 212).

If all of the outgoing connectors from a workstep have no specified condition, then these connectors are the equivalent to an And shape, indicating that once the previous workstep is completed, the next worksteps are activated simultaneously. For example, the connectors to Activity 1 and 2 have no condition and these two activities are both started after the Start workstep is completed.

If one or more of the outgoing connectors from a previous workstep has a specified condition, then these connectors are equivalent to a Decision shape. Once the previous workstep is completed, one or more next worksteps can be activated if the connectors to them fulfill specified conditions. But if these conditions are not met in any of the connectors, then all connectors with no condition will be executed. For example, the connectors from Activity 3 to Activities 4, 5 and 7 each have conditions and one or more of these activities will be executed when the specified conditions are met; the connectors from Activity 3 to Activity 6 has no specified condition and these activities will be executed when the specified conditions for Activities 4, 5 and 7 are not satisfied.

Using multiple incoming/outgoing connectors with gateways

Gateways are diamond-shaped objects in a BPMN process diagram; they represent a change in the workflow—it may indicate the joining, merging, splitting or deciding of the flow’s direction. Gateways include Decision (including Exclusive Decisions), XOR Join, OR-Join, and AND Gateway.

Decisions (◇) have a single incoming connector and multiple outgoing connectors. Or-Join (◇) and XOR Join (◇) gateways have multiple incoming connectors and a single outgoing connector.

When an AND gateway (◇) has multiple incoming connectors, it must have a single outgoing connector—in this case, the AND gateway acts as an And Join. When an AND gateway has a single incoming connector, it can have multiple outgoing connectors—in this case, the AND gateway acts as an And Fork (or Split). These variations in incoming or outgoing connectors for gateways are illustrated in the following figure.

**Figure 45: Examples of Gateway connectors**

If you want to start multiple parallel worksteps after an Or-Join or XOR Join gateway, you must insert an AND Gateway immediately after the Or-Join or XOR Join gateway.
Defining Loops in the workflow

You can define loops in the workflow without using multiple connectors to and out of worksteps, and without using Decision shapes. For more information, see Defining a Loop condition on page 182.

Adding notes

You can add a note (a Sticky Note, an Annotation, or a Group notation) to any element in a process template diagram. Sticky Notes and Annotations generally have the same functions, and they only differ in visual representation. You can use a Sticky Note or Annotation to indicate specific features or conditions, or as prompts or reminders for other users (for example, "Must be reviewed by all managers"). Use the Group notation to select and insert a caption that describe a group of worksteps that share a similar task (for example, all activities performed by the HR Department in Hiring) or that require the same performer (for example, highlighting all worksteps "Performed by Managers Group in HR Department").

To insert a note into a process:

1. Click the Create Annotations link in the Tasks Pane and drag the Sticky Note ( ), Annotation ( ) or Group notation ( ) shape into the Content pane. You can also drag any of these notes onto a workstep or other shape, which creates a connection between it and the note.

2. Click the note to view its properties in the Properties view.

Figure 46: Properties for Notes

a) In the General tab, you can change the appearance of the note (example, Sticky Note to Group). Use the Type drop-down list to specify the new type for the existing note.

b) Click View/Edit link to open the View/Edit dialog box, where you can enter the note's message or the grouping's caption in the text area provided. For a Group notation, enter a caption for the group association (for example, Review all grouped worksteps). Use the toolbar icons to format the text as required.

c) You can also insert a hyperlink by right-clicking the text area and selecting the appropriate option. To add a hyperlink to a note, select Insert > Link opening the Link Properties dialog box. Here, specify the text to be used as the hyperlink and the URL.

d) Click OK to apply the changes to the selected note and return to the Properties view.

e) From the Background section, you can select a background color for Sticky Notes. You cannot change colors for Annotation and Group notations. You can also click More to display more color options.
Note: You can also change the background color of one or more Sticky Notes by selecting the note elements in your Content pane and then clicking the **Color** icon from the palette, to open the color palette. Select one of the listed colors, or click **More** to open the **Color Chooser** dialog box (Figure 75 on page 143) to define your custom color.

f) From the **Associate With**: drop-down list, you can associate the Sticky Note or Annotation with a specific workstep by selecting from the worksteps listed. To disassociate a note from a workstep, select **(none)** from the drop-down list.

Once you define the properties of the notes, the notes appear in the process template diagram, as shown for a Sticky Note in the following figure.

**Figure 47: Notes Associated with Worksteps**

3. Use your cursor to move or resize the Sticky Note, Annotation, or Group notation as required.
Managing gestures

Progress Developer Studio for OpenEdge provides mouse gestures to quickly add shapes, connectors, and layouts to your Content pane, as well as perform commonly-used actions in your process template.

This chapter describes how you can use mouse gestures in your process template diagram, and to create custom gestures using the Gesture Editor.

For details, see the following topics:

- Using mouse gestures
- Creating custom gestures
- Saving custom gestures

Using mouse gestures

You can view the set of predefined mouse gestures in the Default Gestures dialog box.

1. Create or open the process template diagram (SPT or SWT) where you want to use mouse gestures.
2. Click the Show Gestures (_show_gestures_icon_) icon from the palette, to open the Default Gestures dialog box.

   Figure 48 on page 104 displays the mouse gestures predefined for a Business Process.
Figure 48: Default Gestures in a Business Process

Note: Web applications support fewer shapes and layout gestures.

3. Point to each of the shapes, layouts, and actions to view the gesture details in the Gesture Details section. The red dot indicates the starting point of the gesture.
4. Click OK to close the Default Gestures dialog box.

To use any gesture in your Content pane, drag the right mouse button in the required direction.
To connect shapes using gestures, press CTRL key and then drag the right mouse button between shapes to connect them.

Note: By default, you can use gestures to connect shapes with the normal flow connector. To connect shapes using the other connector types, select the other connector types (see Connecting worksteps on page 96) before using gestures to connect shapes.

Creating custom gestures

Progress Developer Studio for OpenEdge provides the Gesture Editor, which enables you to create custom gestures and replace the default gestures, illustrated in Figure 48 on page 104.

Using the Gesture Editor

To start the Gesture Editor:
1. From the OpenEdge > Tools menu, click Gestures to open a blank Gesture Editor dialog box.
2. To populate the Gesture Editor with the set of predefined actions and parameters, click File > New.
The Gesture Editor consists of the following three panes:

- Actions pane, containing the list of predefined gesture actions, as listed in Table 22 on page 105. For information regarding the shapes used, see Using shapes on page 39.

- The middle pane, where you can view (and edit) the action selected in the Actions pane, as well as draw one or many gestures for each action.

- Gestures pane, which displays the gestures associated with each action.

Table 22: List of predefined actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>shape_start</td>
<td>Creates a Start workstep.</td>
</tr>
<tr>
<td>shape_activity</td>
<td>Creates an Activity workstep.</td>
</tr>
<tr>
<td>shape_activity_performer</td>
<td>Creates an Activity workstep with a performer. You can assign the performer, which can be a human, an adapter (managed or custom), a subprocess (with external reference), or an external (user or adapter) performer. For information regarding performers, see Defining and assigning performers on page 129.</td>
</tr>
<tr>
<td>shape_decision</td>
<td>Creates a Decision gateway.</td>
</tr>
<tr>
<td>shape_xor</td>
<td>Creates an Exclusive Or-Join gateway.</td>
</tr>
<tr>
<td>shape_or</td>
<td>Creates an Or-Join gateway.</td>
</tr>
<tr>
<td>shape_and</td>
<td>Creates an And gateway.</td>
</tr>
<tr>
<td>shape_message</td>
<td>Creates a Message workstep.</td>
</tr>
<tr>
<td>shape_end</td>
<td>Creates an End workstep.</td>
</tr>
<tr>
<td>add_swimlane</td>
<td>Adds a swimlane. For information regarding swimlanes, see Using swim lanes on page 142.</td>
</tr>
</tbody>
</table>
### Designing gestures

**To design a gesture in the Gesture Editor:**

1. From the **Actions** pane (Figure 49 on page 105), select the action for which you want to design the gesture.

2. Modify, if required, the default text in the **Label** and **Description** boxes to provide additional information for the gesture. You can enter a static label or description; for instance, “End” for label and “Adds an End workstep” for description.

   BPM Designer converts any value starting with the “$” sign with the corresponding string in the localization file (example, `designer.properties`).

3. In the drawing area provided, drag your mouse to draw the gesture icon to be used for the corresponding action. To accept the drawn shape and clear the drawing area, click **Accept**. To discard the drawn shape, simply click in the drawing area.

4. After you click **Accept**, the drawn shape is displayed as a gesture in the **Gestures** pane. To remove the added gesture from the **Gestures** pane, select the gesture to be deleted and click **Discard**.

Depending on the complexity of the action, create multiple gesture samples. For simpler actions, two to three gesture samples are adequate. For complex actions, you need to create more samples. Repeat Step 3 to Step 4 to add multiple gesture samples. Step Figure 50 on page 107 displays gesture samples created for the Start workstep.
Figure 50: Sample Gestures for Start workstep

You can use the checkbox for each gesture in the **Gestures** pane to select the icon to be displayed for this action in the help for the customised gestures. If you select multiple checkboxes, the gesture that you select first is displayed as the gesture (Step Figure 50 on page 107) icon and the rest of the gestures are displayed in the **Gesture Details** section.

**Guidelines for gestures**

You need to follow the following guidelines when designing a gesture.

- The starting point of a gesture is important. You can use the starting point to distinguish several similar shaped gestures.
- You can use the direction to create two different gestures for the same shape. For instance, you can use a clockwise-drawn circle for a Start workstep, and anti-clockwise circle for the End workstep.
- Always create multiple gesture samples for each action. This ensures that the gesture recognition algorithm compensates most of the variations, thus resulting in reliable recognition.
- Do not try to be too precise when drawing the gesture sample. Do not make the sample size too big or too small. Draw them as you would when using them in practice.
- Draw each gesture with a single stroke. Releasing your mouse indicates the end of the gesture.

**Saving custom gestures**

Progress Developer Studio for OpenEdge stores all gestures (default and custom) in the `Workspace_Home\.com.savvion.studio\gestures` folder. The default gesture set is stored as `default.ptp`. All custom gestures are stored as GLF files (Gesture Library File). For the purpose of starting, Progress Developer Studio for OpenEdge provides a sample gesture set (`sample.glf`) file.

To save your custom gesture:
1. Use the **Gesture Editor** to create your custom gestures for each required action.
2. Click **File > Save**, opening the **Save** dialog box.
3. Type the gesture file name, then click **Save**.

   You can open your custom gesture file (using **File > Open** option in **Gesture Editor**) and modify the same.

### Using custom gestures

You can now use your saved custom gesture in your process template diagram by replacing the default gesture set (default.ptp) with your custom gesture file.

1. Click **Windows > Preferences**, opening the **Preferences** dialog box (described in Setting preferences on page 122).
2. Expand the **Progress OpenEdge > BPM** node and select **Diagram**.
3. From the **Gestures** section, change the default gestures file (default.ptp) by clicking **Browse** next to the **Gestures file** box, then select your custom gestures file in GLF format.
4. To close the **Preferences** dialog box, click **OK**.
5. Open the process template diagram (SPT or SWT) where you want to use your custom gesture.
6. Click the **Show Gestures** (🔢) icon from the palette, which now displays your custom gesture set.
Working with the Overview page

Progress Developer Studio for OpenEdge allows process modeling and analyzing through the Diagram view. In certain situations, this procedure can be cumbersome, as there is a learning curve involved for the business user, who needs to understand the usage and semantics of BPMN shapes before defining a meaningful process.

Consider an instance where a business user wants to quickly outline a large process with a large number of tasks. Instead of adding shapes and defining their properties in the Diagram view, a business user would probably rather work with a project-oriented view of the process by defining a set of tasks, the task/subtask relationships, and additional details without ever needing to switch to the Diagram view. The Diagram view is still a useful view especially for complex flows. However, it is not the only view, nor is it be the only editor for defining new worksteps. Progress Developer Studio for OpenEdge provides the Overview page, which is an effective tool to support project-oriented processes.

For details, see the following topics:

- Introducing the Overview page
- Managing tasks

Introducing the Overview page

The Overview page (or tab) provides a project-oriented approach - including activity timelines - to designing a process, where you can add a set of tasks (or activities), define their relationship, and configure the properties, without switching to the Diagram tab.

The Overview page provides the following benefits:
- You can reduce process design time by over 30% by using the Overview page.
- You can filter process elements in the Overview page for analysis. For example, you can choose to view only Tasks or Adapters.

**Figure 51: Diagram and Overview pages**

![Diagram and Overview pages](image)

Figure 51 on page 110 displays the diagram and overview pages of the sample process, “Assign_A_Task_V2.” As illustrated, both the pages provide different views of the same process. The following are the important common features:

- Any changes made in either of the views are reflected in the other view, when activated.
- All the process template elements in the Diagram view (except for Notes, Swim lanes, Phases, and Rules) are also available in the Overview page.
- The same Properties view for the process and for each workstep is available in both pages.
- As in Diagram view, you can group tasks in the Overview page and then convert it to an inline subprocess.

**Reviewing the Overview page**

You can design a process template from scratch in the **Overview** page of the Progress Developer Studio for OpenEdge interface.

**Figure 52: Overview page**

![Overview page](image)

For a blank process template, the **Overview** page does not contain any elements or tasks. For a process template that contains elements, the **Overview** page contains the corresponding elements or tasks (see right image, Figure 51 on page 110).

The **Overview** page displays the following default information about each task in a tabular format:
Table 23: Task Information

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the task name, with the adjoining icon indicating the shape used. To change the task name, double-click the cell and enter the new task name. An inline subprocess workstep displays an expandable icon, which you can expand to view its worksteps.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of task or workstep. To change the type, click in the cell and then select one of the options available. The available options depend on the workstep and process type (as listed in Changing shapes on page 95.</td>
</tr>
<tr>
<td>Successors</td>
<td>Displays the successor tasks (in case of a single outgoing connector) or multiple tasks (in case of multiple outgoing connectors). To define the successor tasks, click in the cell and then click the ellipsis button. From the left pane of the Add/Modify Successors dialog box that appears, select the tasks to be added as successors and click ( \rightarrow ) to move them to the right pane. To remove tasks added as successors, select the tasks in the right pane and click ( \leftarrow ). You can define successor for any task type, except End.</td>
</tr>
</tbody>
</table>
| Duration | Displays the default duration (2 hours) of Activity, Adapter, and Embedded Sub-Process task types. To modify the duration, click in the cell and then click the ellipsis button. Select either of the following options:  
  - Enter a duration, to open the Duration dialog box, in which you can enter the number of days, hours, or minutes for the workstep duration.  
  - Use a dataslot, to open the Select Dataslots dialog box, which lists the INTEGER and INT64 dataslots available in the process. Select a INTEGER or INT64 dataslot to define a dynamic duration for this workstep. |
| Priority | To change the workstep priority, click in the cell, then select any of the predefined options: Low, Medium, High, or Critical. Click the Use a dataslot option to choose a dynamic dataslot value at runtime. |
| Performer | Displays the default performer for Activity, Adapter, and Subprocess worksteps. Click in the cell to select another performer (if defined). For more information regarding performers, see Defining and assigning performers on page 129. |
| Milestone Alerts | Applicable only to Start, Activity, Adapter, and Subprocess type tasks. Displays the alerts (if any) associated with the completion of a task (or a milestone). To associate an alert, click in the cell and then click the ellipsis button. From the left pane of the Milestone Alerts dialog box that appears, select the alerts to be added and click \( \rightarrow \) to move them to the right pane. To remove any added alert, select the alert in the right pane and click \( \leftarrow \). You can associate multiple milestone alerts with the same task. To associate all of the defined alerts with the task, click \( \rightarrow \). To remove all of the associated alerts with the task, click \( \leftarrow \). For information regarding alerts, see Using alerts on page 253. |
| Phase | Indicates the phase (if any) to which the task belongs. For information regarding phases, see Managing phases on page 85. |
You can sort the Overview page content by clicking on the column header. You can also search the task list based on a keyword, by entering the keyword in the Search box.

You can also filter the listed tasks by selecting the appropriate filtering criteria. You can apply filtering on basis of the type of tasks (for example, Adapter) and on basis of advanced properties (for example, "Worksteps with skip condition" and "Worksteps that have overdue actions").

To filter the tasks:

1. Click the **Click to filter** icon. The Filter dialog box appears.

[Figure 53: Filter dialog box]

2. To enable filtering, select the **Enable filtering** check box.

   To filter the list of tasks on basis of the workstep type, select one (or more) check boxes in the **Type** list (left image, Figure 53 on page 112). To filter the list of tasks on basis of advanced workstep properties, select one (or more) check boxes in the **Advanced** list (right image, Figure 53 on page 112).

3. Click **OK** to apply the selected filtering to the list of tasks in the Overview page.

### Managing tasks

You can create and edit an entire process template in the Overview tab. You can also set the properties of individual tasks (or worksteps) in the Properties view, as described in Setting workstep properties on page 173. You can use the toolbar in the Overview tab (Figure 52 on page 110) to add and manage the tasks of the process template.

### Adding a task

To add a task (or a workstep):
1. Click the **Click to add** icon ( ), inserting a default Activity task. To add a task after an existing task, select the existing task and then click the **Click to add** icon.

2. Type the task name in the **Name** column. Task names can include only alphanumeric characters and the underscore (_) character.

3. In the **Type** column, click in the cell and then select from the available workstep options, as required.

   Step Table 24 on page 113 lists the available options.

### Table 24: Workstep Type

<table>
<thead>
<tr>
<th>Options</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND Gateway</td>
<td>To add an AND gateway. This gateway is not available for Web applications.</td>
</tr>
<tr>
<td>Activity</td>
<td>(default) To add an Activity workstep.</td>
</tr>
<tr>
<td>Adapter</td>
<td>To add an adapter workstep. Displays the <strong>Adapter</strong> dialog box, in which you can define (or select) any adapter.</td>
</tr>
<tr>
<td>Decision</td>
<td>To add a decision gateway.</td>
</tr>
<tr>
<td>Embedded Sub-Process</td>
<td>To add an inline subprocess. This option is not available for Web applications.</td>
</tr>
<tr>
<td>End</td>
<td>To add an End workstep. This type is only available when there is no successor task specified under the <strong>Successors</strong> column.</td>
</tr>
<tr>
<td>External Activity</td>
<td>To add a monitoring Activity workstep.</td>
</tr>
<tr>
<td>External Sub-Process</td>
<td>To add an external subprocess.</td>
</tr>
<tr>
<td>External Adapter</td>
<td>To add a monitoring Adapter workstep.</td>
</tr>
<tr>
<td>Managed</td>
<td>To add a managed adapter workstep. On selecting this type, the Managed Adapter Browser tool appears. For more details, see Using Managed Adapter Browser on page 463.</td>
</tr>
<tr>
<td>Message</td>
<td>To add a Message workstep. This workstep type is not available for Web applications.</td>
</tr>
<tr>
<td>OR Join</td>
<td>To add an Or-Join gateway.</td>
</tr>
<tr>
<td>Start</td>
<td>To add a Start workstep. This option is available only for the first added task, and not for subsequent added tasks.</td>
</tr>
<tr>
<td>XOR Join</td>
<td>To add an Exclusive Or-Join gateway. This gateway is not available for Web applications.</td>
</tr>
</tbody>
</table>

4. To add more tasks, click the **Click to add** icon.

   The **Successor** column for the previous task now displays the default task name (“Activity 2”) of the added task.
Performing other operations

After adding tasks, you can perform any of the following operations using the toolbar in the Overview tab.

- You can expand (and collapse) the entire task list in order to view (or hide) all elements. To expand the list, click the **Click to expand all nodes** icon. To collapse the list, click the **Click to collapse all nodes** icon.

- To remove a task, select the task and click the **Click to remove** icon.

- To group tasks into an inline subprocess, select the tasks and click the **Group tasks** icon. This inserts a subprocess task of type, “Embedded subprocess” and contains the grouped tasks between a Start and End workstep. To ungroup the tasks, select the subprocess task and click the **Ungroup Tasks** icon.

  **Note:** You cannot add nor delete group tasks for sorted and filtered (by workstep type and by advanced properties) data.

- To change the position of a selected task, click the **Move up** icon or the **Move down** icon. Changing the position of a task does not alter the task's predecessor and successor.

- To view any task in the Diagram view, select the task and then switch to the Diagram view.

- You may need to restore the added tasks to its original order. To do so, click the **Restore Default Order of Tasks** icon.

  **Note:** You can design an entire process template in the Overview tab, without switching to the Diagram tab. To ensure that all changes in the Overview page are integrated seamlessly in the Diagram view of the process, see that the Auto Layout functionality is enabled in the Diagram page of the Preferences dialog box (see Using the Diagram page on page 123).
Introducing Path Analysis

This chapter describes how you can perform process path analysis using the Path Analysis view. For details, see the following topics:

- Using the Path Analysis view
- Exploring the Path Analysis view

Using the Path Analysis view

Progress Developer Studio for OpenEdge provides the Path Analysis functionality in the Path Analysis view, which enables you to analyze the timing of process execution.

Path Analysis provides the following functionalities:

- Ability to drill down through a specific path and estimate the time required for the process execution to reach a particular point in the process.
- Displays workstep attributes including duration, priority, and performer.
- Provides process timeline information with:
  - Graphical display of workstep duration.
  - Grid and markers for duration units including days, weeks, and months.
  - Alternate coloring between weeks, to identify week boundaries.
- Displays all process paths from Start to End workstep using nested paths.
• Displays the estimated start time for each workstep, which is calculated by adding the sum of duration of all previous worksteps in that path.

Figure 54 on page 116 shows a sample approval process that requires the reviewer to decide if the request meets specific critical criteria. If the performer of the ReviewRequest workstep decides it is non-critical, it is sent by e-mail to a group at a remote location for submission.

Figure 54: A Sample Approval Process Template

The Review Request workstep assigned to any member from MgrGroup has an assigned work time of two hours; and the Submit Request workstep assigned to any member from the ebmsgroup has a work time of 50 minutes.

If any member from the MgrGroup decides the request is critical, it is sent to the Exec Approve workstep (with assigned work time of 50 minutes), in which a senior executive (performer, "exec") then approves or rejects it. The approved requests are sent to the Submit Request2 workstep (work time of 50 minutes). Any member of the MgrGroup can view the request status in the Request Status workstep (with default duration of 2 hours). Each of the Adapter worksteps has an estimated duration of 10 minutes. The entire process has an estimated duration of 6 hours.

Exploring the Path Analysis view

To open the Path Analysis view for any process template (for instance, the process shown in Figure 54 on page 116), open the process template and then click the Path Analysis content pane tab.

Figure 55: Path Analysis view

The Path Analysis view displays the name of each task and the following default columns.
Table 25: Column Information In Path Browser

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the task name, with the adjoining icon indicating the shape used.</td>
</tr>
<tr>
<td>Est. Start</td>
<td>Indicates the time interval in which the task is estimated to start. If there is no time interval, this column displays “(none)” (for instance, in the case of the Start workstep). This value is derived by adding the duration for previous tasks. For instance, the estimated start of 4 hours for the Notify Reject task is a sum of the duration for Review Request and Exec Approve tasks. An asterisk beside an estimate (in this case, for “Request Status” and “End1” tasks), indicates that the estimate may not be accurate because there are parallel paths to reach that point.</td>
</tr>
</tbody>
</table>
| Duration   | Displays the time required to complete the task. The colors representing the duration are indicated as follows and are relative to the duration of the other tasks.  
- Red for the tasks with the maximum duration (in this case, Review Request and Exec Approve).  
- Green for the tasks with the minimum duration (in this case, Notify Reject and Notify Submit).  
- Yellow for the tasks with the average duration (that is, an average of maximum and minimum duration values). For some processes, if all the tasks have the same duration, their duration is also represented in yellow.  
- All durations that measure between the average and maximum values are represented in gradient colors from yellow to red.  
- All durations that measure between the minimum and average values are represented in gradient colors from green to yellow. |
| Priority   | Displays the workstep priority. Supported values are: Low, Medium, High, Critical, or dataslot name.                             |
| Performer  | Displays the performer for Activity, Adapter, and Subprocess worksteps.                                                      |
| Timeline   | Provides a visual representation of the Estimated Start and Duration data for each task, without displaying the actual numbers. Each timeline starts from the Estimated Start value and continues for the specified Duration. The timeline is tabulated based on the total process time (in this case, 6 hours) with each task timeline representing the work breakdown structure. Timelines also depict the dependencies between tasks (that is, a particular task cannot start before another task is completed). If the timeline for a particular task is displayed in orange (in this case, the Request Status task), it indicates that the estimated start time may not be accurate because there are parallel paths to reach that point. |

Note: You can expand (and collapse) the process path in order to view (or hide) all elements. To expand the list, click the Click to expand all nodes (.expand) icon. To collapse the list, click the Click to collapse all nodes (contract) icon.
The Path Analysis view displays all the possible paths that a process execution can take. When you search a particular workstep type (or name) by entering the keyword in the Search box, the Path Analysis view displays only those paths that contain the keyword you have searched. You can also filter the paths by selecting the appropriate filtering criteria. You can apply filtering on basis of the type of tasks (for example, Adapter) and on basis of advanced properties (for example, “Worksteps that have loop” and “Worksteps that can be skipped”).

To apply filtering:

1. Click the Click to filter icon.

   The Filter dialog box appears, which is similar to Figure 53 on page 112.

2. To enable filtering, select the Enable filtering check box.

   To filter the paths on basis of the workstep type, select one (or more) check boxes in the Type list. To filter the list of tasks on basis of advanced workstep properties, select one (or more) check boxes in the Advanced list.

3. Click OK to apply the selected filtering to the paths in the Path Analysis view.
Defining process properties

This chapter describes how you can define process properties of a Business Process or Web application. You can define process properties for the first time or modify some of the properties that you have defined when creating the application (refer Creating a Business Process on page 48 and Creating a Web application on page 50).

For details, see the following topics:

- Setting process properties
- Setting preferences

Setting process properties

BPM Designer provides the Properties view where you can set (and modify) properties of the process, and the process template elements (as described in Setting workstep properties on page 173).

The procedures for defining the properties of a process are similar for Business Processes and Web applications.

1. Open the process template file, whose properties you want to define.
2. Click a blank area of the Diagram tab, to open the Properties view.
   By default, it opens to the General tab.
You cannot modify the process name in the Name box. You can define (or modify) the rest of the process properties in the General tab. For information on each of these properties, refer to Table 13 on page 49.

3. Click the Description tab and enter a description of the process in the text area provided. This is optional.

4. Click the Attributes tab to review existing attributes and modify their values. You can create attributes only in the Administration module of Business Process Portal (for more information, see Business Process Portal Administrator’s Guide).

To review and modify attributes and their values:
a) From the **Attributes** tab, you can view the process attributes and values. If there are many attributes listed, you can enter a string of letters in the Search box and any attribute name containing that string is displayed in the table provided.

b) By default, the **Attributes** tab lists the **ProcessType** attribute with value, **BusinessProcess**, **SystemProcess** or **PresentationProcess** (available only for web applications). To add attributes, click **More** to open the **Attributes** dialog box (right image, Figure 57 on page 120), which lists the default attributes—Executable, Goal, Influencers, Objective, Organizational Unit, Process Type, Risks, Rewards—as well as attributes that have already been defined in Business Process Portal.

c) Click the **Add** ( ) icon to go to Administration module of Business Process Portal, in which you can add more attributes, if required.

Click the **Refresh** ( ) icon to refresh the view of the listed attributes.

d) Select one or more attributes (except Process Type) listed in the **Attributes** dialog box and click **OK** to add them to the **Attributes** tab in **Properties** view.

e) To modify the value of an attribute, select the attribute and click **Modify**. You can only modify an attribute if it has been defined as Editable in Business Process Portal.

f) Click **Clear** to clear the value of the selected attribute. To remove an attribute, click **More** to open the **Attributes** dialog box, and clear the checkbox of the attribute you want to remove from the process.

5. Click the **Portal** tab (only available for Business Process) to specify the order of user-defined dataslots in the current process as additional task columns in Business Process Portal.

**Figure 58: Properties View – Portal tab**

- View the order of dataslots that will appear as a new column in the My Tasks page of Business Process Portal. To enable a user-defined dataslot to be displayed in this list, you need to select the **Tasks Column** checkbox in the **Access** tab of the **New/Modify Dataslot** dialog box. (For more information, see **Setting the dataslot access** on page 167.

- Select one of these dataslots and then click **Move Up** or **Move Down** to place the dataslot in the correct sequence that will then be displayed in the Tasks page in Business Process Portal.

6. Click the **History** tab to review past actions in the process. This read-only tab provides information on when the process was created or published.
7. Use the Monitoring tab (available only for Business Process with a monitoring workstep) to define the configurations for a monitoring process. For more information, see Introducing monitoring process on page 223.

Setting preferences

Progress Developer Studio for OpenEdge (Developer Studio) provides the Preferences dialog box, a Configuration interface that enables you to easily modify the more commonly used configuration parameters. Once you have defined these configuration parameters in the Preferences dialog box, they are automatically set for each new project.

To set your preferences in Developer Studio:

1. From Window menu, click Preferences, to open the Preferences dialog box.
2. Expand Progress OpenEdge > BPM in the left pane, the following options are displayed:
   - **Activity**: to set the default properties for an Activity workstep, as discussed in Using the Activity page on page 122.
   - **Application**: to set the default properties and attributes for a process, as discussed in Using the Application page on page 123.
   - **Diagram**: to set the default size of the Diagram view, as well as appearance and other settings as discussed in, Using the Diagram page on page 123.
   - **Export**: to configure the display settings of a process template diagram, when exported in JPG format as discussed in Using the Export page on page 124
   - **Form**: to configure the default properties in Form Editor, as discussed in Using the Form page on page 124.
   - **Publish**: to define the configuration for the target Business Process Server, as discussed in Using the Publish page on page 125.
   - **Simulation**: to set the default simulation-related properties in Simulation perspective, as discussed in Using the Simulation page on page 126.
3. After defining the above preferences, click OK to close the Preferences dialog box.

**Note:** To apply the changes made in each page, click Apply. Click Restore Defaults if you want to restore the values of all options in the page to the default values.

Using the Activity page

You can use the Activity page to configure the default properties of an Activity workstep.
1. From the **Presentation** drop-down list, select the default presentation format (Form or Auto-generated) for Activity workstep.

2. Select the default priority (Low, Medium, High, or Critical) for the Activity workstep in the **Priority** drop-down list.

3. Use the **Duration** boxes to change the default duration (2 hours) of the Activity workstep.

### Using the Application page

You can use the **Application** page to configure the default properties of a process and the default attributes, and database settings.

1. From the **Default Properties** section, set the default properties for a process including the default manager, group, duration, category, sub-category, and author.

2. From the **Default Attributes** section, view (or modify) the default server location from where you can import attributes.

3. From the **Database** section, view (or modify) the database system to be used for dataslots in the process. The available options are for OpenEdge database systems. The maximum storage allowed for CHARACTER, INTEGER, and INT64 dataslots in process templates varies, depending on the selected database. For information on configuring the dataslot storage, see the Setting the dataslot storage section.

### Using the Diagram page

You can use the **Diagram** page to configure the following default properties of the **Diagram** tab in the BPM Designer interface.

#### Table 26: Diagram Page Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Size</td>
<td>To set the configuration parameters for width and height of the diagram page. Values range from a 1 to 10.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show pages</td>
<td>Select this to display the page boundary, as it appears on your default printer. Use this feature to create appropriate page breaks in a lengthy process template diagram.</td>
</tr>
<tr>
<td>Show grid</td>
<td>Select this to view the process template diagram with a grid. The grid is always active, whether visible or not. In the <strong>Grid size</strong> box, set the space between the grid points. Although grid size ranges from 1 - 50, use values that are multiples of 4. By default, grid size is set to 12. <strong>Note:</strong> Due to Java limitations, a process template diagram may not display correctly if you select a grid size of 10 or less.</td>
</tr>
<tr>
<td>Fill shapes</td>
<td>Select this to view a solid fill for diagram components. Clear this option to display transparent components. You can also view a gradient fill for diagram components by selecting the <strong>Gradient fill</strong> option.</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Select this to align a new component to the grid.</td>
</tr>
<tr>
<td>Snap to shapes</td>
<td>Select this to align each new workstep with the center of neighboring components. If you want to move a shape when the <strong>Snap to shapes</strong> feature is activated, select the workstep and use the arrow keys to move the workstep.</td>
</tr>
<tr>
<td>Auto Layout</td>
<td>Select the quality of the auto layout functionality in the <strong>Overview</strong> page (see <strong>Performing other operations</strong> on page 114). Options are low (fast), normal, and high (slow). Clear the <strong>Run auto layout after using Tabular View</strong> checkbox to disable the auto layout functionality.</td>
</tr>
<tr>
<td>Gestures</td>
<td>Allows you to enable or disable the Gestures functionality, described in <strong>Managing gestures</strong> on page 103. For details regarding this operation, see <strong>Saving custom gestures</strong> on page 107.</td>
</tr>
</tbody>
</table>

**Using the Export page**

You can use the Export page to enter the width and height (in pixels) of the process template diagram when exported in JPG format. The maximum width or height you can specify (in pixels) is 25000. For information on exporting, see **Exporting the process template** on page 81.

**Using the Form page**

You can use the Form page to configure the default properties of Form Editor. For operations in Form Editor, see **Using the Form Editor** on page 259.
Setting preferences

Figure 61: Form Page

1. Use the **Show asterisk for "Required" data fields** checkbox to display (or hide) an asterisk next to the label of each required data slot, when added as a control to the form. You can view the result of this setting in Business Process Portal or using form preview (see Opening the Form Editor on page 260) in Form Editor.

2. Use the **Show workstep header** checkbox to display (or hide) the default header for a form in a Web application workstep. If you enable this functionality, then you can view the default header (with the Instruction field) on opening the form from a Form-enabled workstep in a Web application. For information about adding a header in a form, see Adding a header and footer topic.

3. Use the **Preview** section to configure settings for form preview. The **Port Number** box displays the default port number used for form preview. To modify the port number, click the **ellipsis** button beside the **Port Number** box. For information regarding form preview, see Previewing forms on page 305.

**Using the Publish page**

You can use the **Publish** page to add, modify, and remove target server options, which are then listed in the **Server** drop-down list (Figure 26 on page 74) in the Publish Wizard, page 1.

**To add a target server:**

1. Click **Add** to open the **Add Target** dialog box.
2. Enter the target name (required) and its description (optional) in the respective fields.

3. You need to specify at least one target location in the **Locations** section. To add a location, click **Add** to open the **Add Location** dialog box, where you can specify the location in the http://localhost:port/ sbm/deployment format. You can also edit or remove a location.

4. Click **OK** to add the target to the **Publish** page.

### Using the Simulation page

You can use the **Simulation** page to configure the simulation settings for the simulation project. For details regarding simulation, see **Configuring and running simulation** on page 353.

1. Use the **Start Simulation** and **Stop Simulation** sections to set the default configurations (for the default scenario) for the Simulation Start and Stop settings. For details regarding each of these parameters, see **Modifying simulation settings for a scenario** on page 358. Use the **Currency** section to set your default currency symbol.

2. From the **Performer** page, set the default settings for the performer types—Group, Individual, and System. For details regarding each of these settings, see **Managing performers** on page 369.
3. From the **Process** page, you can set the default simulation settings for added processes in the default scenario. For detailed information regarding each of these parameters, see Configuring simulation parameters for a process on page 362.

4. From the **Workstep** page, you can set the default worktime distribution method and other settings for supported workstep types in the default scenario. For details regarding each of these parameters, see For worksteps on page 364.

5. From the **Resource** page, you can set the default cost and count for consumable and non-consumable resources. For more information, see Managing resources on page 372.

**Figure 64: Simulation > UI page**

6. From the **UI** page, you can set (or modify) your preferred settings for switching between simulation-related perspectives in Progress Developer Studio for OpenEdge. The perspective switches are listed as follows:

   - **Open Progress OpenEdge BPM Simulation perspective on launching editor**, when creating or opening a simulation project.
   - **Open OpenEdge BPM Run Simulation perspective on simulation run**, when running a process simulation.
   - **Open Progress OpenEdge BPM Simulation perspective on simulation run exit**, when exiting the Simulation Runtime perspective after running a process simulation.

   The available options for each of the above switches are **Always** (to launch the respective perspective without any user prompt), **Never** (to always perform the requested operation in the current perspective without switching the perspective), or **Prompt** (the default option, which prompts you to switch to the respective perspective).

   You can also choose the color settings for status bars and progress bars used in the Simulation perspective. To choose another color, click the bar and then the adjoining color button, opening the **Color** dialog box, where you can select another color. The available bars are listed in Table 27 on page 127.

**Table 27: Appearance Settings**

<table>
<thead>
<tr>
<th>Bar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For <strong>Status</strong> Bar</td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Indicates the Simulation and Process Status bars before the simulation run.</td>
</tr>
<tr>
<td>Bar</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Required</td>
<td>Indicates the total count of required process instances in the Processes Runtime View during the simulation. It also, indicates the time limit for the simulation project in the Simulation Status section of the Simulation Control Editor, during the simulation.</td>
</tr>
<tr>
<td>Created</td>
<td>Indicates the progress status of created process instances in the Processes Runtime View during the simulation.</td>
</tr>
<tr>
<td>Completed</td>
<td>Indicates the progress status of completed process instances in the Processes Runtime View during the simulation run. Indicates the progress status of simulation project in the Simulation Status section of the Simulation Control Editor, during the simulation.</td>
</tr>
</tbody>
</table>

For **Probability Bar** (For details of the **Probability** bar used in the Probability tab of the Properties view in Simulation Perspective; for details, see Setting the probabilities on page 368)

<table>
<thead>
<tr>
<th>Bar Fill Color FG/BG</th>
<th>Indicates the gradient colors (smooth shading of one color to another color) used for the filled portion of the probability bar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Empty Color FG/BG</td>
<td>Indicates the gradient colors (smooth shading of one color to another color) used for the empty portion of the probability bar.</td>
</tr>
<tr>
<td>Text</td>
<td>Indicates the color of the text displayed on the probability bar.</td>
</tr>
<tr>
<td>Shadow</td>
<td>Indicates the color of shadow bar accompanying the probability bar.</td>
</tr>
<tr>
<td>Color when selected</td>
<td>Indicates the color of the probability bar, when selected.</td>
</tr>
<tr>
<td>Border</td>
<td>Indicates the border color of the probability bar.</td>
</tr>
</tbody>
</table>
Defining and assigning performers

You can define performers and assign them to worksteps. BPM Designer supports three types of performers—**User** (human performers), **Adapter** (a Java class as the performer), and **Subprocess** (another process which can be assigned to a workstep).

**Note:** Web applications do not support user-type performers.

This chapter describes how to define and assign performers, as well as using swim lanes. For details, see the following topics:

- Reviewing the Performers tab
- Defining performers
- Assigning performers
- Using swim lanes

### Reviewing the Performers tab

You can review existing performers and define new performers in the **Performers** tab of the BPM Designer interface.
Click the **Performers** tab for a new Business Process, to view the **All Performers** section, which contains all the performers available to the process template.

You can perform the following operations in the **Performers** tab:

**Table 28: Operations in Performers tab**

<table>
<thead>
<tr>
<th>Operations</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a performer</td>
<td>See <a href="#">Defining performers</a> on page 131.</td>
</tr>
<tr>
<td>Remove a performer</td>
<td>Select the performer to be removed, then click <strong>Remove</strong>. You cannot remove the default performer, @CREATOR.</td>
</tr>
<tr>
<td>Modify the performer details</td>
<td>Modify the performer details. You cannot modify the details of the default performer, @CREATOR.</td>
</tr>
<tr>
<td>Filter the performer list</td>
<td>Enter text in the <strong>type filter text</strong> box to filter the performer list and display all performers whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group (or ungroup) the performer list</td>
<td>By default, all performers are grouped under performer type categories, namely, <strong>User</strong> (for human performer), <strong>Adapter</strong> (for adapter performers), or <strong>Sub-Process</strong> (for subprocess performer). To ungroup the performer list, click the <strong>No Grouping</strong> icon in the <strong>All Performers</strong> section. To group the performer list under categories, click the <strong>Group by Type</strong> icon in the <strong>All Performers</strong> section.</td>
</tr>
<tr>
<td>Collapse the performer list</td>
<td>Click the <strong>Collapse All</strong> icon.</td>
</tr>
</tbody>
</table>

You can assign any performer defined in the **All Performers** section to a workstep. The Performer page stores all performers defined for the process template, whether they are assigned to a workstep or are not assigned.
Default performers

In addition to the **Performers** tab, you can view existing performers by clicking the **Assign Participants** link in the Tasks pane.

Figure 66: Performers in Tasks pane

Expand each Performer type to see the available performers for that type. BPM Designer provides the following default performers:

1. For Business Processes, expand the **Users** folder to display two subfolders, namely:
   - **Process**, which stores user-type performers defined for the process template. This includes a default user named “Creator.” Creator is a dynamic dataslot value. In this case, “Creator” is the performer whose name is entered in the Creator dataslot of the process instance, and this value can change from instance to instance and can reflect changes made at runtime.
   - **Organization**, which contains users defined using the User Management tool (see **Working with User Management tool** on page 417) under three sub-categories namely, Users, Groups, and Queues.

2. **Managed adapters** enable you to define configuration and mapping between dataslots in a process template and inputs/outputs from a group of out-of-the-box adapters at process design time. These predefined managed adapters provide examples of specialized adapters that are commonly used in managing business processes. For more information, see **Using managed adapters** on page 135.

Defining performers

You can define performers of any type from the **Performers** tab (see **Figure 65** on page 130). Alternatively, you can define and assign a performer to an Activity workstep using the **Assign Participants** link in the Tasks pane (see **Using the Tasks pane** on page 140).

This section describes how to define performers in the **Performers** tab.
Defining a user as a performer

You can add a new user (human performer), group (group of human performers), or a queue for a Business Process.

To define a user as a performer:

1. From the **Performers** tab, click **Add**.
   The first page of the **New Performer** wizard appears.
   **Figure 67: New Performer wizard: Page 1**

2. Select the **User** type of performer from the available options, then click **Next**. Options for Business Processes include User, Adapter, and Sub-Process.
   **Figure 68: New Performer wizard: User Performer page**
3. Enter an appropriate name for the User performer in the **Enter a name** box. Alternatively, for performer type, "User," you can link the performer to a CHARACTER dataslot. Type '@' in the **Enter a name** box to display the list of CHARACTER dataslots in the process. Select the dataslot to be linked to this performer.

**Note:** If your process contains a business object dataslot (for example, "bo1"), you can also create a individual user mapped to the business object attribute of type, CHARACTER. Enter the performer name as @<dataslot_name> (in this example, @bo1). and then enter the attribute name (only of type, CHARACTER) of the business object. If the business object contains another business object (example, "bo2") as an attribute, you can use a nested expression (in this example, @bo1.bo2.) to enter the attribute name (only of type, CHARACTER) of business object, "bo2."

Alternatively, click **Browse** to select a user, group, or queue defined in the User Management tool (as discussed in Working with User Management tool on page 417). The dialog box that appears depends on the performer type that you select in the **Select a type** section; for example, if you select "User" as the performer type, the **User** dialog box listing all users defined in the User Management tool appears. Select a user (or group or queue) from those listed, then click **OK** to display the name in the **Enter a name** box.

4. Select the user type in the **Select a type** section to indicate whether the human performer is an individual user, queue, or a group. Table 29 on page 133 describes each of the human performer types.

**Table 29: Performer Types**

<table>
<thead>
<tr>
<th>Performer Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>A single human performer.</td>
</tr>
</tbody>
</table>
| Group          | A group of human performers.  
Select **Any member(s) of the group** if only one member from the group is required to complete a task OR select **All** if each performer from the group is required to complete the task.  
You can filter the members of a selected group by entering a valid role (as defined in the Administration module) in the **Role** box. For example, if **All** option is selected, and Manager is entered in the **Role** box, then all managers from this group are required to complete the workstep task. |
| Queue          | A queue is defined as a group of users with the **Any member(s) of the group** option selected. At this time, queues created in BPM Designer do not automatically appear in Business Process Portal, but the same queue name must be created again in Business Process Portal. Also, queues created in the Administration module of Business Process Portal do not appear in the list of performers in the **Performer** tab. |

**Note:** To define the performer of the workstep as an EJB method, enter the name of the EJB in the format: jndi://<appserver_name>/<jndi_name>:<method_name>.
Note: When you assign a User performer type, BPM Designer checks to see if the performer is an Individual User, then checks if it is a Group of users, then a Queue (If it is none of these, the task is assigned to Manager). For this reason, names for User, Group and Queue must be unique.

5. Click Finish to add the new performer to the Performers tab.

Note: To modify the user performer details, select the performer to be modified and make your changes in the User section of the Performers tab.

Defining an adapter as a performer

An adapter (previously called an external performer or EP) is a Java class that provides a mechanism that integrates external third-party classes and actions with Progress Developer Studio for OpenEdge; for instance, an adapter can automate some functions and tasks performed by a server or an external system.

Adapters are the “performers” of Adapter worksteps. Depending on your application requirements, you can use a predefined managed adapter provided by Progress Developer Studio for OpenEdge; or you can develop your own adapters to carry out specific tasks. Progress Developer Studio for OpenEdge provides a series of managed adapters that have complex, specific features. Advanced users can find out more about Managed Adapters in the Managed Adapters Guide.

To define an adapter and add it as a performer:

1. From the Performers tab, click Add.
2. From the first page of the New Performer wizard (Figure 67 on page 132), select the Adapter type of performer, then click Next.
   
   **Figure 69: New Performer wizard: Adapter Performer page**

3. Type the adapter name in the Enter a name box. Specify the Java class and method in the appropriate boxes.
4. Select the Generate Java code checkbox if you want to generate a Java file for the Adapter workstep.
5. Click Next. In the Description page, enter a brief description of the custom adapter.
6. Click Finish to create the custom adapter and add it to the Performers tab.
Note: To modify the adapter performer details, select the performer to be modified and make your changes in the **Adapter** and **Description** sections of the **Performers** tab.

## Using managed adapters

Progress Developer Studio for OpenEdge provides managed adapters that enable you to define configuration and mapping between dataslots in a BPM Project and inputs/outputs from a group of out-of-the-box adapters at process design time. Managed adapters are compatible with Progress Developer Studio for OpenEdge’s adapter configuration and mapping framework.

Note: You must add and configure the managed adapters before using them in Progress Developer Studio for OpenEdge. For more information on Adapter Configuration and Mapping Framework and on the managed adapters provided in Progress Developer Studio for OpenEdge, see relevant chapters in *Managed Adapters Guide*.

Progress Developer Studio for OpenEdge provides the following “out-of-the-box” managed adapters for BPM Projects:

- **Email Adapter**: Enables Progress Developer Studio for OpenEdge to generate and send e-mail messages.
- **File Adapter**: Reads from and writes to a variety of file formats.
- **FTP Adapter**: Enables you to transfer files from and to your local file system, or an FTP server.
- **JMS Adapter**: Enables you to use Java Message Service (JMS) to communicate asynchronously with external systems and facilitates data exchange between Progress Developer Studio for OpenEdge processes and external applications.
- **OpenEdge Adapter**: Enables you to integrate Business Process Server applications with Progress® OpenEdge® solutions.
- **Sonic ESB Adapter**: Enables you to interact with Sonic ESB to invoke a Sonic ESB process or service or send a message to a Sonic ESB endpoint.
- **Web Service Adapter**: Provides a connection to a specified Web Service, and enables the you to map Web service methods to a dataslot in a process. This adapter provides support for both RPC and Document-style Web services.

To specify a managed adapter as the performer of a workstep:

1. Click the **Assign Participants** link in the Tasks pane and expand the **Adapters > Managed** folder to display the managed adapters folders available by default.
2. Expand the respective managed adapter folder, then drag the adapter on an existing workstep (or a blank area of the Content pane) to add the adapter workstep.

   The managed adapter is now assigned as a performer of an Adapter workstep.

Note: Progress Developer Studio for OpenEdge also provides the Managed Adapter Browser tool using which you can perform various operations on managed adapters. For details, see *Using Managed Adapter Browser* on page 463.
Defining a subprocess performer

A Subprocess is a process template that can be included into another process template by using a subprocess workstep. In this case, the performer of the subprocess workstep is the subprocess itself.

You can define a subprocess in a local or remote server as a subprocess performer in your process template without exiting Progress Developer Studio for OpenEdge by performing the following steps.

1. From the Performers tab, click Add.
2. From the first page of the New Performer wizard, select the Sub-Process type of performer, then click Next.

Figure 70: New Performer wizard: Sub-Process Performer page

3. Enter a name for the subprocess in the Enter a name box.
4. You can use an alias to appear as the subprocess instance name in Business Process Portal instead of the lengthy subprocess name that appears by default. In the Enter an alias box (available only for Business Process), enter the alias name. Alternatively, you can use a CHARACTER dataslot as the alias. Type ‘@’ in the Enter a name box to display the list of CHARACTER dataslots in the process. Select the dataslot to be used as the alias. When you use an alias, the subprocess name is in a format (<alias>#<sub-piid>) that controls the length of the subprocess name.

Note: To use aliases in multiple subprocesses, the subprocess box should contain a mapped dataslot for multiple processes and the Alias box must use dataslots of LIST type. In this way, each index can specify the alias for the respective subprocess. For more information, see “Subprocess Alias” in Chapter 16 of the BP Server Developer’s Guide.

5. In the Select a process box, enter a valid name for the process you want to use as a subprocess. Alternatively, you can select one of the following options:
• Assign a dataslot as a dynamic performer of the subprocess. Type '@' in the Select a process box to display the list of CHARACTER dataslots in the process. Select the dataslot to be used as the subprocess performer.

• Click Browse to select a specific process template file to be assigned as a static subprocess performer.

Placing an existing process template in the subprocess box converts that process template to a subprocess.

6. Use the Enter a server URL box (available only for BPM processes) to connect to a remote server (provided your Business Process Server Administrator has already set up this connection. For more information, see the Configuring remote server properties in the oebpsjndi.properties file section in the BP Server developer's Guide). Enter a valid path to the external server using the following format: jndi://$RemoteMachine><jndiName>. Alternatively, type '@' in the Enter a server URL box to assign a CHARACTER dataslot as the dynamic performer on the remote server.

7. Select the Indexed check box (available only for Business Processes) if you want to pass data from a LIST dataslot in a parent process to multiple subprocesses, with each subprocess containing a Primitive dataslot that asynchronously receives specific information from, and sends specific information back to, the LIST dataslot. You can map dataslots in the parent process to dataslots in each subprocess; or, if the dataslot name in each subprocess matches the dataslot name in the parent process, then no mapping is necessary.

This Indexed feature ensures that dataslot values in a subprocess are not overwritten, and that the correct value from a INTEGER dataslot is returned to its specific slot in the LIST dataslot.

If you are using a LIST dataslot as the subprocess performer and the Indexed check box is not selected, each subprocess that is completed and submits data to the parent process may overwrite data from subprocesses that were completed earlier. Use a non-indexed subprocess only when no data is to be returned or when overwriting of data does not matter. For more information about using a LIST dataslot to invoke multiple subprocesses, see Chapter 4, “Using a LIST Dataslot to Invoke Multiple Subprocesses” in the Application Developer's Guide.

8. Click Next. In the Description page, enter a brief description of the subprocess.

9. Click Finish to create a subprocess performer and add it to the Performers tab.

Note: To modify the subprocess performer details, select the subprocess performer and make your changes in the Sub-Process and Description sections of the Performers tab.

Defining an inline subprocess

The inline subprocess is a self-contained subprocess that contains the same dataslots and other data variables as its parent process, and opens within the same File tab as its parent. By creating a process and subprocesses that share the same data variables, you can avoid using external processes as subprocesses to the active project. You may also avoid creating or assigning duplicate dataslots for these external processes, and performing complex dataslot mapping. Inline subprocesses also reduce overheads by avoiding the checking out of multiple external subprocesses that might be part of other Progress Developer Studio for OpenEdge projects.

Note: The inline subprocess is not available for Web applications.

Note the following restrictions on the use of inline subprocesses:

• You cannot convert an inline subprocess to a conventional subprocess.
• The Rollback function is not supported for Inline Subprocesses.

You can use one of the following two methods to create an inline subprocess:

• Use the New Embedded Subprocess icon from the Tasks pane (see Using the New Embedded Subprocess icon on page 138).

• Use the Collapse functionality to collapse a group of worksteps having a single input connector and a single output connector to form an inline subprocess (see Using the Collapse feature on page 138).

Using the New Embedded Subprocess icon

To define an embedded subprocess:

1. From the Tasks pane, click the Assign Participants link, then drag the New Embedded subprocess icon into the process template diagram. Notice that the Embedded Subprocess is indicated by the icon.

2. Open the subprocess workstep’s Properties view and define workstep properties as required.

3. Right-click the subprocess workstep and click Open, to open a blank interface in which you can add shapes, connectors and other data to create an inline subprocess.

4. To return to the parent process or to a higher level subprocess, in the palette, click the One Level Up icon or select the parent process or higher subprocess from the adjacent drop-down list.

Using the Collapse feature

You can define an Inline Subprocess using the Collapse feature by quickly selecting several related worksteps and creating a self-contained inline subprocess which is represented in the diagram as a single workstep.

1. Use the Select tool from the palette to select a workstep or a group of worksteps. The Collapse feature is enabled only if all these worksteps match the criteria of a single point of entry or single point of exit.

2. Right-click the selected worksteps, then select the Collapse option to convert the selected workstep or group of worksteps to an inline subprocess.

3. The inline subprocess workstep is now indicated by an Expandable icon (Step Figure 71 on page 139). Open the workstep’s Properties view and assign a Label, Priority, and other properties, as required.
4. To view the inline subprocess, right-click the inline subprocess workstep and then select **Open**. The grouped worksteps view appears. The current subprocess, Subprocess 1 in this example, is contained under the tab of the parent process and is displayed in the drop-down list adjacent to the **Up One Level** (éro) icon.

5. To move up one level and, in this example, return to the parent process, click 🛠. You can use 🛠 to move up the chain of processes, or you can select a process from those listed in the adjacent box. The current subprocess always appears as the last name in the list of parent process and subprocesses; therefore, the combo box is disabled when the parent process is active.

6. If the worksteps you have grouped include Subprocess worksteps, you can drill down further into the subprocesses by right-clicking the workstep and selecting **Open**. To move up the chain, click 🛠 or select from the parent process/subprocesses list, which displays all visited inline subprocesses.
Assigning performers

After defining a performer, you must assign the performer to a workstep. By default, when you drag an Activity shape (Activity 1) from the Tasks pane to the content pane, you create an activity with no performer assigned. In certain cases, you may want to add this type of activity with an unspecified performer to your process template. You can then perform any of the procedures, described in the following sections, to assign a performer:

Using the Tasks pane

You can use the Assign Participants link in the Tasks pane to define a new performer and then add the appropriate workstep (depending on the performer type) to the process template.

The new performer icons provided in BPM Designer are listed in Table 30 on page 140.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
<th>Navigation path</th>
</tr>
</thead>
<tbody>
<tr>
<td>New User</td>
<td>To create a new user type performer.</td>
<td>Expand Users &gt; Process.</td>
</tr>
<tr>
<td>New Adapter</td>
<td>To create a custom adapter performer.</td>
<td>Expand Adapters &gt; Custom.</td>
</tr>
<tr>
<td>New subprocess</td>
<td>To create a subprocess performer.</td>
<td>Expand Sub-Process &gt; External References.</td>
</tr>
<tr>
<td>New Embedded subprocess</td>
<td>To create an embedded subprocess (not available for web applications).</td>
<td>Expand Sub-Process.</td>
</tr>
</tbody>
</table>

You can drag any of these performers into the process template diagram to open the respective dialog boxes for a User, an Adapter or a Subprocess. After you have created the performer, a workstep is automatically inserted in the process template diagram which is performed by the performer you just created. This new performer is also added to those listed in the Tasks pane under the respective Users, Adapters, or Subprocesses folder.

1. Click the Assign Participants link in the Tasks pane, to open a list of performer types.
2. Expand the folder of the Performer type you want to assign to the activity. Select a specific new performer icon and drag it on an existing activity shape or on the blank template.

**Note**: To assign a performer created using the User Management tool, expand Users > Organization, then drag the performer from the respective subcategory to an existing activity or on the blank template. The assigned performer is also added to the performer list in Users > Process and to the Performers tab.

Table 31 on page 141 illustrates the appearance of the activity shape after a performer is assigned to it.
Table 31: Activity Shape with assigned performer

<table>
<thead>
<tr>
<th>Activity Shape Appearance</th>
<th>Performer Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Activity 1" /></td>
<td>For a individual performer or group member (with Any option selected).</td>
</tr>
<tr>
<td><img src="image2" alt="Activity 1" /></td>
<td>For a group member (with All members option selected).</td>
</tr>
<tr>
<td><img src="image3" alt="Activity 1" /></td>
<td>For a custom adapter.</td>
</tr>
<tr>
<td><img src="image4" alt="Activity 2" /></td>
<td>For a managed adapters. The shape varies according to the managed adapter used.</td>
</tr>
<tr>
<td><img src="image5" alt="Activity 6" /></td>
<td>For a subprocess performer.</td>
</tr>
</tbody>
</table>

**Changing the workstep performer**

You can change the assigned performer of an activity workstep to any other performer or performer type.

1. Right-click an Activity, Adapter, or Subprocess workstep and then select the **Change Performer** option to open the **Change Performer** dialog box.

   **Figure 73: Change Performer dialog box**

2. From any of the listed performer types, select a specific performer and click **OK**.

   You can also change the performer through the Activity or Subprocess workstep’s **Properties** view. This procedure, however, only enables you to change to a performer of the same performer type.
Using swim lanes

A swim lane is a horizontal colored lane across the process template which displays the worksteps performed by a specific user-type performer. Process template designers can use swim lanes to associate human performers with the worksteps they perform. You can also add a swim lane that has no specific performer, and any workstep added to this blank swim lane and retains its original performer. Performers of Activity worksteps are automatically updated when an Activity workstep is added to a swim lane or moved from one swim lane to another. Other workstep types can be included in a swim lane, but, unlike Activity worksteps, their performers are not automatically updated.

Note: Swim lanes are not supported for Web applications.

Creating swim lanes

To add a new swim lane:

1. From the Tasks pane, click the Create Phases and Swim Lanes link in the Design Tasks panel, and then click the Swim Lane icon to open the New Lane dialog box (left image, Figure 74 on page 142).

2. Enter the ID and Name of the new swim lane in the respective boxes.

3. To assign a performer to the swim lane, click the ellipsis button next to the Performer box and then select the Select a performer option to open the Select a Performer dialog box (right image, Figure 74 on page 142), which displays a list of available performers that you can assign to the swim lane.

Note: You can use the Clear performer option to create a swim lane with no performer assigned to it.

To search a performer (user or group), use the Search box to enter a string of letters to filter the number of users presented in the Performers dialog box—for example, enter “mgr” to show all performers that contain that string of letters in their name. Click to clear filter criteria from the Search box.
4. Select a user name from those listed in the **Select a Performer** dialog box, then click **OK**. You can also add a new performer to those listed (see Defining a user as a performer on page 132).

5. Click the **Appearance** tab to apply a unique color to the swim lane.

**Figure 75: Applying Swim lane Color**

![Color Chooser dialog box with Custom Colors](image)

6. Select an option from the colors listed. You can also click **More** to display more color options. You can also change the color of multiple swim lanes by selecting the lanes and clicking the **Color** (``) icon in the palette, to open the color palette, where you can select one of the listed colors, or click **More** to display more color options.

**Figure 76: Color Chooser dialog box with Custom Colors**

7. Click **OK** to add a new swim lane for the specified performer to the process template diagram. Move the workstep that this user is performing into its swim lane (**Figure 74** on page 142).

By default, BPM Designer adds a new swim lane below existing swim lanes. You can also insert a swim lane between existing lanes.

Swim lanes have two headers. The primary Pool Header contains all the swim lanes and displays the name of the Process Model. The Lane Header displays the Name, ID, or Performer of each lane, as determined by selecting one of these options from the View menu in the Lane Popup Menu. The Pool Header remains as a black and white header, but you can define a color for each Swim Lane.
You can assign the same performer to different swim lanes. You need not have to add all worksteps that have the same performer to the performer's swim lane; these worksteps can also be placed in that part of the diagram outside the swim lanes.

**Resizing swim lanes**

You may need to resize a swim lane either to add a shape to the swim lane or to quickly move a shape into (or out of) this swim lane.

- To increase the width of a swim lane, select the **Move shapes when resizing swim lanes** checkbox, before resizing the swim lane. Shapes, adjacent to the swim lane, move as you resize the swim lane.
- To make the performer of the adjacent worksteps to that of this swim lane or to remove a shape from this swim lane, clear the **Move shapes when resizing swim lanes** checkbox, before resizing the swim lane. Shapes, adjacent to the swim lane, do not move as you resize the swim lane.

You can resize a swim lane by passing your cursor over the space between two swim lane headers and using the slider to adjust the swim lane's size up or down.

**Performing additional swim lane operations**

You can perform additional operations on a swim lane by right-clicking the swim lane header. Additional operations include:

- Changing the swim lane header display.
- Inserting a new lane between existing swim lanes.
- Removing a swim lane.
- Modifying existing lane properties.

To change the swim lane display header:

- From the **View** menu (Figure 74 on page 142), select either Name, ID, or Performer to view your selection in the header of each swim lane.

To remove a swim lane:
• Click **Remove Lane**, after removing all worksteps from the swim lane.

To change the properties of a swim lane:

• Click **Properties** to display the current swim lane properties (as defined in the **New Lane** dialog box) in the **Properties** view. You can modify each property, as described in Creating swim lanes on page 142.

## Swim lane restrictions

The following restrictions apply when you change the performer of an Activity workstep in a swim lane:

• You cannot move a swim lane.

• When you move an Activity workstep from one swim lane to another, that workstep is automatically updated and reassigned to the swim lane performer.

• If you assign the swim lane to a new performer, the Activity worksteps in the swim lane are automatically reassigned to the new performer.

• Other types of worksteps can also be added to a performer’s swim lane, but these types of worksteps are not automatically updated to match the swim lane performer.

• You cannot add an external subprocess workstep to a swim lane.
Using dataslots

You can use dataslots to manage information flow in a business process. Dataslots are global variables that enable the process to support exchange of data across worksteps. Typically, a dataslot is defined as the output of one workstep and the input of the successor workstep. Information—in this case, the value of the dataslot—is therefore passed from one workstep to the next workstep.

This chapter describes how to use dataslots in Progress Developer Studio for OpenEdge, and covers the following features:

• Provides a set of predefined system dataslots for Business processes.
• Supports a wide range of dataslot types.
• Enables you to define customized dataslots that are specific to your requirements and can be used in process templates.
• Supports importing and exporting dataslots singly or in bulk.

Note: You can assign dataslots to individual worksteps in the process, using the Fields tab in the workstep’s Properties view. For more information, see Setting workstep properties on page 173.

For details, see the following topics:

• Reviewing the Dataslots tab
• Supported dataslot types
• Using system dataslots
• Creating user-defined dataslots
• Exporting and importing dataslots

Reviewing the Dataslots tab

You can review existing dataslots in a process and define new dataslots in the Dataslots tab of the OpenEdge BPM Designer interface (Figure 5 on page 33). If you are adding a new process template for a Business process, then only predefined system dataslots are listed.

If you are modifying an existing process template, predefined dataslots, as well as dataslots that you have created for this process template, are listed.

**Note:** Web applications do not include any predefined system dataslots.

Click the Dataslots tab for a new Business Process, to view the All Dataslots section, which contains all the dataslots available to the process template.

You can perform the following operations in the Dataslots tab:

**Table 32: Dataslots tab operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a user-defined dataslot</td>
<td>See Creating user-defined dataslots on page 152.</td>
</tr>
<tr>
<td>Remove a dataslot</td>
<td>Select the dataslot to be removed, then click Remove. You cannot remove any</td>
</tr>
<tr>
<td></td>
<td>of the system dataslots. You cannot remove any user-defined dataslot assigned</td>
</tr>
<tr>
<td></td>
<td>to a workstep.</td>
</tr>
<tr>
<td>Modify existing dataslots</td>
<td>Select the dataslot to be modified, then modify its properties in the</td>
</tr>
<tr>
<td></td>
<td>respective sections of the Dataslots tab. You cannot modify the properties</td>
</tr>
<tr>
<td></td>
<td>of any system dataslot.</td>
</tr>
<tr>
<td>Import or export dataslots</td>
<td>See Exporting and importing dataslots on page 168.</td>
</tr>
<tr>
<td>Filter the dataslot list</td>
<td>Enter text in the type filter text box to filter the dataslot list and</td>
</tr>
<tr>
<td></td>
<td>display all dataslots whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group the dataslot list by (or</td>
<td>By default, all dataslots are grouped under dataslot type category, as</td>
</tr>
<tr>
<td>by tag)</td>
<td>discussed in Supported dataslot types on page 149. To group the dataslot</td>
</tr>
<tr>
<td></td>
<td>list by tag namely, System (for system dataslots) or User (for user-defined</td>
</tr>
<tr>
<td></td>
<td>dataslots), click the Group by Tags ( ) icon in the All Dataslots section.</td>
</tr>
<tr>
<td></td>
<td>To group the dataslot list by type, click the Group by Type ( ) icon in the</td>
</tr>
<tr>
<td></td>
<td>All Dataslots section.</td>
</tr>
<tr>
<td>Collapse the dataslot list</td>
<td>Click the Collapse All ( ) icon.</td>
</tr>
</tbody>
</table>
Supported dataslot types

Table 33 on page 149 lists the OpenEdge ABL dataslot types supported for BPM projects in both the Business Process and Web Application.

Note: For more information on ABL data types and their default values, refer to the Data Types section in the OpenEdge Development: ABL Reference guide.

Table 33: OpenEdge ABL Dataslot Types Supported by Progress Developer Studio for OpenEdge

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>A dataslot containing numbers, letters, and special characters.</td>
</tr>
<tr>
<td>DATETIMETZ</td>
<td>A dataslot containing dates. DATETIMETZ datatype has three parts: date, time, and an integer representing the time zone offset from Coordinated Universal Time (UTC). The unit of time is milliseconds from midnight. The unit of time zone offset is minutes. Supports the following DATETIME-TZ formats in OpenEdge:</td>
</tr>
<tr>
<td></td>
<td>• yyyy-MM-dd'T'HH:mm:ss.SSS(+/-)zz:zz or yyyy-MM-dd HH:mm:ss.SSS(+/-)zz:zz</td>
</tr>
<tr>
<td></td>
<td>• yyyy-MM-dd'T'HH:mm:ss.SSS or yyyy-MM-dd HH:mm:ss.SSS</td>
</tr>
<tr>
<td></td>
<td>• yyyy-MM-dd'T'HH:mm:ss or yyyy-MM-dd HH:mm:ss</td>
</tr>
<tr>
<td></td>
<td>• yyyy-MM-dd</td>
</tr>
<tr>
<td></td>
<td>For example, 1995-01-17T12:12:12.234+05:30 or 1995-01-17 12:12:12.234+05:30.</td>
</tr>
<tr>
<td>DECIMAL</td>
<td>A dataslot containing decimal numbers up to 50 digits in length, including up to 10 digits to the right of the decimal point.</td>
</tr>
<tr>
<td>Document</td>
<td>A dataslot to which you can attach one or more documents, upload to or download from the server. There are no restrictions on the file type. The dataslot must be specified as an editable dataslot in a workstep if you want to attach a file to it.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>A dataslot containing 32-bit data (whole numbers).</td>
</tr>
<tr>
<td>INT64</td>
<td>A dataslot containing 64-bit data (whole numbers).</td>
</tr>
<tr>
<td>LOGICAL</td>
<td>A dataslot containing logical data that is evaluated as TRUE or FALSE.</td>
</tr>
<tr>
<td>Handle</td>
<td>A dataslot containing a handle which is a pointer to an ABL handle-based object. This can be a static object defined during compilation or a dynamic object defined at runtime.</td>
</tr>
</tbody>
</table>
### Dataslot Type | Description
--- | ---
Rowid | A dataslot containing a unique internal identifier for a row within a single database storage area.
Memptr | A dataslot containing a sequence of bytes in memory. You can use this dataslot type to manipulate the contents of a BLOB database or temp-table field in ABL language.
Raw | A dataslot containing any data, including data from databases other than OpenEdge.
Dataset | A dataslot containing the values of ABL ProDataset. This dataslot can be mapped to DataSet or DataSet-Handle in ABL.
Table | A dataslot containing the values of ABL temp-table. This dataslot can be mapped to Table or Table-Handle in ABL.
List | A dataslot that treats a collection of related data items as a single entity. For example, a LIST dataslot can be used to hold choices for CHARACTER dataslots where the choices are dynamically determined by querying a database.
Map | A dataslot that enables you to select from a list of choices that can change dynamically. It also stores the choices that are made and these choices can be viewed and used in other worksteps.
Number | A dataslot containing a numeric value. The Number dataset contains Double as a subtype. The numeric value is displayed as a decimal; for example, 2.2.
Object | A dataslot containing a serializable Java object. Typical Object dataset types include Vector and Array which are passed as input or output datasets to Adapters.
Business Object | A dataslot that encapsulates all the data and behavior associated with an entity of a business process. This dataslot type can retrieve data from internal and/or external database sources.
LongChar | A dataslot containing numbers, letters, and special characters.
Table | Contains table definitions.
DataSet | Contains DataSet definitions.

**Table 34** on page 150 describes how these dataslot types appear in the presentation interface:

### Table 34: Dataslots and associated formats for auto-generated forms

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Format types</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>Is displayed as text. There are three CHARACTER types: Text Field, Text Area, and Combo.</td>
</tr>
</tbody>
</table>
Using system dataslots

Progress Developer Studio for OpenEdge provides predefined system dataslots for a Business Process, which are displayed by default in the **Dataslots** tab and are designed to extend the functionality of user-defined dataslots. Predefined system dataslots are read-only and their values are assigned at runtime.

**Note:** You cannot modify, remove, or export a System dataslot.

The following table summarizes the predefined system dataslots.

**Table 35: Predefined System Dataslots in Business Process Server Applications**

<table>
<thead>
<tr>
<th>Dataslot Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllDataslots</td>
<td>OBJECT</td>
<td>Contains (at runtime) all the user-defined dataslots and the associated values for the user-defined dataslots in a Hashtable. The Hashtable key is the dataslot name.</td>
</tr>
<tr>
<td>Creator</td>
<td>CHARACTER</td>
<td>Contains the creator (at runtime) of the process instance. The value of this box can be the login name of a Business Process Portal user.</td>
</tr>
</tbody>
</table>
### Creating user-defined dataslots

You can create dataslots, which are specific to a process. You can create a dataslot from any of the supported dataslot types (see Supported dataslot types on page 149) by performing the following procedures.

**To define dataslots:**

1. From the Dataslots tab, click Add.
   
   The first page of the New Dataslot wizard appears.

2. Enter a unique name for the dataslot in the Enter a unique ID text field. Valid dataslot names must start with a letter and can only included alphanumeric characters and the underscore (_). The maximum length of a dataslot name is 30 characters, due to column width restrictions.

   The following restrictions apply to dataslot names:

   - Although Progress Developer Studio for OpenEdge accepts reserved Java words (or Java identifiers) as dataslot names, do not use them as dataslot names or the application publishing will fail. For example, do not use “LOGICAL” or “Object” as a dataslot name, however you can use “myboolean” or “myobject”.

---

### Chapter 13: Using dataslots

<table>
<thead>
<tr>
<th>Dataslot Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>CHARACTER</td>
<td>Contains the priority (at runtime) of the process (not the workstep priority). This box appears in all automatically generated HTML forms. Restrict priority values to Low</td>
</tr>
<tr>
<td>ProcessInstanceld</td>
<td>INT64</td>
<td>Contains the instance ID of the running process at run-time. This value is a unique identifier of each instance of this process.</td>
</tr>
<tr>
<td>ProcessName</td>
<td>CHARACTER</td>
<td>Contains the process name (at runtime). The process name is a string formed by concatenating the process template name with a unique number.</td>
</tr>
<tr>
<td>ProcessTemplateName</td>
<td>CHARACTER</td>
<td>Contains the process template name (SPT).</td>
</tr>
<tr>
<td>StartTime</td>
<td>INT64</td>
<td>Contains the date (at runtime) when the process instance was started.</td>
</tr>
<tr>
<td>WorkstepName</td>
<td>CHARACTER</td>
<td>Contains the name (at runtime) of the workstep the process is currently executing.</td>
</tr>
</tbody>
</table>

**Note:** Business Processes can only read the values of predefined system dataslots. The system dataslots are only available as input dataslots to the process.
3. Select the dataslot type from the Select a type list. The options are: CHARACTER (default), LongChar, DATETIMETZ, DECIMAL, INTEGER, INT64, LOGICAL, Handle, Rowid, Memptr, Raw, Dataset, Table, List, Map, Number, Object, and Business Object. For more information, see Supported dataslot types on page 149.

4. Specify the dataslot tags in the Enter tags separated by commas text field. OpenEdge BPM Designer provides a default tag named “User” for all user-defined dataslots. You can either retain this default tag, type your own tag in the Enter tags separated by commas text field, or click Browse to select a tag. You can then assign these tags to new and existing dataslots.

5. Click Next. The Value page appears.

6. You can use the Value page to set the initial value of the dataslot. Clear the Undefined check box to specify a initial value of the selected dataslot.

   **Note:** The appearance of the Value page depends on the type of dataslot that you have selected. For detailed information about setting the initial value, see the respective sub-section for the dataslot type in Dataslot properties on page 153.

7. Click Next. The Dataslot description page appears.

8. Specify a brief description of the dataslot in the Description page.

9. Click Finish to create the new dataslot, and add the defined dataslot to the Dataslots tab.

### Dataslot properties

After defining a dataslot, you can configure the dataslot properties in the respective sections of the Dataslots tab. The variations in the dataslot properties are described in the following sub-sections.

### For a CHARACTER dataslot

You can configure the properties of a CHARACTER dataslot in the following sections of the Dataslots tab:

<table>
<thead>
<tr>
<th>Table 36: CHARACTER dataslot properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section</strong></td>
</tr>
<tr>
<td>Dataslot</td>
</tr>
<tr>
<td>Description</td>
</tr>
</tbody>
</table>
To specify the initial value of the dataslot. Enter text in the text area provided to create a static value; that is, a value that is displayed for each instance of the process. For example, entering “Carl” as the value for a dataslot, “Assignee”, it results in Carl being the Assignee for each process instance. Alternatively, to create a dynamic value, enter a dataslot name, preceded by the @ symbol, that displays the value of the designated dataslot at runtime. In this case, entering “@Creator” as the value for the Assignee dataslot means that the person who created the instance is the assignee. This value can change from instance to instance and can reflect changes made at runtime.

**Note:** When you select Combo as the format type for a CHARACTER dataslot from the Default Format section and then define a choice list, you must assign the CHARACTER dataslot’s initial value from the defined list. Otherwise, the process fails to publish.

The CHARACTER dataslot’s initial value must not contain the bar (“|”) character.

### Storage
Specifies the size of data storage for the dataslot. For more information.

**Note:** Storage options are available only for the CHARACTER, DECIMAL, and Number dataslots.

### Access
(Not available for Web applications) Specifies the access properties for the dataslot. For more information, see Setting the dataslot access on page 167.

### Default Format
To configure dataslot properties including the format type, label, and validations. For more information, see Defining the dataslot format on page 163.

### Usage
If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, "Input for Activity 1" indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 173.

### For a INTEGER and INT64 dataslot
You can configure the properties of a INTEGER or INT64 dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see . The only difference is in the Initial Value section, which is described below.

You can use the Enter an initial value text field to specify the initial value of the dataslot.
Figure 78: Initial Value section for a INTEGER and INT64 dataslot

- Specify an initial value in the text field provided in the Initial Value section. The default value is 0.

**Note:** Clear the Unknown check box to enable the text field to enter a value.

The below table lists the valid range for INTEGER and INT64 dataslots.

<table>
<thead>
<tr>
<th>Dataslot</th>
<th>Minimum value (inclusive)</th>
<th>Maximum value (inclusive)</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTEGER</td>
<td>-2,147,483,648</td>
<td>2,147,483,647</td>
</tr>
</tbody>
</table>

**For a LOGICAL dataslot**

You can configure the properties of a LOGICAL dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot. The only difference is in the Initial Value section, where you can select True or False (default) option as the initial value of the dataslot.

Figure 79: Initial Value section for a LOGICAL dataslot

- Select the initial value as true or false on the Initial Value section. The default value is false.

**Note:** Clear the Unknown check box to enable the options.

**For a DATETIMETZ dataslot**

You can configure the properties of a DATETIMETZ dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.
Figure 80: Initial Value section for a DATETIME-TZ dataslot

Select the Date option to use the calendar to set the date. You can modify the default date by clicking the icon. You can also enter the specific time in hour, minute, and second, which you want to use for the dataslot. This dataslot converts string to date-time formats and vice versa.

Alternatively, select the Start Time option to use the "@STARTTIME" dataslot value as the starting time for the DATETIMETZ dataslot.

For a DECIMAL dataslot

You can configure the properties of a DECIMAL dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 153. The only difference is in the Initial Value section, where you can enter a initial value of the dataslot.

Figure 81: Initial Value section for a DECIMAL dataslot

For a Document dataslot

You can configure the properties of a Document dataslot in the respective sections (same sections as that for String dataslot) of the Dataslots tab. The only difference is in the Value section, which is described below.

You can use the Value section to specify one of the following values:

- Select the Single Document option to attach a single document to the dataslot. Click Browse to select the file you want to attach.

- Select the Document Bundle option to attach multiple documents to the dataslot. Select the Editable by author only checkbox (available only for process models) to enable only the user who receives the documents to update and reattach the documents; other users cannot view these changes.

Note: You can only attach documents stored in the <project_name>\docs folder.

When the process is instantiated, the specified document is located and copied as the initial value of the Document dataslot, and the value of the Document dataslot is set to the specified document file.
Note: Each document associated with a Document dataslot in a process must have a unique name. For more information on Document dataslots, see the Developing BPM Applications with Developer Studio manual in the OpenEdge documentation set.

For a List dataslot

You can configure the properties of an List dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 153. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.

**Figure 82: Initial Value section for a List dataslot**

- Click Add to add a list element to the Value table.

  To remove a value from the dataslot, select the value in the Value table and click Remove.

  To change the order of the values, select the value in the panel and click Move Up or Move Down to move it up or down a row.

  Values in a List dataslot are now read from a <Values> tag. The <Value> tag is compatible with the <DataValue> tag used in earlier releases is also read.

Note: For more information, see the About List Dataslots section in the Application Developer’s Guide.

For a Number dataslot

You can configure the properties of a Number dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 103. The only difference is in the Initial Value section.

You can use the Enter an initial value box to specify the initial value of the dataslot.

The Number dataslot supports only the storage type DOUBLE, as shown below.

**Figure 83: Storage section for a Number dataslot**

- Click LONG, DOUBLE, or DECIMAL.

- Click Options and No options are available for this storage type.
For a Rowid dataslot

You can configure the properties of a Rowid dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 153.

For an Object dataslot

An object dataslot contains a serializable Java object of a class available on the BP Server. You can use a project-specific class file (JAR) or common JAR files which are available on publishing a Common Resource project. The class object is instantiated when a BP Server application instance is created or when a Web application is accessed.

You can configure the properties of an Object dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 153. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.

Figure 84: Initial Value section for an Object dataslot

1. In the **Java Class Name** box, enter a unique name for the serializable Java object. Specify the Class Name (including the package name).

   • Classes, which are project-specific, are stored in `<project_name>\lib` folder (for Business Processes) or in `<project_name>\WEB-INF\lib` folder (for Web applications).

   • Classes, which are available on the BP Server after you publish a Common Resource project, are stored in `OEBPS_Home\ebmsapps\common\classes` folder (for a Business Process) or in `WebApp_Home\WEB-INF\classes` folder (for Web application) wherein the `WebApp_Home` is application-server-specific and is the value of the `oebps.webappdir` property in `OEBPS_Home\conf\oebps.conf` file.

2. Use the **Constructor Parameters** section to define the parameters of the class constructor, which is invoked when the process instance is created. The object variables are initialized by invoking the proper constructor with the appropriate parameter values.

   a) Define the parameters by clicking **Add**, to open the **Add** dialog box (right image, Figure 84 on page 158).

   b) Specify the Java class name in the **Type** box and enter the value of the parameter.
You can specify the methods for this class object in the **Before Activation** and **When Completed** tabs of the **Advanced** tab in workstep properties. For more information regarding using these tabs, see **Setting workstep properties** on page 173.

3. Click **OK** to add the constructor parameter in the **Constructor Parameters** section (left image, **Figure 84** on page 158).

### For a Business Object dataslot

You can configure the properties of a Business Object dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the **Dataslots** tab. For information on CHARACTER dataslot properties, see **For a CHARACTER dataslot** on page 153. The only difference is in the **Initial Value** section, which is described below.

**Figure 85** on page 159 shows how to create a business object dataslot.

**Figure 85: Initial Value section for a Business Object dataslot**

For a Business Object dataslot:

1. Click **Browse** to open the **Business Object** dialog box (right image, **Figure 85** on page 159).
2. Select a java file and click **OK**, and a valid business object is displayed in the **Initial Value** box.
   These values are derived from business objects that were previously created. For more information, see **Managing business objects** on page 447.

### For a Map dataslot

You can configure the properties of a Map dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the **Dataslots** tab. For information on CHARACTER dataslot properties, see **For a CHARACTER dataslot** on page 153. The only difference is in the **Initial Value** section, which is described below.

You can use the **Initial Value** section to specify the initial value of the dataslot.

**Figure 86: Initial Value section for a Map dataslot**

To add a name/value pair to the table:
1. To add name/value pairs as choices in a multi-select list, click Add to open the Add dialog box (right image, Figure 86 on page 159), in which you can define your name/value pair.

The Name of the option you enter will be displayed as its label. The Value you enter can be “true” or “false”. If “true”, it is selected by default when displayed; if “false”, it is not selected.

2. Click OK to add the defined name/value pair to the Initial Value table.

You can also change the options displayed for a Map dataslot or provide localized values for the options. In the Figure 86 on page 159, the name “coke” will be displayed as an option when the application is published on the Business Process Portal. To specify another drink in the case of a different locale or context, say “soft drink” and manually edit the properties file in the properties folder under the application by adding coke=soft drink; or open the Label Properties dialog box in the Form Editor (see Adding a label on page 295) and enter “coke” as the Key and “Soft-drink” as the Value.

### For a Table dataslot

You can configure the properties of a Table dataslot in the following sections of the Dataslots tab:

#### Table 37: Table dataslot properties

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in Creating user-defined dataslots on page 152). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in Defining the dataslot description on page 163.</td>
</tr>
<tr>
<td>Storage</td>
<td>Specifies the Table definition for the dataslot. By default it is empty. You can set the Table definition from the storage tab. To set the Table definition, on the storage Tab, click Browse and select the Table and select the Table definition from the Temp-Table tab and click OK. Note: If you are unable to find the file in the Workspace Resources section of the Temp-Table, select File System from the drop-down.</td>
</tr>
<tr>
<td>Access</td>
<td>(Not available for Web applications) Specifies the access properties for the dataslot. For more information, see Setting the dataslot access on page 167.</td>
</tr>
<tr>
<td>Usage</td>
<td>If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, &quot;Input for Activity 1&quot; indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 173.</td>
</tr>
</tbody>
</table>

### For a Dataset dataslot

You can configure the properties of a Dataset dataslot in the following sections of the Dataslots tab:
Table 38: Dataset dataslot properties

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in Creating user-defined dataslots on page 152). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in Defining the dataslot description on page 163.</td>
</tr>
<tr>
<td>Storage</td>
<td>Specifies the Dataset definition for the dataslot. By default it is empty. You can set the Dataset definition from the storage tab. To set the Dataset definition, on the storage Tab, click Browse and select the Dataset and select the Dataset definition from the Prodataset tab and click OK. <strong>Note:</strong> If you are unable to find the file in the Workspace Resources section of the Temp-Table, select File System from the drop-down.</td>
</tr>
<tr>
<td>Access</td>
<td>(Not available for Web applications) Specifies the access properties for the dataslot. For more information, see Setting the dataslot access on page 167.</td>
</tr>
<tr>
<td>Usage</td>
<td>If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, &quot;Input for Activity 1&quot; indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 173.</td>
</tr>
</tbody>
</table>

For a LongChar dataslot

You can configure the properties of a LongChar dataslot in the following sections of the Dataslots tab:

Table 39: LongChar dataslot properties

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in Creating user-defined dataslots on page 152). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in Defining the dataslot description on page 163.</td>
</tr>
</tbody>
</table>
To specify the initial value of the dataslot. Enter text in the text area provided to create a static value; that is, a value that is displayed for each instance of the process. For example, entering “Carl” as the value for a dataslot, “Assignee”, it results in Carl being the Assignee for each process instance. Alternatively, to create a dynamic value, enter a dataslot name, preceded by the @ symbol, that displays the value of the designated dataslot at runtime. In this case, entering “@Creator” as the value for the Assignee dataslot means that the person who created the instance is the assignee. This value can change from instance to instance and can reflect changes made at runtime.

**Note:** When you select Combo as the format type for a LongChar dataslot from the Default Format section and then define a choice list, you must assign the LongChar dataslot's initial value from the defined list. Otherwise, the process fails to publish.

The LongChar dataslot's initial value must not contain the bar (“|”) character.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Value</td>
<td>To specify the initial value of the dataslot. Enter text in the text area provided to create a static value; that is, a value that is displayed for each instance of the process. For example, entering “Carl” as the value for a dataslot, “Assignee”, it results in Carl being the Assignee for each process instance. Alternatively, to create a dynamic value, enter a dataslot name, preceded by the @ symbol, that displays the value of the designated dataslot at runtime. In this case, entering “@Creator” as the value for the Assignee dataslot means that the person who created the instance is the assignee. This value can change from instance to instance and can reflect changes made at runtime. <strong>Note:</strong> When you select Combo as the format type for a LongChar dataslot from the Default Format section and then define a choice list, you must assign the LongChar dataslot's initial value from the defined list. Otherwise, the process fails to publish. The LongChar dataslot's initial value must not contain the bar (“</td>
</tr>
<tr>
<td>Storage</td>
<td>Specifies the size of data storage for the dataslot. For more information. <strong>Note:</strong> Storage options are available only for the CHARACTER, LongChar, DECIMAL, and Number dataslots.</td>
</tr>
<tr>
<td>Access</td>
<td>(Not available for Web applications) Specifies the access properties for the dataslot. For more information, see Setting the dataslot access on page 167.</td>
</tr>
<tr>
<td>Default Format</td>
<td>To configure dataslot properties including the format type, label, and validations. For more information, see Defining the dataslot format on page 163.</td>
</tr>
<tr>
<td>Usage</td>
<td>If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, &quot;Input for Activity 1&quot; indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 173.</td>
</tr>
</tbody>
</table>
Caution: The usage of the LongChar dataslot is suggested only if the data is larger than 32k. For any smaller value, the usage of Character dataslot is suggested. Using Longchar dataslot might cause significant increase in response time.

The maxPostSize value for LongChar feature is set to 2 MB in the DatabaseMapping file in the location: $DLC\oebp\server\conf\resources\common. To increase the size to 5MB, edit the `<mapping>` section as shown below:

```xml
<mapping>
  <java>com.progress.lang.Longchar</java>
  <dataslot>ABL_LONGCHAR</dataslot>
  <database>LVARCHAR</database>
  <database-mb>LVARCHAR</database-mb>
  <size bytes="2097152">2097152</size>
</mapping>
```

to

```xml
<mapping>
  <java>com.progress.lang.Longchar</java>
  <dataslot>ABL_LONGCHAR</dataslot>
  <database>LVARCHAR</database>
  <database-mb>LVARCHAR</database-mb>
  <size bytes="5242880">5242880</size>
</mapping>
```

Also, edit the server.xml file in the location: $DLC\oebp\jboss\server\portalServer\deploy\jbossweb.sar to add maxPostSize attribute as shown in the following tables:

```xml
<Connector protocol="HTTP/1.1" port="18793" address="${jboss.bind.address}" connectionTimeout="20000" redirectPort="18002" URIEncoding="UTF-8" />
```

to

```xml
<Connector protocol="HTTP/1.1" port="18793" address="${jboss.bind.address}" maxPostSize="5242880" connectionTimeout="20000" redirectPort="18002" URIEncoding="UTF-8" />
```

Defining the dataslot description

You can add a description (optional) for a dataslot by selecting the dataslot and entering the description text in the Description section of the Dataslots tab. The Description text area can accept any character or symbol, and has no restrictions on the amount of characters you can enter.

Defining the dataslot format

You can use the Default Format section of the Dataslots tab to set properties such as the presentation format and the label of the dataslot in Business Process Portal, validation (if required). You can also specify whether the dataslot is editable and required.

Note: The Default Format section is not available for the Business Object dataslot.

Table 40 on page 164 lists the format properties, their descriptions, and the dataslot types for which they are available.
Table 40: Default Format for Dataslots

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Supported Dataslot Types</th>
</tr>
</thead>
</table>
| Type    | Determines how the dataslot should be presented in the interface. This is available for CHARACTER, LongChar and DateTimeTZ dataslots only. | • As a text box, text area, or combo box for a CHARACTER or LongChar dataslot.  
• Additionally, as a radio button, checkbox and label for CHARACTER or LongChar dataslot in case of web applications.  
• “Date and Time” or “Date Only” for DateTimeTZ dataslot. |
| Label   | Defines the label of the dataslot in the interface. | For all dataslots. |
| Editable| Specifies whether the dataslot is editable or read-only in the interface. The Editable checkbox is selected, by default. | For all dataslots. |
| Required| Specifies whether the dataslot is mandatory or not. | Not available for LOGICAL dataslot. |
| Validation| Configures validation settings. | Available only for CHARACTER, LongChar, INTEGER, INT64, and DatetimeTZ dataslots. For more information, see Specifying validation at the dataslot level on page 166. |

**Note:** For a CHARACTER or LongChar dataslot with default format “Combo box,” any choices that you define are only applicable when you use the dataslot in a workstep with auto-generated HTML presentation. If you use this dataslot in a Form workstep, the defined choices are ignored. All other attributes that you define for this dataslot in the Default Format section are supported in Form Editor.

You can modify the format of a dataslot at the workstep level, allowing each workstep in a process to have a different format. For example, you can set the format of a dataslot as a combo box with the label “Enter a choice” in one workstep; and as a text box with the label “You selected:” in the next workstep. To modify the format of a dataslot at the workstep level, see the Dataslot Properties section for the workstep type; for instance, for an Activity workstep, see Defining properties of Activity worksteps on page 180

### Format types for CHARACTER or LongChar dataslot

Progress Developer Studio for OpenEdge enables you to display a dataslot as a Text Field (single line of text), a Text Area (multiple lines of text), or a Combo. In the case of Web applications, the dataslot has three additional formats, namely, Radio button, Checkbox, and Label (read-only text). Each of these formats is described in the following bulleted list.

- **Text Field** format - Select this format and then do the following:
Creating user-defined dataslots

Figure 87: Text Field format for Dataslot

1. Enter data in the **Size** and **Length** box (only for Web applications) to define the dimensions of the dataslot as it appears on the interface.

2. Select the **Password** checkbox to present text entered in this field as asterisks, same as the way passwords are commonly displayed.

- **Text Area** format - Select this format and then enter the width and height of the text area in the respective fields.

- **Combo box** format - Select this format and then do the following:

  Figure 88: Combo Box format for Dataslot

1. To add a new choice for the combo box, click **New**, to open the **Choice** dialog box.

2. Enter a Value and a Label in the **Choice** dialog box, (right image, Figure 88 on page 165). A choice can only include alphanumeric characters and underscores (_).

3. Click **OK** to add the choice you created to the Choices area.

   To modify an entry, select the choice in the Choices section and click **Modify**. To remove a choice, select the choice and click **Remove**. To change the order of choice entries, select the choice and click **Move Up** or **Move Down**.

- **Radio button** and **Checkbox** formats (only for Web applications) - The procedure for defining the options for these controls are same as those for a Combo box.

- **Label** format (only for Web application) - You can enter only one label for the dataslot.

   Changing the presentation format at the workstep level does not affect the presentation at the process level. When the same dataslot, occurs in the Summary activity workstep, it is not editable. With this feature, you can change the presentation of a selected dataslot for each Activity workstep.
Specifying validation at the dataslot level

Progress Developer Studio for OpenEdge provides a validation framework that enables you to specify validation at the dataslot level. You can now associate validation rules with a CHARACTER, a LongChar an INTEGER, an INT64, or a DATETIMETZ dataslot type.

Table 41 on page 166 lists and describes the dataslot validation rules and the dataslot types for which they are available.

Table 41: Validation Rules for User-Defined Dataslots

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Available only for CHARACTER and LongChar dataslots. Enter a Minimum Length and a Maximum Length for the string text.</td>
</tr>
<tr>
<td>Number validation</td>
<td>Available for CHARACTER, LongChar and INTEGER dataslots. Select the Number type (Integer or Float) and enter the minimum value and the maximum value in the respective text boxes.</td>
</tr>
<tr>
<td>Decimal validation</td>
<td>Available for CHARACTER, LongChar, DECIMAL, and Number dataslots. Enter the number of digits to the left and to the right of the decimal point in the respective text boxes.</td>
</tr>
<tr>
<td>Decimal validation (advanced)</td>
<td>Available for CHARACTER, LongChar, DECIMAL, and Number dataslots. In addition to the Decimal validation rule, this rule enables you to set a range of digits allowed to the left and to the right of the decimal point.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Available only for CHARACTER and LongChar dataslots. Define the Minimum Port Allowed or the Maximum Port Allowed. Default values are 0 for Minimum and 65535 for Maximum.</td>
</tr>
<tr>
<td>U.S. Social Security Number</td>
<td>Available only for CHARACTER and LongChar dataslots. The predefined format (at runtime) is xxx-xx-xxxx.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Available only for CHARACTER and LongChar dataslots. The format is predefined.</td>
</tr>
<tr>
<td>URL</td>
<td>Available only for CHARACTER and LongChar dataslots. Select any of the allowed protocols (http, https, ftp, or all) and whether the Query strings are allowed.</td>
</tr>
<tr>
<td>Date Validation</td>
<td>Available only for DATETIMETZ dataslots. The format is predefined.</td>
</tr>
</tbody>
</table>

To assign a validation rule to a dataslot:

1. Select the CHARACTER, LongChar, INTEGER, INT64, or DATETIMETZ dataslot in the All Dataslots section.
2. From the Default Format section, click Browse beside the Validation box.
   - The Validation dialog box appears.
3. Select any of the available rules from the Validation Rule drop-down list. Depending on the validation rule you selected, you may have to enter additional information, as described in Table 41 on page 166.
4. Click OK to save the changes you made to the dataslot properties.

**Note:** Validation rules associated with a dataslot are only applicable when you use the dataslot in a workstep with auto-generated HTML presentation. For more information, see Defining Auto-generated HTML presentations on page 236. If you use this dataslot in a Form workstep, the defined validation rules are ignored.

---

### Setting the dataslot access

You can use the Access section in the Dataslots tab to define access properties of the dataslot.

**Note:** The Access section is not available for dataslots in Web applications.

---

#### Figure 90: Access section for Business Processes

From the Access section, you can select (or clear) any of the following access modifier checkboxes:

- **Public**: By default, all dataslots are public and this checkbox is selected. Public dataslots have persistent dataslot values even after the process instance is completed. If the Public checkbox is not selected, the dataslot is private and its value cannot be accessed from other Business Process Server components such as the Management module in Business Process Portal and BPM Events.

- **Management Access**: This checkbox is disabled for List, Map, Business Objects, and Object dataslot types. It allows you to make viewable or hide dataslots from view in the Application Status Viewer in the Management module in Business Process Portal. By default, the Management Access checkbox is selected and dataslots are visible in the Management module. With both Public and Management Access selected, editing dataslots in the Management module is allowed.

- **Global**: Select this checkbox to change the dataslot from a process instance-level dataslot to an application-level dataslot. When you create a Global dataslot, its value is shared for all process instances in an application. If you modify a Global dataslot value in one process instance, that dataslot value in all instances of the application has to be changed. Global dataslots enable...
business applications to keep statistics of all instances of an application and provide accessibility to a workflow, which is important if workflow decisions are based on those statistics.

- **Tasks Column**: This checkbox is disabled for List, Map, Business Objects and Object dataslot types. Select this checkbox to add the dataslot as a column for the application in Business Process Portal. As shown in Figure 91 on page 168, the Home module’s Task List page displays the dataslot label (or dataslot name if no label is assigned) as the column heading for the selected application.

**Note**: You must select the specific application in which the Tasks Column option was set. If the Application and Version drop-down list in Business Process Portal is set to All, the Tasks Column settings will not be displayed.

**Figure 91: Dataslots as Columns in the Task List Page in Business Process Portal**

Data for the dataslot, however, is displayed in the column only if the dataslot is specified as input or output to that workstep. For example in the figure above, all four dataslots were assigned to the Activity 2 workstep and each column displays a value for the Activity 3 task. The Name and State dataslots were assigned to the Start and Activity 1 worksteps, and values for these dataslots are displayed in the respective columns for Activity 1 and Activity 2 tasks. Note that these values are editable.

### Exporting and importing dataslots

Progress Developer Studio for OpenEdge enables you to import or export dataslots, either singly or in bulk, to a file (CSV, XML and Business Rules Vocabulary Definition) which is only available to you.

**Note**: The Export/Import feature does not support attached documents. If a CHARACTER dataslot with an attachment is exported and then imported, an error may occur. You must first remove any attached documents before exporting or importing such CHARACTER dataslots. For BRVD feature, only Export functionality is supported and Import functionality is not supported.

### Exporting dataslots

You can export one or more user-defined dataslots to an existing file or to a file which you specifically create for the dataslots.
To export dataslots:

1. From the Dataslots tab, click the Export ( ) icon. The Export Dataslots wizard appears.

2. From the first page of the Export Dataslots wizard, select any of the following options, then click Next:
   - CSV (Comma-delimited) File: to export the dataslots to a CSV (comma-delimited) file.
   - XML File: to export the dataslots to an XML file.
   - Business Rules Vocabulary Definition File: to export the dataslots to a BRVD file.

3. If you select the CSV (Comma-delimited) File option, the CSV (Comma-delimited) File page of the Export Dataslots wizard appears.

   a) If you want to export the dataslots to an existing CSV file, select the Overwrite existing file without warning checkbox to replace the contents of the existing file without any user warning.

   b) To create a new dataslot file, click Browse File System.

   c) Enter a name in the File name box and click Save. Alternatively, to export the dataslots to an existing file, select the file and click Save.

   The dataslot file and its location is displayed in the text box provided in the CSV (Comma-delimited) File page.

4. If you select the XML File option, the XML File page of the Export Dataslots wizard appears.
Chapter 13: Using dataslots

a) If you want to export the dataslots to an existing XML file, select the **Overwrite existing file without warning** checkbox to replace the contents of the existing file without any user warning.

b) To create a new dataslot file, click **Browse File System**.

c) Enter a name in the **File name** box and click **Save**. Alternatively, to export the dataslots to an existing file, select the file and click **Save**.

The dataslot file and its location is displayed in the text box provided in the **XML File** page.

5. If you select the **Business Rules Vocabulary Definition File**, the **Business Rules Vocabulary Definition File** page of the Export Dataslots wizard opens.

   a) If you want to export the dataslots to an existing BRVD file, select the **Overwrite existing file without warning** checkbox to replace the contents of the existing file without any user warning.

   b) To create a new BRVD file, click **Browse File System**.

   c) Enter a name in the **File name** box and click **Next**. Alternatively, to export the dataslots to an existing file, select the file and click **Next**.

6. Click **Next** to display the **Dataslots** page of the Export Dataslots wizard.

   You can use the **Dataslots** page to select the dataslots that you want to export. The **Dataslots** page displays all user-defined dataslots in your process.

   a) If you have selected **CSV** or **XML File**, select the checkbox of each dataslot or the dataslot type (for example, "CHARACTER") checkbox (to select all dataslots of that type). Alternatively, click **Select All** to select all of the listed dataslots. To deselect the dataslots, click **Deselect All**.

   b) If you have selected **Business Rules Vocabulary Definition File** select the type of Dataslot from the **Type** drop down.

   **Table 42: Dataslot Types and explanation**

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primitive</td>
<td>This option will export all dataslots of the types: Character, Longchar, DateTimeTZ, Decimal, Integer, Int64 and Logical</td>
</tr>
<tr>
<td>Table</td>
<td>From the <strong>Table</strong> drop down, select the Table that you want to export</td>
</tr>
<tr>
<td>DataSet</td>
<td>From the <strong>DataSet</strong> drop down, select the DataSet you want to export.</td>
</tr>
</tbody>
</table>

7. Click **Finish** to export the dataslots. If you are exporting the dataslots to a file and have not selected the **Overwrite existing file without warning** checkbox, you will be prompted to click **Yes** to replace the content of the file with the exported dataslots.

**Importing dataslots**

You can import user-defined dataslots from an existing dataslot XML (or CSV) file or from an existing process template file.

**Note:** Import functionality is not supported for BRVD import. For BRVD, only export functionality is supported.
To import dataslots:

1. From the **Dataslots** tab, click the **Import** icon. The **Import Dataslots** wizard appears.

2. From the first page of the **Import Dataslots** wizard, select any of the following options, then click **Next**:
   - **CSV (Comma-delimited) File**: to import the dataslots from a CSV (comma-delimited) file.
   - **XML File**: to import the dataslots from an XML file.

3. If you select the **CSV (Comma-delimited) File** option, the **CSV (Comma-delimited) File** page of the **Import Dataslots** wizard appears. **Figure 92: Import Dataslots: CSV (Comma-delimited) File page**
   a) To select the CSV file, click **Browse File System**.
   b) Select the CSV file and click **Open**. The selected file and its location is displayed in the text box provided in the **CSV (Comma-delimited) File** page.

4. If you select the **XML File** option, the **XML File** page of the **Import Dataslots** wizard appears. **Figure 93: Import Dataslots: XML File page**
   a) Click **Browse File System** to browse to a file.
   b) Select the file and click **Open**. The dataslot file and its location is displayed in the text box provided in the **XML File** page.

5. Click **Next** to display the **Dataslots** page of the **Import Dataslots** wizard.
You can use the **Dataslots** page to select the dataslots that you want to import.

**Figure 94: Import Dataslots: Dataslots page**

a) Select the check box of each dataslot or the dataslot type (for example, "CHARACTER") check box (to select all dataslots of that type). Alternatively, click **Select All** to select all of the listed dataslots. To deselect the dataslots, click **Deselect All**.

6. Click **Finish** to import the dataslots.
Setting workstep properties

This chapter describes how to set properties of worksteps and other shapes that are used to create process templates in Progress Developer Studio for OpenEdge. Each process template must have one Start workstep, one or more intermediate worksteps, and one or more End worksteps, with the worksteps connected by connectors.

For details, see the following topics:

• About worksteps
• Defining properties of Start workstep
• Defining properties of Activity worksteps
• Defining properties of Adapter worksteps
• Defining properties of Subprocess worksteps
• Defining properties of Message worksteps
• Defining properties of End worksteps
• Defining properties of Decision gateways
• Defining properties of Or-Join gateways
• Defining properties of Exclusive Or-Join gateways
• Defining properties of AND gateways
• Defining link properties
• Adding script to a workstep
• Defining a Rollback
• Defining a Timeout in worksteps
• Managing multiple worksteps

Abouth worksteps

Worksteps define the flow of business processes. You can create a workstep:

• In Business Processes by dragging one of these shapes into the Content pane: Start, Activity, Decision, Or-Join, Exclusive Or-Join, AND Gateway, Message, and End.

• In Web applications using these shapes: Start, Activity, Decision, Or-Join, and End.

Step Table 43 on page 174 lists and describes the types of workstep and how they appear in a process template.

Table 43: Types of Worksteps

<table>
<thead>
<tr>
<th>Workstep Type</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td><img src="image" alt="Activity" /></td>
<td>This workstep is performed by a User (human performer). In a BPM process, an activity can be performed by an individual user or by a group of users. In a Web application, this workstep is performed only by a single user. For details, see Defining properties of Activity worksteps on page 180.</td>
</tr>
<tr>
<td>Adapter</td>
<td><img src="image" alt="Adapter" /></td>
<td>This is an activity workstep, performed by an adapter. For details, see Defining properties of Adapter worksteps on page 194.</td>
</tr>
<tr>
<td>Subprocess</td>
<td><img src="image" alt="SubProcess" /></td>
<td>This workstep is a process by itself with its own process diagram and is external to the main process, including the subprocess worksteps. For details, see Defining properties of Subprocess worksteps on page 198.</td>
</tr>
<tr>
<td>External Activity</td>
<td><img src="image" alt="External Activity 1" /></td>
<td>This is a monitoring workstep, performed by an external human performer. This workstep type is only available for Business Processes. For details, see Introducing monitoring process on page 223.</td>
</tr>
<tr>
<td>External Adapter</td>
<td><img src="image" alt="External Adapter 1" /></td>
<td>This is a monitoring workstep, performed by an external adapter performer. This workstep type is only available for Business Processes. For details, see Introducing monitoring process on page 223</td>
</tr>
</tbody>
</table>
Note: This chapter does not cover the properties of external activity and adapter worksteps. For these details, see Introducing monitoring process on page 223.

Although the properties of an Activity, Adapter, and Subprocess worksteps vary according to their performers, these worksteps have the following properties in common:

- **Name.** Progress Developer Studio for OpenEdge assigns each workstep a default name; for instance, the first Activity workstep added to a process template is displayed as Activity 1. You can replace the default name with a more descriptive name in the Properties view for the workstep.

- **Dataslots.** Dataslots are used to transfer information between worksteps. You can define editable inputs (information that flows into the workstep) and read-only outputs (information that is sent out to other worksteps) in the Dataslots tab of the Properties view for Adapter, Message, and Subprocess worksteps; in the Fields tab of the Properties view for Start and Activity worksteps; and in the Configuration tab of the Properties view for Managed Adapter worksteps.

- **Performers.** Each of these worksteps can be assigned a performer. Performer types include: User, Adapter, and Subprocess.

### Workstep properties

You can configure properties of a workstep, using the Properties view for that workstep.

Note: The Properties view is available for each process template elements in Diagram, Overview, and Path Analysis tabs.

The Properties view for worksteps supports the following dynamic features:

- **General** tab: allows you to define performers for Activity (see Specifying general properties of Activity workstep on page 180) and Adapter (see Specifying general properties of Adapter workstep on page 194) worksteps (only in a Business Process). You can also specify the workstep label (as it appears in Business Process Portal) and define the presentation format for Start and Activity worksteps.

- **Dataslots** tab (or in the Configuration tab for Managed Adapter worksteps or in the Fields tab for Start or Activity worksteps): allows you to assign dataslots to the workstep and modify them as they would appear on Business Process Portal. For more information on defining dataslots for a workstep type, see the Dataslot Properties description for that workstep type; for instance, for the Start workstep, see Using the Fields tab of Start workstep properties on page 177.

- **Collaboration** tab (only available for Activity worksteps): allows you to select a level of collaboration and indicate the performers with whom you want to collaborate. You can also add such options to the workstep as reassigning tasks, adding Notes to a process, or sending Email or Instant Messaging.

- **Messaging** tab (only available for Start, Message, and End worksteps in Business Processes): allows you to select a message to initiate a process or a workstep; and to generate an outgoing message on the completion of a workstep or a process. Using this type of workstep provides a way to synchronize process events and to define actionable events at various stages of the process execution.

- **Alerts** tab (only available for Business Processes): Allows you to add alerts to be associated with activation or completion of the workstep.
Defining properties of Start workstep

The Start workstep (○) indicates the beginning of a Business Process Server process template. Each process must have one Start workstep. The Start workstep only contains output dataslots, which can be mapped to specific locations.

**Note:** The Properties view for worksteps in Business Processes have more features than those for Web Applications. In the following sections, only Properties view for Start worksteps in Business Processes are presented, which are applicable for Web applications as well, unless otherwise stated.

Click the Start workstep to view its properties in the Properties view. As shown in Step Figure 95 on page 176, the Properties view includes six tabs (Start worksteps in Web applications includes four tabs).

Specifying general properties of Start workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the Name box. The workstep name appears in the process template diagram. Workstep names can only include alphanumeric characters and underscores (_).

![Figure 95: Start Workstep Properties – General tab](image)

2. Enter a label for the workstep in the Label box. Once you assign a label to a Start workstep, it always appears in the Start workstep in the process template diagram and in Business Process Portal—the Name of the Start workstep will no longer appear.

3. To modify the default look and feel of the presentation pages for the Start workstep in Business Process Portal, click the ellipsis button next to the Presentation box (for more information, see Defining workstep presentation format on page 233).

**Note:** You can enter a description (optional) for the workstep in the Description tab. Description can be up to 4095 characters.
Using the Fields tab of Start workstep properties

For Business Processes, you can use the Fields tab (see Step Figure 96 on page 177) to assign and manage dataslots which control the information flow from the Start workstep. In Web applications, the Dataslots tab replaces the Fields tab.

Figure 96: Start Workstep Properties – Fields tab

The Header section displays the options for—Instructions, Priority—to be displayed in the header section of Business Process Portal’s task details page (corresponding to this workstep). You can choose to show or hide such information as Instructions for the workstep in the Header section of the Start workstep.

To use the the Fields tab:

1. Select any or all of the checkboxes in the Options section, to display the corresponding fields in the user’s Business Process Portal page.
2. Enter instructions for the workstep in the Instructions box. Instructions can be up to 255 characters. These instructions will appear in Business Process Portal.

Alternatively, you can link the instructions to a specific CHARACTER dataslot. To do so, select the Link instructions to Dataslot check box, then select the dataslot (if any) from the adjoining drop-down list. To create a new dataslot, click the adjoining ellipsis button to open the New Dataslot dialog box.

The user-defined dataslots assigned to the workstep are listed in the Fields section, which contains a table displaying the Icon, Name, Type, Category, Label, Editable, and Required columns. For information regarding these dataslot parameters, see Using dataslots on page 147.

Important: For a workstep with Form presentation format, the dataslots that you add are displayed as form controls on opening the form. After opening the form atleast once, the Add, Remove, and Modify buttons in the Fields tab are disabled and a message states that “You can add or remove fields in the Form Editor”. Add or remove a dataslot from the Form Editor or select a different presentation form to enable these functions.

Adding dataslots

To add a user-defined dataslot to the Fields section in the Fields tab:
1. Click **Add** to open the **Add** dialog box, which lists all the dataslots available to the process.

Figure 97: Add dialog box

![Add dialog box](image)

2. Select one or more dataslots and click **OK** to add them to the workstep.

### Modifying dataslots

You can modify a dataslot listed in the Fields section by selecting it and clicking **Modify**, to open the **Field Properties** dialog box in which you can edit the selected dataslot’s properties. The fields displayed in the **Field Properties** dialog box depends upon the type of the dataslot being edited. Step Figure 98 on page 178 displays the properties of a CHARACTER dataslot. You can make the necessary modifications and then click **OK**.

**Note:** You cannot modify predefined system dataslots.

Figure 98: Field Properties of a CHARACTER Dataslot in a Workstep

![Field Properties of a CHARACTER Dataslot in a Workstep](image)

For a CHARACTER dataslot in a workstep with Flow presentation format, you can click in the **Map** column to map the dataslot to the corresponding dataslot in the Web application. You must map to the same dataslot type.

Figure 99: Field Properties of a CHARACTER Dataslot in a Workstep with Flow presentation

![Field Properties of a CHARACTER Dataslot in a Workstep with Flow presentation](image)
Important: Do not use dataslots with predefined values in a Start workstep. If any CHARACTER dataslot has predefined attachments and you add this type of dataslot to the Start workstep, these attachments will not be visible in Business Process Portal when an instance is created.

Note: For Business Processes, you can use the Alerts tab to associate an alert with a Start workstep when it is completed. For more information, see Associating an alert with a workstep on page 256.

Using the Messaging tab of Start workstep properties

For Business Processes, you can use the Messaging tab to select a message received when the Start workstep is activated, which starts a new process instance. Start worksteps in Web applications do not have the Messaging tab.

To assign a message to a Start workstep:

1. From the Messaging tab (Step Figure 100 on page 179), expand General, then click in the Value column in the Enabled row, to enable a drop-down list.
2. Select True from the drop-down list enabled, to display a Message row.
3. Click in the Value column of the Message row, to open a drop-down list which displays a list of previously defined Messages. Select a message from the list, to view Header, Payload, and other available message components.

Figure 100: Start Workstep Properties – Messaging tab

4. Click in the Value column for each of the Header and Payload rows to view a list of available dataslots. Select a dataslot to associate the Header or Payload item with a dataslot value.

After you have assigned a message, a Message icon () is shown within the Start workstep, indicating that it can receive a message that, for example, can start a process instance. For more information about defining or editing messages, see Using the Message Manager on page 435.

Using the Advanced tab of Start workstep properties

You can use the Advanced tab in the Properties view to define events, which are executed on completion of the Start workstep in a Business Process and on activation as well as completion of the Start workstep in the case of Web applications.
The **Advanced** tab for Business Processes (Figure 101 on page 180) contains the **When Completed** tab. Start worksteps in Web applications have a **Before Activation** tab as well as a **When Completed** tab.

To define the event, click **Add Script**.

**Figure 101: Advanced: When Completed Tab**

The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see Using the GEL tool in BPM projects on page 311.

To remove the defined event, click **Delete**.

---

### Defining properties of Activity worksteps

Activity worksteps are the basic unit of work, and must be performed in their entirety. An Activity workstep in a Business Process is an activity assigned to an individual user or to a group of users. An Activity workstep in a Web application can only be assigned to an individual user.

**Note:** The **Properties** view for worksteps in Business Processes have more features than those for Web applications. In the following sections, only **Properties** view for Activity worksteps in Business Processes are described, unless otherwise stated.

Click the Activity workstep to view its properties in the **Properties** view. As shown in Step **Figure 102** on page 181, the **Properties** view contains six tabs (Start worksteps in Web applications contains four tabs).

---

### Specifying general properties of Activity workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the **Name** box. The name of the workstep is displayed in the process template diagram. Workstep names can only include alphanumeric characters and underscores (_).
2. Enter a label for the workstep in the **Label** box. This label of the workstep appears in Business Process Portal.

3. The **Performer** box (available only for Business Processes) displays the performer assigned to the Activity workstep (as described in Assigning performers on page 140. To assign other performer, click the **ellipsis** button beside to the **Performer** box, to open the **Performer** dialog box.
   a) All the User performer types available in the process are listed in the **Performer** dialog box. If there are many performers listed, you can search the performer using the Search box and any User name containing that string is displayed in the text area. For example, if you entered “mgr” in the Search box in the Performer dialog, two users, mgrA and remoteMgr, are listed. You can create a performer by clicking **New**, to open the **Performer** dialog box (Figure 68 on page 132).
   b) Click **OK**, to assign the selected user as the workstep performer and to return to the **General** tab.

4. From the **Default performer** box (available only for BPM processes), specify the default performer, to whom the Activity workstep is assigned if the workstep performer is not available. The default performer can be an individual user or a dataslot. This is an optional field. To assign a default performer, click the **ellipsis** button beside the **Default performer** box, then click the **Select a Performer** option to open the **Performer** dialog box that lists all the performers.

   To remove the selected performer, click the **ellipsis** button beside the **Default performer** box, and select the **Clear** option.

5. The **Presentation** box defines the look and feel of the presentation pages for the Activity workstep. To change the presentation format, click the **ellipsis** button beside the **Presentation** box to open the **Presentation** dialog box (for more information, see Defining workstep presentation format on page 233).

6. To set the priority of the workstep, select any of the predefined options from the **Priority** drop-down list (available only for Business Processes). Predefined options include: **Low**, **Medium**, **High**, **Critical**, and **Use a dataslot**. If you select **Use a dataslot**, you can use the **Select Dataslots** dialog box to select any of the listed dataslots of CHARACTER type.

7. The **Overdue in** box displays the default duration (2 hours) in which the workstep needs to be completed. Modify the time in which the workstep is overdue by clicking the **ellipsis** button beside the **Overdue in** box, and select either of the following options.

   - **Enter a duration** option to open the **Duration** dialog box (left image, Step Figure 103 on page 182). Enter the number of days, hours, minutes, or seconds to specify the workstep’s duration and click **OK**.
Use a Dataslot option to open the Select Dataslots dialog box which lists the INTEGER and INT64 dataslots available in the process (right image, Step Figure 103 on page 182). Select a INTEGER or INT64 dataslot to specify a dynamic duration for the workstep, and click **OK**. You can use only dataslots with integer values for duration.

**Note:** The value of the dataslot must be in seconds, since this is the unit of time that BP Server expects for the duration until workstep completion. For example, if you want to set the workstep overdue duration to two minutes, then enter the dataslot value as 120 seconds.

8. Select the **Skippable** check box to allow for an individual or member of a group to skip this work item (or task) at runtime. When the application is published on Business Process Portal, the task that represents the work item includes a **Skip** button that performers can click to skip the task. For example, if a work item is assigned to three performers and two of the performers choose to skip the work item, the third performer can perform the task. This feature is present only in Activity worksteps for Business Processes.

9. Select the **Collect Work Time** check box if you want to force the performer to enter the time it took them to complete the task. By selecting this checkbox, you create a footer in Business Process Portal that requires the user to enter the Days, Hours and/or Minutes they needed to complete the task. This feature is present only in Activity worksteps for Business Processes.

10. To make the Activity workstep execute multiple times, select the **Loop** checkbox. Follow the procedure in Defining a Loop condition on page 182. This feature is not available for Web applications.

### Defining a Loop condition

A Loop occurs when the workflow is repeated through the current workstep until a specified loop condition is met. To track the number of times the workstep is executed, you can define a counter that increments every time the loop is executed.

**To define a Loop condition:**

1. From the **General** tab of an Activity workstep’s **Properties** view, select the **Loop** checkbox, beside the adjacent field and ellipsis button.

2. Click the **ellipsis** button to open the **Loop** dialog box, in which you can define the Loop condition.
3. Enter a variable (note that the variable must be a INTEGER dataslot type) by clicking the ellipsis button beside the Variables box. From the Select Dataslots dialog box, select a INTEGER dataslot type from those listed. Each time the workstep executes the loop, this variable is incremented by one.

4. From the Condition section, build a condition by selecting a dataslot from the drop-down list on the left and an operator from the middle drop-down list, and then selecting or entering a value in the drop-down list on the right. To enter a value, do the following:
   a) Open the drop-down list on the right and select Enter Value option, to open the Enter Value dialog box.
   b) Enter the value and click OK.

5. Click OK after defining the loop condition for this workstep.

As long as the defined condition is “true”, the workstep will execute a loop. When the condition reads “false”, the workflow passes to the next workstep.

The example shown in Step Figure 104 on page 183 is a counter-controlled loop, where the first condition sets the workstep to iterate five times. To do this, set the count dataslot to “is less than or equal to”. On the sixth iteration, the workflow will go out of the loop and continue to the next workstep. This type of loop is useful if, for example, you wanted a user to enter data five times before proceeding to the next workstep.

The second condition indicates that the Assignee dataslot must equal “Jones”: if the assignee is not Jones, the condition is false and the workflow proceeds to the next workstep.

When a workstep is defined as a Looping workstep, the Loop icon (○) appears within the workstep shape, indicating to other users that a loop occurs in this workstep.

**Note:** If a workstep has both a Skip condition and a Loop condition, the Skip condition is evaluated first. If it evaluates to true, the workstep is skipped; if false, the workstep is executed and the Loop condition is evaluated. If the Loop condition is evaluated as true, the Skip condition is evaluated again.

**Note:** You can enter a description (optional) for the Activity workstep in the Description tab. A description can be up to 4095 characters.
Using Fields tab of Activity workstep properties

You can use the **Fields** tab to assign and manage dataslots that control the information flow into and out of an Activity workstep. You can manage existing dataslots and add dataslots using the **Fields** tab, as described for the Start workstep (see Using the Fields tab of Start workstep properties on page 177).

**Important:** For a workstep with Form presentation format, the dataslots that you add are displayed as form controls on opening the form. After opening the form at least once, the **Add**, **Remove**, and **Modify** buttons in the Fields tab are disabled and a message states that “You can add or remove fields in the Form Editor”. Add or remove a dataslot from the Form Editor or select a different presentation form to enable these functions.

Defining collaboration tasks

The Collaboration feature is available only for Activity worksteps in Business Processes. Collaboration allows you to set a number of options in BPM Designer which allows the activity workstep to appear as a collaborative task in Business Process Portal. Collaborative tasks allow application users to complete their work by collaborating with other users or groups (referred to as Collaborators). These options include the ability to select a level of collaboration as well as indicating the performers with whom you want to collaborate. You can also select other options such as reassigning tasks, adding Notes to a process, or sending Email or Instant Messaging.

**To define collaboration properties:**

1. Click the **Collaboration** tab in the **Properties** view for an Activity workstep.

**Figure 105: Activity Workstep Properties – Collaboration tab**

2. From the **Options** section, select one or more of the following options that you want to include in Business Process Portal.

   - **Collaborative Tasks** Select the appropriate options in the beside the drop-down list to indicate whether you want to allow the Business Process Portal user to edit the dataslots associated with the workstep, or only view the dataslots that are now read-only, or see no dataslots.

**Note:**

You can use a CHARACTER dataslot for specifying the collaborator.
• **Notes** Specify whether you want the Business Process Portal user to see notes at the Instance Level (for all worksteps in the instance) or at the Workstep Level (for the current workstep). For more details regarding Notes, see the *Business Process Portal User's Guide*.

• **Reassign** By default, the assigned performer of this workstep can reassign the task to another performer. To disable reassigning, clear this checkbox.

• **Email** To allow the assigned performer of this workstep to communicate with any of the collaborators using e-mail.

• **Instant Messaging** To allow the assigned performer of this workstep to chat with any of the collaborators using Instant Messaging.

3. From the **Collaborators** section, add the collaborators and also specify the operations the workstep performer can perform with each collaborator in Business Process Portal. Note that there is a column added for each option that you select in the **Options** section.

**Figure 106: Activity Workstep Properties – Collaboration Tab, Collaborators Section**

a) To add a collaborator, click **Add**, to open the **Select Users** dialog box, which you can select one or more of the users or groups and click **OK** to add them to the **Collaborators** list.

**Note:** You cannot add (or create) a queue as a collaborator. Further, you cannot add a group with ‘Any’ member selected as a collaborator or a group with a defined role.

b) For each of the specified collaboration options, select either “true” or “false” from the drop-down list.

**Note:** To delete a collaborator from the list, select the user or group and click **Remove**.

For worksteps using Form presentation, all the options selected in the **Options** section will automatically be available in the Standard footer in Form Editor. For worksteps with default presentation, the options selected in the **Options** section are displayed in the Task Details page of the workstep and all the collaborators defined in the **Collaborators** section will be available in the **Collaborators** list in the **Create Collaboration** page in Business Process Portal.

**Note:** For Business Processes, you can use the **Alerts** tab to associate an alert with an Activity workstep when it is initially activated, completed, or as an Overdue action when it is overdue. For more information, see *Associating an alert with a workstep* on page 256.
Using Advanced tab of Activity workstep properties

You can use the **Advanced** tab to configure advanced events for the Activity workstep on activation, before activation, on completion, when overdue, when an error occurs and on recovery.

The **Advanced** tab in the **Properties** view for a Business Process (Step Figure 107 on page 186) consists of six tabs, namely: **Before Activation**, **On Activation**, **When Completed**, **Overdue Actions**, **On Error**, and **On Recovery**. By default, the **Advanced** tab displays the **Before Activation** tab. Activity worksteps in Web applications have **Before Activation** and **When Completed** tabs (similar to those for the Start workstep).

Before workstep activation

You can use the **Before Activation** tab to configure procedures which occur before the Activity workstep is activated.

**Figure 107: Activity Workstep Properties, Advanced Tab, Before Activation tab**

To configure procedures:

1. The **Activation Limit** checkbox is only available for a system process, as defined in the **ProcessType** attribute in process properties (see Setting process properties on page 119). Select this checkbox and enter a value (greater than 0), which sets a maximum limit that this workstep is executed in loop for a process instance at runtime. To execute the workstep loop indefinitely, specify the value as -1. If no value is specified, the value of the `bpserver.ws.max.activationcount` parameter in the `OEBPS_Home\conf\bpserver.conf` file is considered as the maximum limit.

2. Select the **Activate On** checkbox to enter the date and time when the workstep will be activated. Click the **ellipsis** button and select one of the following options.
   - **Enter a value** option: to open the **Activate On** dialog box (Step Figure 107 on page 186), in which you can select a static date value.
   - **Use a dataslot** option: to open the **Select Dataslots** dialog box, in which you can select any of the DateTimeTZ dataslots listed, to define a dynamic date for the workstep activation. You can also add, edit or delete DateTimeTZ dataslots. These dataslots are saved as `<ActivateOn>@dsname</ActivateOn>`.

3. Select the **Activate After** checkbox to specify the time interval until activation starts. Click the **ellipsis** button and select one of the following options.
   - **Enter a value** option: to open the **Duration** dialog box in which you can enter a duration value in terms of days, hours, minutes, or seconds.
• **Use a dataslot** option: to open the **Select Dataslots** dialog box, in which you select any of the INTEGER dataslots listed to define the interval until the workstep is activated. These dataslots are saved as `<ActivateAfter>@dsname</ActivateAfter>`.

**Note:** The value of this INTEGER dataslot must be in milliseconds, since this is the unit of time that BP Server expects for the duration until workstep activation. For example, if the workstep is to be activated after two minutes, then the dataslot value must be specified 120,000 milliseconds.

4. You can use the **Wait for Condition** dialog box to specify a condition to be satisfied before the workstep is activated. Click the **ellipsis** button to open the **Wait for Condition** dialog box (Figure 108 on page 187). Use the Expression Builder feature to define a valid condition.

**Figure 108: Wait for Condition dialog box**

![Wait for Condition dialog box](image)

a) Select a dataslot from the drop-down list on the left (The Basic mode only includes CHARACTER, INTEGER, INT64, LOGICAL, and DATETIMETZ dataslot types; Advanced mode includes all data types). Select an operator. To complete defining the condition, select a dataslot from the drop-down list on the right or enter a value.

b) To add another condition, click ![add condition](image) and select the **And** or **Or** option. To remove a condition, click ![remove condition](image).

c) To create a condition, click **Advanced** option by adding specific dataslots or by entering or pasting a condition. You can drag any of the dataslots listed (from the **Dataslots** section) to the **Condition** text area and build a condition, for example, `jst.getStringDataSlot("CREATOR").equals("Peter").`

d) To check on your expression's validity, click **Validate**.

5. You can use the **Skip Condition** dialog box to define a condition which, when satisfied, allows the performer to skip the workstep before it becomes activated. Click the **ellipsis** button to open the **Skip condition** dialog box. Procedures to define a condition is the same as those described for “Wait for Condition” feature. In the example (Figure 109 on page 188), the workstep is skipped when the Initial Cost is less than $1500 and it has a Low priority.
6. You can use the **Execute script** box to define the event, which is executed before the workstep is activated.

- To define the event, click **Add Script**. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see **Using the GEL tool in BPM projects** on page 311.
- To remove the defined event, click **Delete**.

**On workstep activation**

You can use the **On Activation** tab to configure procedures that occur when the Activity workstep is initially activated. This tab includes three sections namely, Exclude performers, Synchronization, and Rollback:

**You can perform the following steps:**
1. Use the **Exclude Performers** section to designate performers which you want to exclude from performing the current workstep. For more information, see Excluding a performer on page 193.

2. From the **Synchronization** section, select the **Send e-mail to performer and complete if answered** check box to send an e-mail to the performer of the workstep when it is activated.

   If the performer answers the e-mail, the workstep is considered to be completed; or the performer can go to the Home module in Business Process Portal and complete the task there.

   **Note:** Make sure the e-mail address you entered is valid. No action will be taken, and no errors logged, if the e-mail address is invalid.

3. In the **Rollback** section, select the **Create rollback point** check box to designate this workstep as the rollback point from which the workflow will be restarted in the event of an error or system crash. For more information, see Defining a Rollback on page 216.

### On workstep completion

You can use the **When Completed** tab to define the action, which is executed on the completion of the Activity workstep.

**Figure 111: Activity Workstep Properties, Advanced Tab, When Completed tab**

You can use the **Execute script** box to define the event, which is executed on completion of the workstep.

- To define the event, click **Add Script**. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see Using the GEL tool in BPM projects on page 311.
- To remove the defined event, click **Delete**.

### Adding overdue actions

You can use the **Overdue Actions** tab to set procedures that occur when the Activity workstep is overdue. This tab includes two sections, namely, Overdue Actions and On last overdue. Use the **Overdue Actions** table to add new overdue actions, edit or remove existing overdue actions, and change their sequencing. These actions are executed each time the workstep is overdue. For information regarding actions in the **On last overdue** section, see For the last overdue action on page 192.
BPM Designer calculates the due date of a workstep by adding the duration of the workstep (as defined in the General tab) to the time the workstep is actually activated. If the duration is not specified, the due date of an activated workstep is set to the next day. By default, BPM Designer checks all activated worksteps every 30 seconds and performs specified overdue actions.

**Figure 112: Activity Workstep Properties, Advanced Tab, On Overdue tab**

Note: For more information on overdue actions, refer to the “Assigning Overdue Actions” section in Chapter 3 of the Application Developer’s Guide.

To add an overdue action:

1. From the Overdue Actions section, click New, to open the Overdue Actions dialog box. This dialog box contains a Number of times to execute box and three tabs, namely, Actions, Script, and Alerts. The Actions tab lists actions you can define for an overdue workstep.

**Figure 113: Overdue Actions dialog box – Actions tab**

2. In the Number of times to execute box, specify the number of times you want the Overdue actions to execute.
3. Select the Send Email checkbox to send an e-mail each time the Overdue is activated.
   a) Click the ellipsis button, to open the Send Email dialog box.
b) Enter the required content in the appropriate boxes. Use comma-separated values to enter multiple e-mail addresses. Specify an e-mail address as @<DataslotName> to dynamically obtain a mapped dataslot value.

**Note:** Make sure the e-mail address you entered is valid. No action will be taken, and no errors logged, if the e-mail address is invalid.

c) Click **OK**, to return to the **Overdue Actions** dialog box.

4. Select the **Change priority** checkbox to set and change the priority of the overdue action. From the adjoining drop-down list, select any of the priorities listed.

5. Use the **Extend duration** section to extend the duration of an Overdue action. Enter duration in terms of days, hours, minutes, or seconds. The earlier duration defined for this workstep gets extended by this value. For example, after a workstep with a duration of one hour becomes overdue, you can extend the duration of an overdue action to two hours. The duration is now redefined to two hours starting from the time the workstep becomes overdue. The number of repeat actions you defined in **Number of times to execute** box extends the workstep's duration that many times.

6. From the **Scripts** tab, enter script that will be executed for each Overdue Action. For more information on entering Java or JavaScript, see **Adding script to a workstep** on page 214.

7. Use the **Alerts** tab (left image, Figure 115 on page 192) to add one or more alerts during the Overdue Action.
   a) Click **Add** to add a new alert, to open the **Add** dialog box (right image, Figure 115 on page 192).
   b) Select an alert, if available, from the drop-down list and click **OK** to add the alert to the overdue action.

**Note:** For details regarding creating an alert, see **Using alerts** on page 253.
Figure 115: Overdue Actions dialog box – Alerts tab

Note: To remove an alert from the list, click Remove; or click Move Up or Move Down to change the sequencing of the Alerts. For more information, see Associating an alert with an overdue action on page 257.

8. After defining the Overdue Actions, click OK, to return to the Overdue Actions tab in the Advanced tab of the Properties view.

For the last overdue action

You can use the On last overdue section in the Overdue Actions tab to define last overdue actions.

To execute an On last overdue action:

1. To change the performer for the last execution of an Overdue action, select the Change performer checkbox (see Step Figure 112 on page 190). Click the ellipsis button to open the Change Performer dialog box, in which you can define the next performer.
2. To force the completion of the workstep on the last time of an Overdue action, select the Complete workstep checkbox.
3. When a connector from the Activity workstep is of the Timeout Flow type, the Activate Timeout Flow checkbox is enabled. The Timeout Flow indicates the direction of a work flow after Overdue Actions have been executed and the Last Overdue action is completed. For more information on Timeout Flow, see Defining a Timeout in worksteps on page 218.

On workstep error

You can use the On Error tab to select the rollback point to which the process will roll back in the event of an error. The Activate rollback point drop-down list is enabled only when you have a workstep with a rollback point defined (see Step 3) in your process.

On workstep recovery

In certain instances, an Activity workstep may be stopped or suspended. In such cases, you can use the On Recovery tab to define the event to recover the data.

You can use the Execute script box to define the event, which is executed for workstep recovery.
To define the event, click **Add Script**. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see **Using the GEL tool in BPM projects** on page 311.

To remove the defined event, click **Delete**.

---

**Excluding a performer**

BPM Designer allows you to exclude a performer of a previously executed workstep in a process template from any human-performed workstep that is performed by a queue. Excluded performers can include valid BPM Designer users, dataslots that return users, and EJB applications that return users. Excluded performers cannot include groups or queues.

By introducing the excluded performer concept, BPM Designer supports the Four-Eyes Principle. In business processes, the Four-Eyes Principle states that the performer of one workstep should be excluded from acting as the performer of a subsequent workstep, even if that performer is a member of a group or queue that can perform the workstep. For example, if a manager creates a purchase request, then the same manager should not be able to approve the purchase request, and should be excluded from any performer list for the approval workstep.

---

**Note:** An exception in excluding performers occurs if a performer has been excluded from a workstep, but then that task has been delegated to the same performer in Business Process Portal. In this case, the performer can undertake and complete the delegated task.

---

**To exclude a performer from an Activity workstep in a Business Process:**

1. From the **Advanced** tab of the workstep's **Properties** view, click the **On Activation** tab.
2. From the **Exclude Performers** section, click **Add** to open the **Performer Exclusion** dialog box, in which you can select the performer to be excluded.

---

**Figure 116: Performer Exclusion**

3. You can either exclude a specific performer or a performer of a previously executed workstep.
   a) To exclude a specific performer:

   - Select the **Performer by name** option from the **Exclude:** list.
   - Click the **ellipsis** button beside the **Performer** box, to open the **Performer** dialog box.
Defining properties of Adapter worksteps

An adapter workstep is an activity workstep performed by an adapter which runs an external system, remote device, or an application that is on a remote server external to Progress Developer Studio for OpenEdge. You can either create an adapter workstep using a custom adapter or any of the predefined managed adapters (as described in Defining and assigning performers on page 129.

Note: Properties view for worksteps in Business Processes have more features than those for Web applications. In the following sections, only Properties view for Custom Adapter worksteps in Business Processes are described, unless otherwise stated.

Click the Adapter workstep to view its properties in the Properties view. The Properties view contains five tabs (Adapter worksteps in Web applications contains four tabs), as shown in Step Figure 117 on page 194.

Specifying general properties of Adapter workstep

Similar to that for an Activity workstep (Specifying general properties of Activity workstep on page 180), you can use the General tab to define the general properties of an Adapter workstep.

Figure 117: Adapter Workstep Properties – General tab

1. Identify the workstep by entering a name in the Name box. Workstep names can contain only alphanumeric characters and the underscore (_) character can be used.

Note: There is no default duration shown in the Overdue in box for Custom and Managed Adapters. There is no Performer box for managed adapters.

2. To define other general properties of an Adapter workstep that are identical to those already described for Activity worksteps, refer to Specifying general properties of Activity workstep on page 180.
Using the Dataslots tab of Adapter workstep properties

You can use the Dataslots tab to control the information flow into and from a workstep performed by a custom (user-defined) adapter. From the Dataslots tab, you can assign dataslots to the adapter workstep and manage existing dataslots.

Note: For a managed adapter, the Configuration tab replaces the Dataslots tab. For information on configuring the managed adapter and mapping dataslots between Managed Adapter inputs/outputs and dataslots in BPM Designer processes, see the Managed Adapters Guide.

Figure 118: Adapter Workstep Properties – Dataslots Tab

Dataslots assigned to the adapter workstep are listed in a table in the Dataslots tab. You can add, modify, or remove the dataslots.

The Name column provides the name of the dataslot. The other two columns show whether the dataslot provides Input to the Adapter or Output from the Adapter. For information on mapping dataslots, see Mapping dataslots in an adapter workstep on page 196.

To add dataslots to those listed in the table:

1. Click Add, to open the Select Dataslot dialog box.
2. Select one or more dataslots and click OK to assign them to the adapter workstep.

You can modify the Input and Output adapter settings for the existing dataslots in the Dataslots tab. Click in the Input to Adapter or Output to Adapter column for the dataslot you want to modify, then select true or false in the drop-down list.
Mapping dataslots in an adapter workstep

Mapping dataslots play an important role in adapter worksteps. Mappings enable you to pass data between dataslots in a process and methods in an adapter, and to automatically handle occasions when the names of the dataslot do not match the names of the adapter methods.

When you define a dataslot as an input to an adapter, BP Server invokes a corresponding set method in the adapter to assign the dataslot value to the variable in the set method (adapter). Similarly, to retrieve a variable from an adapter to a dataslot, BP Server invokes a get method at runtime.

Note: For information on configuring and mapping any of the Managed Adapters, see the relevant chapters in the Managed Adapters Guide.

To map dataslots in an adapter workstep to a method in an external adapter:

1. From the adapter workstep Properties view, assign the dataslots for the adapter workstep, as described in Using the Dataslots tab of Adapter workstep properties on page 195.

   The Fields view, which is displayed by default, shows dataslots as Input to the adapter, Output from the adapter, or both.

2. Select the Advanced option from the drop-down list.

   The Advanced view automatically creates and displays the set methods used for adapter inputs and the get methods used for adapter outputs.

3. To edit an adapter input (set method), select an adapter input as displayed in the Advanced View and click Modify, to open the Field properties dialog box.
4. Click the *ellipsis* button beside the **Adapter input(s)** box to open the **Adapter input(s)** dialog box.

5. Enter a new set method name in the text box provided and click **Add**, which adds it to the list in the **Adapter input(s)** dialog box.

**Note:** To delete a set method, select it from the list and click **Remove**. To change the sequence of listed set methods, use the **Move up** and **Move down** button.

6. After defining the set methods, click **OK** to return to the **Field properties** dialog box.

7. To add an adapter output (or get method), enter a name in the **Adapter output** box.

8. Click **OK** to complete the mapping of dataslots in the adapter workstep to methods in the external adapter.

---

### Using the Advanced tab of Adapter workstep properties

You can use the **Advanced** tab in the **Properties** view to configure advanced events for the adapter workstep on activation, before activation, on completion, when overdue, when an error occurs, and on recovery. The **Advanced** tab for the adapter workstep is similar to the **Advanced** tab for the User-performed Activity workstep: it includes six tabs—**Before Activation**, **On Activation**, **When Completed**, **Overdue Actions**, **On Error**, and **On Recovery**. For more information, refer to Using Advanced tab of Activity workstep properties on page 186.

By default, the **Advanced** tab for the adapter workstep displays the **Before Activation** tab. Adapter worksteps in Web applications have **Before Activation** and **When Completed** tabs, in which you can define the action to be executed on activation and on completion of the adapter workstep (for more information, see Adding script to a workstep on page 214).

![Figure 121: Adapter Workstep Properties, Advanced tab](image)

Features in the Advanced properties of the adapter workstep that differ from the Advanced properties in the Activity workstep include:

1. The **On Activation** tab includes:
   - The adapter queue section which includes the **Long running adapter** checkbox. You can select this checkbox to indicate if this adapter is a normal or a long running adapter. A long running adapter executes on a limited number of threads configured in a queue designated for long running adapters. Normal adapters executes on larger number of threads configured in a queue designated for regular adapters.
   - A synchronization function that provides a **Wait for the adapter to complete before proceeding** checkbox. Select this checkbox to set the Adapter workstep as synchronous.
that is, the process waits for the adapter to be completed before proceeding (this checkbox is disabled for Managed Adapters).

- To enable inline execution of the adapter, select the **Execute on the same thread** checkbox if required.

**Note:** In case of managed adapters, the **Execute on the same thread** checkbox is only available for Database and JMS adapters. You can disable this checkbox for these adapters. To do so, set the `inline-enabled` property to `false` in the Advanced Properties dialog box in the **Configuration** tab of the **Properties** view. For more information, see the *Managed Adapters Guide*.

- The **On Activation** tab does not allow you to send an e-mail to a performer and complete the workstep if answered nor does it allow you to exclude any performer.

2. The **Overdue Actions** tab does not have a **On last overdue** section.

**Note:** For more information on working with adapters, refer to the "Developing Adapters" section of the *Application Developer’s Guide*.

---

### Defining properties of Subprocess worksteps

The Subprocess workstep is an activity workstep performed by another process. It allows you to nest a complete process into another process template.

#### Parent Process: Subprocess interaction

You can assign a process as performer of an activity to create a Subprocess workstep. At runtime, the parent process (which contains the subprocess workstep) and one of the subprocesses (if any) communicate with each other—the parent process may send data to the subprocess and the subprocess in turn sends data back to the parent process. A subprocess can receive one or more parameters as input and can return one or more values to the parent process.

You can define a parent process as a subprocess in a different application. There is no limit on the number of processes that are nested within a Subprocess workstep created in BPM Designer.

**Important:** For Web applications, the parent process and the subprocess must share the same HTTP session. Since Web applications have lightweight persistency between Web pages using the HTTP session, no communication is possible if they do not share the session.

A parent process identifies a subprocess by its name, or “signature”, and must provide the expected names for both input and output data.
To define the method “signature”, you must define the subprocess and specify the name and number of values which are expected as input and which values are returned to the parent process. If the names of the dataslots in the parent process match the names of the dataslots in the subprocess, default mapping occurs and you do not need to map the dataslots. However, it is more common occurs that these names do not match, and which you need to map the relevant dataslots. For more information, see Mapping dataslots in a subprocess workstep on page 200.

**Note:** Properties view for Subprocess worksteps in BPM processes have more features than those for Web Applications. In the following sections, only Properties view for Subprocess worksteps in Business Processes are described, unless otherwise stated.

Click the Subprocess workstep to view its properties in the Properties view. The Properties view includes five tabs (Properties view in Web applications contains four tabs), as shown in Step Figure 122 on page 199.

### Specifying general properties of Subprocess workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the Name box. The name of the workstep can only include only alphanumeric characters and underscore (_) character can be used.

   ![Figure 122: Subprocess Workstep Properties – General Tab](image)

2. When specifying the Performer in a Subprocess workstep, you must select a process to serve as the subprocess in the workstep. You can specify a process installed either on your local server or on a remote server.

   To define a performer (that is, to select a process) for the Subprocess workstep, click the ellipsis button beside the Performer box to open the Performer dialog box.

   a) All the subprocesses available in the process are listed in the Performer dialog box. If many subprocesses are listed, you can search the Subprocesses performer type using the Search box and any name containing that string is listed.

   b) After selecting a subprocess, click OK, to return a process installed to the Subprocess Properties view. The subprocess is defined as the performer of the Subprocess workstep.

3. To define other general properties of a Subprocess workstep which are the same as those described for Activity worksteps, refer to Specifying general properties of Activity workstep on page 180.

**Note:** You can enter a description (optional) of the subprocess workstep in the Description tab. A description can be up to 4095 characters.
Using the Dataslot tab of Subprocess workstep properties

You can use the Dataslots tab to assign and manage dataslots which control the information flow into and from the Subprocess workstep.

**Note:** The Dataslots tab is not available for inline subprocesses.

Figure 123: Subprocess Workstep Properties – Dataslots Tab

You can add, modify, or remove dataslots assigned to the Subprocess workstep in the Dataslots tab, an easy-to-use interface where you can add new or modify existing dataslots.

By default, the **Fields** view is displayed, with dataslots listed in a table. The Name column lists the name of the dataslot. The other two columns indicate whether the dataslot is input or output for the subprocess.

You can add, modify, or remove dataslots, the same way as you manage dataslots for an Adapter workstep (as described in Using the Dataslots tab of Adapter workstep properties on page 195).

To assign a dataslot as input to output from the **Fields** view, click in the **Input to subprocess** or **Output from subprocess** column for the dataslot you want to modify, then select **true** or **false** in the drop-down list.

The input or output assignments are displayed in the Dataslots tab.

Mapping dataslots in a subprocess workstep

If the name and data type of the dataslots in a Business Process and the dataslots in a Web application are identical, default mapping occurs between the processes. If the name or data type differ, default dataslot mapping will not work correctly.

**Note:** Default dataslot mapping is case-sensitive. For example, dataslots called “Budget” and “budget” are not mapped by default and must be mapped in the workstep Properties.

To map dataslots in a Subprocess workstep:

1. From the drop-down list under Dataslots (Figure 124 on page 201), select **Advanced** option, which displays the **Set dataslot(s)** and **Get dataslot** columns in the table below that.

   The Advanced view enables you to pass dataslot values from the subprocess to an input (Set) dataslot or to an output (Get) dataslot in a parent process.
Note: For Input dataslots added to the subprocess workstep in a Web application, data from the Web subprocess is passed to the parent process only when the corresponding mapped dataslots are added to the End workstep of the Web subprocess.

2. Select a dataslot and click **Modify**, to launch the **Field Properties** dialog box. You can enter multiple Set dataslots and one Get dataslot for the Subprocess dataslot.

3. To map a parent process dataslot to one or more inputs in the subprocess, click the **ellipsis** button beside the **Set dataslot(s)** box to open the **Set Dataslots** dialog box.
   a) In the text box, enter the name of the dataslot in the parent process that you want to map to the subprocess dataslot and click **Add**. The parent process dataslot is added to the dataslot list. Use the other command buttons to delete, or move a selected dataslot up or down.
   b) Click **OK** to return to the **Field Properties** dialog box.

4. In the **Field properties** dialog box, enter an output dataslot name in the **Get dataslot** box to map a subprocess dataslot to an output dataslot in a parent process.

5. Click **OK**.

The dataslots to which you mapped the subprocess dataslots are displayed in the Set dataslot(s) and Get dataslot columns.

**Important:** There is a list of reserved dataslot names that should not be used as names for a user-defined dataslot in Web applications that communicate with BPM processes for; example, “workitemName”, “performer”, “returnPage”. For more information, see “Reserved Dataslot Names” section of *Application Developer’s Guide*.

### Mapping document dataslots in subprocess worksteps

If the name and data type of the dataslots in a BPM process and the dataslots in a Web application are identical, default mapping occurs between the processes. If the name or data type differ, default dataslot mapping will not work correctly. For more information on mapping dataslots in a subprocess workstep, see the Developing BPM Applications with Developer Studio manual in the OpenEdge documentation set. Mapping Document dataslots in Subprocess worksteps can demand unique document handling. Currently, information in a Document dataslot of a subprocess workstep is of the passed-by-reference type, that means, a single copy of the Document dataslot is shared between the parent process and a subprocess. Any change made to a Document dataslot in a subprocess is immediately visible in the parent process, and any change in a Document dataslot in the parent process is immediately visible in a subprocess.

The following restrictions apply when mapping document dataslots between the parent process and subprocesses:
1. Document dataslots of a parent process can only be mapped to the instance document dataslots of a subprocess. No mapping is allowed to a global document dataslot of a subprocess. The possible combinations are presented in Step Table 44 on page 202.

Table 44: Restrictions for Document Dataslots in Subprocess Worksteps

<table>
<thead>
<tr>
<th>Level of Dataslot in Parent Process</th>
<th>Level of Dataslot in Subprocess</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Instance</td>
<td>Allowed</td>
</tr>
<tr>
<td>Global</td>
<td>Instance</td>
<td>Allowed</td>
</tr>
<tr>
<td>Instance</td>
<td>Global</td>
<td>Not Allowed</td>
</tr>
<tr>
<td>Global</td>
<td>Global</td>
<td>Not Allowed</td>
</tr>
</tbody>
</table>

2. Document dataslots in a Private Flow are specific to the process instance and are removed when the process instance is completed. Doing so can lead to inconsistent data in the parent process when the subprocess is completed. Therefore, private document dataslots should not be passed from parent process to subprocess.

Note: For BPM processes, you can use the Alerts tab (which is not available for Inline subprocess workstep) to associate an alert with the Subprocess workstep when it is initially activated, completed, or as an Overdue action when it is overdue. For more information on using alerts with a workstep, see the Developing BPM Applications with Developer Studio manual in the OpenEdge documentation set.

Using the Advanced tab of Subprocess workstep properties

You can use the Advanced tab to configure advanced events for the Subprocess workstep on activation, before activation, on completion, when overdue, when an error occurs and on recovery. The Advanced tab of the Properties view for the Subprocess workstep is similar to the Advanced tab for an Activity workstep in that it contains six tabs—Before Activation, On Activation, When Completed, Overdue Actions, On Error, and On Recovery.

By default, the Advanced tab of the Subprocess workstep displays the Before Activation tab. Subprocess worksteps in Web applications have Before Activation and When Completed tabs, in which you can define the event to be executed on activation and on completion of the subprocess workstep (For more information, see Adding script to a workstep on page 214).

Figure 125: Subprocess Workstep Properties – Advanced Tab
For information on procedures for defining advanced properties of a Subprocess workstep that are similar to Activity worksteps, see Using Advanced tab of Activity workstep properties on page 186. Features in the Advanced properties of the Subprocess workstep that differ from the Advanced properties in the Activity workstep are:

1. The **On Activation** tab contains the synchronization function that provides a *Wait for the subprocess to complete before proceeding* checkbox. Select this checkbox to set the workstep as synchronous: the process waits for the subprocess workstep to be completed before proceeding.

2. The **Overdue Actions** tab does not have an **On last overdue** section. You can change performers of overdue actions only for Activity worksteps.

## Defining properties of Message worksteps

The Message workstep (✉️) allows you to use an incoming event or message to initiate a process or a workstep; and to generate an outgoing message with the completion of a workstep or a process. The Message workstep provides a way to synchronize process events and to define actionable events at various stages of the process execution. For information regarding defining messages and channels, see Managing messages and channels on page 435.

**Note:** The Message workstep is only available for Business Processes.

If the Message workstep is used to start the workflow, it indicates that one or more process instances can be directly created through messages and you are not required to go through Business Process Portal to start a process. If the Message workstep is used as a workstep within the workflow, it indicates that it will wait for a message before activating or will generate and send a message when a workstep event (for example, workstep activated or workstep completed) occurs.

Click the Message workstep to view its properties in the **Properties** view. The **Properties** view contains six tabs as shown in Step Figure 126 on page 204.

## Specifying general properties of Message workstep

From the General tab of the Properties view:

1. Enter the workstep name in the **Name** box. The workstep name appears in the process template diagram. Workstep names can contain only alphanumeric characters and the underscore (_) character.
2. Enter a label for the workstep in the **Label** box.

The label you assign to a Message workstep will appear in Business Process Portal. If no label is entered, the workstep will display an incremented label in Business Process Portal that begins with 'Message1'.

**Note:** You can enter a description (optional) for the message workstep in the **Description** tab. Description can have 4095 characters.

### Using the Dataslots tab of Message workstep properties

You can use the **Dataslots** tab to define and assign dataslots that control the information flow into and out of the Message workstep. The **Dataslots** tab is similar to the **Fields** tab for the Start workstep, but without the Header section (see Step Figure 96 on page 177). For more information, see Using the **Fields** tab of Start workstep properties on page 177.

### Using the Messaging tab of Message workstep properties

You can use the **Messaging** tab to subscribe to (or receive) a message from a local or remote server. It initiates an action in the current process template or generates and publishes (or send) a message to a local or remote server and initiates an action in a process in a remote location.

#### To define a message:

1. Use the **Mode** box to select the type of messaging: Subscriber or Publisher.
2. Click in the associated **Value** column, and then click to select one of the two options: Publish or Subscribe. Select the appropriate option.
3. If you are in the Publish Mode, a Channel row is shown. Accept the default channel or click in the associated Value column, to open a drop-down list that displays all the previously defined channels. The Channel row is not displayed for Messages in the Subscribe mode since only the BP Server channel can be used to subscribe messages.

**Note:** If you are in the Publish mode, you can only use remote channels. Local channels, such as the default BP Server channel, cannot be used to publish messages. For more information, see Using the Channel Manager on page 442.

4. Use the **Handler** box to select a handler (optional). In the **Handler** box, enter a Java class name that you want to use, to perform a specific action on the message.

5. From the **Message** row, click in the associated Value column and then click to view a drop-down list containing previously defined messages.

Selecting a message displays the Header and the payload sections.

6. In the **Header** and **Payload** sections, headers and payloads associated with the message are listed in the left column. Click in each associated Value column to display dataslots that are of the same type and are available in the current process.

   - For example, map "orderID" to an available INTEGER dataslot type named “ds1”; or map "vendor" to “VendorName”, an available CHARACTER dataslot.
   - You can also enter a value by selecting the "<enter value>" option. In the example shown in Step Figure 127 on page 204, we have entered "JonesMfgCo" in the **Enter Value** dialog box, indicating that this value is a constant and only purchase order messages requested by Jones Manufacturing Company will be processed.

**Other Message workstep properties**

Open the **Alerts** tab, in which you can associate an alert with the Message workstep when it is initially activated or when it is completed. For more information, see Associating an alert with a workstep on page 256.

Use the **Advanced** tab to configure advanced events for the Message workstep on activation, before activation, on completion, when an error occurs and on recovery. These operations are similar to those for Activity worksteps (see Using Advanced tab of Activity workstep properties on page 186).

**Defining properties of End worksteps**

End worksteps (○) mark the end of the process flow. A process template must have at least one End workstep.

Click the End workstep to view its properties in the **Properties** view. The **Properties** view (Step Figure 128 on page 206) of the End workstep for Business Processes contains four tabs. For web applications, it contains three tabs.
From the **General** tab, enter the label for the workstep in the **Label** box. Once you assign a label to an End workstep, it always appears in the process template diagram and in Business Process Portal. If no label is entered, the End workstep appears blank.

**Note:** You can enter a description (optional) for the End workstep in the **Description** tab. A description can be up to 4095 characters.

**Note:** For Business Processes, you can use the **Alerts** tab to associate an alert with an End workstep when it is activated or when it is completed. For more information, see [Associating an alert with a workstep](#) on page 256.

### Using the Messaging tab of End workstep properties

For Business Processes, you can use the **Messaging** tab to associate a message with the End workstep: the message is published (sent) when the workstep is completed. The message typically starts a new action, such as sending an e-mail. End worksteps in Web applications do not have a **Messaging** tab.

To assign a message to an End workstep:

1. From the **Messaging** tab, (right image, Step Figure 129 on page 206), expand **General**, then click in the Value column in the Enabled row, to open a drop-down list.
2. Select **True** from the drop-down list, to view Channel and Message rows.
3. Accept the default Channel or click in the Value column of the Channel row, to view a drop-down list of previously defined channels.
4. Click in the associated Value column of the Message row, to view a drop-down list of previously defined Messages. Select a message from the list: to view the Header and Payload sections.
5. Click in the Value column for each of the Header and Payload section rows to view a list of available dataslots. Select a dataslot to associate the Header or Payload item with a dataslot value.
After you have selected a message, a Message ( messageId) icon is shown within the End workstep, indicating a message will be sent when the process is completed. For more information about defining or editing messages, see Using the Message Manager on page 435.

Using the Dataslots tab for Web applications

The Dataslots tab is available for End worksteps in Web applications only. If you are planning to use the process as a subprocess, you can use the Dataslots tab to assign dataslots to the End workstep that will pass information onto the parent process.

You can add, modify, and remove dataslots assigned to the End workstep, similar to how you manage dataslots for other worksteps.

Defining properties of Decision gateways

The Decision gateway ( Decision gateway) represents a division of the control flow of the process. A Decision gateway can contain multiple incoming and outgoing connectors. For each Decision gateway, at least one of the outgoing connectors must have an empty Condition (the Default connector), and the other connectors can each contain a condition. BPM Designer follows BPMN notation by automatically displaying the default connector as a line with a slash (/) through it.

Alternatively, you can get the equivalent of a Decision gateway by adding multiple outgoing connectors to a successor Activity workstep, and assigning a specified condition to some of the connectors. With this type of connector, any connectors with conditions are indicated by a small diamond (Diamond) at the start of the connector, and the default connector as a line with a slash (/) through it. Once the predecessor workstep is completed, one or more successor worksteps will be activated if conditions in the connectors are fulfilled.

Note: It is possible that the number of outgoing connectors for a Decision gateway can be more than the number of incoming connectors. This can occur when a Decision gateway has more than two outgoing connectors and two or more of these connectors fall within the probability range and are activated, resulting in an apparent discrepancy in simulation data. For an Exclusive Decision (see Defining Exclusive Decisions on page 208), however, only one outgoing connector is activated and the number of outgoing connectors will always be equal to the number of incoming instances.

Click the Decision gateway to view its properties in the Properties view. The Properties view of a Decision gateway includes two tabs—General and Description.

Figure 130: Decision Gateway Properties
To define properties for the Decision gateway:

1. From the General tab, modify (if required) the name of the Decision gateway in the Name box. Enter the label for the gateway in the Label box. Once you assign a label to a Decision, it always appears in the process template diagram. If no label is entered, the Decision is blank.

2. To make the Decision gateway an exclusive decision gateway, select the Exclusive checkbox (available for Business Processes only). For details, see Defining Exclusive Decisions on page 208.

3. The Links section contains a table that lists all the multiple outgoing connectors (and condition, if any) from this gateway. You can modify or remove any connector by selecting it and then clicking Modify or Remove. For information on defining connector properties, see Defining link properties on page 211.

Note: You can enter a description (optional) for the Decision gateway in the Description tab. A description can be upto 4095 characters.

---

**Defining Exclusive Decisions**

An Exclusive Decision indicates that the workflow can go through only one outgoing connector, while the typical Decision executes all connectors that meet specified conditions. To set the Decision gateway as an Exclusive Decision gateway, select the Exclusive checkbox. When you select the Exclusive checkbox, the Move Up and Move Down buttons are displayed (Figure 131 on page 208), allowing you to establish the sequence of the outgoing connectors.

![Figure 131: Exclusive Decision Gateway Properties](image)

This ordering is important because connectors are evaluated in sequence, and the first connector that fulfills the specified condition is executed. The remaining connectors are not evaluated.

In an Exclusive Decision, there must be only one default connector (that is, a connector with no condition). This connector is executed when conditions on the other connectors are not fulfilled. If there is more than one default connector or if there is no default connector, an error is displayed.

Once you have defined the Decision as an Exclusive Decision gateway, it is displayed as a Decision gateway with an ‘X’ through it ( ). According to BPMN conventions, the appearance of the Exclusive Decision icon is the same as that of the Exclusive Or-Join (XOR) icon. The Exclusive Decision differs in that it has a single predecessor workstep and multiple successor worksteps.

Note: The Exclusive Decision gateway is not available for Web applications.
Defining conditions in links from decisions

The condition associated with a connector coming from a Decision gateway uses Java operators that include “&&” for AND and “| |” for OR. The expression reads from left to right and can be as long as required. Only user-defined dataslots can be used as the variables.

BPM Designer also provides expression validation: that means, expressions are checked and validated at design time, not at runtime. Application developers are notified of any errors in the expressions and can correct the errors before executing the application.

Accessing dataslot values in a link

You can compare dataslots by accessing a dataslot’s value in a condition statement. For instance, if you have two dataslots (of type CHARACTER) such as TotalNumber and CurrentNumber, then you can express a condition as: CurrentNumber<TotalNumber.

You can also make different combinations using the AND and OR operators. You should not use parentheses. The expression evaluates from left to right. For instance, you can have: CurrentNumber>MinimumNumber AND CurrentNumber<TotalNumber.

Defining properties of Or-Join gateways

You can use an Or-Join gateway to connect multiple predecessor worksteps to one successor workstep. The successor workstep is performed only when any one of the predecessor worksteps are completed. The most common use of an Or-Join gateway is with a loop back or to connect to an End workstep. Alternatively, you can get the equivalent of an Or-Join by adding multiple incoming connectors to an Activity workstep, and this workstep will be activated when any of its predecessor worksteps are completed.

Click the Or-Join gateway to view its properties in the Properties view. The Properties view of the Or-Join gateway contains a General tab and a Description tab.

The Name, Label, and Description are not displayed in the process template diagram, but are displayed as text entries in the process summary.

Figure 132: Or-Join Properties
Defining properties of Exclusive Or-Join gateways

You can use an Exclusive Or-Join gateway (XOR) to direct the process workflow to proceed only once from multiple predecessor worksteps to a successor workstep. When the Exclusive Or-Join (XOR) gateway is completed, any other predecessor human-performed worksteps that immediately precede the XOR are terminated. According to BPMN conventions, the Exclusive Or-Join (XOR) icon is the same to that of the Exclusive Decision icon. The Exclusive Or-Join (XOR) differs in that it has multiple predecessor worksteps and a single successor workstep.

Click the Exclusive Or-Join gateway to view its properties in the Properties view, which is similar in functionality as that for Or-Join gateway.

**Note:** The Exclusive Or-Join gateway is supported only in Business Processes.

**Figure 133: Exclusive Or-Join example**

The XOR gateway allows workflow to proceed from only one of the predecessor worksteps. This action differs from the Or-Join, which would allow workflow to continue from Activity 1, 2, or 3 as each of these Activity worksteps are completed.

**Note:** The XOR gateway functions correctly (that is, terminates the remaining predecessor worksteps) only if the predecessor worksteps are all human-performed Activity worksteps.
Defining properties of AND gateways

You can use an AND gateway (ederation) to connect multiple worksteps to one successor workstep, or a single predecessor workstep to multiple successor worksteps. The successor workstep is activated only if all the predecessor worksteps are completed. This feature enables you to synchronize the completion of multiple predecessor worksteps. When an AND gateway has multiple incoming connectors, it must have a single outgoing connector: in this case, the AND Gateway acts as an And-Join. When an AND Gateway has a single incoming connector, it can have multiple outgoing connectors: in this case, the AND Gateway acts as an And Fork (or Split). These variations in incoming and outgoing connectors for AND gateways are illustrated in Figure 45 on page 99.

Click the AND gateway to view its properties in the **Properties** view, which is similar in functionality to that of the Or-Join gateway.

**Note:** The AND gateway is supported only in Business Processes.

Defining link properties

You can use the **Connect Shapes** link in the Tasks pane (see Connecting worksteps on page 96) to define the workflow connection (or links) between process template elements. You can either use the Normal Flow to link worksteps in the workspace, or the Compensation Flow to define the workflow in the event of a rollback (see Defining a Rollback on page 216), or the Time-out Flow (see Defining a Timeout in worksteps on page 218).

You can define links with or without conditions. In Decision gateway (see Defining properties of Decision gateways on page 207), you can modify an existing link condition in the **Properties** view, as described in this section.

For Business Processes

You can now assign a condition to a link in the process template diagram. In previous releases, you could assign a condition only to a link from a Decision gateway. Once you assign a condition to a link that does not have a Decision as a predecessor workstep, the link becomes the equivalent of a Decision gateway.

To define the properties of a standard link in Business Processes:
Figure 134: Link Properties – Basic Setting

1. Click the link to view its properties in the **Properties** view.

2. Assign a name to the link in the **Name** box, and add a label in the **Label** box of the **General** tab.

3. To assign a condition to the link, clear the **Default** checkbox to view the **Basic** and **Advanced** settings. By default, the **Basic** setting is displayed. For information on **Advanced** settings, see Step 5 below.

4. Use the features of the **Basic** setting to build an expression based on existing conditions.
   a) Select a dataslot from the drop-down list on the left (the Basic mode only includes CHARACTER, INTEGER, INT64, LOGICAL, and DateTimeTZ dataslot types; the Advanced mode includes all data types). Select an operator from the adjacent drop-down list. Operator values change, depending on the dataslot type: For example, a CHARACTER dataslot displays more options than a INTEGER dataslot.
   
   **Tip:** If you want to evaluate a Null value for a CHARACTER dataslot, you only need to select ‘is null’ from the Operator drop-down list.

   b) Select a dataslot from the drop-down list on the right, or select **Enter value** option to open the **Enter Value** dialog box, in which you can enter a static value.

   c) Click ![add condition icon] to add another condition, enabling the And/Or operand.

   d) Select **And** or **Or** and add as many conditional expressions as required.

   e) To remove a conditional expression, click ![remove condition icon].

5. To configure the condition using Advanced settings, select **Advanced** option to view a list of dataslots and a **Condition** text area (Figure 135 on page 213) wherein you can build more complex expressions or to cut and paste expression that have been defined elsewhere.

**Note:** For a business object dataslot in your process, type the name of the dataslot (for example, `bods1`) to view all the attributes of the associated business object. You can select any of the listed attributes.
Defining link properties

Figure 135: Link Properties – Advanced setting

![Advanced setting for link properties](image)

- You can enter or paste an expression in the **Condition** text area, or drag a dataslot from the Dataslot list to add it to the advanced condition.
- When you add an expression in the **Advanced** setting, it overwrites all expressions which you created in the **Basic** setting. Click **Validate** to verify if the expression is valid.
- Click **Basic** option to delete the expressions in the **Advanced** setting and to return to the **Basic** setting.

**Note:** You can enter a description (optional) for the link in the **Description** tab. A description can be up to 4095 characters.

For Web applications

To define the properties of a link from an Activity workstep in Web applications:

**Figure 136: Link properties in Web applications**

![Web application link properties](image)

1. Click the link to view its properties in the **Properties** view.
2. Assign a name to the link in the **Name** box and enter the label in the **Label** box.
3. BPM Designer supports three types of links for Web applications namely, **Submit button**, **Hyperlink**, and **Image**. Select the link type from the **Type** list.
   - Select the **Submit button** option to display a **Submit** button on the interface page. Data is passed on from this interface page to the next interface page. Enter text in the **Label** box to be displayed as the name of the button, replacing the default Submit label for the button.
Chapter 14: Setting workstep properties

Note: For detailed information about creating multiple submit buttons out of a workstep, see Creating multiple command buttons in web applications on page 250.

- Select the **Hyperlink** option to create a line of text on the interface page that functions as a hyperlink. The hyperlink connection is displayed as a dotted line (••••••••). In the Label box, enter the hypertext label that you want to appear on the image or text link seen on the workstep interface page in your browser. You can also open the dialog box in your browser to add a brief description that will appear when you move the mouse over the image.

- Select the **Image** option to create an image link on the interface page. In the Label box, enter the hypertext label to be displayed on the image or text link seen on the workstep interface page in your browser. Specify the image file name to appear on the workstep interface in the Image box. Store application images under the Workspace_Home\<ProjectName>\<ProcessName>\images folder for a single application or under the Workspace_Home\common\images folder for shared images for multiple applications. For images stored outside the Progress Developer Studio for OpenEdge installation directories (for example, in a Web server folder), specify the full URL in the Image box. Select the Submit checkbox, to ensure that information from dataslots on the current interface page is passed on the next interface page. If the Submit checkbox is cleared, no data is passed on to the next interface page and the link in the process template diagram is displayed as a dashed line, not a solid line.

Note: You can enter a description (optional) for the connector in the **Description** tab. A description can be upto 4095 characters.

When using links in Web applications, please note that:

- You must select the **Submit** checkbox for Image types of connectors in order to pass on data to the next page.

- Activity worksteps that includes output dataslots can use a link of the link type. Image type links can be used only if the Submit checkbox is selected. Activity worksteps without output dataslots must contain connectors of the Image type, or a connector type with a value.

- Selecting **Submit button** as the link type for an Activity workstep automatically creates a **Submit button** in the application interface. You can override the default “Submit” label by entering a label name in the Label box of the **Properties** view for the link.

Adding script to a workstep

You can use script to add customized business logic into worksteps in processes. Adding Java or JavaScript (for Business Processes) or Java (for Web applications) to a workstep enables you to accomplish a wide range of activities, including:

- Executing rules as an Adapter workstep, without having to write a Java program.
- Manipulating dataslots within a workstep, without having to write an adapter.
- Performing a Script’s regular expressions, searching function and pattern matches, as well as using its Math Library feature, to run complex calculations on dataslot values.
In Business Processes, you can use Java or JavaScript to add customized business logic to Start, Activity, Adapter, Subprocess, and Message worksteps. In Web applications, you must use Java to add customized business logic into all these worksteps, except Message (which is not supported). Each of these worksteps include an Execute script function in their respective Properties view. From the Advanced tab of the respective workstep’s Properties view, use the following supported tabs to define the action scripts.

Table 45: Script Tabs

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Purpose</th>
<th>Supported worksteps (Business Process)</th>
<th>Supported worksteps (Web)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before Activation</td>
<td>Executes the script before the workstep is started, but after the precondition is executed.</td>
<td>Activity, Adapter, Subprocess, and Message</td>
<td>Start, Activity, Adapter, and Subprocess</td>
</tr>
<tr>
<td>When Completed</td>
<td>Executes the script after the workstep is completed.</td>
<td>Start, Activity, Adapter, Subprocess, and Message</td>
<td>Start, Activity, Adapter, and Subprocess</td>
</tr>
<tr>
<td>Overdue Actions (Scripts tab in Overdue Actions)</td>
<td>Executes the script when an action is overdue.</td>
<td>Activity, Adapter, and Subprocess</td>
<td>Not supported</td>
</tr>
<tr>
<td>On Recovery</td>
<td>Executes the script after a rollback has recovered the specified data.</td>
<td>Activity, Adapter, Subprocess, and Message</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

Note: BPM Designer automatically converts any previous BP Server/BPM Webflow expressions to the current Java-style expressions.

To add Script to a workstep:

1. Open a workstep’s Properties view, and click the Advanced tab.
2. From the Advanced tab, click the appropriate tab wherein you want to add the script.
3. You can use the Execute script box to define the script. Click Add Script. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see Using the GEL tool in BPM projects on page 311.
Defining a Rollback

BPM Designer allows you to add a “rollback” operation to a workstep in a Business Process, which has already been completed earlier in a process; that is, the workflow is restarted from the designated rollback workstep in the process. This process is required to restore the original information and eliminate the numerous changes that can occur to the process between the designated rollback workstep and the currently activated workstep.

To define the Rollback, you must set a workstep as a rollback point and specify which dataslot values are saved. In addition, you have the option of:

• Writing JavaScript code to handle a rollback request.
• Configuring an Activate workstep that, after the rollback is performed, activates the given workstep and returns to the same state as when that workstep was first performed.

In a rollback, the workflow will be restarted from the workstep selected as the rollback point in the process. You can only apply a rollback point to Activity, Adapter and Subprocess worksteps in Business Processes.

You can define a rollback either by using the Compensation Flow type of connector or by using the workstep’s Properties view.

Using the Compensation Flow connector

You can use the Compensation Flow connector (see Connecting worksteps on page 96) to define the workflow in case of a rollback.

1. Click the Connect Shapes link in the Tasks pane, to view the three supported Flow types.

2. Click the Draw compensation flow connectors icon and connect the workstep that initiates the rollback to the rollback point workstep from where the workflow will be restarted.

Note: For detailed information on using JavaScript and for JavaScript examples, see “Using JavaScript in a Workstep” section of the Application Developer’s Guide.
An example of a rollback is shown in Figure 138 on page 217, in which Activity 5 initiates the rollback and Activity 1 is the Rollback Point.

**Figure 138: Example of a Process with Rollback and Timeout**

Inserting a Compensation Flow automatically makes the target workstep the rollback point. As seen in Figure 138 on page 217, the Rollback Point workstep is marked with a icon and the start of the Compensation Flow connector is indicated by the link.

**Using Properties view**

You can also define a rollback using the Advanced tab of the workstep's Properties view.

**Figure 139: Rollback Point in Advanced Tab**

To define the rollback point:
1. Click the **Advanced** tab of the **Properties** view of the target workstep to which you want to roll back.

2. From the **On Activation** tab, select the **Create rollback point** check box.

   **Note:** The first time a rollback workstep is activated, BP Server takes a snapshot of all selected dataslot values for later replacement.

3. To select one or more dataslots that will retain their original values during a rollback, click the **ellipsis** button beside the **Save dataslot values for** box, to open the **Save dataslot values** dialog box.

   You need to specify the dataslot names for replacement because some processes use many dataslots and restoring all dataslot values in each rollback can compromise server performance. This option helps the workflow process to replace the selected dataslot values with the original dataslot values.

   a) To add dataslots, click **Add** to open the **Select Dataslots** dialog box, in which you can select any dataslots containing the value you want to save. Click **OK** to add it to the **Save Dataslot Values** table.

   **Note:** To remove one or more dataslots from the table, select the dataslot names and click **Remove**. To edit a user-defined dataslot, select the dataslot and click **Modify**.

   b) Click **OK** to save your selections.

### Activating rollback point

**To activate specific rollback points for other worksteps that may fail:**

1. Click the **Advanced** tab of the **Properties** view of the workstep from where you want to roll back.

2. From the **On Error** tab, select the rollback point option from the **Activate rollback point** drop-down list.

   **Note:** For detailed information about creating an application using the Rollback Process, see the *Application Developer's Guide*.

### Defining a Timeout in worksteps

You can use the Timeout feature to indicate the direction of a process workflow after Overdue Actions for the workstep have been executed and the Last Overdue action is completed.

**To define a Timeout:**

1. Click the **Connect Shapes** link in the Tasks pane, to display the three supported Flow types.

2. Click the **Draw time-out flow connectors** icon and connect the workstep that begins the timeout flow to the next workstep in the timeout workflow.
In the example shown in the Figure 138 on page 217, Activity 2 initiates the timeout and Activity 3 is the next step in the Timeout flow. The source workstep of a Timeout Flow is marked with a ☥. The Activate timeout flow checkbox in the On Overdue tab of the Advanced tab of the target workstep's Properties view is automatically activated.

Figure 140: Activate Timeout Flow Option in On Overdue Tab

3. To remove the Timeout Flow, clear the Activate timeout flow checkbox, or right-click the Timeout Flow connector and click Remove.

Managing multiple worksteps

You can perform the same operation on multiple worksteps in a process template using the Select icon in the palette.

Modifying multiple workstep properties

You can simultaneously edit multiple worksteps of the same type. For example, you can select all Activity worksteps in a process template and assign the same performer to all, or change the Priority of all Adapter worksteps at the same time.

To modify multiple worksteps:

1. Click the Select (えば) icon in the palette and drag the worksteps to be selected.
   Alternatively, you can press CTRL and then click the worksteps to be selected.
2. Modify properties such as the performer, priority, and duration, as required. For instance, change the priority to Critical.

**Aligning and spacing worksteps**

BPM Designer allows you to align selected worksteps and distribute selected worksteps at equal intervals.

To align worksteps or other components in a process template diagram:

1. Use the **Select** tool to select the worksteps and other components that you want to align.
2. Click the **Select and Change Layout** link in the Tasks pane, displaying the Layout options in the **Layout Tasks** panel.
Table 46 on page 221 lists the available layout options.

Table 46: Layout options

<table>
<thead>
<tr>
<th>Layout Operation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align shapes horizontally</td>
<td>To align the selected components horizontally.</td>
</tr>
<tr>
<td>Align shapes vertically</td>
<td>To align the selected components vertically.</td>
</tr>
<tr>
<td>Distribute shapes evenly on the horizontal</td>
<td>To evenly space the selected components horizontally. If you select more than two components, only the components between the one on the far left and the one on the far right are moved.</td>
</tr>
<tr>
<td>Distribute shapes evenly on the vertical</td>
<td>To evenly space the selected components vertically. If you select more than two components, the uppermost and lowermost components are not moved and the other components are evenly distributed in reference to the upper and lower components.</td>
</tr>
<tr>
<td>Auto layout</td>
<td>Generates an ideal layout for process template elements, thus eliminating the need for manual adjustment.</td>
</tr>
</tbody>
</table>
Chapter 14: Setting workstep properties
Introducing monitoring process

Progress Developer Studio for OpenEdge enables you to design and configure a Monitoring process, which uses business events to monitor an external process on Business Process Server platform. This chapter describes how you can create a monitoring process.

Note: For detailed description of the working of monitoring process, see Chapter 29: "Working with Monitoring process" in BP Server Developer’s Guide.

For details, see the following topics:

- Introduction
- Designing a monitoring process
- Using process refresh
- Simulating a monitoring process

Introduction

A monitoring process offers complete insight into an existing process, which can be executing on packaged applications such as ERP, CRM, or legacy applications. As the monitoring process is executed and moves from one state to the next, Business Process Server can capture monitoring information: this provides an end-to-end visibility into the process for business users.

A monitoring process:

- Retrieves performer information along with other data from the event.
• Records the time stamp of the event as and when it occurs, rather than when the event is received by Business Process Server.

• Handles events that are received in a different sequence than the sequence of occurrence. For example, if A-B-C-D is the sequence in which events occur, they may be received in the sequence A-B-D-C. The monitoring process takes care of such anomalies.

A monitoring process must contain one user-defined CHARACTER dataslot, identified as External Instance ID (EIID). This dataslot can have null value and is used to identify each instance of the monitoring process. The value of EIID must be unique across all instances of the monitoring process. For example, for an “Order” process, the “Order ID” is unique across multiple orders and can be selected as the EIID.

Supported events

A monitoring process supports the following types of external events. For more information regarding external events, see the BP Server Developer’s Guide.

Table 47: Supported events

<table>
<thead>
<tr>
<th>Operation Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATE_INSTANCE</td>
<td>This event triggers the creation of the process instance of the monitoring process in Business Process Server. The event contains the EIID, whose value is unique for this process instance.</td>
</tr>
<tr>
<td>ACTIVATE_WORKSTEP</td>
<td>This event triggers the activation of the workstep in the monitoring process. The target workstep is identified by values of the EIID, process name, and workstep name in the event.</td>
</tr>
<tr>
<td>COMPLETE_WORKSTEP</td>
<td>This event triggers the completion of the workstep in the monitoring process. The target workstep is identified by values of the EIID, process name, and workstep name in the event.</td>
</tr>
<tr>
<td>UPDATE_DATASLOT</td>
<td>This event updates the dataslot values in the process instance of the monitoring process in Business Process Server. The instance is identified on basis of the EIID and process name in the event.</td>
</tr>
</tbody>
</table>

Designing a monitoring process

You can create a Business Process (as discussed in Creating a Business Process on page 48) that can be used as a monitoring process. The following restrictions apply to a monitoring process:

• It must include at least one monitoring workstep. A monitoring workstep can be of type, External activity or adapter, which receives external events for activation and completion.

• It must include a CHARACTER dataslot selected as the EIID, as discussed in Assigning EIID on page 228.

• Any dataslot, associated with a monitoring workstep, must be editable, so that its value can be modified by the external event. For more information, see Using dataslots on page 229.
Configuring monitoring workstep

Setting workstep properties on page 173 describes how you can add and configure activity, adapter and other workstep types in BPM Designer. Similarly, you can add and configure monitoring worksteps for tasks performed by external participants.

BPM Designer supports the following types of monitoring worksteps performed by external participants:

- **External Activity**: This workstep is performed by an user, specified in the triggering event. In case the event does not include the performer’s name, you can configure a default performer for this workstep.

  **Note**: The name of the external performer, as well as the default performer, need not be defined in your monitoring process template.

- **External Adapter**: This workstep is triggered and performed by an external system performer.

  **To add a monitoring workstep:**

  1. Create a Business Process using Progress Developer Studio for OpenEdge.
  2. From the Tasks pane, click the Assign Participants link and expand the External folder.
     a) To add an external activity workstep, drag the External User icon.
     b) To add an external adapter workstep, drag the External Adapter icon.

  **Figure 144: Adding monitoring workstep**

  ![Diagram of monitoring worksteps](image)

  Similar to activity and adapter worksteps, you can use the Properties view to configure workstep properties for the external activity and adapter worksteps.
Figure 145: External activity workstep properties – General tab

Step Figure 145 on page 226 displays the General tab of the Properties view for an external activity workstep. The Properties view is similar to that for an Activity workstep (as discussed in Defining properties of Activity worksteps on page 180) with the following exceptions:

- From the General tab, you cannot assign or change the performer in the Performer box. This is because the performer is from the external system and need not exist in the current process template.

- In addition to selecting an individual performer or dataslot, you can use the Default performer box to specify a performer, who does not exist in the current process template. For more information, see Default performer for monitoring workstep on page 227.

- If you select the Wait For Activation checkbox, then the external activity workstep waits and processes the ACTIVATE_WORKSTEP event before proceeding with the COMPLETE_WORKSTEP event, even if it has arrived. If the Wait For Activation checkbox is not selected, then the workflow processes the event which comes first. For example, if COMPLETE_WORKSTEP event comes before ACTIVATE_WORKSTEP event, then it is processed and the ACTIVATE_WORKSTEP event is moved to invalid event table.

- The General tab does not contain Priority, Presentation, Skippable, and Collect Work Time fields, as they are not applicable of a monitoring workstep.

- You can use the Dataslots tab to add dataslots. For more information, see Using dataslots on page 229.

- There is no Collaboration tab, because it is not required in a monitoring workstep.

- The Advanced tab contains only the following tabs:
  - The Before Activation and When Completed tab, in which you can only enter the respective code to be executed.
  - The On Overdue tab does not contain the Change Performer and Complete workstep checkboxes.

**Note:** You can also configure these properties by right-clicking on the external activity and external adapter worksteps and selecting Properties. For more information, refer to Workstep properties on page 175.

**Note:** You can configure the remaining external activity properties, as discussed in Defining properties of Activity worksteps on page 180.
Figure 146: External adapter workstep properties – General tab

![Figure 146: External adapter workstep properties – General tab](image)

Step Figure 146 on page 227 displays the General tab of the Properties view for an external adapter workstep. The Properties view is similar to that for an external activity workstep. The only exception is that there is no default performer, because this field is not applicable for an adapter workstep.

**Default performer for monitoring workstep**

You can specify a default performer for an external activity workstep, by clicking the ellipsis button beside Default performer box in the General tab (Step Figure 145 on page 226), and then performing any of the following operations by selecting the appropriate option:

- To assign an existing performer:
  1. Select the Select a Performer option. The Performer dialog box appears, which lists all the performers in the current process.
  2. Select any of the performers listed and click OK to assign the selected user as the default performer.

- You can create and assign a new performer as a default performer. To create and assign a new performer:
  1. Select the Select a Performer option.
  2. From the Performer dialog box, click New to open the Performer dialog box.
  3. Enter the name of the performer in the Name box.

  Alternatively, click the ellipsis button beside the Name box, then select either of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an Existing User</td>
<td>To add a user defined in the User Management tool (see Working with User Management tool on page 417).</td>
</tr>
<tr>
<td>Use a Dataslot</td>
<td>To select a CHARACTER dataslot as the performer.</td>
</tr>
</tbody>
</table>

  4. Click OK to add the selected performer to the list of performers in the Performer dialog box.
  5. Click OK to assign the new performer as the default performer.
• You can add a performer that does not exist in the process template.
  1. Select the **Enter a new value** option
  2. From the **Default Performer** dialog box that appears, type the name of the performer.
  3. Click **OK** to assign the specified performer as the default performer.

To change the default performer, click the **ellipsis** button beside the **Default performer** box, and select the **Select a Performer** option. From the **Performer** dialog box that appears, select another performer from the list of available performers.

To remove the selected default performer, click the **ellipsis** button beside the **Default performer** box, and select the **Clear** option.

### Assigning EIID

You can assign an EIID to the monitoring process after adding a monitoring workstep. You can assign only one dataslot as the EIID.

The dataslot assigned as the EIID must satisfy the following requirements:

- Must be User-defined with type, CHARACTER.
- Value must be unique across all instances of the monitoring process.
- Storage type must be VARCHAR with size 128.

**To assign the EIID to a monitoring process:**

1. Click a blank area of the **Diagram** tab, to open the **Properties** view. For details regarding process properties, see **Setting process properties** on page 119.

   The **Properties** view displays the additional **Monitoring** tab.

   ![Figure 147: Process Properties – Monitoring tab](image)

2. Click the **ellipsis** button beside the **External Instance Id Dataslot** box and then select one of the following options:

   - **Use a User Dataslot**: The **Select Dataslot** dialog box that appears, lists the user-defined CHARACTER dataslots in this process. Select a dataslot, then click **OK** to assign it as the EIID. Alternatively, you can click **New** to create a CHARACTER dataslot and then assign it as the EIID.
   - **Use ProcessInstanceId**: Assigns the system dataslot, “ProcessInstanceId”, as the EIID.

The assigned dataslot is displayed in the **External Instance Id Dataslot** box. To clear this selection, click the **ellipsis** button beside the **External Instance Id Dataslot** box and then select the **Clear** option.
Using a Subprocess

In some cases, you may need to use multiple EIID s in the same monitoring process. For example, an “Order” process requires a unique Order ID during ordering, as well as Shipment ID during product shipment.

You can handle this requirement by using a subprocess. In the above example, the subprocess can handle the shipment process. For more information regarding subprocesses, see Defining a subprocess performer on page 136.

Note: You cannot use an inline subprocess to handle this requirement.

As the subprocess is an independent process model, it can have its own EIID (for instance, ShipmentID), which can be mapped to a dataslot from the parent process. If required, the parent process can pass on its EIID (example, OrderID) to the subprocess at the time of its creation.

Important: Ensure that the value of the dataslot in the parent process, mapped to the EIID of the subprocess, is not null (or empty); otherwise the subprocess instance will be suspended.

Using dataslots

Table 49 on page 229 lists the dataslot types that you can assign to a monitoring workstep in the monitoring process.

Table 49: Supported dataslots

<table>
<thead>
<tr>
<th>Dataslot</th>
<th>Java Type</th>
<th>Comments (if any)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>String</td>
<td>Any character length longer than the maximum length specified for the process template, is truncated.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>Double</td>
<td></td>
</tr>
<tr>
<td>INT64</td>
<td>Long</td>
<td></td>
</tr>
<tr>
<td>LOGICAL</td>
<td>Boolean</td>
<td></td>
</tr>
<tr>
<td>DATETIME-TZ</td>
<td>Long</td>
<td>Date must be specified in milliseconds.</td>
</tr>
<tr>
<td>LIST</td>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Map</td>
<td>Map</td>
<td></td>
</tr>
</tbody>
</table>

Note: Dataslots of the type Object and Business Object are not supported for monitoring process.

The following business events can modify the value of the dataslots in the monitoring process instance.
• **UPDATE_DATASLOT**: This event can update the value of any user-defined dataslot (of the type listed in Table 49 on page 229) in the monitoring process, including those dataslots not added to the monitoring workstep. This event identifies the process instance using the EIID value, before updating the dataslot values. If the value of the dataslot passed on by the event is invalid, then the dataslot update fails.

• **COMPLETE_WORKSTEP**: This event can only update the values of the dataslots (of the type listed in Table 49 on page 229), added to the monitoring workstep. This event triggers the completion of the monitoring workstep, only after updating the dataslot values. If the value of the dataslot passed on by the event is invalid, then the dataslot update fails.

**Note:** The UPDATE_DATASLOT and COMPLETE_WORKSTEP events cannot update the EIID value.

**To add a dataslot to a monitoring workstep:**

1. From the **Properties** view of the workstep (external activity or adapter), click the **Dataslots** tab.

   **Figure 148: Monitoring workstep properties – Dataslots tab**

   ![Monitoring workstep properties – Dataslots tab](image)

2. Click **Add** to open the **Select Dataslots** dialog box, which lists all the user-defined dataslots in the monitoring process.

   **Note:** You must add only editable dataslots to a monitoring workstep.

3. Select the dataslot to be added, then click **OK** to add the dataslot to the table in the **Dataslots** tab.

**Using process refresh**

BPM Designer provides the Process Refresh feature, which allows you to refresh an installed application on Business Process Server servers. For information regarding process refresh, see *Managing changes in Business Processes* on page 513.

All the restrictions and rules of process refresh are applicable for a monitoring process as well. Note that:

• The dataslot marked as the EIID cannot be changed.

• Converting a monitoring workstep to other workstep types (or the converse) is supported for process refresh.

• The value of the EIID in all process instances of the monitoring process being refreshed, must be unique or null.
Simulating a monitoring process

Progress Developer Studio for OpenEdge provides the Simulation feature, which allows you to configure and execute simulation for Business Processes. For information regarding simulation, see Configuring and running simulation on page 353.

You can configure and run simulation for a monitoring process the same way you simulate any other process in Progress Developer Studio for OpenEdge. You need to remember the following points for optimum performer utilization in a simulation run for a monitoring process:

- The Simulation project considers a separate individual performer for each external activity workstep. For example, if your monitoring process contains four external activity worksteps, simulation considers four separate individual performers, each listed as “Performer of <external_activity_workstep_name>” in the list of performers.

- There may be cases of multiple external activity worksteps, being performed by the same external user. In such cases, the implementation (in the previous bulleted point) will not indicate the accurate performer utilization. To resolve this issue, you need to enter the same performer name as the default performer in each workstep.
Defining workstep presentation format

OpenEdge BPM Designer allows you to add multiple presentation types such as Portal, Mobile, GUI, Rollbase and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

The presentation formats available are:

- **Portal**:  
  - **Auto-generated**: This is the default HTML presentation form, automatically generated at runtime in Business Process Portal.
  - **Form**: Enables you to design the presentation using the Form Editor wherein you can create more complex interfaces with multiple columns, radio buttons and other formatting, and bind these fields to specific dataslots. You can then load and save the new form.
  - **Custom**: Enables you to define a customized Java Server Page (JSP) which is generated from an XSL transformation.
  - **Flow**: Available only for Business Processes. Enables you to start and design a Web application from a Business Process.
  - **Flow (private)**: Available only for Business Processes. This is the same as the Flow format but can be used only in the process template in which it is placed.

- **Mobile**: Available only for Business Processes. Enables you to complete an activity workstep (in a Business Process) on a Mobile device.
- **GUI**: Available only for Business Processes. Enables you to complete an activity workstep from a GUI for .NET desktop application.
- **Tablet**: Available only for Business Processes. Enables you to complete an activity workstep on a Tablet.
• **Other**: Available only for Business Processes. You choose Other to complete an activity workstep using an interface other than the options listed above. For example, if you want to complete an activity workstep on an iPad, you select Other as the presentation type for the activity in Business Process.

• **Rollbase**: This presentation type is to help users to view/edit/complete worksteps from a Rollbase application.

This chapter describes how to define presentation (or interface) types for Business Processes and Web applications.

For details, see the following topics:

• Defining workstep presentation for Business Processes
• Defining workstep presentations for Web applications
• Using the Form presentation

---

### Defining workstep presentation for Business Processes

You can change the look and feel of the presentation pages for Start or Activity worksteps in Business Processes. You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, a Rollbase application or a Tablet device.

**To define the presentation format:**

1. Click the Start or Activity workstep in the process template to display its properties in the Properties view.
2. From the General tab, click the Add button from the Presentation section (left image, Figure 149 on page 234) to display the Add Presentation dialog box (right image, Figure 149 on page 234).
3. Select Portal from the Type drop-down list. Other presentation type options available are Mobile, GUI, Tablet, Rollbase and Other.

**Figure 149: Add Presentation dialog box**

![Add Presentation dialog box](image)

**Note**: You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, a Rollbase application or a Tablet device.
4. Select the presentation format option from the Form Type drop-down list. The options are Auto-generated, Form, Custom JSP, Flow, and Flow (private).

5. If required, modify the presentation name in the Name box. You cannot specify a name for the Auto-generated format.

Alternatively, you can map worksteps (with Custom JSP and Flow presentations) to CHARACTER dataslots to dynamically associate the workstep with a JSP file or a Web application respectively. You need to set the initial value of the CHARACTER dataslot to a Web application (*.BpmWebFlow) or a valid JSP file (existing in the <project_name>/jsp folder). This feature is not available for Web applications.

a) From the Form Type drop-down list, select the appropriate option. The available options are Custom JSP, Flow, and Flow (private). The Form Type drop-down is not available for Mobile, GUI, Tablet, or Other as the presentation types.

b) Click the ellipsis button beside the Name or URL text field, then select Use a Dataslot option to display the Add Dataslots dialog box. Select the CHARACTER dataslot to be mapped to the workstep presentation, then click OK to add the dataslot in the Name box.

6. Click OK, to return to the Properties view.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

For more details regarding each of the presentation formats available for BPM processes, refer to Table 50 on page 235.

**Table 50: Presentation Format for Business Processes**

<table>
<thead>
<tr>
<th>Presentation Type</th>
<th>Format</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Auto-generated</td>
<td>Defining Auto-generated HTML presentations on page 236.</td>
<td></td>
</tr>
<tr>
<td>Portal Form</td>
<td>Using the Form presentation on page 252.</td>
<td></td>
</tr>
<tr>
<td>Portal Custom</td>
<td>Defining custom presentations on page 236.</td>
<td></td>
</tr>
<tr>
<td>Portal Flow</td>
<td>Using a Flow presentation on page 238.</td>
<td></td>
</tr>
<tr>
<td>Portal Flow (private)</td>
<td>Using a Flow (private) presentation on page 240.</td>
<td></td>
</tr>
<tr>
<td>Mobile -</td>
<td>Defining Mobile presentation on page 242</td>
<td></td>
</tr>
<tr>
<td>GUI -</td>
<td>Defining GUI presentation on page 244</td>
<td></td>
</tr>
<tr>
<td>Tablet -</td>
<td>Defining Tablet presentation on page 245</td>
<td></td>
</tr>
</tbody>
</table>
Defining Auto-generated HTML presentations

Progress Developer Studio for OpenEdge provides a default HTML presentation for Start and Activity worksteps, automatically generated at runtime in Business Process Portal. For instance, the Assignment sample application uses the auto-generated format.

Figure 150: Default Presentation Format for the Assignment Application in Business Process Portal

Business Process Portal uses the Header options and dataslots specified in the workstep’s Properties view (see Using the Fields tab of Start workstep properties on page 177). In addition to Header options that include the Instruction and Priority fields directly under the heading, Business Process Portal also displays fields corresponding to the read-only and editable dataslots specified in the Fields tab in the workstep’s Properties view. In the figure above, the Task name, Assignee, Priority, Due Date, and Instructions boxes are editable; that is, you can enter data in these fields and the data is passed on to the next workstep.

Note: If you enter a file name without an extension for the HTML type, Progress Developer Studio for OpenEdge automatically adds the .html extension.

Defining custom presentations

The Custom presentation form for Business Processes can be used with HTML forms. To add custom JSP presentations like the HTML presentations, the presentation of the JSP forms can be edited using an HTML editor that supports JSP tags. In addition, the logic part of the JSP (implemented in Java) can be modified to customize the content of the presentation using any text editor. For example, it is possible to add Java code to populate the content of a drop-down list from a database query.

If you select the Custom option in the Presentation dialog box (right image, Figure 149 on page 234) in the Start or Activity worksteps properties, Progress Developer Studio for OpenEdge creates a Java Server Page (JSP) workstep presentation that is generated from an XSL transformation. This type of JSP presentation enables you to change the interface for all worksteps using this option by making a single change in the XSL transformations.
Using external editors

Progress Developer Studio for OpenEdge allows you to open generated files in external editors and to customize a workstep or another application file in the selected external editor. For Activity worksteps with a Custom presentation or for user-created Adapter worksteps, you can use the Default (Notepad) and Wordpad as external editor options. This feature is not available for other workstep types.

**Note:** You can also use the External Editor feature to open Text files using Notepad as the default editor, Excel files using Excel as the default editor, and PDF files using Adobe Acrobat as the default editor. To configure these external editors to your requirements, navigate to DesignerFileTypes.xml in the Workspace_Home\.com.savvion.studio\conf\resources\designer folder.

To use an external editor for customizing Activity (with Custom presentations) or Adapter worksteps (that are not predefined):

1. Right-click the Activity or Adapter workstep that you want to customize, point to the **Open With** option, and then select an external editor option.

**Note:** In order to use an external editor, the application file must be a custom JSP presentation form. You cannot use an external editor for worksteps with a Default presentation form or with Form Editor.

The file is generated, then opened in the specified external editor: for example, in WordPad.

**Figure 151: Opening into an External Editor**

![External Editor](image)

**Note:** BPM CustomUI API tags are now delimited by `{}`, instead of the previously used `<>`. Progress Developer Studio for OpenEdge continues to recognize BPM CustomUI API tags with `<>`.

2. Select the fields to be edited, and apply customizations that can include changing the background color or adding a border, or modifying or deleting dataslots.

4. To view the customized interfaces from Progress Developer Studio for OpenEdge, open the customized form’s file from its folder in the Project Explorer view; for instance, open the Activity1.jsp file from the JSP folder.

5. Publish the application as described in Publishing an application on page 73. To republish the customized interfaces without reinstalling the applications, select the Copy files to Server only option in the Publish wizard.

6. Select the Go to Business Process Portal check box to view the customized interfaces in your Web browser.

Defining Flow presentations

You can use the Flow presentation (available only in a Business Process) to execute a Web application without opening it from Business Process Portal. You need to only click on a connector provided in the interface to launch a Web browser with this format. OpenEdge BPM Designer provides two Flow options in the Presentation dialog box:

- **Flow** starts a Web application from a workstep in the Business Process by redirecting the Web application to the BPM WebFlow server (see Using a Flow presentation on page 238).

- **Flow (private)** creates a workstep that is restricted to the current process template and is not redirected to the BPM WebFlow server. You must copy the files in the Web application to the webapp folder in Progress Developer Studio for OpenEdge. For more information, see Using a Flow (private) presentation on page 240.

Using a Flow presentation

You can define an Activity workstep (in a Business Process) with Flow presentation type to start a Web application in Progress Developer Studio for OpenEdge. As this workstep runs in a Web browser, the Web application it calls must be installed.

To define a Flow presentation for a workstep:

1. From the Properties view, click the General tab to view the Presentation section.

   Figure 152: Presentation Types section

   ![Presentation Types section]

   **Note:** By default, Portal type with Form (Activity_name.jsp) presentation format is listed in the table on the Presentation section.

2. Click Add to open the Add Presentation dialog box.

3. Select Portal from the Type drop-down list.
4. Select the **Flow** option from the **Form Type** drop-down list.
5. Click the **ellipsis** button beside the **Name** text field to open the **Add Dataslots** dialog box.
6. You can modify the name of the default Flow interface in the **Name** box. The default name is the name of the current workstep followed by the *.”BpmWebFlow” extension.

The “.BpmWebFlow” extension indicates to the servlet that it should invoke the appropriate methods of the BPM WebFlow server to get the URL for the BPM WebFlow server and redirect the Web application to that page. The BPM WebFlow server implements a dispatcher that takes as input the Web application name and produces the URL of the Start workstep of the Web application.

7. Click **OK** to define the Flow presentation format for this workstep.

**Opening a Flow presentation**

After defining the presentation format of the workstep as Flow, you can either create a new Web application or select any existing Web application.

**To open flow presentation:**

1. Right-click the workstep with Flow presentation, then click **Open Flow** to launch the **Open <workstep_name>** dialog box.
2. Select either an existing web application (in Existing folder) or Web application Project.
3. Click OK to open the flow presentation workstep. If you select an existing web application (in Existing folder), the process template of this web application is displayed. Alternatively, if you select Web Application Project, the New Web application wizard (see Figure 10 on page 51) is launched, using which you create a Web application.

Using a Flow (private) presentation

Unlike the Flow presentation type, the Flow (private) presentation type does not require you to publish and install the Web application in order to execute properly in its process template. Additionally, upon subsequent modifications to the input or output dataslots of the workstep in a Business Process with a Flow (private) presentation, the dataslots of the private flow are automatically updated to reflect the input and output changes in the workstep. This results in the automatic dataslot synchronization between Business Processes and Flow (private) applications. Removing dataslots from the Business Process does not remove corresponding dataslots in the Flow (private) application, but is interpreted as disassociating the dataslots in the Business Process from the dataslots in the Flow (private) application.

Right-click the workstep with a Flow (private) presentation and selecting Open, launches a Web application (without any Web application wizard).

The defined process appears in the Project pane as a process with a SWT extension in a WebApp folder. The process functions only in the current process, and you need not define and publish a Web application to use this type of workstep.

**Note:** If an application is used as a Flow (private) application in Progress Developer Studio for OpenEdge, you cannot use it as a stand-alone Web application; similarly, an installed Web application cannot be used as a Flow (private) workstep.

To create a Flow (private) presentation for a workstep:

1. From the Properties view, click the General tab to view the Presentation section.
Figure 155: Presentation Types section

Note: By default, Portal type with Form (Activity_name.jsp) presentation format is listed in the table on the Presentation section.

2. Click Add to open the Add Presentation dialog box.

Figure 156: Add Presentation dialog box

3. Select Portal from the Type drop-down list.
4. Select the Flow (private) option from the Form Type drop-down list.
5. Modify, if required, the default name in the Name box. The default name is the name of the current workstep. Alternatively, you can associate a dataslot with the Flow (private) workstep.
   a) Click the ellipsis button beside the Name box.
   b) Select the Use a dataslot option.
   c) Select the dataslot from the Add Dataslots dialog box.
   d) Click OK to add the dataslot.
6. Click OK to define the presentation format for this workstep.
7. Right-click the workstep and click Open Flow to open a blank Web application with the same name as the Flow (private) workstep.

The Flow (private) workstep is now confined to the current process template. Any dataslot that you create in the Web application (invoked from the Flow (private) workstep) are confined to the Web application and cannot be used in the Business Process. To pass dataslot values from the Business Process to the Web application, you must create the dataslot with the same name and type in both processes.
Defining Mobile presentation

You can define an activity workstep (in a Business Process) with presentation type as Mobile to complete the activity using a Mobile device. As the activity runs in a Mobile device, you must install a mobile app in the device. Then, you must map the mobile app’s URL to the activity workstep (in a Business Process) to access the activity.

**Note:** You can build and install mobile apps using Progress Software’s Telerik Platform and you can access supported Progress data resources from mobile apps built in the Telerik Platform using Progress Data Services such as OpenEdge and Rollbase. For more information, see the *Progress Data Services Guide and Reference*, which you can reference from the [http://clouddataobject.github.io/](http://clouddataobject.github.io/).

To define a Mobile presentation for an activity workstep:

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Mobile.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.

   **Figure 157: Presentation section**

   ![Presentation section figure]

   **Note:** By default, the Form *(Activity_name.jsp)* presentation type is defined for the activity workstep that is displayed in the **Presentation** section.

3. Click **Add** to open the **Add Presentation** dialog box.

   **Figure 158: Add Presentation dialog box**

   ![Add Presentation dialog box figure]

4. Select Mobile from the **Type** drop-down list.
5. Specify the mobile app file path or URL in the **URL** text field. For example, `https://<host>:<port>/mobile/activity.html`.

   Alternatively, you can map workstep with Mobile presentation format to CHARACTER dataslot to dynamically associate the workstep with a mobile app URL. You need to set the initial value of the CHARACTER dataslot to a valid mobile app URL.
a) Click the **ellipsis** button beside the **URL** text field.
b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.

6. Click **OK** to add the Mobile presentation format for the activity workstep.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the **Presentation Type already exists. Do you want to override?**. Click **OK** to override the presentation type.

The Mobile presentation format is mapped to the selected activity workstep. The defined Mobile presentation type is displayed in the **Presentation** section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

### Defining Rollbase presentation

You can define an activity workstep (in a Business Process) with presentation type as Rollbase to complete the activity using a Rollbase application. Then, you must map the Rollbase page ID to the activity workstep (in a Business Process) to access the activity.

**To define a Rollbase presentation for an activity workstep:**

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Rollbase.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.

**Figure 159: Presentation section**

![Presentation section](image)

**Note:** By default, the **Form** (activity_name.jsp) presentation type is defined for the activity workstep that is displayed in the **Presentation** section.

3. Click **Add** to open the **Add Presentation** dialog box.
4. Select **Rollbase** from the **Type** drop-down list.
5. Specify the Rollbase page ID in the **ID** text field. For example, **1400**.

Alternatively, you can map workstep with Rollbase presentation format to CHARACTER dataslot or LongChar dataslot to dynamically associate the workstep with a Rollbase page ID. You need to set the initial value of the CHARACTER dataslot to a valid Rollbase application page ID.

a) Click the **ellipsis** button beside the **ID** text field.
b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
d) Click OK to add the dataslot and then close the Add Dataslots dialog box.

6. Click OK to add the Rollbase presentation format for the activity workstep.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override? Click OK to override the presentation type.

The Rollbase presentation format is mapped to the selected activity workstep. The defined Rollbase presentation type is displayed in the Presentation section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, Rollbase application or a Tablet device.

## Defining GUI presentation

You can define an activity workstep (in a Business Process) with presentation type as GUI to complete the activity using a GUI for .NET desktop application. As the activity runs a GUI for .NET desktop application, you must develop a OpenEdge GUI for .NET application. Then, you must map the GUI for .NET application name (ABL class .cls filename) to the activity workstep (in a Business Process) to access the activity.

**Note:** For more information on developing OpenEdge GUI for .NET applications, see the OpenEdge Getting Started: Introducing the Progress Developer Studio for OpenEdge Visual Designer guide.

To define a GUI for .NET presentation for a workstep:

1. Select an activity workstep in a Business Process for which you want to define the presentation type as GUI.
2. From the Properties view, click the General tab to view the Presentation section.

**Figure 160: Presentation Types section**

![Presentation Types section](image)

**Note:** By default, Portal type with Form (Activity_name.jsp) presentation format is listed in the table on the Presentation section.

3. Click Add to open the Presentation Types dialog box.
4. Select **GUI** from the **Type** drop-down list.

5. Specify an ABL class (.cls) file in the **Name** field. For example, `SampleApp.cls`.
   Alternatively, you can map workstep with GUI presentation format to CHARACTER dataslot to dynamically associate the workstep with an ABL .cls filename. You need to set the initial value of the CHARACTER dataslot to a valid ABL .cls filename.
   a) Click the **ellipsis** button beside the **Name** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
   c) Select the CHARACTER dataslot from the **Add Dataslots** dialog box.
   d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.

6. Click **OK** to add the Mobile presentation format for the activity workstep.

   **Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the **Presentation Type already exists. Do you want to override?** Click **OK** to override the presentation type.

The GUI presentation format is mapped to the selected activity workstep. The defined GUI presentation type is displayed in the **Presentation** section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

---

**Defining Tablet presentation**

You can define an activity workstep (in a Business Process) with presentation type as Tablet to complete the activity using a Tablet device. As the activity runs in a Tablet device, you must install a mobile app in the device. Then, you must map the mobile app's URL to the activity workstep (in a Business Process) to access the activity.

**Note:** You can build and install mobile apps using Progress Software’s Telerik Platform and you can access supported Progress data resources from mobile apps built in the Telerik Platform using Progress Data Services such as OpenEdge and Rollbase. For more information, see the *Progress Data Services Guide and Reference*, which you can reference from the [http://clouddataobject.github.io/](http://clouddataobject.github.io/).

To define a Tablet presentation for an activity workstep:
1. Select an activity workstep in a Business Process for which you want to define the presentation type as Tablet.

2. From the Properties view, click the General tab to view the Presentation section.

   ![Figure 162: Presentation section](image)

   **Note:** By default, the Form (Activity name.jsp) presentation type is defined for the activity workstep that is displayed in the Presentation section.

3. Click Add to open the Add Presentation dialog box.

   ![Figure 163: Add Presentation dialog box](image)

4. Select Tablet from the Type drop-down list.

5. Specify the mobile app file path or URL in the URL text field. For example, https://<host>:<port>/tablet/activity.html.

   Alternatively, you can map workstep with Tablet presentation format to CHARACTER dataslot to dynamically associate the workstep with a mobile app URL. You need to set the initial value of the CHARACTER dataslot to a valid mobile app URL.

   a) Click the ellipsis button beside the URL text field.

   b) Select Use a dataslot to open the Add Dataslots dialog box.

   c) Select a CHARACTER dataslot to be mapped to the workstep presentation.

   d) Click OK to add the dataslot and then close the Add Dataslots dialog box.

6. Click OK to add the Tablet presentation format for the activity workstep.

   **Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

The Tablet presentation format is mapped to the selected activity workstep. The defined Tablet presentation type is displayed in the Presentation section.
Defining workstep presentation for Business Processes

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

### Defining Other presentation

You can define an activity workstep (in a Business Process) with presentation type as Other to complete the activity using a device other than the defined presentation types such as Portal, Mobile, GUI, or Tablet.

**To define a Tablet presentation for an activity workstep:**

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Other.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.

   ![Figure 164: Presentation section](image)

   **Note:** By default, the Form *(Activity_name.jsp)* presentation type is defined for the activity workstep that is displayed in the **Presentation** section.

3. Click **Add** to open the **Add Presentation** dialog box.

   ![Figure 165: Add Presentation dialog box](image)

4. Select Other from the **Type** drop-down list.
5. Specify the filename in the **Other** text field.

   Alternatively, you can map workstep with Other presentation format to CHARACTER dataslot to dynamically associate the workstep with a file. You need to set the initial value of the CHARACTER dataslot to a valid file that you want to use to complete the activity.

   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.

---

**Defining workstep presentation for Business Processes**

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

### Defining Other presentation

You can define an activity workstep (in a Business Process) with presentation type as Other to complete the activity using a device other than the defined presentation types such as Portal, Mobile, GUI, or Tablet.

**To define a Tablet presentation for an activity workstep:**

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Other.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.

   ![Figure 164: Presentation section](image)

   **Note:** By default, the Form *(Activity_name.jsp)* presentation type is defined for the activity workstep that is displayed in the **Presentation** section.

3. Click **Add** to open the **Add Presentation** dialog box.

   ![Figure 165: Add Presentation dialog box](image)

4. Select Other from the **Type** drop-down list.
5. Specify the filename in the **Other** text field.

   Alternatively, you can map workstep with Other presentation format to CHARACTER dataslot to dynamically associate the workstep with a file. You need to set the initial value of the CHARACTER dataslot to a valid file that you want to use to complete the activity.

   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.

---

**Defining workstep presentation for Business Processes**

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

### Defining Other presentation

You can define an activity workstep (in a Business Process) with presentation type as Other to complete the activity using a device other than the defined presentation types such as Portal, Mobile, GUI, or Tablet.

**To define a Tablet presentation for an activity workstep:**

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Other.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.

   ![Figure 164: Presentation section](image)

   **Note:** By default, the Form *(Activity_name.jsp)* presentation type is defined for the activity workstep that is displayed in the **Presentation** section.

3. Click **Add** to open the **Add Presentation** dialog box.

   ![Figure 165: Add Presentation dialog box](image)

4. Select Other from the **Type** drop-down list.
5. Specify the filename in the **Other** text field.

   Alternatively, you can map workstep with Other presentation format to CHARACTER dataslot to dynamically associate the workstep with a file. You need to set the initial value of the CHARACTER dataslot to a valid file that you want to use to complete the activity.

   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
d) Click OK to add the dataslot and then close the Add Dataslots dialog box.

6. Click OK to add the Other presentation format for the activity workstep.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override? Click OK to override the presentation type.

The Other presentation format is mapped to the selected activity workstep. The defined Other presentation type is displayed in the Presentation section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

## Defining workstep presentations for Web applications

Similar to Business Processes, you can define the look and feel of the presentation pages for Activity worksteps in Web applications. For Web applications, you cannot change the presentation format for the Start workstep.

After you have developed a Web application, you can view it as a series of presentation pages (or interfaces) in your Web browser by entering the appropriate URL. For example, to view the BarChartDemo Web application, enter the following URL:


To change the look and feel of the presentation pages for Activity worksteps in Web applications perform the following steps:

1. From the General tab of the Properties view of an activity workstep, click the ellipsis button (left image, Figure 166 on page 248) beside the Presentation box to open the Presentation dialog box (right image, Figure 166 on page 248).

**Figure 166: Defining Interfaces for Web application**

2. Select the presentation format option from the Type drop-down list. For Web applications, the available options are Auto-generated, Form, and Custom.
3. If required, modify the presentation name in the **Name** box.
4. Click **OK**, to return to the **Properties** view.

For more details regarding each of the presentation formats available for Web application, refer to **Table 51** on page 249.

**Table 51: Presentation Format for Web application components**

<table>
<thead>
<tr>
<th>Presentation Format</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-generated</td>
<td>Using the Auto-generated presentation on page 249.</td>
</tr>
<tr>
<td>Form</td>
<td>Using the Form presentation on page 252.</td>
</tr>
<tr>
<td>Custom</td>
<td>Using the custom presentation on page 249.</td>
</tr>
</tbody>
</table>

**Using the Auto-generated presentation**

For Web applications, BPM Designer enables you to generate JSP forms with HTML interfaces using XSL. XSL-based interfaces provide greater flexibility and are easier to customize.

**Using the custom presentation**

BPM Designer provides a Custom presentation option for Web applications that enables you to further customize presentation forms that were created using the Default presentation option or that were created in the Form Editor. You can also customize JSP files that were imported from outside sources.

Use the Custom presentation option to retain any changes that you made to the presentation form—these changes are preserved after the application is published. Presentations that are created using the Default or Form options are not preserved following application publishing.

**Customizing presentation pages**

You can add, edit, or delete customized features to the presentation pages by modifying workstep, connector and/or dataslot properties for Web applications in BPM Designer.

**Specifying hyperlinks between Presentation pages**

You can add hyperlinks to connect workstep presentation pages in Web applications. In contrast, Business Processes do not allow linking to other workstep presentations; users must click a **Submit** or **Complete** button to move the process forward to the next step.

You can create hyperlinks from one workstep to another workstep within a Web application by choosing any of the available three hyperlink connector types namely, Submit button, Hyperlink, and Image. For details regarding these link types, see **Defining link properties** on page 211 and **For Web applications** on page 213.

The following process template segment is taken from the SVBSurvey_Ver2 sample process and illustrate defining customized text hyperlinks.
Figure 167: Sample Application Connector Properties Defined in the Process Template

![Diagram](image)

In Figure 168 on page 250, the properties entered in the connector **Properties** view are displayed on the workstep presentation as text hyperlinks “Privacy Policy” and “Start The Survey”.

Figure 168: SVB Survey Sample Application Presentation

Creating multiple command buttons in web applications

OpenEdge BPM Designer automatically displays multiple command buttons (Submit button, Hyperlink, or Image) in the presentation page of an Activity workstep that has multiple outgoing connectors. Each command button corresponds to each of the outgoing connector.

By default, the **Properties** view for each connector contains a blank Label box that inserts the default label in the presentation page. To change the default label, in the **Properties** view, enter a new label in the Label box, which replaces the default label for the button.

**To create multiple Command buttons:**

1. Add worksteps to the application and connect them to an Activity workstep. In the example illustrated in Step Figure 169 on page 251, four Link type connectors are added to the “Activity 2” workstep.
2. Click each of the connector to display its **Properties** view.
3. Select the appropriate option from the Type drop-down list as illustrated in Step Figure 169 on page 251.
4. Assign a name and enter a label for each connector. The label for the moreinfo connector is “Need more information”, the approve connector’s label is “Approve Request,” the reject connector’s label is “Reject Request”, and the label for the defer connector is “Defer indefinitely.”
5. Click **File > Save** or the **Save** icon to save the changes.

6. Publish the Web application, as described in Publishing an application on page 73. In the interface (or presentation) page, these values appear as labels of the buttons.

![Figure 169: Creating Multiple Command Buttons for an Activity Workstep](image)

**Note:** When the application user has two or more options in a presentation, the conditions are mutually exclusive—the user cannot click more than one Submit button at the same time.

### Preserving customization after process reinstall

After a Web application is uninstalled through Business Process Portal, a warning indicates which worksteps have been customized and where they are saved.

A JSP file is generated for the Start workstep (**Start.jsp**) and for each Activity workstep. You can customize these JSP files to modify their presentation. Do not attempt to customize the **Start.jsp**, because it contains information about the control flow of your Web application. When uninstalling a Web application, customized JSPs are saved under `OEBPS_HOME\BPMWebFlow\<App_Name>\jsp.bak\$timestamp`.

You can get the value of any data in Table 52 on page 252 using the `BpmWebFlow.getDS.jsp` tags.
Table 52: JSP Internal Data in Presentation Files

<table>
<thead>
<tr>
<th>Internal Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP Server-specific tags:</td>
<td></td>
</tr>
<tr>
<td>workitemName</td>
<td>workitem name</td>
</tr>
<tr>
<td>BPMCustomUIAPI_instanceName</td>
<td>process instance name</td>
</tr>
<tr>
<td>ptName</td>
<td>process template name</td>
</tr>
<tr>
<td>returnPage</td>
<td>URL to which the BPM WebFlow process is to return</td>
</tr>
<tr>
<td>Business Process Portal-specific tags:</td>
<td></td>
</tr>
<tr>
<td>BPMCustomUIAPI_priority</td>
<td>task priority</td>
</tr>
<tr>
<td>BPMCustomUIAPI_startDate</td>
<td>task start date</td>
</tr>
<tr>
<td>BPMCustomUIAPI_dueDate</td>
<td>task due date</td>
</tr>
<tr>
<td>BPMCustomUIAPI_instruction</td>
<td>task instruction</td>
</tr>
<tr>
<td>BPMCustomUIAPI_user</td>
<td>user who is executing the BPM WebFlow process</td>
</tr>
</tbody>
</table>

Using the Form presentation

You can also use the Form presentation format for Business Processes and Web applications to use the Form Editor, where you can create a customized interface form. The Form Editor option enables you to create a more complex presentation form for each Activity workstep (and for Start worksteps only in Business Processes), including headers, multi-column tables, adding formatting (text fields, drop-down lists, images, and so on), and the ability to bind dataslots to a specific presentation item. For details regarding using Form Editor, see Using the Form Editor on page 259 and Defining workstep presentation for Business Processes on page 234.
Using alerts

Progress Developer Studio for OpenEdge provides the Alerts functionality for Business Processes, which you can define and associate with selected worksteps. Using Alerts, you can notify application users in Business Process Portal of a predefined event, such as change in the status of a process instance or in case of an exceptional condition being satisfied. In BPM Designer, you can use the Alerts tab to define a pool of alerts that can be associated with selected worksteps. These alerts can be associated with selected worksteps using the Alerts tab in the workstep’s Properties view, at various transition points (such as, “On activation”, “When completed”, and “On Overdue”) during execution of the process.

The associated alerts appear in Business Process Portal under the My Alerts tab when, for example, a specific workstep is activated or when it is completed. Each alert must contain a message. Alerts can be assigned to one or more specified recipients or they can be triggered by a particular condition. For information on managing alerts in Business Process Portal, see the Business Process Portal User’s Guide.

For details, see the following topics:

• Reviewing the Alerts tab
• Defining an alert
• Associating an alert with a workstep

Reviewing the Alerts tab

You can view the "default" alert and define new alerts in the Alerts tab of the BPM Designer interface (Figure 5 on page 33).
Figure 171: Alerts tab

Click the Alerts tab for a new Business Process, to view the All Alerts section, which contains all the alerts available to the process template.

You can perform the following operations in the Alerts tab:

**Table 53: Alerts tab operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define an alert</td>
<td>See Defining an alert on page 254.</td>
</tr>
<tr>
<td>Remove an alert</td>
<td>Select the alert to be removed, then click Remove. You cannot remove the &quot;default&quot; alert.</td>
</tr>
<tr>
<td>Modify existing alerts</td>
<td>Select the alert to be modified, then modify its properties in the respective sections of the Alerts tab.</td>
</tr>
<tr>
<td>Filter the alert list</td>
<td>Enter text in the type filter text box to filter the alert list and display all alerts whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group (or ungroup) the alert list</td>
<td>By default, all alerts are grouped under alert severity categories, namely, Critical, High, Medium, and Low. To ungroup the alert list, click the No Grouping (廪) icon in the All Alerts section. To group the performer list under severity categories, click the Group by Severity (廪) icon in the All Alerts section.</td>
</tr>
<tr>
<td>Collapse the alert list</td>
<td>Click the Collapse All (廪) icon.</td>
</tr>
</tbody>
</table>

**Defining an alert**

You can define new alerts in the Alerts tab.
To define an alert:

1. Load the Business Process (SPT) for which you want to define the alert.
2. From the Alerts tab (Figure 171 on page 254), click Add.
   The New Alert wizard appears.

**Figure 172: New Alert wizard: Page 1**

3. From the first page of the New Alert wizard, you can specify the alert name, severity, and description of the alert.
   a) Type the name of the alert in the Name box. The name can only include alphanumeric characters and underscore (“_”). Do not start the alert name with a numeric character. The name for an Alert should not exceed 64 characters.
   b) Select an option from the Severity drop-down list; options are: Critical, High, Medium, and Low. The Severity indicates to the alert recipients the urgency with which they should respond to the Alert.
   c) Enter a description (optional) of the alert in the Description box. This will enable other users of the application in BPM Designer to determine the intent of the alert.

4. Click Next. From the second page of the New Alert wizard, you can define a condition that activates the alert when the condition is satisfied.
   a) To define an alert condition, click Condition to open the Condition dialog box.
   b) Select a dataslot from the drop-down list on the left. Only CHARACTER, INTEGER, INT64, LOGICAL, and DATETIME-TZ dataslot types are listed.
   c) Select an operator. To complete defining the condition, select a dataslot from the drop-down list on the right or enter a value.
   d) To add another condition, click and select And or Or option from the drop-down list. To remove a condition, click .
   e) Click the Advanced option to go to the advanced mode where you can create a condition by adding specific dataslots or by entering (or copy-paste) a condition.
   f) To verify the expression's validity, click Validate in basic or advanced mode, and the “Validation successful” message appears.

5. Click Next. You can use the third page of the New Alert wizard to specify the alert message.
   In the Message box, enter the content of the message that you want the alert recipients to see when they open the Alert. You can enter static or dynamic values in the message. For dynamic values, you can use dataslots (${dataslot_name} or ${@System_dataslot}). Press CTRL+SPACE to view the list of dataslots in the process. Select the dataslot to be added and press ENTER to add the dataslot in the Message box. For example, a message reading
“Vacation request of ${(days)} has been filed by ${@CREATOR}” will use the days dataslot (a dataslot in the User category) and the @CREATOR dataslot (a System category dataslot) to obtain dynamic values for the number of days and the name of the person who filed the vacation request at runtime.

**Note:** If you use a System dataslot, it must be prefixed with “@”.

6. Click **Next** to define the recipients of the alert.
   a) Click **Add** to open the **Performer** dialog box, which lists performers of type, "User" and "Group" (group of sub-type, "All") in the process.

   **Note:** You cannot add queues, groups of type "Any," or comma-separated lists of multiple performers as alert recipients.

   b) Select a single (or multiple) performer and click **OK** to assign your selected user or group as the alert recipient.

   To delete a recipient, select the recipient and click **Remove**.

7. Click **Finish** to add the defined alert to the **Alerts** tab.

**Associating an alert with a workstep**

After defining the alert in the **Alerts** tab, you must associate the alert with a workstep at various workstep transition points (such as, “On activation”, “When completed”, and for an Overdue Action in “On Overdue”) during execution of the process. You can associate an alert with a Start, End, Activity, Adapter, or Subprocess workstep. In the case of the Start workstep, you can associate the alert only on completion of the workstep.

**To associate an alert with a workstep:**

1. From the workstep’s **Properties** view, open the **Alerts** tab.

   The Alerts tab displays the **On Activation** and **When Completed** sections. For the Start workstep, the **When Completed** section is only displayed.
2. To associate the alert with the workstep when the workstep is initially activated, add the alert to the table in the **On Activation** section.

   To associate the alert when the workstep is completed, add the alert to the table provided in the **When Completed** section.

3. Click **Add** to display the **Add** dialog, which lists all the available Alerts (Step Figure 173 on page 257).
   a) Select an Alert from the drop-down list provided.
   b) Select the **Send SMS** check box to send the alert message as an SMS to the alert recipients. The alert message is sent to the recipient's phone number, as registered on Business Process Portal.

   **Note:** To enable using SMS for sending alerts, the Business Process Server property `oebps.sms.enable` must be set to TRUE in the `oebps.conf` configuration file. In addition, you can set the `oebps.sms.failonerror` property to TRUE for suspending a workstep when SMS sending fails. The `oebps.conf` file is located in the `OEBPS_HOME\conf` directory. You must update the `oebpssms.properties` file in the `OEBPS_HOME\conf` directory with the SMS gateway provider details.

   The Alert is added to the table in the **Properties** view.

**Associating an alert with an overdue action**

You can also associate an alert to be activated in the event of an Overdue Action to an Activity, Adapter, and Subprocess workstep.

**To associate an alert:**

1. In the **Advanced** tab of the workstep’s **Properties** view, click the **On Overdue** tab.
2. To add a new Overdue Action, click **New**, to open the **Overdue Actions** dialog box.
3. Enter a number in the **Number of times to execute** box to indicate the number of times the Alert will be repeated.

4. From the **Alerts** tab, click **Add** to add an alert as described in **Associating an alert with a workstep** on page 256.

The Alert is added to the list of alerts in the **Overdue Actions** dialog box.

**Note:** You can also add an Alert as an action in the Schedule, Timeout, Process Path, Decision Counter, Task Assignment, and File Poller Rule Wizards. For more information, see **Defining rules with Rule Wizards** on page 467.
Progress Developer Studio for OpenEdge provides the Form Editor, which enables you to design a customized Form interface right from the scratch. This option is available for all Activity worksteps and for Start workstep (only in the case of Business Processes). You can use the Form Editor to develop customized forms with:

- Layout components including multi-column tables, tabbed panes, and dividers.
- Standard HTML controls including text fields, drop-down lists, images, trees, grids, and buttons.

For a workstep with designed form interface, the corresponding task (at runtime) renders the designed form interface with all the added form elements.

This chapter describes how to use the Form Editor to design a form interface for worksteps with "Form" presentation format. For defining the presentation format of a workstep, see Defining workstep presentation format on page 233.

The instructions provided in this chapter are equally applicable to worksteps in BPM processes and to Web applications.

For details, see the following topics:

- Opening the Form Editor
- Using a form template
- Using the Layout tab
- Defining the form's layout
- Defining the form's controls
- Defining the form's flow
- Defining the form's data sources
Chapter 18: Using the Form Editor

- Using form fragments
- Other Form Editor operations
- Using the Overview tab
- Configuring actions
- Using Script tab
- Managing forms
- Invoking server-side methods

Opening the Form Editor

To open the Form Editor, you must enable the Form interface for a workstep by selecting the Form presentation format from the Presentation box (Defining workstep presentation for Business Processes on page 234).

1. From the General tab in the Properties view of an Activity workstep (or for a Start workstep in a Business Process), click the ellipsis button beside the Presentation box, to open the Presentation box.
2. Select the Form option from the Type drop-down list, and modify the default name (if required) for the form in the Name box, then click OK. If you do not enter a name, the form is assigned the name of the workstep (as in Activity1.jsp).

The name appears in the Presentation box of the Properties view.
3. Right-click the workstep to which you have enabled the Form Editor option, then click Open Form, opening a new file tab with the workstep name.

Figure 175: Form Editor

Figure 175 on page 260 identifies the commonly used panes and components in the Form Editor interface, which are further described in the following table.
### Table 54: Form Editor Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Form Editor Toolbar</strong></td>
<td>Contains icons, which provide shortcuts to the following commonly used functions:</td>
</tr>
<tr>
<td></td>
<td>• <strong>New Form (&gt;Create)</strong> icon, to create a new form or to open an existing form template from the current process (see Using a form template on page 262).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Preview (Preview)</strong> icon, to open a window that provides a preview of the current form or of all your forms. For more information, see Previewing forms on page 305.</td>
</tr>
<tr>
<td></td>
<td>• Text-formatting icons, which enable you to: define text font, size, and style (Bold, Italics, Underline); align text to the right, left, or center; and a <strong>Font Color</strong> icon to define the color of the text.</td>
</tr>
<tr>
<td><strong>Content pane</strong></td>
<td>Contains the main work space to which you can add the various elements of the form, including dataslots, tables, command buttons, and form controls (such as text box, drop-down list, combo box, and link).</td>
</tr>
<tr>
<td><strong>Form Editor Tasks pane</strong></td>
<td>Contains the following five links:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Layout</strong>, using which you can add multi-column tables and tabbed panes. For more information, see Defining the form's layout on page 265.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Controls</strong> to add standard form controls such as text boxes, text areas, images, and sliders. For more information, see the Defining the form's controls topic.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Flow</strong> to add command buttons and links that connect form pages. For more information, see Defining the form's flow on page 287.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Data Sources</strong>, where you can add and view dataslots and adaplets. For more information, see Defining the form's data sources on page 289.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Form Fragments</strong>, which lists all form fragments. For more information, see Using form fragments on page 293.</td>
</tr>
<tr>
<td><strong>Form Editor tabs</strong></td>
<td>• <strong>Layout</strong>, the default tab where you can design the form using the Tasks pane elements. For more information, see Using the Layout tab on page 264.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Overview</strong> to filter form elements based on type and search for form elements. For more information, see Using the Overview tab on page 297.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Logic</strong>, which contains the Graphical Event Logic (GEL) tool to add advanced expressions and conditions for defined events. For more information, see Using the GEL tool in Form Editor on page 323.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong> to design the form using JavaScript. For more information, see Using Script tab on page 303.</td>
</tr>
</tbody>
</table>
You can save the form with an SFT (Business Form Template) extension or as an XML file. If you want to reuse the saved form as a template, click **File > Save As** to save the form to the Forms Library. By default, the form is saved to the `Workspace_Home\.com.savvion.studio\forms\bizlogic\library` folder (for a Business Process) and `Workspace_Home\.com.savvion.studio\forms\bizlsolo\library` folder (for a Web application). Once saved, the form then appears in the **File** tab, and is available to all your Progress Developer Studio for OpenEdge applications.

### Using a form template

You can use the default form (as shown in Figure 175 on page 260) or use a previously designed form as a template. Progress Developer Studio for OpenEdge provides pre-designed forms that you can use to replace the default form.

**To use a form template:**

- From the Form Editor toolbar, click the **New Form** icon to open the **New Form** dialog box.

![Figure 176: New Form dialog box – File Tab](image)

The **New Form** dialog box contains the following two tabs:
Table 55: New Form Tabs

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Click <strong>Browse</strong> to open the library folder (right image, Figure 176 on page 262), which display three predefined forms for—Header and Footer to open a form with default header and footer, New Blank Form to open a blank form, and Purchase Order to display a sample purchase order template—that are available to all Form-enabled worksteps. Additionally, it may contain any forms that you design and save as templates. Click the <em>sft</em> file to be used, then click <strong>Open</strong>.</td>
</tr>
<tr>
<td>Process</td>
<td>Contains forms (if any) that you have developed for other worksteps in your current process template. You can use these forms only in the current process.</td>
</tr>
</tbody>
</table>

**Note:** The location of the predefined forms is OEBPS_Home\conf\resources\designer\bpserver\forms\library folder (for a Business Process) and OEBPS_Home\conf\resources\designer\bpserver\forms\library folder (for a Web application).

---

### Setting form properties

You can use the **Properties** view to set (and modify) properties of the form.

1. Open the form whose properties you want to define.
2. Click a blank area of the Content pane, to open the **Properties** view.

   By default, it opens the **Attributes** tab.

   **Figure 177: Form Properties view**

   ![Form Properties view](image)

3. You can use the **Class** attribute to select a CSS class style from the list of predefined styles. To do so, click the **Style** row and then click the **ellipsis** button in the Value column.

   The **Properties** dialog box appears.
Figure 178: CSS Class Selector

![CSS Class Selector](image)

a) From the **Class** drop-down list, select any predefined style. Click **OK**.

4. The default form header and footer is not visible at runtime. To change this setting, set the **Visible** attribute value in the Header and Footer sections to true.

5. Use the **Events** tab to add events associated with the form. The available events for form are **onLoad**, **onUnload**, and **onSubmit**. For information regarding the usage of the **Events** tab, see **Configuring actions** on page 299.

Using the Layout tab

The **Layout** tab in the Form Editor interface is the default tab, where you can design the form elements using the following Tasks pane links:

- **Layout** to add multi-column tables and tabbed panes. For more information, see Defining the form's layout on page 265.
- **Controls** to add standard form controls such as text boxes, text areas, images, and sliders. For more information, see the Defining the form's controls topic.
- **Flow** to add command buttons and links that connect form pages. For more information, see Defining the form's flow on page 287.
- **Data Sources**, to which you can add and view dataslots and adaplets. For more information, see Defining the form's data sources on page 289.
- **Form Fragments**, which lists all form fragments. For more information, see Using form fragments on page 293.

You can use drag-and-drop operation to move form elements to another location in your form. Select the form element and drag it to a location you want to move it to.
Defining the form's layout

You can design the layout of your form using the Layout link in the Tasks pane. The Layout section in the Form Editor displays the following layout controls: One-, Two- or Three-Column Table, Custom Table, Tabbed Pane, Field Set, Divider, Panel, and Include, each of which you can click to add to the Content pane. Each of these layout controls are described in the following sections.

Adding a table

You can insert a single-column, multi-column, and a custom table to your Content pane. You can click any of the following table type options to add the corresponding type of table to the Content pane.

### Table 56: Table types

<table>
<thead>
<tr>
<th>Table Options In Layout section</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-Column Table</td>
<td>Inserts a single-column table.</td>
</tr>
<tr>
<td>Two-Column Table</td>
<td>Inserts a table with two columns.</td>
</tr>
<tr>
<td>Three-Column Table</td>
<td>Inserts a table with three columns.</td>
</tr>
<tr>
<td>Custom Table</td>
<td>Displays the Custom Table dialog box, where you can specify the number of rows and columns, as well as the number of header and footer rows. Clicking OK inserts the custom table.</td>
</tr>
</tbody>
</table>

You can enter text in the table cells and apply formatting to it using the font type, size, and style tools in the Form Editor Toolbar. You can also align the text in each cell by using the aligning tool in the toolbar. You can also perform the following common table operations.

### Table 57: Other Table Operations

<table>
<thead>
<tr>
<th>To...</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a row or column</td>
<td>Right-click the table, point to Insert, then select the Insert Columns to the Left, Insert Columns to the Right, Insert Rows Above, or Insert Rows Below options.</td>
</tr>
<tr>
<td>Remove a row or column</td>
<td>Right-click any cell of the row or column to be removed, point to Delete, then click Delete Rows or Delete Columns options.</td>
</tr>
<tr>
<td>Split a cell</td>
<td>Right-click the cell, then select Split Cells option.</td>
</tr>
<tr>
<td>Merge Cells</td>
<td>Select the cells to be merged. Right-click the selection, then select Merge Cells option.</td>
</tr>
<tr>
<td>To...</td>
<td>Operation</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Define Table Properties</td>
<td>Select the table and define the Table properties in the Properties view. For details, see Defining table properties on page 266.</td>
</tr>
<tr>
<td>Define Table Cell Properties</td>
<td>Click in the table cell and define the cell properties in the Properties view. For details, see Defining table cell properties on page 266.</td>
</tr>
<tr>
<td>Delete the table</td>
<td>Select the table and press Delete. Alternatively, right-click the table and select the Delete option.</td>
</tr>
</tbody>
</table>

### Defining table properties

**Figure 179: Form Editor – Table Properties**

To configure table properties:

1. From the default Attributes tab, define the Table Alignment (Left, Right, Center, or Justify) and Table Width (auto, in %, or in pixels) in the respective fields. You can also adjust the Table Border and the Padding and Spacing of the Table cells in the respective boxes.
2. You can use the Class row to select a class from the list of predefined styles. To do so, click the ellipsis button in the Value column, then select the style from the Properties dialog box.
3. Enter a name in the ID box. This name is in a `<div>` tag that you can refer to when generating JavaScript in the Script tab. This name must be unique. You can refer to the table’s name to hide (or show) it as required by entering JavaScript in the Script tab. For example, `sbm.util.hide('name_Mytable');`
4. Use the Events tab to add events associated with the layout. For information regarding the usage of the Events tab, see Configuring actions on page 299.

**Note:** You can use your customized table in other forms by clicking File > Save As and saving it in the appropriate Form fragments folder. After you save the table and refresh BPM Designer, the customized table can be retrieved from the Form Fragments section in the Tasks pane. For more information, see Using form fragments on page 293.

### Defining table cell properties

You can define the properties of each cell of a table added to your form.
To configure cell properties in the Properties view:

1. Click in the table cell to be configured.
2. From the Attributes tab, define the following properties in the Appearance section:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment</td>
<td>Specifies the horizontal alignment of the text in the cell. Available options are: left, right, center, justify, and char.</td>
</tr>
<tr>
<td>Class</td>
<td>Specifies the CSS class style used for the table cell. To select another style, click the ellipsis button in the Value column, then select the style from the Properties dialog box.</td>
</tr>
<tr>
<td>Vertical Alignment</td>
<td>Specifies the vertical alignment of the text in the cell. Available options are: top, middle, bottom, and baseline.</td>
</tr>
<tr>
<td>Width</td>
<td>Specifies the width of the cell (in pixels or %).</td>
</tr>
</tbody>
</table>

3. Enter a name in the ID box. The name (or its Field ID) must be a unique designation because JavaScript uses it to identify the cell. As this designation must be unique, BPM Designer does not allow the duplication of the cell name.

Adding a tabbed pane

You can use a tabbed pane to categorize form information across multiple tabs, thus reducing complexity. You can add text, tables, fields controls, dataslots and even another tabbed pane to a tabbed pane.

By default, a Tabbed Pane in the Form Editor interface displays only one page with the default label, “Page 1.” You can perform the following operations to manage a tabbed pane.

<table>
<thead>
<tr>
<th>To</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a page</td>
<td>Right-click a page label, point to Add, then select the Add Page option. This displays the Add Page dialog box, where you can type the unique page ID and the page label in the respective boxes. Click OK to add a page.</td>
</tr>
<tr>
<td>To</td>
<td>Operation</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove a page</td>
<td>Right-click a page label, point to <strong>Delete</strong>, then select the <strong>Delete Page</strong> option.</td>
</tr>
<tr>
<td>Define Pane</td>
<td>Click the tabbed pane to view the pane properties in the Properties view. From the <strong>General</strong> tab, you can enter the name. The name (or its Field ID) must be unique because JavaScript uses it to identify the field. As this designation must be unique, Progress Developer Studio for OpenEdge does not allow the duplication of the field name. Use the <strong>Events</strong> tab to add events associated with the layout. For information regarding the usage of the Events tab, see <strong>Configuring actions</strong> on page 299.</td>
</tr>
</tbody>
</table>

An example of a tabbed pane is displayed in **Figure 181** on page 268.

**Figure 181: Form with added tabbed pane**

![Form with added tabbed pane](image)

**Note:** You can save and use your customized tabbed pane in other forms by clicking **File > Save As** and save it in the appropriate Form fragments folder. After you save the tabbed pane and refresh Progress Developer Studio for OpenEdge, the customized tabbed pane can be retrieved from the Form Fragments section in the Tasks pane. For more information, see **Using form fragments** on page 293.

To assign a specific style sheet to a Tabbed Pane, you must move it into a Divider. You can then assign a style sheet to the Divider, and this style is also assumed by the Tabbed Pane that is within the Divider. For more information, see **Adding a divider** on page 269.

**Adding a Field Set**

You can use a Field Set to insert a group of related field components. A Field Set is represented by an outlined box. You can add dataslots, form fragment, and other elements to a Field Set box.

To define properties for the added field set, select the field set and define the Field Set properties in the **Properties** view.

**Figure 182: Form Editor – Field Set**

![Form Editor - Field Set](image)
Defining the form's layout

1. Enter the field set name in the **ID** value box. The name (or its Field ID) must be a unique designation because JavaScript uses it to identify the field. As this designation must be unique, Progress Developer Studio for OpenEdge does not allow the duplication of the field name.

2. Select a Class from the list of predefined styles. To do so, click the **ellipsis** button in the **Value** column, then select the style from the **Style** dialog box.

3. Enter the title of the field set in the **Legend** value box.

4. Use the **Events** tab to add events associated with the layout. For information regarding the usage of the **Events** tab, see Configuring actions on page 299.

**Note:** You can save and use your customized field set in other forms by clicking **File > Save As** and save it in the appropriate Form fragments folder. After you save the field set and refresh Progress Developer Studio for OpenEdge, the customized field set can be retrieved from the Form Fragments section in the Tasks pane. For more information, see Using form fragments on page 293.

To assign a specific style sheet to a Field Set, you must move it into a Divider. You can then assign a style sheet to the Divider, and this style is also assumed by the Field Set that is within the Divider. For more information, see Adding a divider on page 269.

### Adding a divider

You can use the Divider layout to add an HTML divider to the form. The Divider sets the boundary of a `<div>` tag. A typical use of the Divider option is to associate a business object or a form Layout type with a set of css styles associated with the `<div>` tag. Any item added to a Divider—for example, a dataslot, a table, a tabbed pane or a field set, assumes the style assigned to the Divider.

**To define properties for the divider:**

1. Select the Divider layout and define the Divider properties in the **Properties** view (Figure 183 on page 269).

2. Enter the divider name in the **ID** value box. The name (or its Field ID) must be a unique designation because JavaScript uses it to identify the field. As this designation must be unique, Progress Developer Studio for OpenEdge does not allow the duplication of the field name.

3. Select a Class from the list of predefined styles. To do so, click the **ellipsis** button in the **Value** column, then select the style from the **Style** dialog box.

4. Use the **Style** to associate a particular style to the selected class. To do so, click the **ellipsis** button in the **Value** column, then select the style from the **Style** dialog box.

5. Use the **Events** tab to add events associated with the layout. For information regarding the usage of the **Events** tab, see Configuring actions on page 299.

The figure below shows the Divider properties. This class, “ApBody”, is applied to any form component added to the Divider.

**Figure 183: Form Editor – Divider Properties**

![Divider Properties](image)
Note: You can save and use a customized divider in other forms by clicking File > Save As and save it in the appropriate Form fragments folder. After you save the divider and refresh Progress Developer Studio for OpenEdge, the customized divider can be retrieved from the Form Fragments section in the Tasks pane. For more information, see Using form fragments on page 293.

Adding a Panel

You can use the Panel layout to embed form components. A panel functions as a Divider, and supports attributes including title, width, height, and collapsibility.

To define properties for a Panel layout, select the panel layout and define the panel properties in the Properties view.

Figure 184: Form Editor – Panel

1. Enter the panel name in the ID value box. The panel name (or its Field ID) must be a unique designation because JavaScript uses it to identify the field. As this designation must be unique, Progress Developer Studio for OpenEdge does not allow the duplication of the field name.
2. Enter the panel title in the Title value box. The panel title is displayed in the form interface.
3. From the Collapsible value box, enable (or disable) the collapsibility by specifying true or false.
4. From the Width and Height value boxes, set the width and height (in pixels) of the panel.
5. Use the Style to associate a particular style to the selected class. To do so, click the ellipsis button in the Value column, then select the style from the Style dialog box.

Select a Class from the list of predefined styles. To do so, click the ellipsis button in the Value column, then select the style from the Style dialog box.

Note: The Events tab is not supported for Panel layout.
Adding an Include layout

You can use an Include layout to insert an inline frame within a form or a block of text. It can act as a target for other links, including URLs, HTML documents, and external objects. The Include layout can act as a Client-side Include that uses an iFrame layout option; or as a Server-side Include, where the content of the Include section is generated on the server and is rendered on the Form Editor as HTML markup (equivalent to using a `<jsp:include>` tag in JSP forms).

To define properties for an Include section, select the Include layout and define the properties in the Properties view.

**Figure 185: Form Editor – Include Properties**

1. Enter a name for the Include layout in the Name value box. The name (or its Field ID) must be a unique designation because JavaScript uses it to identify the field. As this designation must be unique, Progress Developer Studio for OpenEdge does not allow the duplication of the field name.
2. For Type box, select either the Client-side Include or Server-side Include option.
3. For a Client-side Include, enter a valid URL in the URL box.
   The URL parameter for a client-side Include section can be a Relative or an Absolute URL. In addition, the value can be dynamically assigned by using a tag such as: `<bpmwebflow:value name='myDataslot'/>`. In this example, the Include option has its source set dynamically based on the value of myDataslot, which must be a CHARACTER dataslot with a valid URL as its value.
4. For a Server-side Include, enter a URL in the URL box, or click the ellipsis button beside the URL box to select a JSP file published on the server. In this case, the content of the Include section is generated on the server and rendered on the form as HTML markup. The Server-side URL can be a Relative URL that starts with "...", or an Absolute URL that starts with "http://", or Relative to the Web application root that starts with "${request.contextPath}".

**Note:** The Events tab is not supported for Include layout.

Assigning a style

You can use the Style Sheet Links function to associate a specific style sheet (or *.css file) with the main form, a table, or table cell (or group of tables or cells); for example, you can change the background color for a column in a table or define a border style around fields.

To associate a style sheet with a form element:

1. Select a form, table or a table cell (or a group of each type).
2. From the Tools menu, click Style Sheet Links, opening the Style Sheet Links dialog box.
3. To access the *.css files you want, click **New** to open the **Style Sheet Link** dialog box (right image, **Figure 186** on page 272). Click the **ellipsis** button beside the **URL** box and select either of the following options.

- **Use default style sheet** to use the default
- **Select from file** to browse to a location for the *.css files. Select the file, then click **Open** to return to the **Style Sheet Link** dialog box.

4. Click **OK** to add it to the **Style Sheet Links** dialog box. You can also enter or paste a valid URL address (with the http prefix) to access the required *.css files.

5. Select a style sheet from the table in the **Style Sheet Links** dialog box and click **OK** to assign it to the main form, a selected file, or selected table cell.

---

**Defining the form's controls**

The Form Editor supports controls (or widgets) accessible from the **Controls** panel of the **Controls** link in the Form Editor. Form controls provide the following benefits:

- General attributes including appearance and effects, as described in **Setting attributes** on page 274.
- Can be bound to a service, dataslot, or have a static value. For details, see **Using data binding** on page 277.
- Advanced validation framework, as described in **Applying validation** on page 284.
- Advanced event handling.
You can drag each of the following controls to your form, or click the control to insert the control at the insertion point.

Table 59: List of Controls

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextField</td>
<td>A Text field control</td>
</tr>
<tr>
<td>TextArea</td>
<td>A Text Area control</td>
</tr>
<tr>
<td>Combobox</td>
<td>A Combo box control</td>
</tr>
<tr>
<td>Checkbox</td>
<td>A checkbox control</td>
</tr>
<tr>
<td>Radio</td>
<td>A Radio button control</td>
</tr>
<tr>
<td>List</td>
<td>A List control, consisting of static, multiple data</td>
</tr>
<tr>
<td>Tree</td>
<td>A tree control, consisting of nodes and subitems</td>
</tr>
<tr>
<td>Grid</td>
<td>A Grid control</td>
</tr>
<tr>
<td>Menu</td>
<td>A menu control containing an array of menu items</td>
</tr>
<tr>
<td>Slider</td>
<td>A Slider control that enables you to adjust values over a finite range</td>
</tr>
<tr>
<td>Date Time</td>
<td>A data and time control that allows you to choose a date or time</td>
</tr>
<tr>
<td>Button</td>
<td>A generic command button typically used to trigger a event</td>
</tr>
</tbody>
</table>
### Control Names and Descriptions

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>An image control</td>
</tr>
<tr>
<td>Label</td>
<td>A text label. For more information, see Adding a label on page 295.</td>
</tr>
</tbody>
</table>

In addition to these widgets, you can add widgets available on Business Process Server server (located under OEBPS_Home\webapps\deploy\sbm.war\resources folder).

**To add the widget to Form Editor:**

1. Copy the widget folder (available on Business Process Server) to Workspace_Home\.com.savvion.studio\forms\widgets folder.
2. Edit the widgets.xml file (located in Workspace_Home\.com.savvion.studio\forms folder) with the entry for the widget to be added.
   - Add the entry for image (*.png) to any of the available sections (for instance, <sbm>) as `<widget_name icon="<image_name>.png">`. For example, `<textfield icon="textfield_icon.png">`.
3. Start Progress Developer Studio for OpenEdge to view the control in the **Controls** panel in the **Controls** link of the Form Editor Tasks pane.

**Setting attributes**

You can configure control attributes including appearance, effects, and general properties for each control from the **Attributes** tab of control’s **Properties** view. Figure 188 on page 274 displays the **Attributes** tab for a TextField widget.

**Figure 188: Control Properties for TextField widget – Attributes tab**

Table 60 on page 274 describes the common attributes and the list of controls they are used for.

**Table 60: List of Attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Control used for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>TextField, Combobox, Checkbox, Radio, TextArea, List</td>
<td>A Boolean attribute to disable the control or not.</td>
</tr>
</tbody>
</table>
### Table 61: Control-Specific Attributes

<table>
<thead>
<tr>
<th>Control</th>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextField</td>
<td>Type</td>
<td>Indicates the type of text field control. Available options are <strong>Text</strong>, <strong>Password</strong>, and <strong>Label</strong>.</td>
</tr>
<tr>
<td></td>
<td>Max Length</td>
<td>An integer attribute to specify the maximum number of characters allowed in the control. The default value is 50.</td>
</tr>
<tr>
<td></td>
<td>Effects</td>
<td>Used to apply visual enhancement to the control. The available effects are Fade, Slide, Blind, Grow, Shake, and Highlight. To apply an effect, click the <strong>ellipsis</strong> button in the <strong>Value</strong> column. You can modify the default duration of the effect and set the initial and final opacity (in pixels or percentage) of the effect.</td>
</tr>
<tr>
<td>Control</td>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Combobox</td>
<td>Dropdown Size</td>
<td>Used to specify the size of the dropdown list of the Combobox control.</td>
</tr>
<tr>
<td></td>
<td>Cascade / Level</td>
<td>Used for creating a cascading control. For details, see Creating a cascading combo box with Tree service on page 283.</td>
</tr>
<tr>
<td>TextArea</td>
<td>Wrap</td>
<td>To enable or disable word wrap. Select any of the following available options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Soft</strong>: to move the entire word being truncated to the next line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Hard</strong>: to split the word.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Off</strong>: to disable word wrap. In this case, the entered text appears on a same line.</td>
</tr>
<tr>
<td></td>
<td>Rows</td>
<td>Indicates the rows of text displayed in the Text Area.</td>
</tr>
<tr>
<td></td>
<td>Cols</td>
<td>Indicates the appropriate width of the control.</td>
</tr>
<tr>
<td>Image</td>
<td>URL</td>
<td>Used to specify the image file to be displayed in your form.</td>
</tr>
<tr>
<td></td>
<td>width/ height</td>
<td>Used to specify the size (in pixels) of the image.</td>
</tr>
<tr>
<td>Slider</td>
<td>initialValue</td>
<td>Indicates the starting point (and value) of the slider.</td>
</tr>
<tr>
<td></td>
<td>maxValue</td>
<td>Indicates the maximum value (or point) of the slider.</td>
</tr>
<tr>
<td></td>
<td>minValue</td>
<td>Indicates the minimum value (or point) of the slider.</td>
</tr>
<tr>
<td></td>
<td>sizeInPixels</td>
<td>Used to specify the size (in pixels) of the slider.</td>
</tr>
<tr>
<td></td>
<td>sliderType</td>
<td>Sets the slider orientation to Horizontal (H) or Vertical (V).</td>
</tr>
<tr>
<td></td>
<td>tickSize</td>
<td>Specifies the size of each movement of the slider.</td>
</tr>
<tr>
<td>Date Time</td>
<td>Display Format</td>
<td>Used to set the display format of the date. The default format is MM/dd/yyyy.</td>
</tr>
<tr>
<td>Button</td>
<td>type</td>
<td>Specifies the type of button. Available options are: button, complete, cancel, reset, save, and reassign.</td>
</tr>
<tr>
<td></td>
<td>label</td>
<td>Specifies the button label. Default label is “Push me.”</td>
</tr>
<tr>
<td></td>
<td>checked</td>
<td>A Boolean attribute to indicate if the control is selected or not.</td>
</tr>
</tbody>
</table>

**Note:** For information on attributes specific to Label control, see Adding a label on page 295.

To enter an attribute value, click the **Value** column for that attribute and type the value. Alternatively, to select an attribute value, double-click the **Value** column for that attribute and select the value from the drop-down list that appears.
Using data binding

Progress Developer Studio for OpenEdge supports multiple dataslot types for binding to a form control. For example, the “Date Time” control can be bound to a CHARACTER or DateTimeTZ dataslot. You can define the data binding using the Data Binding tab of control’s Properties view. Figure 189 on page 277 displays the Data Binding tab for a TextField control.

Figure 189: Control Properties for TextField control—Data Binding tab

Depending on the type of control, the Data Binding tab contains the following properties:

- **Data Source** property (not available for List, Combo box, Radio, and Check box controls), using which you can select the data source to which you can bind the control. To configure a data source, click the ellipsis button in the Value column for the Data Source property. The Data Source Binding Wizard appears.

Figure 190: Data Source Binding wizard

You can select any of the following options for data source:

- **Service**, as discussed in Using a defined service on page 279.
- **DataSlot**, as discussed in Using dataslot on page 279.
- **Static** (default), as discussed in Specifying static data on page 282.

- **Choices** property (available only for multi-select controls including List, Combobox, Radio, and Checkbox), using which you can select the choice option for populating the control. To configure a choice, click the ellipsis button in the Value column for the Choices property. The Choices Data Binding Wizard appears.
You can select any of the following options for populating the control:

- **Service**, as discussed in Using a defined service on page 279.
- **DataSlot**, as discussed in Using dataslot on page 279.
- **Adaplet**, as discussed in Using adaplets on page 282.
- **Static**, as discussed in Specifying static data on page 282.

- **Data Target** property (not available for List, Combobox, Radio, and Checkbox controls), using which you can select the dataslot to store the control data when the form is submitted. If you have specified a dataslot as the source dataslot in the **Data Source** property, the same dataslot must be used in the **Data Target** property. To configure a data target, click the **ellipsis** button in the **Value** column for the **Data Target** property. The **Data Binding Wizard** appears.

Select the **DataSlot** option for the data target. For more information, see Using dataslot on page 279.

- **Selection Source/Target** property (available only for List, Combobox, Radio, and Checkbox controls), using which you can select the same dataslot to be used as the source (for data retrieving) and target (for data storage). To configure this property, click the **ellipsis** button in the **Value** column for the **Selection Source/Target** property. The **Data Binding Wizard** appears,
which is similar to Figure 192 on page 278. Select the DataSlot option for the source and target. For more information, see Using dataslot on page 279.

Note: The Data Binding tab is not available for the Button control.

Using a defined service

You can bind controls to a defined service (*.sjs) to be used either as a data source or as a choice for populating Combobox, List, Checkbox, and Radio controls.

To do so:

1. From the Data Source Binding Wizard (Figure 190 on page 277) or Choices Data Binding Wizard (Figure 191 on page 278), click the Service option, then click Next.

Note: For information regarding creating a service, see Working with Form Data Designer tool on page 409.

2. From the second page of the respective wizard, select either of the following data sources:

   • Specify the JSON file. To do so, click the ellipsis button and select the JSON file (*.sjs) located in the <Project_Name>/jsp folder.
   • Specify the URL to a location that returns JSON style data. You can use this option for dynamic services that connect to the datasource at runtime and return data in proper JSON format. For an example of dynamic services, refer to the "WidgetDemo" project, which contains the Grid control bound to the data1.jsp service. At runtime, this service uses Hibernate to query the database and returns data in the grid JSON format.

3. Click Finish to add the specified service and specify the value as "Service" for the respective property.

Using dataslot

You can bind controls to supported dataslots to be used as a data source, data target (or both), or as a choice for populating Combobox, List, Checkbox, and Radio controls. You cannot bind Tree, Grid, and Image controls to dataslots.
To bind the control to a dataslot:

1. From the **Data Source Binding Wizard** (Figure 190 on page 277), **Choices Data Binding Wizard** (Figure 191 on page 278), or **Data Binding Wizard** (Figure 192 on page 278), click the **DataSlot** option, then click **Next**.

2. The second page of the respective wizard displays the list of system-defined (not available for Data Target) and user-defined dataslots.

**Figure 194: Selecting a dataslot**

![Data Source Binding Wizard](image)

- Select the dataslot to populate the control.
- Click **Finish** to add the specified dataslot and value (if set) and specify the value as "DataSlot" for the respective property.

If you select a dataslot in the **Data Source** property for the control, the **Data Target** property is disabled as the same dataslot specified in the **Data Source** property is used to store the output data. For the other selections, you can select the dataslot in the **Data Target** property similar to as described in the preceding steps.

**Note:** For the Slider control, you can only specify a dataslot in the **Data Target** property.

For Combo box, List, Checkbox, and Radio controls, you can use the **Selection Source/Target** property to specify the dataslot to be used as the source and target.

**Note:** You can also bind a control to a dataslot by dragging the valid dataslot from the **Data Sources** section of the Tasks pane (as described in **Binding to a data source** on page 290) on the control.

Table 62 on page 280 provides the list of supported dataslot types for each of the controls.

**Table 62: Supported Dataslot Types for Controls**

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Dataslot Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextField</td>
<td>• CHARACTER</td>
</tr>
<tr>
<td></td>
<td>• INTEGER and INT64</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER and INTEGER attributes of Business Object dataslot</td>
</tr>
</tbody>
</table>
### Defining the form's controls

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Dataslot Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextArea</td>
<td>• CHARACTER</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER attribute of Business Object dataslot</td>
</tr>
<tr>
<td>Combobox</td>
<td>• CHARACTER</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER attribute of Business Object dataslot</td>
</tr>
<tr>
<td>Checkbox</td>
<td>• CHARACTER, LOGICAL</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER and LOGICAL attributes of Business Object dataslot</td>
</tr>
<tr>
<td>Radio</td>
<td>• CHARACTER, List</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER attribute of Business Object dataslot</td>
</tr>
<tr>
<td>List</td>
<td>• CHARACTER for choice dataslot only.</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER attribute of Business Object dataslot (for choice dataslot only)</td>
</tr>
<tr>
<td>Image</td>
<td>Dataslots not supported.</td>
</tr>
<tr>
<td>Tree</td>
<td>Dataslots not supported.</td>
</tr>
<tr>
<td>Grid</td>
<td>Dataslots not supported.</td>
</tr>
<tr>
<td>Menu</td>
<td>• CHARACTER</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER attribute of Business Object dataslot</td>
</tr>
<tr>
<td>Slider</td>
<td>Supported only for target dataslot:</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER attribute of Business Object dataslot</td>
</tr>
<tr>
<td>Date Time</td>
<td>• CHARACTER, DateTimeTZ</td>
</tr>
<tr>
<td></td>
<td>• CHARACTER and DateTimeTZ attributes of Business Object dataslot</td>
</tr>
</tbody>
</table>
Using adaplets

Adaplets are preconfigured managed adapters used in forms. An adaplet represents a managed adapter with a predefined output format. For more information regarding adaplets, see Adding adaplets to a form on page 292.

You can bind Combobox, List, Checkbox, and Radio controls to adaplets, which returns a List object to the control.

To bind a control to an adaplet:

1. From the **Choices Data Binding Wizard** (Figure 191 on page 278), click the **Adaplet** option, then click **Next**.
2. From the second page of the **Choices Data Binding Wizard**, click the **ellipsis** button to open the **Select Choices Source** dialog box, which lists the defined adaplets under each configured adapter. For example, DBAdapter1.
3. Select the adaplet, then click **OK** to bind the adaplet to the control. Ensure that you select an adaplet that returns a List object to the control.

Specifying static data

You can specify a static value for controls.

To enter static data for the control:

1. From the **Data Source Binding Wizard** (Figure 190 on page 277) or **Choices Data Binding Wizard** (Figure 191 on page 278), click the **Static** option, then click **Next**.
2. The second page of the respective wizard displays two tabs, namely, **Editor** and **Source**.

   The appearance of the **Editor** and **Source** tabs differs for each control, as described in Table 63 on page 282.

<table>
<thead>
<tr>
<th>Controls</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextField, TextArea, Image, Slider, Date Time</td>
<td>Enter the initial value in the box provided in the <strong>Editor</strong> tab.</td>
</tr>
<tr>
<td>Checkbox, Combobox, List, Radio</td>
<td>Enter the label/value pair by clicking <strong>New</strong> and entering the appropriate details. Repeat for additional label/value pairs. You can also modify, remove, or change the position of the list entries.</td>
</tr>
</tbody>
</table>
| Tree | • To edit any of the existing nodes, select the node and click **Edit Node**. Modify the label and value in the appropriate boxes.  
• To add a node, select the root node and click **Add Node**. Enter the label and value in the appropriate boxes.  
• You can also remove and change the node position. |
### Defining the form's controls

<table>
<thead>
<tr>
<th>Controls</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Menu** | Design a menu.  
- To add a node, select the root node and click **Add Node**. Enter the label and the menu action to be performed. You can also specify a style (*.CSS) and disable the node.  
- To edit any of the existing nodes, select the node and click **Edit Node**. Modify the menu properties, as required.  
- You can also remove and change the node position. |
| **Grid** | Design a grid. You can edit the table contents and column name, as well as add and remove rows/columns. You can also move up (or down) the inserted rows. |

3. Click **Finish** to add the static value and specify the value as “Static” for the respective property.

### Creating a cascading combo box with Tree service

You can create a cascading combo box widget by binding a collection of combo boxes to the same Tree service, designed using the Form Data Designer tool. In these cases, each combo box lists only those options defined at each node level in the multi-level tree.

**To design a cascading combo box:**

1. Design a tree service with three levels using the Form Data Designer tool. For details, see **Using the Tree service** on page 411. Save the Tree service as `tree.sjs`.

Figure 195: Sample Tree service

```
Regions
  • Please select a region
  western
    • Select a state in west
    california
      • Select a city in CA
        • san francisco
        • santa clara
    eastern
      • Select a city in AZ
        • phoenix
    midwest
      • Select a city in IL
        • chicago
        • champaign
  florida
    • Select a city in FL
      • miami
      • orlando
```

2. Add three combo boxes to your form using the **Combobox** control.
3. Bind each control to the Tree service (tree.sjs) file by selecting the **Service** option.
4. To configure the cascading effect, click the **Attributes** tab (in the **Properties** view) for each control.
a) Set the **Cascade** attribute to “true” for each control.
b) Use the **Level** attribute to enter a level corresponding to the level in the tree. The starting level is “0” for the first tree level (in this case, “western” and “eastern”) and increments by 1 for each higher level.

On loading the form, the combo box (with Level “1”) lists the options depending on the option selected in the combo box (with Level “0”). For example, “california” and “arizona” if “western” is selected. Similarly, the combo box (with Level “2”) lists the options depending on the option selected in the combo box (with Level “1”).

### Applying validation

You can use an advanced validation framework to validate controls in the **Validation** tab of control’s **Properties** view. You can configure validation for the **TextField**, **CheckBox**, **Combobox**, **List**, **Radio**, and **TextArea** controls. **Figure 196** on page 284 displays a sample **Validation** tab for a **TextField** control.

**Figure 196: Control Properties for TextField control – Validation tab**

![Validation tab example](image)

**Table 64** on page 284 lists the common validation rules for all controls.

**Table 64: Common Validation Rules**

<table>
<thead>
<tr>
<th>Validation Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate On</td>
<td>Specifies when to validate the control. Available options are “[blur]” (when the control loses focus), “[change]” (when the data is entered or modified in the control), and “[blur,change]” when both these events occur.</td>
</tr>
<tr>
<td>IsRequired</td>
<td>Specifies if the control is a required field.</td>
</tr>
<tr>
<td>Use Character Masking</td>
<td>(Available for TextField and TextArea) Enables character masking (or wildcard entry) for the controls. Not available for TextField types “Email” and “URL.”</td>
</tr>
<tr>
<td>Minimum Characters</td>
<td>(Available for TextField and TextArea) Specifies the minimum number of characters to be entered in the control. In the case of TextField, this field is available only for types, “Email” and “URL.”</td>
</tr>
<tr>
<td>Validation Rule</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Maximum Characters</td>
<td>(Available for TextField and TextArea) Specifies the maximum number of characters which can be entered in the control. In the case of TextField, this field is available only for types, “Email” and “URL.”</td>
</tr>
<tr>
<td>Invalid Value</td>
<td>(Available for Combobox and List) Specifies the value that cannot be entered in the control. Default value is -1.</td>
</tr>
</tbody>
</table>

Table 65 on page 285 lists the control-specific validation rules.

**Table 65: Widget-Specific Validation Rules**

<table>
<thead>
<tr>
<th>Control</th>
<th>Validation Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkbox</td>
<td>Minimum Selections</td>
<td>Used to specify the minimum number of checkboxes in a group to be selected.</td>
</tr>
<tr>
<td></td>
<td>Maximum Selections</td>
<td>Used to specify the maximum number of checkboxes in a group to be selected.</td>
</tr>
<tr>
<td>Control</td>
<td>Validation Rule</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TextField</td>
<td><strong>Credit Card Format</strong></td>
<td>(Available for type “Credit Card”) Used for validating format of credit card number. Available formats are Visa, Mastercard, Amex, Discover, and Dinersclub.</td>
</tr>
<tr>
<td>Minimum / Maximum Value</td>
<td><strong>(Available for types “Currency,” “Date,” “Integer,” “Real,” and “Time”)</strong></td>
<td>Used to specify a range of values that can be entered.</td>
</tr>
<tr>
<td>Pattern</td>
<td><strong>(Available for types “Custom,” “Social Security Number,” “Phone Number,” and “Zip Code”)</strong></td>
<td>Used for setting the pattern of the entered value. Patterns include checking for whole numbers and case-sensitivity.</td>
</tr>
<tr>
<td>Date Format</td>
<td><strong>(Available for type “Date”)</strong></td>
<td>Used for validating format of the entered date. Available formats are mm/dd/yy, mm/dd/yyyy, dd/mm/yy, dd/mm/yyyy, yy/mm/dd, yyyy/mm/dd, mm-dd-yy, dd-mm-yy, yyyy-mm-dd, mm.dd.yyyy, and dd.mm.yyyy.</td>
</tr>
<tr>
<td>IP format</td>
<td><strong>(Available for type “IP”)</strong></td>
<td>Used for validating format of the entered IP address. Available formats are IPv4, Dot Comma, and IPv4, IPv6.</td>
</tr>
<tr>
<td>Phone Format</td>
<td><strong>(Available for type “Phone Number”)</strong></td>
<td>Used for customizing format of the phone number. Available formats are Custom Phone Number (default) and Phone Number. You can customize the phone number format using the <strong>Pattern</strong> box.</td>
</tr>
<tr>
<td>Time Format</td>
<td><strong>(Available for type “Time”)</strong></td>
<td>Used for validating format of the entered time. Available formats are HH:mm, HH:mm:ss, hh:mm tt, hh:mm:ss tt, hh:mm t, and hh:mm:ss t.</td>
</tr>
<tr>
<td>TextArea</td>
<td><strong>Textarea Counter Type</strong></td>
<td>Checks the number of characters entered. Available types are “Characters Remaining,” which deducts the number of entered characters from the value in the <strong>Maximum Characters</strong> box, and “Character Count” which counts the number of entered characters.</td>
</tr>
<tr>
<td></td>
<td><strong>Textarea Hint</strong></td>
<td>Indicates the type of data that the user needs to enter in the Text Area.</td>
</tr>
</tbody>
</table>

*Table 66* on page 287 lists the error messages for each control in case of validation failure.
Table 66: Validation Messages

<table>
<thead>
<tr>
<th>Control</th>
<th>Validation Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextField</td>
<td>Textfield Required Message</td>
<td>Used to specify a common message for any validation failure.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Checkbox Required Message</td>
<td>Used to specify the message in case a required checkbox is not selected.</td>
</tr>
<tr>
<td></td>
<td>Checkbox Minimum Selection Message</td>
<td>Used to specify the message in case the minimum number of checkboxes are not selected.</td>
</tr>
<tr>
<td></td>
<td>Checkbox Maximum Selection Message</td>
<td>Used to specify the message in case the maximum number of checkboxes are exceeded.</td>
</tr>
<tr>
<td>Radio</td>
<td>Radio Required Message</td>
<td>Used to specify a common message for any validation failure.</td>
</tr>
<tr>
<td>TextArea</td>
<td>Textarea Validation Message</td>
<td>Used to specify the message in case an invalid value is entered.</td>
</tr>
<tr>
<td></td>
<td>Validation Minimum Characters Message</td>
<td>Used to specify the message in case the minimum number of characters are not entered.</td>
</tr>
<tr>
<td></td>
<td>Validation Maximum Characters Message</td>
<td>Used to specify the message in case the maximum number of characters are exceeded.</td>
</tr>
</tbody>
</table>

**Note:** You can use the Events tab to add events associated with the control. For information regarding the usage of the Events tab, see Configuring actions on page 299.

---

**Defining the form's flow**

You can add navigation tools to your form using the Flow link in the Tasks pane. Using this link, you can add a button or link that helps you to proceed to the next workstep. The Flow section in the Form Editor displays the Button and Link flow controls, each of which you can click to add to the Content pane.

**Adding a button**

You can use the Button icon to add a button to your form. By default, an added button is displayed as a Complete button (Complete). For example, you can add the Complete button to a customized footer in your form. For a form workstep in a Web application, you can use the Complete button to activate the next page.
To define the button properties, click the button to display its Control Properties in the Properties view. By default, the Properties view opens to the General tab.

**Figure 197: Control Properties – Button**

1. Accept the default name assigned to the control or enter a unique name in the ID box. The control name (or its Field ID) must be a unique designation because JavaScript uses it to identify the field. As this designation must be unique, Progress Developer Studio for OpenEdge does not allow the duplication of a control name.

2. Use the Tab Order box to set the sequence in which the various controls appear in the presentation by entering a sequence of numbers; for example, 1, 2, 3, 4, 5, 6.

3. Select the button type from the Type drop-down list. Table 67 on page 288 lists the available button types.

**Table 67: Button Types**

<table>
<thead>
<tr>
<th>Button Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>To complete the workstep.</td>
</tr>
<tr>
<td>Save</td>
<td>To save form details.</td>
</tr>
<tr>
<td>Reset</td>
<td>To reset the form field details to its original values.</td>
</tr>
<tr>
<td>Cancel</td>
<td>To cancel the changes made, and exit the form.</td>
</tr>
<tr>
<td>Reassign</td>
<td>To reassign the workstep to another performer.</td>
</tr>
<tr>
<td>Button</td>
<td>A configurable command button to perform any other function.</td>
</tr>
</tbody>
</table>

4. Enter a label for the button in the Label box. The Label overwrites the name of the selected type.

5. Use the Description tab (optional) to enter a description.

6. Use the Events tab to add events associated with the control. For information regarding the usage of the Events tab, see Configuring actions on page 299.

**Adding a link**

You can use the Link icon to add a link to your form. You can also specify the target URL of the link and indicate how the target URL opens in Business Process Portal. In the case of a link, you can specify the link properties when you click the Link icon in the Tasks pane.
Defining the form's data sources

You can use the Data Sources link in the Tasks pane to bind form elements to a Dataslot or Adaplet. The Data Sources function in the Tasks pane displays all the current process-level dataslots and adaplets.
You can expand the **Dataslots** and **Adaplets** folders to view and select the item you want to bind to the Form Editor element.

- The **Dataslots** folder contains two subfolders, namely, **System Dataslots** (predefined dataslots displayed only for forms in Business Processes) and **User Dataslots** (user-defined dataslots).

- The **Adaplets** folder contains DBAdapters and WebServiceAdapters adaplet types. For more information, see Adding adaplets to a form on page 292).

**Figure 199: Data Sources section in the Form Editor**

You can add more user-defined dataslots to the existing list. Right-click the **User Dataslots** folder, then select **Add** option to open the **New Dataslot** dialog box where you can add a new dataslot. For more information, see Creating user-defined dataslots on page 152.

You can add all the listed dataslots (system and user) in bulk to your form.

1. Expand the **Dataslots** folder, then drag the **System Dataslots** folder (to add all the predefined system dataslots available in a Business Process) or **User Dataslots** folder (to add all the user-defined dataslots) to your form.

   The Form Editor displays the following options:
   - **Controls Table**, to display the added dataslots in a two-column table.
   - **Controls**, to display the added dataslots as separate fields.

2. Click the appropriate option to add the dataslots in bulk.

   **Note:** You can also add business objects with "Collection" attribute by dragging them to your form. For more information, see Using business objects in a form on page 456.

**Binding to a data source**

You can drag an individual dataslot or adaplet to a blank portion of your form to create a data source field. You can also drag a data source to an existing table column, text field, or other control element, in order to bind it to the Form Editor element.

**Binding to a data source** on page 290 is an example of form elements added by dragging the corresponding dataslot.
You can edit the label of the bound form element, by right-clicking the label (displayed in orange typeface), then selecting the **Label Properties** option. For further details, see **Adding a label** on page 295.

You can define properties for the form element bound to a dataslot, similar to defining properties for an unbound element. To define the properties for a field bound to a dataslot, click the control to view its Control Properties (as described in the Defining the form’s controls topic) in the **Properties** view.

The **Properties** view for each dataslot type (bound to the control) is described below:

- For controls bound to Character or Integer dataslot types, the **Properties** view is the same as that for the Text Field control.
- For controls bound to DateTimeTZ dataslot type, the **Properties** view is the same as that for the Date Time control.
- For controls bound to Logical dataslot type, the **Properties** view is the same as that for the Checkbox control.
- For controls bound to LIST dataslot type, the **Properties** view is the same as that for the List control.
- For controls bound to Map dataslot type, the **Properties** view is the same as that for the Combobox control.
- For controls bound to an Object dataslot, the **Properties** view includes the **Renderer** box with the default custom dataslot (**Binding to a data source** on page 290). To use a Custom Dataslot in a form, retain Default as the Renderer. You can use the default renderer if its class implements iHTML (or inline HTML) and Serializable.
Adding adaplets to a form

Adaplets contain the same functions that Managed Adapters have, but are more compact—for example, they can be included in a form without adding a separate Adapter workstep or additional dataslots. Using an adaplet enables you to add a configured adapter to a workstep’s presentation form and associate it with a form element. When you open that workstep as a task in Business Process Portal, the adaplet controls are displayed when a specified event, such as loading the form or on clicking a button, occurs.

You can review the group of adaplets (generic and preconfigured) in the Adaplets folder in the Data Sources section of the Tasks pane. For instance, WebServiceAdapters displays its generic and preconfigured (if any) adaplets.

You can only use adaplets that have been preconfigured. You may not use generic adaplets in the Form Editor unless you configure them first. To configure a generic adaplet, right-click the adaplet and select Properties option. The Configurator for that adaplet opens; for example, selecting Properties for the DAdapter opens the DBAdapter Configurator dialog box. For information on configuring a specific adaplet type, see the relevant chapter in the Managed Adapters Guide. You can also use this method to re-configure an existing preconfigured adaplet.

**Note:** The preconfigured adaplet can only be used for the current form.

Alternatively, you can configure an adaplet from the Managed Adapter Browser by making a copy of a generic adapter and configuring it. For more information on using this browser, see Using Managed Adapter Browser on page 463.

**Note:** If you add or configure an adaplet in the Managed Adapter Browser, you can use the Refresh functionality to reflect the changes in the adaplet list in your form. To do so, right-click the adaplet folder in the Data Sources link and select the Refresh option.

You can drag the configured adaplet into the form. You can also expand a configured adaplet and drag and drop one or more of its input/output parameters in the form.

You can invoke an adaplet from an added form control using the Graphical Event Logic (GEL) tool, as described in Adding Expressions on page 323. For example, to copy the dataslot values when the adaplet is invoked, use a callback function as described in the following steps:

1. Create the preconfigured adaplet, "GetCustomerInfo" for an DBAdapter in your process.
2. Add the button, "button1" in your form and add the onClick event to this button.
3. Using Graphical Event Logic (GEL) tool, add the "Invoke adaplet with callback" expression for this event with the "<activity_name>/<DBAdapters>/GetCustomerInfo" as the adaplet name and updateFields() as the callback function.

   In this case, the callback function, updateFields(), is invoked following completion of the GetCustomerInfo adaplet.

4. Add the following JavaScript for the updateFields() method in the Script tab (Using Script tab on page 303) of the Form Editor.

```javascript
function updateFields() {
    sbm.util.setValue('custid_ds', sbm.util.getValue('CustomerID'));
    sbm.util.setValue('custname_ds', sbm.util.getValue('CustomerName'));
    sbm.util.setValue('custaddr_ds', sbm.util.getValue('CustomerAddress'));
}
```
When you open this form in Business Process Portal, the input/output parameters (including Customer ID and Customer Address) of the DBAdapter will be displayed and available for users to view or enter input. Click the Submit button (“button1”) to open the Web services Adapter.

Using form fragments

You can add customized form elements (for example, a header, footer, divider, table, or other Layout fragment) to your form, using the Form Fragments link in the Tasks pane. The Form Fragments section displays individual form elements that are not associated with any specific functionality. You can define form fragments for the following categories in Form Editor:

- **Local**: to be accessed by forms in current process only. You must save the local form fragments in the
  Workspace_Home\<project_folder>\<application_folder>\resources\forms\fragments folder.
- **Workspace**: to be accessed by forms in current and other processes. You must save the workspace form fragments in the
  Workspace_Home\.com.savvion.studio\forms\bpserver (or bpmwebflow)\fragments folder.

The new form fragment appears in the respective category (Local or Workspace) under Form Fragments section in the Tasks pane (as shown in Figure 202 on page 293). You can then drag a specific form fragment into the Content pane and use it as a predefined element in other forms as well.

You can easily develop a form using available form fragments. In the example shown in Figure 202 on page 293, the form header was created from the “Custom” type header and the footer from the “Custom” type footer in the Local form fragment category.

**Figure 202: Form Editor – Using Form Fragments**

![Form Editor with Form Fragments](image)

Defining header and footer fragments

By default, the Form Fragments section displays two subfolders, namely, Headers and Footers, in the Local and Workspace category folders. The Headers and Footers folders contains the Custom form fragment.

To define a custom header or footer:
1. From the Form Fragments section, expand **Local** (or **Workspace**) folder, and then **Headers** (or **Footers**) subfolder, and drag the Custom fragment to the Content pane. This inserts a custom header (or footer) table.

2. You can customize the custom (or footer) table and the controls added in the footer, according to your requirement. Click the form element to be customized, and modify the properties in the **Properties** view.

3. To use the customized Header (or Footer) in other forms, click **File > Save As** and save it to the **Workspace_Home\com.savvion.studio\forms\bpserver\fragments\Headers** (or **Footers**) folder. After you save the form and refresh BPM Designer, the modified Header (or Footer) can be retrieved from the Workspace category in the Form Fragments section.

---

### Defining custom footer with work time

**To define a custom Footer with Work Time:**

- From the Form Fragments section, expand **Local** (or **Workspace**) folder, and then **Footers** subfolder, and drag the Work Time fragment to the Content pane.

The Footer with Work Time (as shown in Figure 202 on page 293) contains fields for Days, Hours and Minutes of Work Time, in addition to the fields in the Standard footer. Each performer assigned a task that contains this footer can enter the time it actually took him/her to complete this task. This information is required when you are running simulations of real-time data.

### Defining other form fragments

In addition to header and footer fragment, you can customize layout controls such as table, divider, field set, and tabbed pane and add them to the form fragment section.

**Note:** You cannot add a form fragment within another form fragment.

**To create a custom form fragment:**

1. Open a blank Content pane in the Form Editor.
2. Add a **Divider** layout to your form, as described in **Adding a divider** on page 269.
3. Within the divider, add a table, divider, or other layout options to be used as form fragments. For information, see **Defining the form’s layout** on page 265.
4. Click **File > Save As**, and save the fragment (*.sft) file as a local form fragment (in the **Workspace_Home\<application_folder>\resources\forms\fragments** folder) or as a workspace form fragment (in the **Workspace_Home\com.savvion.studio\forms\bpserver** (or **bpmwebflow**) **fragments** folder).
5. Restart Form Editor, and the saved fragment appears in the respective category in the Form Fragments section.

---

### Using form fragments by reference

You can use form fragments by reference in new and existing forms. The key benefit of using form fragments by reference is that you can edit a form fragment (local and workspace category) in Progress Developer Studio for OpenEdge, independent of the form in which it is used. Once saved, all the forms in the process that contain this form fragment are updated to reflect the change.
To update a form fragment by reference:

1. Create a form using Form Editor and add a form fragment (for example, Custom footer) to this form.
2. Save and close the form.
3. Open the form fragment for editing as follows:
   - For local form fragments, from the Project Explorer, double-click the associated *.sft located in <project_name>esources\forms\fragments folder (for example, Custom.sft located in <project_name>\..\fragments\Footers folder) to display the selected form fragment in the Form Editor.
   - For workspace form fragments, click File > Open File, then go to the Workspace_Home\.com.savvion.studio\forms\bpserver\fragments\Headers (or Footers) folder. Double-click the associated *.sft file to display the selected form fragment in the Form Editor.
4. Edit the form fragment (*.sft) using the Form Editor features. For example, drag a user-defined dataslot to the Custom footer.
5. Save and close the Form Fragment file.
6. Open the form containing this form fragment.

The form now displays the updated form fragment.

Other Form Editor operations

This section describes other Form Editor operations such as adding a label and inserting a dataslot value.

Adding a label

You can add a label with a key/value pair (or as a static value) to your form. For localizing purpose, it is easier to use the key/value pair for inserted labels in your form.

You can add a label to your form using either of the following methods:

- By dragging the Label control from the Controls panel in the Form Editor tasks pane (Figure 187 on page 273). You can use this method to add a label with static text.
- By right-clicking a blank portion of your form and select the Insert > Insert Label option. The Insert Label dialog box appears, which lists the keys defined in the application-specific properties file. Select a key, then click OK to insert the label with a key. At runtime, the label is replaced with the key value, specified in the properties file.
Labels with static text are displayed on your form with an orange typeface (for example, ManagerName). Labels with keys are displayed on your form with a grey typeface (for example, %process.label). Similar to other form elements, you can drag the labels to other locations in your form and configure its properties in the Properties view.

To define properties for the added label, select the label and define the label properties in the Properties view.

1. From the Label For property, select the control ID associated with this label. Click in the Value column box to select the control.

2. Enter the label name in the ID value box. This name is in a <div> tag that you can refer to when generating JavaScript in the Script tab. This name must be unique. You can refer to the label's name to hide (or show) it as required by entering JavaScript in the Script tab; for example: sbm.util.hide('name_MyCustAddress');

3. In the Text box, enter the label text that you will see in your form. You can enter a static value for the label (for example, "Enter name."). Alternatively, you can link the label value to a dataslot value. Click in the Value column box and type '@' to display the list of dataslots in the process. Select the dataslot to be linked to this label.

To modify the label text to a property key, type '%' in the Value column box to display the list of property keys (as listed in Figure 203 on page 296). Select the key to be used as the label value.
Note: You cannot edit the text of an inserted label directly on the form. You can only modify the label using the Properties view.

The added label is saved in the <App_Name>.properties file under the properties folder of the application. Any key/value pairs imported from other properties files are merged with the application's properties file and saved as properties\<App_Name>.properties. You can localize the key/value pairs by manually copying the <App_Name>.properties file and renaming it as a localizable file; for instance, <App_Name ja>.properties. You can then open this file with a text editor and change its key/value settings to labels in Japanese. For a language that does not use a Latin 1 compatible character set, you can use the Java tool native2ascii (see the appropriate Java documentation) to more easily edit non-Latin 1 *.properties files.

Inserting a dataslot value

To insert a dataslot value to your form:

1. Right-click a blank portion of your form and select the Insert > Insert Dataslot Value option to open the Dataslot Value dialog box. Use this dialog box to select a dataslot and include its value as a label that is visible in Business Portal Portal.
2. Select the dataslot whose value you want to insert into your form.
   To add a new dataslot, click New, to open the New Dataslot dialog box; or select a dataslot from those listed and click Modify to modify it in the Modify Dataslot dialog box, which appears.
   a) Enter a value, if required, and make any other required changes.
   b) Click OK, to return to the Dataslot Value dialog box.
3. Click OK to add the Dataslot value to the Form Editor interface.

   The name of the Dataslot containing the assigned value is displayed in the Form Editor in a blue typeface, as shown in this example: newAssignee.

Using the Overview tab

The Overview tab in the Form Editor interface provides a list of the form elements added in the Layout tab. The Overview tab provides the following benefits:

- You can filter the list of form elements on basis of the element type (for example, TextField).
- You can search a form element using its unique ID (or name). For example, if you enter the search text as "list0," the search result displays List controls with ID, "list0" and "list01." Similarly, if you search for "01," all form elements with "01" in their ID (for example, "textField01," "checkbox01, "fieldSet01") are listed.
- You can configure the properties of each form element in the Properties view without switching to the Layout tab.
- Any form element changes that you make in the Overview tab are reflected in the Layout tab as both tabs are synchronized. You can also select a form element in either tab and switch to the other tab to view the selection.
• It is easier to review the form design from the **Overview** tab. You can view all the form elements, including the controls inside a layout and check the dataslot binding, choice binding, validations, and events for each control.

The **Overview** tab is useful for complex forms with multiple form elements. The figure below displays a sample **Overview** tab.

**Figure 205: Form Editor - Overview tab**

The **Overview** tab displays the following default information about each form element in a tabular format:

**Table 69: Information in Overview tab**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements</td>
<td>Displays the name (or Field ID) of the form element. To change the name, click the row of the form element and modify the name using the <strong>Properties</strong> view.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of form element. For example, Image, TextField.</td>
</tr>
<tr>
<td>Source</td>
<td>Displays the data source (if any) bound to the control. You can also set (or modify) the data source in the <strong>Data Source Binding Wizard</strong> (Figure 190 on page 277), which appears when you click the <strong>ellipsis</strong> (...) button for the control in this column.</td>
</tr>
<tr>
<td>Target</td>
<td>Displays the data target (if any) bound to the control. You can also set (or modify) the data target in the <strong>Data Binding Wizard</strong> (Figure 192 on page 278), which appears when you click the <strong>ellipsis</strong> (...) button for the control in this column.</td>
</tr>
<tr>
<td>Choices</td>
<td>Displays the source of choices (if any) bound to multi-select controls. You can also set (or modify) the choice source in the <strong>Choices Data Source Binding Wizard</strong> (Figure 191 on page 278), which appears when you click the <strong>ellipsis</strong> (...) button for the control in this column.</td>
</tr>
<tr>
<td>Validation</td>
<td>Displays any validation rule configured for the control. For details on applying validation, see <strong>Applying validation</strong> on page 284.</td>
</tr>
<tr>
<td>Events</td>
<td>Displays events (if any) added to this control. For more information, see <strong>Configuring actions</strong> on page 299.</td>
</tr>
</tbody>
</table>

The table below describes the operations that you can perform in the **Overview** tab.
**Configuring actions**

The Form Editor provides the **Events** tab in the **Properties** view of your form and for each added element in your form.

**Note:** The **Events** tab is not supported for Grid and Menu controls.

**To configure actions for your added control or layout:**

1. Add a form element (example, a Text field) to your form.
2. Select the added element, then open the **Events** tab in the **Properties** view. The list of events in the **Events** tab vary according to the selected element.
3. Select an event (in this case, onClick), then click **Add** to open the **Event Name** dialog box, in which you can modify the default event name, if required. For information about all form events, see **About form events** on page 300.

**Figure 206: Adding an Event**

4. Click **OK** to add the event name to the **Events** tab.
The Graphical Event Logic (GEL) tool appears with the added event. For more information, see Using the GEL tool in Form Editor on page 323.

- To remove the event, click Remove.
- Alternatively, to open the GEL tool for the added event, click View Action.

About form events

You can add JavaScript events for your form (and form elements) in the Events tab of the Properties view.

You can add the following events for the form in the Form Properties view (Figure 177 on page 263):

- **onLoad**: This event occurs when the form is loaded.
- **onUnload**: This event occurs when the form is unloaded.
- **onSubmit**: This event occurs when you submit the form.

The table below lists and describes the form events and the form elements to which they can be added.

Table 71: Form Events

<table>
<thead>
<tr>
<th>Event name</th>
<th>Supported form elements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>onClick</td>
<td>Layout controls: Table, Field Set, Divider Form controls: TextField, Checkbox, Radio, Tree, Menu, Button Flow controls: Button</td>
<td>This event occurs when you click the element.</td>
</tr>
<tr>
<td>onDblClick</td>
<td>Layout controls: Table, Field Set, Divider Flow control: Button</td>
<td>This event occurs when you double-click the element.</td>
</tr>
<tr>
<td>Event name</td>
<td>Supported form elements</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>onChange</td>
<td>Layout controls: TextField, TextArea, Combobox, Checkbox,</td>
<td>This event occurs when the selection, the checked state, or the contents</td>
</tr>
<tr>
<td></td>
<td>Radio, List, Slider</td>
<td>of the element is changed.</td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onFocus</td>
<td>Layout controls: TextField, Combobox,</td>
<td>This event occurs when the element receives focus.</td>
</tr>
<tr>
<td></td>
<td>Checkbox, Radio, List, Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onBlur</td>
<td>Layout controls: TextField, Combobox,</td>
<td>This event occurs when the element loses focus.</td>
</tr>
<tr>
<td></td>
<td>Checkbox, Radio, List, Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onSelect</td>
<td>Grid, Date Time</td>
<td>This event occurs when some content of the element is selected.</td>
</tr>
<tr>
<td>onMouseDown</td>
<td>Layout controls: Table, Field Set,</td>
<td>This event occurs when you press a mouse button over an element.</td>
</tr>
<tr>
<td></td>
<td>Divider</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Form controls: TextField, Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onMouseUp</td>
<td>Form control: Image</td>
<td>This event occurs when you release a mouse button over an element.</td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>Event name</td>
<td>Supported form elements</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>onMouseMove</td>
<td>Layout controls: Table, Field Set, Divider</td>
<td>This event occurs when you hover (or move) your mouse over the element.</td>
</tr>
<tr>
<td></td>
<td>Form control: Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onMouseOver</td>
<td>Layout controls: Table, Field Set, Divider</td>
<td>This event occurs when you move your mouse pointer into the element.</td>
</tr>
<tr>
<td></td>
<td>Form control: Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onMouseOut</td>
<td>Layout controls: Table, Field Set, Divider</td>
<td>This event occurs when you move your mouse pointer out of the element.</td>
</tr>
<tr>
<td></td>
<td>Form controls: TextField, Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
<tr>
<td>onKeyDown</td>
<td>Layout controls: Table, Field Set, Divider</td>
<td>This event occurs when you press any key on the element that has the focus.</td>
</tr>
<tr>
<td></td>
<td>Flow control: Button</td>
<td></td>
</tr>
</tbody>
</table>
### Event name | Supported form elements | Description
--- | --- | ---
oneKeyUp | Layout controls: Table, Field Set, Divider Form control: TextField Flow control: Button | This event occurs when you release any key on the element that has the focus.
oneKeyPress | Layout controls: Table, Field Set, Divider Form controls: TextField, TextArea Flow control: Button | This event occurs when you press a key on the element that has the focus. Unlike the onKeyRed event, this event is not supported for all keys.

### Using Script tab

You can use the **Script** tab in the Form Editor interface, which provides the JavaScript editor to add Java or JavaScript code to your form.

### Adding script

You can add Java and JavaScript methods using the JavaScript editor in the **Script** tab. The JavaScript editor displays the default AutoComplete options. To populate Business Process Server options, the Progress Developer Studio for OpenEdgeScript Library is added with the BPM project.

**Note:** The JavaScript editor does not support parameter level AutoComplete.

1. From the **Script** tab, enter the functions that you want to use.

   Alternatively, use the AutoComplete feature by entering `sbm` to activate a series of JavaScript packages containing methods and utilities.
2. Depending on the function selected, build your JavaScript method or utility, as required.

**Note:** For more information on the functions in each package in the AutoComplete feature, see AutoComplete APIs.

3. Press **ENTER** to start a new line and add more JavaScript code, if needed.

### Referencing JavaScript file

You can insert a reference to a specific JavaScript (or *.js file) from your local file system (Relative) or from remote files (Absolute) to your form. The JavaScript commands in the referenced file are executed when the form is loaded in Business Process Portal. To insert a reference:

1. From the **Tools** menu, click **Scripts**, to open the **Scripts** dialog box (left image, Figure 208 on page 304).

2. To insert a source *.js file, click **New** to open the **Script** dialog box (right image, Figure 208 on page 304). To reference a local file, click the **ellipsis** button beside the **Source** box to select the *.js file you require and click **Open**, to return to the **Script** dialog box. Click **OK** to add it to the list in the **Scripts** dialog box.

   To insert a reference to a remote file, enter or paste a valid URL in the **Source** box in the **Script** dialog box. Click **OK** to add it to the **Scripts** dialog box.

   **Note:** If you select a Relative reference, note that JavaScript is not loaded until it is published. If you select a URL (Absolute) reference, the *.js file is available to all applications.

3. Click **OK** to insert the reference.
Adding code

You can also insert a code snippet to your form:

1. Right-click a blank portion of your form and select the Insert > Insert Code option to open the Code dialog box.
2. Enter custom code (either HTML or JSP) and click OK.

The code is displayed in the Form Editor in a distinctive background and font color with angle brackets, as in `< ? >`.

To edit the code snippet, select `< ? >`. Right-click the selection, then select Insert > Insert Code option to open the Code dialog box, in which you can edit the code.

Managing forms

When you publish the process, the *.xml file you have created in the Form Editor (for instance, Activity1.xml) is transformed to a *.jsp file, which is placed in the jsp folder under that application (for instance, Approval\jsp\Activity1.jsp), and published on the server. After publishing, you can delete the generated *.jsp forms, which is typical behavior for most business users who have completed all the customization of the form in the Form Editor.

As an advanced user, however, you may want to further customize the generated JSPs before they are published on the server. You can create an interface in the Form Editor, then save it as a custom JSP form. You can then open the JSP pages and further customize the interface to your specifications.

You can also save and reuse any forms you have created in the Form Editor.

To save a form to your Form Library:

1. From the File menu, click Save As, to open the Save As dialog box.
2. Type a file name and click Save to save the form in the forms folder in Business Process Modeler.

   This form is now displayed in the File tab of the New Form dialog box (Figure 176 on page 262) and is available to all processes in your Business Process Modeler installation.
3. To reuse a form in another workstep, click the New Form button from the Form Editor toolbar. Select the form you want to reuse. For more information, see Using a form template on page 262.

   **Note:** Dataslot bindings persist for worksteps within the same process, or if dataslots of the same name exist in other processes. If a dataslot with the same name is not found, however, the dataslot binding is discarded when you perform the Save As operation.

Previewing forms

After designing a form using Form Editor, you can preview its appearance in your Web browser.
To preview a form, click the **Preview** icon in the Form Editor toolbar. The Form Editor renders the form preview using a generated JSP page, which is the same as the page rendered by Business Process Portal to display the form. You can interact with the form similar to how you interact with a rendered form using Business Process Portal. Additionally, clicking the **Preview** icon prompts you to save the form (only if your form has unsaved changes). You can save the form to reflect the changes in the form preview. If you do not save the form, the form preview is displayed for the previously saved form.

The following figure illustrates the form preview of the "Load Form" form workstep in the FormsDemo sample process.

**Figure 209: Sample Form Preview**

To view the form in your default Web browser, click **Go** to open the specified URL in your browser.

---

**Note:** Form preview resembles the native Web browser of the operating system; for example, Internet Explorer for Windows operating system.

Form preview supports:

- Rendering of all form controls.
- Rendering of data of form controls bound to static data and services. Form controls bound to dataslots are rendered with the dataslot values.
- Rendering of all form layouts.

**Note:** Form preview fails if the port number specified in the **Form** page of the **Preferences** dialog box (Figure 61 on page 125) is not available. Ensure that this port number is available or modify the port number in the **Form** page. Form preview in multiple sessions of Progress Developer Studio for OpenEdge must be performed using different port numbers.

Form preview does not support:

- Access to runtime data using adaplets.
- Custom scripting.
- Rendering of any effects and event actions configured for form controls.

**Caution:** Do not attempt to use JavaScript invocation code when in the Preview mode. Preview can only be used to see how the form might look in Business Process Portal.
Note: To preview forms on a UNIX platform, you must modify the browser handler that is located in
Workspace_Home\.com.savvion.studio\conf\resources\designer\DesignerFileTypes.xml, where in $DLC is your OpenEdge installation directory. For all UNIX operating systems, the argument for command should not contain quotes (shown as &quot;).

Invoking server-side methods

You can invoke server-side methods by using Direct Web Remoting (DWR).

Perform the following procedures if you have a Java class with a function that returns a value you want to use on the client (either a Collection or primitive value). In this example, you can expose the getProcessTemplateWorksteps(String processTemplateName) function from the Java class com.savvion.sbm.bizmanage.api.BPM Manage APIBean. This class returns the list of worksteps for a particular process template.

To do this:

1. Create the following entry for the class and function in the dwr.xml located in the $webapp\sbm.war\WEB-INF folder.

   <create creator="new" javascript="BMB" class="com.savvion.sbm.bizmanage.api.BPM Manage APIBean"><include method="getProcessTemplateWorksteps"/></create>

Observe the following best practices:

- The JavaScript attribute value above must be unique. It should not have the same value as any of the other create tags in the file.
- The class attribute value must be the class name of the containing class, including the package hierarchy.
- The method attribute value of the include tag must be the name of the method you want to expose. You may expose multiple methods per class, by adding another include tag for each method you want to expose.

2. Modify the sbm.js to include the JavaScript method that will access your newly exposed java method, as shown in the following sample entry for getProcessTemplateWorksteps:

   function getProcessTemplateWorkstepList(processTemplateName, callback)
   {DWREngine._execute('/sbm/dwr', 'BMB', 'getProcessTemplateWorksteps', callback, processTemplateName);
   }

   The above sample code defines a new JavaScript function that takes two parameters: callback, which is the name of the JavaScript method the engine will appropriately call back after completing, and processTemplateName which will be the process template name.

3. You must also create your own DWREngine._execute() call. The first parameter, which is the URL to send the request to, must always be /sbm/dwr. The second parameter, BMB, must match the JavaScript attribute value of the create tag you made in the dwr.xml file. The third parameter is the name of the method you want to call. The fourth parameter is the name of the

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio
callback method. In this case, the name of the callback method is passed on. After passing on, all of the parameter values required by your java method are taken in the order it expects them. If your method has no parameters, your call will end after the callback method. In this example, the Java method takes one parameter—the process template name.

4. Call the newly created JavaScript method from your web page. The following sample provides a usage of the `getProcessTemplateWorkstepList` method defined above.

```javascript
function updateWorksteps()
{var appName = getValue('application');
getProcessTemplateWorkstepList(appName, createList);
}function createList(WsList)
{
DWRUtil.removeAllOptions("workstep");
DWRUtil.addOptions("workstep", allOption);
DWRUtil.addOptions("workstep", WsList);
}
```

The HTML code is not included, but the onChange event of the application combo box calls the `updateWorksteps()` method. The `getValue` method retrieves the value of the application combo box. Then, the `getProcessTemplateWorkstepList` method is called, passing the process template named retrieved from the combo box and the callback method `createList`. When the DWR engine has finished executing the Java method, it calls the `createList` function passing the list that the Java method returned as its return value. Then, use the enclosed utility functions to remove all the existing options in the workstep combo box, add an 'All' option, and add all of that process template's worksteps to the workstep combo box.
Working with Graphical Event Logic tool

Progress Developer Studio for OpenEdge provides the Graphical Event Logic tool (henceforth referred to as GEL tool), which allows you to configure actions for worksteps (for example, on workstep completion) and events for form elements (for example, textField1_onChange).

For details, see the following topics:

- Benefits
- Exploring the GEL tool
- Using the GEL tool in BPM projects
- Using the GEL tool in Form Editor
- Other GEL tool operations

Benefits

The GEL tool provides the following benefits:

- Provides a centralized location to configure multiple actions.
- Provides a framework to define logic actions without scripting. This is useful for business users, who do not have knowledge of Java (or JavaScript) languages.
- Easy user interaction using GEL actions, which can be simply dragged to configure the logic. Additionally, you can easily rearrange and remove actions.
- Allows you to develop customized GEL actions.
• Provides a consistent UI design across Progress Developer Studio for OpenEdge modules. The GEL tool is currently used in:
  • The Logic tab in the Form Editor interface.
  • The Logic content pane tab in the Progress Developer Studio for OpenEdge interface.

Exploring the GEL tool

This section describes the commonly-used user interface elements of the GEL tool. You can access the GEL tool from the Logic tab in the Progress Developer Studio for OpenEdge and Form Editor interfaces.

Figure 210 on page 310 displays the GEL tool user interface for a Business Process.

Figure 210: GEL Tool User Interface

The following table describes the commonly-used elements in the GEL tool interface.
Table 72: GEL Editor Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Contains icons providing shortcuts to the following commonly used functions:</td>
</tr>
<tr>
<td></td>
<td>- Expand all (_expand) icon, to display the details of all added actions.</td>
</tr>
<tr>
<td></td>
<td>- Collapse all (折叠) icon, to hide the details and only display the list of actions.</td>
</tr>
<tr>
<td></td>
<td>- Show only functions for selection (显示) icon, to filter the list of displayed actions based on the process template (or form) element you select in the Diagram content pane tab (or Layout view of Form Editor). To activate this function, select this icon and click the element (for example, &quot;Activity1&quot;) in the Diagram tab. The Logic tab displays only those actions defined for &quot;Activity1&quot; workstep.</td>
</tr>
<tr>
<td></td>
<td>- The Search box, which can be used to search the action name. Type the text to be searched in the Search box.</td>
</tr>
<tr>
<td>Main pane</td>
<td>Displays the list of events added for all process template (or form) elements. You can configure events for multiple elements. To configure an event, drag any expression action from the Expressions pane to the added event. For each listed event, you can click the View/Change info (更改) icon to enter information about the event (for example, &quot;This block contains actions that are performed before the activation of Activity1 workstep.&quot;). You can enter your customized text in the Information dialog box that appears. Alternatively, you can open the Information dialog box by right-clicking the event header and selecting the View/Change info option. Similarly, you can enter information for each action that you drag to the added event. For more information, see Adding information to action blocks on page 331.</td>
</tr>
<tr>
<td>Palette pane</td>
<td>Displays the list of available GEL actions that you can drag to a defined event. The set of available GEL actions in the Palette pane varies for a BPM project (as discussed in GEL Actions in BPM projects on page 312) and for Form Editor (as discussed in GEL Actions in Form Editor on page 323). You can also create custom GEL actions and include the same in the Palette pane, as discussed in Customizing GEL Actions on page 331.</td>
</tr>
</tbody>
</table>

Using the GEL tool in BPM projects

This section describes how you can configure logic actions for a Business Process (or Web application) using the GEL tool. The Logic content pane tab provides the list of defined events for worksteps. Before using the GEL tool, you must define the logic event in the Advanced tab of the workstep Properties view. For example, to define a logic event for Start workstep, see Using the Advanced tab of Start workstep properties on page 179.
Note: In the following sections, the Logic view for Business Process is presented, which is applicable to Web applications as well, unless otherwise stated.

GEL Actions in BPM projects

The following table lists the out-of-the-box GEL actions in the Palette pane for a Business Process (or Web application).

Table 73: Palette pane in BPM projects

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Operations pane</td>
<td>Displays the list of data operations that you can drag to a defined event in the Logic tab. For information on data operations, see Adding data operations on page 312.</td>
</tr>
<tr>
<td>Value Expressions pane</td>
<td>Displays the list of value expressions that you can add in the Logic tab. For information on value expressions, see Adding value expressions on page 313.</td>
</tr>
<tr>
<td>Other pane</td>
<td>Displays the list of expression constructs (including IF-THEN, IF-THEN-ELSE, and WHILE loop) and custom Java (and JavaScript) code. For more information, see Adding control structures and custom script on page 315.</td>
</tr>
<tr>
<td>Conditions pane</td>
<td>Displays the list of comparison conditions, validations, and custom conditions that you can drag to an expression construct in the Logic tab. For information on conditions, see Adding Conditions on page 317.</td>
</tr>
<tr>
<td>JSTools API</td>
<td>Displays the list of API methods that you can configure for a defined event in the Logic tab. For information on JSTools API methods, see Using JSTools API on page 320.</td>
</tr>
</tbody>
</table>

Adding data operations

You can use the Data Operations pane in the Logic tab to add data operations to listed events.

Figure 211: Data Operations pane

You can drag and configure the following GEL actions for each added event.

- **Set Dataslot**: Sets the value of a user-defined dataslot to a constant value. Alternatively, you can set the value of the dataslot to a value expression, as discussed in Adding value expressions on page 313.

  Figure 212: Example
• **Set Context Variable**: Allows you to define a context variable and set its value to a constant value. Alternatively, you can set the value of the variable to a value expression, as discussed in *Adding value expressions* on page 313.

![Figure 213: Example](image1)

• **Copy Value (generic)**: Copies a constant value to the selected user-defined dataslot. Alternatively, you can copy values between value expressions, as discussed in *Adding value expressions* on page 313.

![Figure 214: Example](image2)

### Adding value expressions

You can use the Value Expressions pane in the Logic tab to add value expressions to GEL actions with data operations (as discussed in *Adding data operations* on page 312) and expression constructs with conditions (as discussed in *Adding Conditions* on page 317).

![Figure 215: Value Expressions pane](image3)

You can remove the default options of data operations and conditions and replace it with any of the value expressions. To perform this, you must first close the default option (for example, the "(constant) <value_box>" for the Set Dataslot action) and then drag the value expression to the placeholder labeled, "Drop value expression here."

You can drag and configure the following GEL actions.

• **User Dataslot**: To use a user-defined dataslot. For instance, you can set the value of another user-defined dataslot (or variable) to a user dataslot.

![Figure 216: Example](image4)

• **System Dataslot**: To use a system (or predefined) dataslot. For instance, you can set the value of a user-defined dataslot (or variable) to a system dataslot. This option is not available for Web applications.

![Figure 217: Example](image5)
• **Constant Expression**: To use a constant expression (or constant value). For instance, you can use this to revert the Set Dataslot and Set Context Variable actions (if you have changed the default options) to its default target constant value.

• **Custom Expressions**: To use customized Java (or JavaScript). For instance, you can specify a Java (or JavaScript) function that returns a particular value, which can be assigned to a variable (or dataslot).

**Figure 218: Example**

![Example](image)

**Note**: You can also use the AutoComplete functionality to automatically add script functions. To activate AutoComplete, type `jst.` (for a Business Process) or `bean.` (for a Web application) in the respective box.

• **Context Variable**: To use a context variable. For instance, you can copy the value of a context variable to another context variable.

**Figure 219: Example**

![Example](image)

### Value expressions in web applications

For Web applications, you can use the Value Expressions pane for additional value expressions used for complex expressions and date/time operations.

**Figure 220: Value Expressions pane for Web applications**

You can drag and configure the following additional GEL actions.

• **Complex Expressions**: Used for complex expressions. The supported actions are:
  - **Number Operation**: Used to perform arithmetic operations (add, subtract, divide, and multiple) on other value expressions. For instance, you can calculate the sum of values of two user-defined dataslots (or variables).

**Figure 221: Example**

![Example](image)
• **String Concatenation**: Used to perform String concatenation on other value expressions. For instance, you can concatenate the string values of two user-defined dataslots (or variables).

   **Figure 222: Example**

   ![Figure 222](image)

• **Statistical Operation**: Used to perform Statistical operations (sum, average, minimum, maximum) on multiple value expressions. For instance, you can calculate the average of values of two user-defined dataslots (or variables).

   **Figure 223: Example**

   ![Figure 223](image)

• **Date/Time**: Used for adding date and time expressions. The supported GEL actions are:

  • **Date-Only**: Used to add a date expression in dd-mm-yyyy format. You can modify the default date by clicking the icon.

   **Figure 224: Example**

   ![Figure 224](image)

  • **Date/Time**: Used to add date (in dd-mm-yyyy format) and time (in hh:mm:ss format) expressions. You can modify the default date by clicking the icon and the default time by using the arrow keys.

   **Figure 225: Example**

   ![Figure 225](image)

• **Time Interval**: Used to assign a time interval with days, hours, minutes, and seconds boxes. You can modify the default values in these boxes by using the arrow keys.

   **Figure 226: Example**

   ![Figure 226](image)

**Adding control structures and custom script**

You can use the **Other** pane in the **Logic** tab to add control structures and custom script to listed events.
You can drag and configure the following GEL actions for each added event.

- **Control Structures**: Used to add expression constructs. The supported actions are:
  - **If-Then** and **If-Then-Else**: Used to add an IF-THEN and IF-THEN-ELSE constructs. For the IF block, you must add a condition, as discussed in Adding Conditions on page 317.
  
  ![Figure 228: IF-THEN-ELSE construct](image)

- **While loop**: Used to add a WHILE loop. For the WHILE block, you must add a condition, as discussed in Adding Conditions on page 317.

  ![Figure 229: WHILE loop](image)

- **For loop**: Used to add a FOR loop.

  ![Figure 230: Example](image)

**Note**: Depending on your requirement, you can also create nested actions using the above control structures.

- **Return value**: Used to return the specified value.

  ![Figure 231: Example](image)
• **Custom**: Used to add customized Java (or JavaScript). The supported actions are:

  - **Custom script (one line)**: Used to add a single line of code.

    Figure 232: Example

    ![Activity 1_WhenCompleted](image)
    ```java
    jst.putDataSlot("dsAgr","ebms")
    ```

  - **Custom script (multi-line)**: Used to add multiple lines of Java (or JavaScript) code.

    Figure 233: Example

    ![Activity 1_WhenCompleted](image)
    ```java
    jst.getName()
    jst.sendEmail(String address,String subject,String content)
    ```

**Note**: You can also use the AutoComplete functionality to automatically add script functions. To activate AutoComplete, type `jst.` (for a BPM process) or `bean.` (for a Web application) in the respective box.

• **Query APIs for DataSet and TempTable**: You can use this feature to execute an API support query like:

  - `jst.insertRow("<dataslot_name>", "<table name>", map);` which creates another map to adds a record.
  - `jst.deleteRow("<dataslot_name>", "<table name>", map);` which deletes multiple records that match values specified in the table.

**Note**: If any of the column in the map does not have a matching value with the corresponding column for a row in the table, that row will not be deleted.

The dataslot can either be a TempTable or a ProdataSet.

**Note**: Indexing items with square brackets (ex: “Customers[0]/Name”) does not work with ProDataSets and the query based on the attribute value, ex: “OrderItem[ProductId=1]” always returns the first match though there is more than one match with a ProductId=1.

---

**Adding Conditions**

You can use the **Conditions** pane in the **Logic** tab to add conditions to IF-THEN, IF-THEN-ELSE, and WHILE constructs.
You can drag and configure the following conditions.

- **Comparisons**: Used to compare value of an added dataslot (or variable) with static values or value in another added dataslot (or variable), and also to check the length of the entered value. The supported conditions are:
  - **Numerical Comparison**: Compares the value of a user-defined dataslot to a number. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 313.
  - **String Comparison**: Compares the value of a user-defined dataslot to a Character. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 313.
  - **Boolean Comparison**: Checks if the value of a user-defined Logical dataslot is true or false. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 313.
- **Object Comparison**: Compares the values of user-defined dataslots of the same dataslot type. Alternatively, you can replace the user dataslot boxes with any of the value expressions, as discussed in Adding value expressions on page 313.

  **Figure 238: Example**
  ![Object Comparison Example](image)

- **Null/Empty String**: Used to check if a user-defined dataslot contains a value or not. Alternatively, you can replace the user dataslot box with any of the value expressions, as discussed in Adding value expressions on page 313.

  **Figure 239: Example**
  ![Null/Empty String Example](image)

- **String length**: Used to check the string length of a user-defined dataslot. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 313.

  **Figure 240: Example**
  ![String length Example](image)

- **Other**: Used to apply validation rules and customized code as conditions in expression constructs. The supported conditions are:
  - **Regex validation**: Used as a regular expression (regex) validator. Matches the value of a user-defined dataslot to a regex constant value. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 313.

    **Figure 241: Example**
    ![Regex validation Example](image)

- **Complex condition**: Used to add multiple (or cascading) conditions. You can configure this condition to perform the action if all (or any) of the conditions are satisfied.
Figure 242: Example

- **Custom condition (one line):** Used to add a single line of Java (or JavaScript) condition.

Figure 243: Example

- **Custom condition (multi-line):** Used to add multiple lines of Java (or JavaScript) condition. Depending on your requirement, you can build your code block that returns true (or false) value.

**Note:** You can also use the AutoComplete functionality to automatically add script functions. To activate AutoComplete, type `jst.` (for a Business Process) or `bean.` (for a Web application) in the respective box.

**Using JSTools API**

You can use the JSTools API pane in the Logic tab to add JSTools API methods to listed events. This pane is not available for Web applications.
You can drag and configure the JSTools API methods from each of the following categories:

- **Getters**: includes methods that return a value. You can use these methods:
  
  - To assign a value to a dataslot (or variable) in data operations (see Adding data operations on page 312) instead of a value expression.

  **Figure 245: Example**

  ![Set the value of priority to JSTools API call: getPriority()](image)

  - In conditions (see Adding Conditions on page 317) to replace the user dataslot and constant expression boxes.

  **Figure 246: Example**

- **Setters**: includes methods that store a value. The supported methods are:
  
  - **setDueDate()**: Used to specify the user-defined dataslot to store the due date value. Alternatively, you can replace the user dataslot box with any of the value expressions, as discussed in Adding value expressions on page 313.
  
  - **setInstruction()**: Used to store the instructions entered as a constant value. Alternatively, you can replace the constant expression box with any of the value expressions, as discussed in Adding value expressions on page 313.
• **setPerformer()**: Used to store the performer entered as a constant value. Alternatively, you can replace the constant expression box with any of the value expressions, as discussed in Adding value expressions on page 313.

• **setXPathValue()**: Used to specify the user-defined dataslot to store the passed XPath constant value at the specified XPath location. Alternatively, you can replace the XPath and Value constant expression box with any of the value expressions, as discussed in Adding value expressions on page 313. setXPathValue can be used to set xpath value in LongChar or TempTable/Dataset (Use SDO XPath for TempTable/DataSet).

• **insertRow**: This API accepts three arguments- DataSlotName, TableName, Java Map Object. Java Map Object has key-value pairs for the table’s ‘column name’ and their ‘values’. Values in the map can either be provided as java objects or as a string. The entry for Insert is as follows:

```java
gel.insertRow(<DataslotName>, <TempTable Name>, map)
```

• **deleteRow**: This API accepts three arguments- DataSlotName, TableName, Java Map Object. Java Map Objects have key-value pairs for the table’s ‘column name’ and their ‘values’. The entry for Delete is as follows:

```java
gel.deleteRow(<DataslotName>, <TempTable Name>, map)
```

**Note**: Users should add only those columns (in the map) for which a row with matching data has to be deleted. For example, if input map has four columns and if a row doesn’t have matching data even for a single column out of the four, the row will not be deleted. If the input map has a wrong column name, none of the rows get deleted because every column name in the map should match with a column in the table and the data should match too. Values in the map can be provided either as a java object or a string.

• **get(dataslot, xpath)**: This can be used to get xpath value in a longchar or TempTable/Dataset. (Use SDO XPath for TempTable/DataSet)

• **Utility**: provides the following utility methods:

  • **sendMail()**: Used to send a mail. This utility allows you to specify the email address, subject, and message as constant values. Alternatively, you can replace the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 313.

  • **writeLog()**: Used to debug Java (or JavaScript) code. This utility allows you to specify the debug message as a constant value. Alternatively, you can replace the constant expression box with any of the value expressions, as discussed in Adding value expressions on page 313.

**Note**: You can also use the AutoComplete functionality to automatically add the above functions. To activate AutoComplete, type `jst.` (for a Business Process) or `bean.` (for a Web application) in the respective box.
Using the GEL tool in Form Editor

This section describes how you can configure logic actions for Form Editor elements using the GEL tool. The Logic tab provides the list of defined events for form elements, as discussed in Configuring actions on page 299.

Note: For a tutorial on using the GEL tool in Form Editor, see Tutorial: Using the GEL tool in Form Editor.

GEL Actions in Form Editor

The following table lists the out-of-the-box GEL actions in the Palette pane for Form Editor.

Table 74: Palette pane in Form Editor

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expressions pane</td>
<td>Displays the list of expressions that you can drag to a defined event in the Logic tab. For information on expressions, see Adding Expressions on page 323.</td>
</tr>
<tr>
<td>Conditions pane</td>
<td>Displays the list of conditions that you can drag to an IF-THEN or IF-THEN-ELSE expression construct in the Logic tab. For information on conditions, see Adding Conditions on page 326.</td>
</tr>
</tbody>
</table>

Adding Expressions

You can use the Expressions pane in the Graphical Event Logic (GEL) editor to add expressions to listed events in the Logic tab.
You can drag and configure the following GEL actions for events generated for each added control in your form.

- **Data Operations**: Associated with TextField, TextArea, and Combobox controls. Supports the following actions:
  
  - **Set widget value**: Sets the value of a control (TextField, TextArea, or Combobox) to a constant value.

    **Figure 248: Example**

    ![Set widget value example](image)

  - **Copy widget value**: Copies the value of one control to another control. Applicable to TextField, TextArea, Radio, Checkbox, Combobox, and List controls.

    **Figure 249: Example**

    ![Copy widget value example](image)

  - **Set XPath Value()**: Used to set xpath value in LongChar or TempTable/Dataset (Use SDO XPath for TempTable/DataSet).

- **Effects**: Applies the selected effect (or visual enhancement) to form elements. The supported effects are:
  
  - **Show widget**: Shows a hidden form element. Applicable to all form elements.

    **Figure 250: Example**

    ![Show widget example](image)

  - **Hide widget**: Hides the selected form element. Applicable to all form elements.

    **Figure 251: Example**

    ![Hide widget example](image)

  - **Enable widget**: Enables the selected form element. Applicable to all form elements.

    **Figure 252: Example**

    ![Enable widget example](image)

  - **Disable widget**: Disables the selected form element. Applicable to all form elements.
• **Messages**: Displays a message to the user in either of the following formats:
  • **Popup message**: Displays the specified message in a popup message.
  • **Inline message**: Displays the specified message as an inline message within the form. The inline message is displayed in the specified Divider layout.

• **Control Structures**: Supports the following actions:
  • **If-Then and If-Then-Else**: Used to add an IF-THEN and IF-THEN-ELSE constructs. For the IF block, you must add a condition, as discussed in Adding Conditions on page 326. Depending on your requirement, you can also create nested actions. For information on usage and examples, see Adding Conditions on page 326.
  • **Stop script execution**: Used to stop the current script execution.
  • **Return value**: Used to return the specified value.

• **Other**: Used to add customized JavaScript and invoke adaplet for your control. The supported actions are:
  • **Custom script (one line)**: Used to add a single line of JavaScript code.
Figure 257: Example

• **Custom script (multi-line):** Used to add multiple lines of JavaScript code.

Figure 258: Example

• **Invoke adaptlet:** Used to invoke the specified adaptlet. For more information on adaptlets, see *Adding adaptlets to a form* on page 292.

Figure 259: Example

• **Invoke adaptlet with callback:** Used to invoke the specified adaptlet along with the callback method. For more information on adaptlets, see *Adding adaptlets to a form* on page 292.

Figure 260: Example

Add Conditions

You can use the **Conditions** pane in the Graphical Event Logic (GEL) editor to add conditions to the IF block of an IF-THEN or IF-THEN-ELSE construct.

Figure 261: Conditions pane

The figure below displays an IF-THEN-ELSE construct.
You can drag and configure the following conditions for the IF block in your IF-THEN and IF-THEN-ELSE control structures.

- **Comparisons**: Used to compare value of an added control with static values or value in another added control, and also to check the length of the entered value. The supported conditions are:
  - **Compare with number**: Compares the value of a control (TextField, TextArea, Combobox, Checkbox, Radio, and List) to a number.
  - **Compare with string**: Compares the value of a control (TextField, TextArea, Combobox, Checkbox, Radio, and List) with a string.
  - **Empty/Nonempty string**: Used to check if a control (TextField, TextArea, Combobox, Checkbox, Radio, and List) contains a value or not.
Figure 265: Example

- **String length**: Used to check the length of a string (or number of characters entered) in a control (TextField, TextArea, Combobox, Checkbox, Radio, and List).

Figure 266: Example

- **Compare two widgets (numeric)**: Compares the numeric value of a control to the numeric value of another control. Applicable to TextField, TextArea, Combobox, Checkbox, Radio, and List controls.

Figure 267: Example

- **Compare two widgets (string)**: Compares the string value of a control to the string value of another control. Applicable to TextField, TextArea, Combobox, Checkbox, Radio, and List controls.
• **Validations**: Used to apply validation rules to all controls. The supported condition is:

  • **Regex validation**: Used as a regular expression (regex) validator.

  **Figure 269: Example**

  ![Example](image)

  ![Example](image)

• **Other**: Used to add JavaScript conditions. The supported conditions are:

  • **Complex condition**: Used to add multiple (or cascading) conditions. You can configure this condition to perform the action if all (or any) of the conditions are satisfied.

  **Figure 270: Example**

  ![Example](image)

  ![Example](image)

• **Custom condition (one line)**: Used to add a single line of JavaScript condition.
Figure 271: Example

- **Custom condition (multi-line):** Used to add multiple lines of JavaScript condition. Depending on your requirement, you can build your JavaScript code block that returns true (or false) value.

Depending on your requirement, you can create nested conditions using the IF-THEN-ELSE construct. For example,

```javascript
Condition1
---Start Block---
Condition2
---Start Block---
Action 2
Action 3
---End Block---
Action 4
---End Block---
```

The figure below shows an example of an IF-THEN construct nested within an IF-THEN-ELSE construct.

Figure 272: Example
Other GEL tool operations

This section describes other GEL tool operations such as adding information to action blocks and customizing GEL actions.

Adding information to action blocks

In addition to storing information for each listed event, the GEL tool allows you to add customized information for each action block within the added event. In the case of an action block containing a large number of actions, this information is useful in providing a summary of the action block.

To add information for an action block, right-click the blank portion of an action block (as illustrated in Figure 273 on page 331) and select the View/Change info option. You can enter the customized information in the Information dialog box that appears.

Figure 273: Adding information for action block

The entered information is displayed when the action block is collapsed. For example, the figure below shows sample information for the above IF-THEN block.

Figure 274: Adding information for action block

Customizing GEL Actions

Progress Developer Studio for OpenEdge stores all out-of-the-box GEL actions (listed in the Palette pane of the GEL tool) as XML files in the following subfolders of the Workspace_Home\com.savvion.studio\scripting folder:

- bpserver folder, which contains GEL action files for BPM processes.
- bpmwebflow folder, which contains GEL action files for Web applications.
- forms folder, which contains GEL action files for Form Editor.

The following table lists the GEL action files available in each of the above folders:
### Table 75: List of GEL action files

<table>
<thead>
<tr>
<th>For</th>
<th>GEL Action files</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Processes</td>
<td>main.palette</td>
<td>The initial file to be loaded and which contains the list of other GEL action files used along with the overall structure including the categories and the labels.</td>
</tr>
<tr>
<td></td>
<td>data_operations.palette</td>
<td>Includes the GEL actions in the <strong>Data Operations</strong> pane, as described in Adding data operations on page 312.</td>
</tr>
<tr>
<td></td>
<td>value_expressions.palette</td>
<td>Includes the GEL actions in the <strong>Value Expressions</strong> pane, as described in Adding value expressions on page 313.</td>
</tr>
<tr>
<td></td>
<td>other.palette, control_structures.palette, custom.palette</td>
<td>For the <strong>Other</strong> pane, which includes the GEL actions in the sub-categories, namely <strong>Control Structures</strong> and <strong>Custom</strong>, as described in Adding control structures and custom script on page 315.</td>
</tr>
<tr>
<td></td>
<td>conditions.palette, conditions_comparison.palette, conditions_other.palette</td>
<td>For the <strong>Conditions</strong> pane, which includes the GEL actions in the sub-categories, namely <strong>Comparisons</strong> and <strong>Other</strong>, as described in Adding Conditions on page 317.</td>
</tr>
<tr>
<td></td>
<td>jst.palette, jst_get.palette, jst_set.palette, jst_utility.palette (located in the jst folder)</td>
<td>For the <strong>JSTools API</strong> pane, which includes the GEL actions in the sub-categories, namely <strong>Getters</strong>, <strong>Setters</strong>, and <strong>Utility</strong>, as described in Using JSTools API on page 320.</td>
</tr>
<tr>
<td>Web applications</td>
<td>The list and description of GEL action files are same as that for Business Processes, with the following differences:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Does not include the JST palette files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Includes the <strong>value_expressions_complex.palette</strong> and <strong>value_expressions_datetime.palette</strong> files, which include the GEL actions in the sub-categories, namely <strong>Complex Expressions</strong> and <strong>Date/Time</strong>, as described in Value expressions in web applications on page 314.</td>
<td></td>
</tr>
<tr>
<td>For</td>
<td>GEL Action files</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Form Editor</td>
<td>main.palette</td>
<td>The initial file to be loaded and which contains the list of other GEL action files used along with the overall structure including the categories and the labels.</td>
</tr>
</tbody>
</table>

The following GEL action files are included in sub-categories under the **Expressions** pane, as described in Adding Expressions on page 323.

- **data_operations.palette**
  - Includes the GEL actions in the **Data Operations** category in the **Expressions** pane.
- **effects.palette**
  - Includes the GEL actions in the **Effects** category in the **Expressions** pane.
- **messages.palette**
  - Includes the GEL actions in the **Messages** category in the **Expressions** pane.
- **control_structures.palette**
  - Includes the GEL actions in the **Control Structures** category in the **Expressions** pane.
- **other_expressions.palette**
  - Includes the GEL actions in the **Other** category in the **Expressions** pane.

The following GEL action files are included in sub-categories under the **Conditions** pane, as described in Adding Conditions on page 326.

- **comparisons.palette**
  - Includes the GEL actions in the **Comparisons** category in the **Conditions** pane.
- **validationspalette**
  - Includes the GEL actions in the **Validations** category in the **Conditions** pane.
- **other_conditions.palette**
  - Includes the GEL actions in the **Other** category in the **Conditions** pane.

You can use the main.palette file to define the categories and the list of GEL action files. The following is the content of the main.palette file used for Form Editor:

```xml
<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<palette version="1.0">
  ...
  <category label="$Scripting.category.expressions" path="expressions"
    icon="fldr_obj.gif"/>
  <category label="$Scripting.category.conditions" path="boolean"
    icon="fldr_obj.gif"/>
</palette>
```
Each `<category>` tag defines the category label (for example, "expressions" and "conditions"), as well as the path of this category in the tree. For the path of subcategories (for example, "data_operations"), you must prefix it with the category name (in this case, "expressions/data_operations"). The order of the subcategories in this file is important, as this same order is displayed in the tree.

Each of the action files (for example, data_operations.palette) includes the list of action items (in this case, "Set widget value" and "Copy widget value"). The content of the data_operations.palette file for Form Editor is provided below:

```xml
<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<palette version="1.0">
  <category label="$Scripting.category.data_operations" path="expressions/data_operations" icon="fldr_obj.gif"/>

  <item label="$Scripting.item.set_widget_value" path="expressions/data_operations" icon="template.gif">
    <grid content="EXPRESSION" collapsible="true" description="$Scripting.item.set_widget_value">
      <template>Bm.util.setValue('${widget}', '${string}');</template>
      <widgets>
        <label row="0" col="0" rowspan="1" colspan="1">$Scripting.label.set_the_value_of</label>
        <choiceWidget col="1" colspan="1" id="widget" row="0" rowspan="1" type="WIDGET" filter="COMBO_BOX,TEXT_AREA,TEXT_FIELD">
          <selection type="widget"></selection>
        </choiceWidget>
        <label col="2" colspan="1">$Scripting.label.to</label>
        <entryWidget row="0" col="3" rowspan="1" colspan="1" id="string" presentation="FIELD" validation="NONE">
          <reference type="constant" encoding="JAVA_STRING"></reference>
        </entryWidget>
      </widgets>
    </grid>
  </item>

  <item label="$Scripting.item.copy_widget_value" path="expressions/data_operations" icon="template.gif">
    ...
  </item>
</palette>
```

**Note:** To define a localized value, you must use the `$property.key` syntax (for example, `$Scripting.item.set_widget_value` instead of “Set the value of”) to refer to a value in your property file. Custom property files must be stored in the same folder location as the *.palette files. Progress Developer Studio for OpenEdge provides two property files namely, scripting.properties and scripting_ja.properties, to be used for localization.
You can create your own categories and custom GEL action files. You must include the same in the `main.palette` file so that the GEL tool (when launched later) displays your custom categories and actions.

The following code is a simplified version of the "Set widget value" action:

```xml
<item label="Set widget value" path="expressions/data_operations"
  icon="template.gif">
  <grid content="EXPRESSION">
    <widgets>
      <label row="0" col="0">Set the value of</label>
      <choiceWidget row="0" col="1" id="widget" type="WIDGET"/>
      <label row="0" col="2">to</label>
      <entryWidget row="0" col="3" id="character" presentation="FIELD">
        <reference type="constant" encoding="JAVA_STRING"></reference>
      </entryWidget>
    </widgets>
    <template>Bm.util.setValue('${widget}', '${string}');</template>
  </grid>
</item>
```

Each `<item>` tag includes the following attributes:

- `label` of the action item that is displayed in the tree (for example, "Set widget value").
- `path`, which defines the location in the tree where the action item appears (in this case, "expressions/data_operations").
- `icon`, which defines the image file to be used for the action item (in this case, "template.gif").

The `grid` item within the `<item>` tag is used to organize the widgets in a grid format. The figure below (with the highlighted widgets) is for the "Set widget value" action item.

**Figure 275: Conditions pane**

![Conditions pane](image)

The `grid` item for the "Set widget value" action item includes the following attributes:

- `label` to add the label, "Set the value of."
- `choiceWidget` to add a combo box. The `id="widget"` attribute is used in code generation to refer to the widget's selected value. The `type="WIDGET"` attribute is used to list all available (or those specified in the `filter` tag) widgets on your form.
- `label` to add the "to" label.
- `entryWidget` to add a text box or text area. The `id` attribute is used in code generation to refer to this widget. The `presentation` attribute is used to specify either a text box or a text area.

The `<template>` tag contains the script to be executed using the values entered (or selected) in the listed fields. The `${<widgetID>}` syntax is used to refer to the widget ID (for example, `${widget}` or `${character}`) and is replaced (at runtime) with value entered in the widget with this ID.

**Note**: For detailed information on all tags and attributes that can be used in the `.PALETTE` files, see [Action script tags](#) on page 336.
Action script tags

You can use the following tags and attributes in the .PALETTE (out-of-the-box and custom) action files:

- `<palette version=1.0>`
  This is the root tag of each .PALETTE file. You must ensure that the `version` attribute value is the same in your custom file.

- `<category label="" path="" icon=""/>`
  Defines the category label (for example, "data operations") and category path (for example, "expressions/data_operations").

- `<item label="" path="" icon=""/>
  Defines the label of the action item (for example, "Set widget value") and the path of the category under which this item is listed (for example, "expressions/data_operations").

- `<grid>`
  The grid container tag with the `<widgets>` tag, which contains the list of nested widgets.

- `<template>`
  Located in the body of the widget and specifies the script generated by the widget. Uses `${widgetID}` to refer to the value of the widget. For list widget values, this tag can include the prefix and suffix using the `prefix ${list} suffix` format, where `${list}` refers to the list of multiple list widget statements, separated by a new line delimiter.

- `<choiceWidget type="" filter=""/>
  This is a combo box widget, which allows you to select a form control, adaplet, or a constant value. The `type` attribute is used to set the type of values (WIDGET, ADAPLET, or CONSTANT). In the case of the `type="WIDGET"` attribute value, you can add the `filter` attribute to specify a comma-separated list of widget types to be displayed. The available widget types are BUTTON, CHECK_BOX, COMBO_BOX, CUSTOM, DATETIME, IMAGE, LINK, LIST, NONE, OBJECT, RADIO_BUTTON, TEXT_AREA, TEXT_FIELD, XML, and DIVIDER. Alternatively, you can use the predefined widget type lists namely, *ALL (for all widgets), *INTEGER_WIDGETS (for widgets with integer values), or *CHARACTER_WIDGETS (for widgets with string values). You can use the following tags within the `<choiceWidget>` block:

  - `<choice type="" presentation="">value</choice>
    You can add multiple `<choice>` tags to list the choices in the combo box widget. The `type` attribute value must match the value of the `type` attribute in the `<choiceWidget>` tag. The `presentation` attribute is used only for `type="CONSTANT"` attribute value and value is displayed in place of the value specified.

  - `<selection type="" presentation="">value</selection>
    Used to specify the default selection among the list of choices in the combo box widget. The `type` attribute value must match the value of the `type` attribute in the `<choiceWidget>` tag. The `presentation` attribute is used only for `type="CONSTANT"` attribute value and value is displayed in place of the value specified.

  - `<string id="" value=""/>`
You can use this tag to predefined a list of widgets that can replace the comma-separated value of the filter attribute in choiceWidget tag. This is useful when the list of widgets in the filter attribute is long and also when you can reuse this string ID at multiple locations. The id attribute is used to set a unique name (for example, "CHARACTER_WIDGETS") and the value attribute is the comma-separated list of widgets.

• To define the <string> tag for use in a single .PALETTE file, you must add the <string> tag definition once before the <choiceWidget> tags in which you want to use it. For example, refer the <string id="MY_WIDGETS" value="CHECK_BOX,COMBO_BOX,LIST,TEXT_AREA,TEXT_FIELD"/> in any <choiceWidget> tag as <choiceWidget type="WIDGET" filter="*MY_WIDGETS"> by using the *ID syntax.

• Alternatively, to define the <string> tag for use in all .PALETTE files, you must add your <string> tag definition in the main.palette file. The main.palette file contains predefined <string> tags, namely, ALL, INTEGER_WIDGETS, and CHARACTER_WIDGETS. You can refer the predefined and custom <string> tags in the <choiceWidget> tags by using the *ID syntax.

• <entryWidget presentation="" validation=""/>

  This is a text box (or text area) widget. The presentation attribute is used to specify if the widget is a text box (value, "FIELD") or a text area (value, "AREA"). The validation attribute is optional and is used to limit the type of values that you can enter. The available values are FLOAT, INTEGER, or NONE. You can use the following tag within the <entryWidget> block:

  • <reference type="" dataType="" encoding=""">value</reference>

    Used to specify how to manage the value entered in the widget. The type attribute is used to set the type of value (WIDGET, ADAPLET, DATASLOT, or CONSTANT) that you can enter in the widget. You must enter any widget ID (in your form) for type="WIDGET" attribute value, or adaplet (in your form) name for type="ADAPLET" attribute value, or any constant value for type="CONSTANT" attribute value. For Dataslot type, the dataType attribute is used to specify the type of data to be stored in the dataslot. Supported values are LOGICAL, BUSINESSOBJECT, DATE, INTEGER, INT64, OBJECT, and CHARACTER. The encoding attribute (generally used only for constant values) is used to encode the entered string during script generation. Supported values are NONE (no encoding is performed), JAVA_STRING (to encode the entered value as a Java string), HTML (to replace characters (for example, ">") with its HTML code (in this case, ">")), HTML JAVA_STRING (to combine HTML and JAVA_STRING encodings), and Business Process_STRING_CONSTANT (used in constant expression boxes to exclude the "@" and "$" characters).

• <list label="" prompt="" allowedContent="" max="" delimiter=""/>

  This is a list container widget used in IF-THEN and IF-THEN-ELSE constructs. The label attribute is optional and used to specify the label (for example, "If," "then," or "else"). The prompt attribute (optional) is displayed in the list body when it is empty (for example, "drop an expression here."). The allowedContent attribute is used to specify the type of GEL actions that can be dragged on this list. Supported values are EXPRESSION (to drag expression actions) and LOGICAL (to drag conditions that return true or false values). The max attribute value is used to specify the maximum number of action files that can be dropped on the list. The delimiter attribute (optional) is used to specify the string value used to separate the code generated by each widget in the list.

• <operationJoin allowedContent="" label="" prompt=""/>
This is similar to the list container widget and is used for complex nested conditions joined with an operator. All attributes used in this tag are used for the same purpose as the <list> tag attributes. You must use the following tag within the <operationJoin> block:

- <operation>
  
  Used to define the widget to select the type of join operation ("all" or "any") of the list.

- <datetime presentation="">
  
  Available only for Web applications. This widget is used for entering date and time (or date only) values. The presentation attribute is used to specify if the widget is a date-only box (value, "DATE ONLY") or a date and time box (value, "DATE_TIME"). You can use the <reference> tag within the <datetime> block to specify the default value (in milliseconds), which is the elapsed time (in milliseconds) from the Unix epoch time (January 1, 1970). You can specify a negative value to specify a default value prior to the Unix epoch time. If you do not specify any value in the <reference> tag, the current date (and time) is displayed in the widget at runtime.

- <interval>
  
  Available only for Web applications. This widget is used for entering the time interval values in days, hours, minutes, and seconds. You can use the <reference> tag within the <interval> block to specify the number of seconds in the selected time interval.

- <info>
  
  This attribute stores information of each configured event block added in the Logic tab. You can directly add the information by clicking the View/Change info icon for the block in the Logic tab.

- <label>
  
  This is the label widget used to specify text.

You can use the following attributes in all widgets and the <grid> tag.

- id=""
  
  The widget ID value, which is referred using the ${widgetID} syntax from the <template> tag.

- content=""
  
  Used to specify the type of content returned by the widget. Supported values are EXPRESSION (to return a script expression (such as, alert('Hello');) and LOGICAL (to return a logical value (true or false)).

- row="" col="" rowspan="" colspan="" fill="true|false"
  
  The row and col attributes are used to specify the position of the widget in the grid. For example, row="0" col="0" places the widget in row 1 and column 1 of the grid. The rowspan and colspan attributes are optional and are used for widgets, which span more than cell in the grid. The fill attribute is optional and used to control the layout of the widget in the grid. If set to true (default), the widget displays as expanded and fills the allocated space. If set to false, the widget does not expand in the allocated space.

- collapsible="true|false" collapsed="true|false"
The **collapsible** attribute is used to specify if the widget can be collapsed (**true**) or not (**false**). For collapsible widgets, the **collapsed** attribute is used to specify the default state of the widget. The widget displays the toggle expand button (for `collapsed="true"`) and collapse button (for `collapsed=false`).

- **description=""**
  Provides the description text for a widget block. This is useful when the complete widget block is not displayed (for example, when the block is collapsed).

- **searchable="true|false"**
  If set to **true** (default), the content of the widget is indexed and included when you search in the Graphical Event Logic (GEL) Editor. If set to **false**, the contents of this widget cannot be searched.
Using the Servers view

You can use the Publish wizard which facilitates application publishing, as discussed in Publishing an application on page 73. Additionally, you can use the Servers view to configure and publish processes as modules on the connected Business Process Server. You can use the Servers view to:

- Publish single (or multiple) processes (or modules) in a BPM project on the Business Process Server.
- Define Business Process Servers on local (or remote) machines, along with the connection and login details.
- Start and stop the Business Process Server running on the local machine.
- Copy modules between the available Business Process Servers.

For details, see the following topics:

- Creating a server
- Creating a Business Process Cluster Server
- Opening Servers view

Creating a server

Progress Developer Studio for OpenEdge provides the New Server wizard using which you can define a Business Process Server along with its connection and login details.

To create a server:
1. From the **File** menu, select **New > Other** to launch the **New** wizard.
2. Select **Server > Server** and click **Next**. The **New Server** wizard appears.

**Note:** Alternatively, right-click in the Project Explorer view, then select **New > Server** to launch the **New Server** wizard.

---

**Figure 276: New Server Wizard: Page 1**

---

3. From the **Define a New Server** page of the **New Server** wizard, select **Progress Software Corporation > Progress OpenEdge Business Process Server** and configure the server properties, as described in **Table 76** on page 342.

**Table 76: Server properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server's host name</td>
<td>For Progress Business Process Sever, the server host name is set to “localhost”. You can specify a name or IP address of the server, located on the local or remote machine.</td>
</tr>
<tr>
<td>Server name</td>
<td>Modify (if required) the server name. The name is displayed for this server in the Servers view.</td>
</tr>
<tr>
<td>Server runtime environment</td>
<td>This field appears only if you have added a server runtime environment in the <strong>Preferences</strong> dialog box (see <strong>Adding server runtime environment</strong> on page 343). You can select from the available options in the drop-down list provided. To add a server environment, click <strong>Add</strong> to open the <strong>Progress OpenEdge Business Process Server</strong> wizard page, which you can use to define a different server name and location. You can also configure the available runtime environments by clicking <strong>Configure runtime environments</strong> to open the <strong>Servers Runtime Environments</strong> dialog box.</td>
</tr>
</tbody>
</table>

4. Click **Next** to open the **Progress OpenEdge Business Process Server** page. This page appears only if you have not added a server runtime environment in the **Preferences** dialog box (see **Adding server runtime environment** on page 343).

**Note:** The **Progress OpenEdge Business Process Server** page is disabled if you have specified a remote server in the previous page.
a) In the **Runtime environment name** box, modify (if required) the default server name.
b) In the **Server location** box, enter the full path of the Business Process Server location, or click **Browse** to select the folder location.

5. Click **Next** to open the **Progress OpenEdge Business Process Server** page, in which you can set (or modify) the Business Process Server connection information.

   **Table 77** on page 343 describes the server connection properties with default values retrieved from the specified Business Process Server installation.

   **Table 77: Server connection properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>(Read-only) The host name of the specified Business Process Server.</td>
</tr>
<tr>
<td>Http port</td>
<td>The default value is set to 18793. You can modify the server port number,</td>
</tr>
<tr>
<td></td>
<td>if required.</td>
</tr>
<tr>
<td>URL</td>
<td>(Read-only) Concatenates the <strong>Host name</strong> and <strong>Http port</strong> values. Indicates</td>
</tr>
<tr>
<td></td>
<td>the URL of the server location where all the processes are published.</td>
</tr>
<tr>
<td>User name/</td>
<td>To enter the user name and password to connect to the specified server.</td>
</tr>
<tr>
<td>Password</td>
<td>The default value is &quot;ebms&quot; for both user name and password.</td>
</tr>
</tbody>
</table>

6. Click **Next** to open the **Add and Remove** page, in which you can add (or remove) the project modules to be configured on this server.

   This page displays the list of project modules in the **Available** section, which you can add to the **Configured** section. You can perform the following operations:

   - To add a specific project module from the **Available** section, select the project module and click **Add** to add it to the **Configured** section.
   - To add all project modules listed in the **Available** section to the **Configured** section, click **Add All**.
   - To remove a specific project module from the **Configured** section, select the project module and click **Remove**.
   - To remove all project modules listed in the **Configured** section, click **Remove All**.

7. Click **Finish**. The defined server and its configured project modules are displayed in the Servers view. For information on operations in the Servers view, see **Opening Servers view** on page 348.

---

**Adding server runtime environment**

You can add server runtime environments in the **Preferences** dialog box, in order to use any of these added server environments when defining a server.

**To create a server runtime environment:**

1. From the **Window** menu, click **Preferences**, to open the **Preferences** dialog box.
2. Expand **Server > Runtime Environments** in the left pane. The **Server Runtime Environments** page appears.
This page displays the list of existing server runtime environments. You can perform the following operations:

- To add a server runtime environment, click **Add**. The first page of the **New Server Runtime Environment** wizard appears.

  **Figure 278: New Server Runtime Environment wizard: page 1**

  1. Select **Progress Software Corporation > Progress OpenEdge Business Process Server**.
  2. Select the **Create a new local server** checkbox to add a server runtime environment on the local machine.
  3. Click **Next** to open the **Progress OpenEdge Business Process Server** page. In the **Runtime environment name** box, modify (if required) the default server name. In the **Server location** box, enter the folder path of the Business Process Server location, or click **Browse** to select the folder location.
  4. Click **Finish** to add the server runtime environment.

- To modify an existing server runtime environment, select it and click **Edit**.

- To remove a server runtime environment from the list, select it and click **Remove**.
• To search for server runtime environments on local and remote machines, click **Search**.

3. After defining the server runtime environments, click **OK** to close the **Preferences** dialog box.

## Creating a Business Process Cluster Server

Progress Developer Studio for OpenEdge provides the **New Server** wizard using which you can define a Business Process Server along with its connection and login details.

**To create a server:**

1. From the **File** menu, select **New > Other** to launch the **New** wizard.
2. Select **Server > Server** and click **Next**. The **New Server** wizard appears.

**Note:** Alternatively, right-click in the Project Explorer view, then select **New > Server** to launch the **New Server** wizard.

### Figure 279: New Server Wizard: Page 1

3. From the **Define a New Server** page of the **New Server** wizard, select **Progress Software Corporation > Progress Business Process Cluster Server** and configure the server properties, as described in Table 78 on page 346.
Table 78: Server properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server's host name</td>
<td>For Progress Business Process Cluster Sever, the server host name is set to “localhost”. You can specify a name or IP address of the server, located on the local or remote machine.</td>
</tr>
<tr>
<td>Server name</td>
<td>Modify (if required) the server name. The name is displayed for this server in the Servers view.</td>
</tr>
</tbody>
</table>

4. Click Next to open the **OpenEdge Business Process Cluster Server** page. This page appears only if you have not added a server runtime environment in the Preferences dialog box (see Adding server runtime environment on page 346).

**Note:** The OpenEdge Business Process Cluster Server page is disabled if you have specified a remote server in the previous page.

- In the **Credentials** area, enter the Username and Password.
- In the **Business Process Server URLs** box, enter the full path of the Business Process Server location, or click Import to import the server location.

5. Click Next to open the **Add and Remove** page, in which you can add (or remove) the project modules to be configured on this server.

This page displays the list of project modules in the Available section, which you can add to the Configured section. You can perform the following operations:

- To add a specific project module from the Available section, select the project module and click Add to add it to the Configured section.
- To add all project modules listed in the Available section to the Configured section, click Add All.
- To remove a specific project module from the Configured section, select the project module and click Remove.
- To remove all project modules listed in the Configured section, click Remove All.

6. Click Finish. The defined server and its configured project modules are displayed in the Servers view. For information on operations in the Servers view, see Opening Servers view on page 348.

### Adding server runtime environment

You can add server runtime environments in the Preferences dialog box, in order to use any of these added server environments when defining a server.

**To create a server runtime environment:**

1. From the Window menu, click Preferences, to open the Preferences dialog box.
2. Expand Server > Runtime Environments in the left pane. The Server Runtime Environments page appears.
This page displays the list of existing server runtime environments. You can perform the following operations:

- To add a server runtime environment, click **Add**. The first page of the **New Server Runtime Environment** wizard appears.

  **Figure 281: New Server Runtime Environment wizard: page 1**

1. Select **Progress Software Corporation > Progress OpenEdge Business Process Server**.

2. Select the **Create a new local server** checkbox to add a server runtime environment on the local machine.

3. Click **Next** to open the **Progress OpenEdge Business Process Server** page. In the **Runtime environment name** box, modify (if required) the default server name. In the **Server location** box, enter the folder path of the Business Process Server location, or click **Browse** to select the folder location.

4. Click **Finish** to add the server runtime environment.

- To modify an existing server runtime environment, select it and click **Edit**.
- To remove a server runtime environment from the list, select it and click **Remove**.
To search for server runtime environments on local and remote machines, click **Search**.

3. After defining the server runtime environments, click **OK** to close the **Preferences** dialog box.

**Opening Servers view**

Progress Developer Studio for OpenEdge lists all the defined servers and the configured project modules in the Servers view. You can use the Servers view to modify the server information, connection details, publishing settings, and server timeouts.

**Figure 282: Servers view and Server Editor**

The Servers view displays the defined servers, along with the added project modules. To edit the server settings, double-click the server name to open the Server Editor. You can configure the server settings as described in **Table 79** on page 348.

**Table 79: Server Editor fields**

<table>
<thead>
<tr>
<th>Server settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Information</td>
<td>To modify the server host name and runtime environment in the appropriate fields.</td>
</tr>
<tr>
<td>Connection Information</td>
<td>To modify the server connection details including host name, http port number, and user credentials in the appropriate fields.</td>
</tr>
</tbody>
</table>
### Server settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Publishing</strong></td>
<td>To modify the publishing settings for the server. You can select any of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Automatically publish when resources change, to publish the project modules automatically when they are modified.</td>
</tr>
<tr>
<td></td>
<td>• Automatically publish after a build event, to publish the project modules automatically after building the project. You can also specify the time interval in seconds in the <strong>Publishing interval (in seconds)</strong> box.</td>
</tr>
<tr>
<td><strong>Timeouts</strong></td>
<td>To modify the time limit for starting and stopping the server. The default limit is 600 seconds for starting the server and 120 seconds for stopping the server.</td>
</tr>
</tbody>
</table>

You can also add and remove project modules in the defined server. Right-click the server name in the Servers view, then click **Add and Remove** option to open the **Add and Remove** page, which displays the available and configured project modules in the server. You can add or remove the project modules.

You can associate the project modules with the corresponding projects in the Project Explorer view. From the Servers view, click **View Menu () > Link with Project Explorer**. When you select a project in the Project Explorer view, the server containing the associated project module expands and highlights the project module.

**Note:** For a common resource project added as a project module, you can change the adapter type. Right-click the project module and select either **BP Server Adapter** or **Web Application Adapter**. If you change the objects of a common resource project published on a local (or remote) server, you must restart the local (or remote) server in order to reflect the changes.

In the Servers view, you can also:

- Copy project modules between defined servers, as described in **Copying modules** on page 349.
- Publish the project modules to the defined server, as described in **Publishing project modules** on page 350.

### Copying modules

In the Servers view (Figure 282 on page 348), you can copy project modules from a defined server to another server.

To copy a project module from a defined server in the Servers view, right-click the project module and select the **Copy Module** option. Right-click the defined server to which you want to copy the module, then select the **Paste Module** option.

You can also copy multiple (or all) project modules from a defined server in the Servers view.

- To copy multiple project modules, select the modules. Right-click the selection and select the **Copy Modules** option. Right-click the defined server to which you want to copy the modules, and then select the **Paste Modules** option.
- To copy all project modules from a defined server, right-click the server name and select the **Copy Modules** option. Right-click the defined server to which you want to copy the modules, and then select the **Paste Modules** option.
Publishing project modules

In the Servers view (Figure 282 on page 348), you can publish project modules to the configured Business Process Server environment.

Alternatively, you can configure automatic publishing for the defined server in the Server Editor (Figure 282 on page 348).

If you are publishing all project modules associated with a defined server for the first time, then the Publish operation publishes all modules to the Business Process Portal. For project modules in the server that were previously published, then the Publish operation publishes only those modules that are not in synchronized state.

Before publishing, you can select the following options after right-clicking the project modules in the Servers view.

Table 80: Project modules options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherit ACL</td>
<td>To retain any user permissions in the version of the process you are creating, which are associated with the parent process. By selecting this option, you ensure that when you publish this version on Business Process Portal, it will have the same user permissions as the original process.</td>
</tr>
<tr>
<td>Publish as a Web service</td>
<td>To publish the process as a Web service. For a previously published process, you can clear this option to change the option to Republish. This does not unpublish the process from the web services.</td>
</tr>
</tbody>
</table>

To publish the project modules associated with the defined server:

1. In the Servers view, right-click the defined server and select Start option to start the Business Process Servers.
   - The server name displays the "[Started]" status when the Business Process Server is successfully started.
2. Right-click the server and select the Publish option to publish the associated project modules to the Business Process Server.
   - The server name displays the "[Synchronized]" status when all project modules are successfully published to the Business Process Server.

Republishing project modules

For project modules in the server that were previously published, the server name displays the "[Republish]" state if you have modified any of the previously published project modules.

Table 81 on page 350 describes the Republish options available after right-clicking the server name in the Servers view.

Table 81: Republishing options for a previously published module

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean</td>
<td>To reinstall all project modules on the configured Business Process Server.</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy Files to Server Only</td>
<td>To copy any updated files to the server.</td>
</tr>
<tr>
<td>Refresh Process Template</td>
<td>To apply changes in the associated process template to the active process instances in the server. This option is disabled if the changes cannot be applied to the process instances.</td>
</tr>
</tbody>
</table>
Configuring and running simulation

Progress Developer Studio for OpenEdge provides the Simulation project (see Creating a simulation project on page 68), which you can use to configure and run simulation for multiple processes. The Simulation project is implemented using a new simulation engine and is detached from the process workflow. You can perform simulation activities like defining and configuring scenarios, execution, and generating reports and analysis, using the simulation perspective in Progress Developer Studio for OpenEdge.

Progress Developer Studio for OpenEdge provides two perspectives namely, Progress OpenEdge BPM Simulation perspective (for configuring simulation parameters) and the OpenEdge BPM Run Simulation perspective (for monitoring the simulation run, and then generating simulation reports).

The Simulation perspectives provides:

- **Faster Testing for Design Flaws**: Allows you to quickly uncover potential problems in a process design. Instead of using a testing environment that requires two servers—one for production and one for testing—to create and test instances of the process, you can run a process in the Simulation perspectives as many times as required.

- **Estimated Cost of Resources**: Enables you to estimate the cost of the process, or the number of resources that the process will consume. You can define consumable (or single usage) resources (such as, equipment, electricity, and paper) and non-consumable (or reusable) resources (such as, computer and printer) at the process level to calculate the total estimated cost of the process.

- **Utilization of Business Calendar**: Allows you to set performer availability as defined in the organization-level business calendar. For details regarding business calendar, see Working with Business Calendar on page 429.

- **Identification of Bottlenecks**: Assigns worksteps to performing resources; for example, users or user groups for Activity worksteps. The simulation engine locks a performing resource during the execution of the workstep and releases it when the workstep is completed. Bottlenecks
occur when another workstep needs the same performing resource, and must wait for the performing resource to be released from the previous workstep. Until then, the task for the next workstep is placed in a waiting queue. The simulation engine keeps track of the number and status of instances in the waiting queues and indicates when a bottleneck occurs, that is, when a workstep has to wait for a performing resource to be released.

- **Randomization**: Supports two types of randomization techniques: randomizing the intervals between process instances; or randomizing the duration of work time for a specific workstep in the process. Progress Developer Studio for OpenEdge provides four probability distribution types: Constant distribution, Negative Exponential distribution, Normal distribution, and Uniform distribution.

For details, see the following topics:

- Designing a simulation
- Exploring the Progress OpenEdge BPM Simulation perspective
- Configuring a simulation scenario
- Performing other operations
- Validating the simulation project
- Running a process simulation
- After completion of simulation

## Designing a simulation

To run a process simulation, you must first design a process template that illustrates the business process you want to simulate. The process template below shows an approval process that requires the reviewer to decide if the request meets specific critical criteria. If the performer of the Review Request workstep decides it is non-critical, it is sent by e-mail to a group at a remote location for submittal.

**Figure 283: Opening a Process Template for Simulation**

Each Activity workstep must be assigned a work time, or the Simulation will not execute. For the default scenario, the **Review Request** workstep assigned to any member from “MgrGroup” has an assigned work time of two hours; and the **Submit Request** workstep assigned to any member from the “ebmsgroup” has a work time of 50 minutes.
If any member from the MgrGroup decides the request is critical, it is sent to the Exec Approve workstep, where a senior executive (performer, “exec”) will approve or reject it. The approved requests are sent to the Submit Request2 workstep, where they are assigned to any member of group1. For the default scenario, the Exec Approve workstep has an assigned work time of 2 hours and the Submit Request2 workstep has a work time of 50 minutes. Each of the Adapter worksteps has an estimated duration of 10 minutes. The entire process has an estimated duration of 6 hours.

The probability settings for each pair of multiple outgoing connectors must total 100%, or the Simulation will not execute. For the default scenario, the IfCritical connector is assigned a 40% probability, the IfNotCritical connector has a 60% probability, the Submit connector is assigned a 70% probability, and the Reject connector has a 30% probability.

### Adding a process

You can add a completed process to a simulation project from the Design perspective.

1. Open the Business Process (*.spt) to be added to the simulation project.
2. From the toolbar, click Start simulation icon ( ).
   
   If the current Business Process has been added as a process to a simulation project, the Simulate dialog box appears, which lists the simulation projects containing the Business Process.

   For a Business Process that has not been added to a simulation project, the New Simulation Project wizard (Figure 22 on page 69) appears, using which you can create a new simulation project (as described in Creating a simulation project on page 68) and add the current Business Process.

   **Figure 284: Simulate dialog box**

   ![Simulate dialog box](image)

3. From the Simulate dialog box, select an existing simulation project, or click Simulation Project to add the Business Process to a new simulation project.
4. Click OK.

### Simulation constraints

Please note the following constraints when designing your simulation:

- Each Activity workstep must be assigned a work time, or the Simulation will not execute.
• The probability settings for each pair of connectors out of a workstep must add up to 100%, or the Simulation will not execute.

• The simulation engine uses duration to estimate the work time for each workstep, providing a “worst case scenario” in which all the worksteps are executed taking the maximum allowed time.

• Since the simulation engine does not use dataslots, it assumes that a performer linked to a dataslot is a group, if the ALL or ANY options have been selected; or a single performer, if neither ALL or ANY was selected.

• There are no limits on resources.

Exploring the Progress OpenEdge BPM Simulation perspective

The Progress OpenEdge BPM Simulation perspective in the Progress Developer Studio for OpenEdge interface provides a central location where you can view or edit all the simulation parameters for each of your simulation scenarios. This section describes the Progress OpenEdge BPM Simulation perspective user interface.

Figure 285 on page 356 displays a typical simulation perspective interface created for configuring a Simulation project.

Figure 285: Progress OpenEdge BPM Simulation

Figure 285 on page 356 indicates the commonly used panes and views in the Progress OpenEdge BPM Simulation perspective, and these are further described in Table 82 on page 357.
Table 82: Progress OpenEdge BPM Simulation Perspective Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Explorer View</td>
<td>The Project Explorer displays the contents of active projects, including the Simulation project. It consists of a hierarchical view of all the files that make up the active project.</td>
</tr>
</tbody>
</table>
| Simulation Control Editor (or Simulation controller) | The Simulation Control editor contains the following three sections.  
  • Scenarios, to add and remove scenarios. For details, see Adding a scenario on page 358.  
  • Processes, to add (or remove) processes. It also displays the current processes, performers, and resources in the project. You can view (and edit) the properties for added scenarios, as well for each individual process (and its worksteps), path, performer, and resource in the Properties view.  
  • Controls, which contains controls to start, stop, pause, exit the simulation run, as well as set the speed of the simulation. For operations, see Running a process simulation on page 379. |
| Properties view                          | Allows you to view (an edit) the properties for a selected item in the Simulation Control Editor. You can define (or edit) properties for the current simulation project, as well as for each of the added processes, worksteps, connectors, paths, performers, and resources. You can define the objectives for each of these components (see Defining objectives on page 373) and manage resources (see Managing resources on page 372). |
| Processes view                           | Consists of a Process tab for each of the added processes. Each Process tab comprises of the:  
  • Show Process drop-down list, which lists the current process and inline subprocesses (if any). For information regarding inline subprocess, see Defining an inline subprocess on page 137.  
  • Diagram view, which displays the process template diagram. |

Configuring a simulation scenario

Progress Developer Studio for OpenEdge creates a single “default” scenario for each simulation project. You can add scenarios to the simulation project and configure simulation settings for each scenario independently. You can also import and export scenario information between simulation projects. After running simulation for each scenario, you can compare the results of the selected scenarios.

Configuring a Simulation scenario consists of:

• **Simulation configuration**: includes setting the simulation start (and stop) date and time. For details, see Modifying simulation settings for a scenario on page 358.

• **Process configuration**: includes configuring simulation properties for each process (simulation start and stop date and time, number of instances, randomization method) and for each process.
workstep (specifying worktime with time deviation method, specifying the resources, specifying the probabilities in case of multiple outgoing connectors and for Decision gateway).

- **Performer and Resource configuration**: includes setting the cost of each workstep performer, as well as defining consumable and non-consumable resources and their properties.
- **Objectives definition**: includes setting simulation objectives for the process, workstep, path, and for the usage of performers and resources.

**Note**: Any process or resource that you add in the Simulation perspective, is independent of simulation scenarios.

The following sections describe how to add a scenario and configure simulation properties for individual scenarios, and import and export scenario information.

### Adding a scenario

Progress Developer Studio for OpenEdge enables you to create simulation scenarios in which you can change resources, the size of a group, the probabilities out of Decisions, and other simulation parameters.

**To define a new scenario:**

1. From the **Scenarios** section in the **Simulation Control Editor**, click the **Add** icon ( ), opening the **Add Scenario** dialog box.

   ![Add Scenario](Image)

   Figure 286: New Scenario

2. Enter a name for the scenario in the **Name** box. This is mandatory.

3. From the **Using scenario** drop-down list, select any of the existing scenarios as a template for the new scenario. Resources, as well as processes and performers, defined in the scenario used are provided in the new scenario.

4. Click **OK** to add the new scenario to the Scenario drop-down list. Create as many additional scenarios as required.

To remove the scenario displayed in the Scenario drop-down list, click  

### Modifying simulation settings for a scenario

You can modify the simulation settings for the default scenario, as well as for any added scenarios. By default, any scenario created (see the preceding section) as a copy of the “default” scenario has the same simulation start and stop time as the default scenario.

**To modify the simulation settings for a particular scenario:**
1. From the **Scenarios** drop-down list in the **Scenarios** section (in the **Simulation Control Editor**), select the scenario to be configured.

2. From the **Processes** section, click the current simulation project (in this case, *simul1*). In the **Properties** view, the **General** tab displays the details (name, label, description, and default currency) of the current simulation project. If required, enter the label and description and modify the default currency symbol in the respective boxes.

3. Click the **Scenario** tab to view the simulation settings (including simulation start time and end time) for the selected scenario (as described in Step 4 in Creating a simulation project on page 68). Modify the settings, as required.

4. From the **Objectives** tab, add the objectives for the selected scenario. For details, see Defining objectives on page 373.

5. From the **Calendar** tab, you can view the project calendar settings configured for the current scenario (as described in Creating a simulation project on page 68. Modify the settings, as required.

### Importing and exporting a scenario

You can import and export scenario information between simulation projects using the **Simulation Control Editor**. You can also import scenario real-time data from the server. Importing and exporting scenario information enables you to:

- Modify scenario information using any XML Editor, independent of Progress Developer Studio for OpenEdge.
- Replace the current scenario settings with the imported scenario information, thus eliminating the need to configure each parameter in the scenario.

### Exports a scenario

**To export scenario information to a simulation scenario file (***.ssf***):**

1. From the **Scenarios** drop-down list in the **Scenarios** section (in the **Simulation Control Editor**), select the scenario to be exported.

2. Click the **Export current scenario information** icon ( ), opening the **Export To** dialog box.

3. Modify the default file name, if required, then click **Save** to save the ***.ssf** file in the Workspace_Home\<Application_Name>\exports folder.

### Importing a scenario

**To import a scenario information file (***.ssf*** to the current scenario:**

1. From the **Scenarios** drop-down list in the **Scenarios** section (in the **Simulation Control Editor**), select the scenario to be replaced.

2. Click the **Import information into current scenario** icon ( ), to open the **Import Scenario Data** wizard.
3. From the first page of the Import Scenario Data wizard, select the source from which you want to import data.

4. Click the Local file option to import scenario data from the local *.ssf file, then click Next.

5. From the Import file details page, click the ellipsis button next to the Select file box, then select the *.ssf file containing the required scenario information.

6. Click Finish to import the selected scenario information to your simulation project.

7. Click the Server (Real-Life) option to import real-time scenario information from the server, then click Next.
8. Specify the server IP address and port number in the respective boxes.
9. Enter the user name and password required to connect to the server.
10. Modify (if required) the start date and end date in the Start Date and End Date boxes by clicking the adjoining ellipsis button. For details, see Specifying a date on page 377. Data of all the process instances that have been completed in this date range (between start and end date) are retrieved from the server.
11. Click Connect to verify the connection to the server.
12. Click Next to display the Scenario Difference Page.

**Figure 290: Scenario Difference Page**

The left pane of the Scenario Difference page displays the simulation-related components of the current scenario including the added processes (and their individual worksteps), subprocesses (if any), performers, and resources. This structure is similar to the Processes section of the Simulation Control Editor.
13. Click any component to view the difference in the current and real-time data in the table provided in the right pane.

Table 83 on page 362 describes each column in the real-time data table.

**Table 83: Real-time data table**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the simulation-related properties for the selected component. For example, instance count, duration, randomization type, and start time for a process (as shown in Figure 290 on page 361).</td>
</tr>
<tr>
<td>Old Value</td>
<td>Displays the current value.</td>
</tr>
<tr>
<td>New Value</td>
<td>Displays the real-time value. Once imported, this value replaces the old value.</td>
</tr>
</tbody>
</table>

14. Click **Finish** to import the real-time scenario data to your current scenario.

**Note:** After running the simulation, you can also generate a real-time comparison report which compares the result of a simulation run with the server real-time data. For more information, see Generating real-time comparison report on page 396.

### Configuring simulation parameters for a process

You can use the **Processes** section in the **Simulation Control Editor** to add processes as well as configure simulation parameters for each of the added processes and its worksteps. You can also configure simulation properties for each of the workstep paths in the process.

**Figure 291: Processes section in Simulation Control Editor**

To add and configure simulation parameters for each process for a particular scenario:

1. From the **Processes** section, click the **Add** (+) icon, opening the **Required Project Selection** dialog box, which lists the current projects in Progress Developer Studio for OpenEdge.
2. Click the project to be added, then click **OK**.
   
   The selected process is added to the list of processes under the **Processes** folder (**Figure 291** on page 362). To remove a process from the simulation project, select the process from the list of processes, then click **X**. You cannot remove a subprocess.
3. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.

4. Expand the Processes folder (Figure 291 on page 362), then click the process (for instance, Process1) whose simulation properties you want to configure. In the Properties view, the General tab displays the process details (name and label) of the selected process. You cannot modify any information in this tab.

5. Click the Instances tab to view the simulation settings (process start time, instances, and randomization type) for the selected process, as configured when adding the process in the New Simulation Project wizard (Figure 22 on page 69). If required, modify the settings, as described Creating a simulation project on page 68.

**Note:** In a simulation project with multiple processes, if you do not want to include a particular process in the simulation run, enter “0” as the process instance count.

**Figure 292: Properties view for a Process – Instances tab**

![Properties view for a Process – Instances tab](image)

**Note:** The Instances tab does not appear for Subprocesses.

6. From the Objectives tab, add the objectives for the selected process. For details, see Defining objectives on page 373.

7. Use the Calendar tab to include calendar restrictions for the current process. For details, see Setting calendar on page 375.

Alternatively, you can view the entire list of added processes and subprocesses in a tabular format by clicking the Processes folder in the Processes section of the Simulation Control Editor.
Figure 293: List of added Processes in the Properties View

Figure 293 on page 364 displays the list of main processes in the **Master Processes** section table and subprocesses (if any) in the **Auxiliary Processes** section table. You can add, modify, or delete a main process by clicking the appropriate button.

You can also configure simulation properties for each workstep in the process and for each of the workstep paths and connectors, as described in the following sections.

**For worksteps**

You can configure simulation settings for individual worksteps in a process. Workstep configuration is applied to the selected scenario only.

1. From the **Scenarios** drop-down list in the **Scenarios** section (in the **Simulation Control Editor**), select the scenario to be configured.
2. Expand the **Processes** folder (Figure 291 on page 362), then expand the process (for instance, Process1). Expand the **Worksteps** folder to display the list of contained worksteps.
3. Click the workstep to be configured. Alternatively, you can click the workstep in the **Diagram** view.

   In the **Properties** view, the **General** tab displays workstep details including name and label. You cannot modify any information in this tab. The rest of the tabs vary depending on the type of the selected workstep, and are described in the table below.
<table>
<thead>
<tr>
<th>Workstep type</th>
<th>Subtabs in the Properties view</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity/Adapter/Subprocess worksteps</td>
<td>Task</td>
<td>For an Activity or Adapter workstep, review the workstep performer in the <strong>Performer</strong> box. From the <strong>Time Distribution</strong> section (available only for Activity worksteps), you can modify randomization method for workstep instances (see Choosing a randomization method on page 376). <strong>Note:</strong> You cannot configure the worktime distribution for an adapter workstep. By default, it is set to 1 second. For an Activity workstep with a Timeout connector, use the <strong>Timeout</strong> section to enable the workstep timeout functionality. You can specify the timeout duration in terms of hours, minutes, and seconds in the respective boxes. For a Subprocess workstep, click the <strong>Using worktime</strong> option and specify the randomization method for the workstep instances in the <strong>Worktime Distribution</strong> section.</td>
</tr>
<tr>
<td></td>
<td>Probability</td>
<td>Allows you to configure the probability setting for worksteps with multiple outgoing connectors. For details, see Setting the probabilities on page 368.</td>
</tr>
<tr>
<td></td>
<td>Objectives</td>
<td>Allows you to add objectives for the workstep (example, the total completion time for all instances of the workstep must not exceed 10 hours). For details, see Defining objectives on page 373.</td>
</tr>
<tr>
<td></td>
<td>Resources</td>
<td>Allows you to add resources (consumable and non-consumable) and the quantity likely to be consumed for this workstep. For non-consumable resources, you cannot specify a consumption count more than the available count.</td>
</tr>
<tr>
<td>Start/End workstep</td>
<td>Objectives</td>
<td>Allows you to add objectives for the workstep (example, the total count of workstep instances created must exceed 10). For details, see Defining objectives on page 373.</td>
</tr>
<tr>
<td>Decision gateway</td>
<td>Probability</td>
<td>Allows you to configure the probability setting for the default connector and the conditional connector. For details, see Setting the probabilities on page 368.</td>
</tr>
<tr>
<td></td>
<td>Objectives</td>
<td>Allows you to add objectives for the Decision gateway. For details, see Defining objectives on page 373.</td>
</tr>
<tr>
<td>Other Gateway types</td>
<td>Objectives</td>
<td>Allows you to add objectives for the particular gateway. For details, see Defining objectives on page 373.</td>
</tr>
</tbody>
</table>

Alternatively, you can configure (or modify) simulation settings for worksteps by clicking the **Workstep** folder for the selected process in the **Processes** section of the Simulation Control Editor.
Step Figure 294 on page 366 displays the **Activity Worksteps** section table (containing all the activity worksteps), **Adapter Worksteps** section table (containing adapter worksteps), **Decision Worksteps** section table (containing decision gateways), **Inline Worksteps** section table (containing inline subprocess worksteps), **Subprocess Worksteps** section table (containing subprocess worksteps), and **Other Worksteps** section table (containing additional worksteps such as Start and End). You can modify the simulation settings for any workstep by selecting it and then clicking the adjoining **Modify** button.

### For connectors

You can use workstep connectors to configure a delay between the connecting worksteps. This introduces a time delay between workstep instance creation during the simulation run. This configuration is applied to the selected scenario only.

#### To configure a connector delay:

1. From the **Scenarios** drop-down list in the **Scenarios** section (in the Simulation Control Editor), select the scenario to be configured.
2. Expand the **Processes** folder (Figure 291 on page 362), then expand the process (for instance, Process1). Expand the Connectors folder to display the list of workstep connectors.
3. Click the connector to display the connector properties in the **Properties** view. In the **Properties** view, the **General** tab displays connector details including name, label, type (default or conditional) as well as the names of the connecting worksteps. You cannot modify any information in this tab.
4. Use the **Delay** tab to configure the connector delay.
• From the Delay Distribution section, choose a method of randomizing the duration of delay between workstep instances in the simulation. For information regarding randomizing methods, see Choosing a randomization method on page 376.

For paths

A simple process consisting of a couple of Activity worksteps with Start and End worksteps, has an isolated path from start to completion. A complex process (for instance, a manufacturing system) can have a network of paths providing multiple routes between the same two locations. For such cases, Progress Developer Studio for OpenEdge provides path analysis functionality in order to determine the shortest path or the least expensive path.

You can define paths for individual processes in a simulation project. You can configure these added paths differently for different scenarios.

Note: A defined path must contain more than one Activity workstep.

To define a path:

1. Expand the Processes folder (Figure 291 on page 362), then expand the process (for instance, Process1).
2. Click Paths to display the Paths table in the Properties view.
   This table displays the list of defined paths for this project. You can add new paths, and modify or delete existing paths.
3. Click Add, opening the Path dialog box.

   Figure 296: Defining a Path

4. Enter the name and a brief description of the path in the Name and Description boxes respectively.
5. The Available Choices section displays a list of all the elements contained in the process. Select the element that denotes the starting location of your path, then click the Move Left (❖) icon to add the element to the Current Path section. The Successors section on the right, now displays the elements following the added element in the process.
6. Continue adding elements to build the path.
To delete a path element, select the element in the Current Path section, then click \( \times \). You can only remove the last added element. To reset the path elements, click \( \square \).

7. After building the path, click OK to add the path to the Paths table in the Properties view.

8. After you define a path, expand the Paths folder for this process to view the added path. Click the path to view the path properties in the Properties view, where you can modify the path properties, as well as define objectives. To define path objective for a particular scenario:
   a) Select a scenario from the Scenario drop-down list in the Simulation Control Editor.
   b) Click the added path to be configured.
   c) From the Objectives tab of the Properties view, add the objectives for the selected path. For details, see Defining objectives on page 373.

### Setting the probabilities

You can use the Probability tab in the Properties view to review or change probability settings for:

- Activity worksteps with multiple outgoing connectors.
- Activity worksteps with a defined loop condition (see Defining a Loop condition on page 182).
- Decision gateways.

**To configure the probability settings for any of these worksteps:**

1. Select a scenario from the Scenario drop-down list in the Simulation Control Editor.
2. Click the Activity workstep or Decision gateway to be configured, then click the Probability tab in the Properties view.

---

**Figure 297: Setting Probability for a Simulation**

![Setting Probability for a Simulation](image)

---

**Note:** To perform this operation, you need to understand how to configure multiple connectors originating from a workstep. For details, see Using multiple connectors on page 98.

The Probability tab displays the Default bar, which represents default connectors with no specified condition. Additionally, it may display the following bars:

- **Conditional** bars, which represent connectors with a specified condition.
- **Looping** bar (only for Activity worksteps), if the workstep contains a loop condition.
- **Compensation** bar (only for Activity worksteps), which represents connectors with a compensation flow.

The sum of the Probability values (on the right side) always equals 100%.
3. You can modify the probability value of all bars, except the Default bar. Use your cursor to move any of the probability bars to the right or left, or specify a value in the adjoining box. This automatically adjusts the value in the Default bar.

4. For worksteps with multiple conditional connectors, you can also add a **Multiple Condition bar**, which represents a condition when multiple conditional connectors are executed (that is, when the condition in all the connectors are satisfied).

**Note:** You cannot add a multiple condition bar for an Exclusive Decision gateway.

Figure 298: Setting Probabilities for Workstep with multiple conditional connectors

a) Click **Add** to open the **Conditional Links** dialog box, which displays all the conditional links from the workstep.

Figure 299: Adding a Multiple Condition bar

b) Click the conditional link to be added. Press **CTRL**, and then click the other conditional link to be added. You need to select at least two conditional link to enable the **OK** button.

c) Click **OK** to add a multiple condition bar to the **Probability** tab. You can now adjust the probability value for this bar, as explained in Step 3.

To remove a multiple condition bar, select the bar and then click **Remove**. You cannot remove any of the other probability bars.

Managing performers

You can define the simulation properties for the assigned performers using the **Performers** section in the Simulation Control Editor. You can review (or modify) the settings for human performers (individual and group) and adapter performers. Performer configuration is applied to the selected scenario only.

**To configure simulation settings for a performer:**
1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.

2. From the Processes section in the Simulation Control Editor, expand Performers to display four subfolders namely, Systems (containing any adapter performers), Individuals (containing single human performers), Groups (containing a group of human performers), and Queues (containing any queue performers).

In case you add (or modify) groups in the User Management tool after adding the process (containing the group performer) to the simulation project, select the Groups folder, then click the Refresh icon to reflect the changes made in the group members.

3. Expand these folders to view the respective performers assigned to the worksteps in the processes added to this project.

4. Click each performer to review the current performer information in the Properties view.

   • For an Adapter performer, review the name of the performer in the General tab (see Figure 300 on page 370). Enter a number (greater than 0) in the Limit box to specify the maximum number of times you want to invoke the adapter. Enter an amount (greater than 0) in the Cost box that provides a value for the cost per adapter invocation. In this case, the adapter will be invoked three times at the cost of $5.75 per invocation; any additional invocations must wait until one of the three invocations has completed its task. Use the Objectives tab to add objectives for the performer, as described in Defining objectives on page 373.

   Figure 300: Configuring an Adapter Performer

   ![Figure 300: Configuring an Adapter Performer](image)

   • For an individual performer, review the name of the performer in the General tab (see Figure 301 on page 370). Enter the hourly cost for the performer in the Per Hour box. Use the Objectives tab to add objectives for the performer, as described in Defining objectives on page 373. Use the Calendar tab to add calendar restrictions for the performer, as described in Setting calendar on page 375.

   Figure 301: Configuring an Individual Performer

   ![Figure 301: Configuring an Individual Performer](image)
• The **Properties** view is similar for group and queue performers. Review the name of the performer in the **General** tab. In the **Members** tab (see **Figure 302** on page 371), click the **From User Management** option to configure the performer settings as defined in the User Management tool. Alternatively, click the **Virtual** option to enter a virtual group size in the **Number of Members** box and the hourly cost of each group member in the **Cost (per Hour)** box. You need to specify a minimum virtual group size more than or equal to 1.

**Figure 302: Configuring Group or Queue Performer**

<table>
<thead>
<tr>
<th>General</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Doe</td>
<td>Smith</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Virtual Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Members</td>
</tr>
<tr>
<td>Cost (per Hour)</td>
</tr>
</tbody>
</table>

**Note:** The From User Management option is only enabled for groups and queues existing in the User Management tool and containing group members. For more information, see **Managing groups** on page 422 and **Managing queues** on page 425.

**Note:** You can use the **Calendar** tab to add calendar restrictions for the group or queue performer, as described in **Setting calendar** on page 375.

Alternatively, you can configure (or modify) simulation settings for performers by clicking the **Performers** folder in the **Processes** section of the **Simulation Control Editor**.

**Figure 303: List of Performers in the Properties View**

**Figure 303** on page 371 displays the **Individual Performers** section table (containing individual performers), **System Performers** section table (containing adapter performers), **Group Performers** section table (containing group performers), and **Queue Performers** section table (containing queue performers). You can modify the simulation settings for any performer by selecting it and then clicking the adjoining **Modify** button.
Tip: You can also click any of the four subfolders under the Performers folder (in the Simulation Control Editor) to view and modify the simulation settings for the respective performer type.

Managing resources

You can define resources independent of any process or scenario. Resources are any expendable items, but do not include personnel. Progress Developer Studio for OpenEdge supports two types of resources, namely:

- **Consumable** resources: These are the resources that are used up during the simulation and may typically include either Services (such as electricity, gas) or Supplies (such as paper, staples). These resources are usually modeled either as a function of time or associated with an events, such as the completion of an operation.

- **Non Consumable** resources: These are the shared resources with multiple activities waiting for the same resource. These type of resources are most likely to affect system performance, as they may cause bottlenecks. An example of a non-consumable resource is machinery.

To define a new resource (consumable or non-consumable):

1. From the Processes section in the Simulation Control Editor (Figure 291 on page 362), expand Resources to display the Consumables and NonConsumables folders.
2. Click each of the respective folders to display the Consumables or the Non Consumables table in the Properties view. This table displays the list of defined resources for this project. You can add new resources, modify existing resources, and delete resources from the respective Properties view.
3. Click Add in the respective Properties view, opening the Consumable Resource dialog box (to add a consumable resource as shown in left image, Figure 304 on page 372), or the Non Consumable Resource dialog box (to add a non-consumable resource as shown in right image, Figure 304 on page 372).

**Figure 304: Resource dialog box**

![Resource dialog box](image)

a) For a consumable resource, enter the appropriate data in the Name, Unit, and Cost boxes. The name of the resource cannot contain any blank spaces. Data entered in the Unit box must contain only alphabetic characters.

b) For a non-consumable resource, enter the appropriate data in the Name, Availability, and Cost boxes. Enter a number in the Availability box, which indicates the quantity of the resource that can be shared.

4. Click OK to save the resource and add it to the respective table in the Properties view.
5. After you define a resource, expand the Consumables or NonConsumables folder (in the Simulation Control Editor) to view the added resources. Click the resource to view the resource properties in the Properties view.
a) From the **General** tab, modify (if required) the respective resource properties.
b) From the **Objectives** tab, add the objectives for the selected resource. For details, see the following **Defining objectives** on page 373 section.

Alternatively, you can view the entire list of added resources in a tabular format by clicking the **Resources** folder in the **Processes** section of the **Simulation Control Editor**.

**Figure 305: List of Resources in the Properties View**

Figure 305 on page 373 displays the **Consumable Resources** section table (containing list of consumable resources) and **Non Consumable Resources** section table (containing list of non-consumable resources). You can add, modify, or delete a consumable or non-consumable resource by clicking the appropriate button.

### Defining objectives

Progress Developer Studio for OpenEdge allows you to define objectives, which helps achieve goals for optimum time, cost, and resource utilization. You can define objectives at process, workstep, and path levels, as well as for defined performers and resources. Any violation of these objectives during simulation execution are listed in the **Violations** view in the Simulation perspective.

Progress Developer Studio for OpenEdge provides a predefined set of properties for objectives. You can define a condition for these properties, whose values are set according to cost, count or a time duration, as shown in **Figure 306** on page 373.

**Figure 306: Setting Objectives**

To define an objective:

1. Type the name of the objective in the **Name** box.
2. From the **Condition** drop-down list, select the operator. The available options are: == (equal to), != (not equal to), < (less than), > (greater than), <= (less than or equal to), and >= (more than or equal to).
3. In the adjoining text box, enter the condition value in terms of a number (for count- or cost-based objectives) or in terms of hours, minutes, and seconds (for duration-based objectives).

**Table 85** on page 374 provides the complete list of predefined properties and their description.
### Table 85: Predefined Properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Available for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completion Duration</td>
<td>Simulation project only</td>
<td>Sets the duration for the complete simulation.</td>
</tr>
<tr>
<td>Created instances count</td>
<td>Process and workstep</td>
<td>Sets the number of instances created for a process or workstep.</td>
</tr>
<tr>
<td>Completed instances count</td>
<td>Process and workstep</td>
<td>Sets the number of completed instances for a process or workstep.</td>
</tr>
<tr>
<td>Terminated instance count</td>
<td>Process and workstep</td>
<td>Sets the number of instances terminated for a process or workstep.</td>
</tr>
<tr>
<td>Aggregate completion time</td>
<td>Process and workstep</td>
<td>Sets the total completion time of all instances of a process or workstep.</td>
</tr>
<tr>
<td>Average completion time</td>
<td>Process and workstep</td>
<td>Sets the average completion time of all instances of a process or workstep.</td>
</tr>
<tr>
<td>Total Task Count</td>
<td>Individual Performer</td>
<td>Sets the total count of tasks performed by the performer.</td>
</tr>
<tr>
<td>Total Task Duration</td>
<td>Individual Performer</td>
<td>Sets the total duration of tasks performed by the performer.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Performer and Resource</td>
<td>Sets the total cost of a performer or resource.</td>
</tr>
<tr>
<td>Average Cost per Task</td>
<td>Individual Performer</td>
<td>Sets the average cost of a performer for each completed task.</td>
</tr>
<tr>
<td>Total Utilization</td>
<td>Individual Performer and Resource (Non-consumable)</td>
<td>Sets the utilization value of a performer or a non-consumable resource.</td>
</tr>
<tr>
<td>Total Count</td>
<td>Resource (consumable)</td>
<td>Sets the total count for a consumable resource.</td>
</tr>
<tr>
<td>Average Cost</td>
<td>Resource (Non-consumable)</td>
<td>Sets the average cost of a non-consumable resource.</td>
</tr>
<tr>
<td>Total Invocations</td>
<td>Adapter Performer</td>
<td>Sets the number of adapter invocations.</td>
</tr>
<tr>
<td>Traversal Count</td>
<td>Path</td>
<td>Sets the total count for traversing a path.</td>
</tr>
<tr>
<td>Summed Traversal Time</td>
<td>Path</td>
<td>Sets the total time for traversing a path for all process instances.</td>
</tr>
<tr>
<td>Average Traversal Time</td>
<td>Path</td>
<td>Sets the average time for traversing a path for all process instances.</td>
</tr>
</tbody>
</table>
The defined objective is added to a table in the Objectives tab of the Properties view in the Simulation perspective. You can also modify or remove the objective from the table by clicking the respective buttons.

### Setting calendar

Progress Developer Studio for OpenEdge enables you to set calendar restrictions for each project added to your simulation project, as well as for each human performer (individual and group) and queue performer in your simulation project.

You can use the Calendar tab in the Properties view for the process or performer to configure the calendar restriction. Figure 307 on page 375 displays the Calendar tab in the Properties view for a process.

**Figure 307: Properties view for a Process – Calendar tab**

You can click any of the following options to configure calendar settings:

- **None** to exclude all calendar restrictions. This option is not available for human and queue performers.
- **User management** to include calendar restrictions as specified in the calendar created using the Business Calendar tool, as discussed in Working with Business Calendar on page 429.
- **Project** to include calendar restrictions as specified in the project calendar for the current simulation project.
- **Local** to configure process-specific calendar settings using the Workdays and Sessions sections provided. This operation is similar to configuring the project calendar, as discussed in Step 5 in Creating a simulation project on page 68.

### Performing other operations

This section describes commonly used simulation-related operations such as, selecting a randomizing method and selecting a date.
Choosing a randomization method

Progress Developer Studio for OpenEdge supports two types of randomization in the Simulation perspective; namely, randomizing the time of intervals between process instances; or randomizing the duration of work time for a specific workstep in the process.

- To randomize the time interval between process instances, use the Instances tab of the Properties view for a process, as described in Step 5 in Configuring simulation parameters for a process on page 362 section.

- To randomize the work time for a specific workstep instance, use the Task tab of the Properties view for a Activity, Adapter, or Subprocess workstep, as described in Step 3 in For worksteps on page 364 section.

Progress Developer Studio for OpenEdge provides four probability distribution types, which are described below:

Table 86: Probability distribution types

<table>
<thead>
<tr>
<th>Distribution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Use this option to maintain the same interval between instances in the simulation. You can define the mean interval between instances in the adjoining boxes in terms of hours, minutes, and seconds. This is used when the duration is fixed, and does not change over time.</td>
</tr>
<tr>
<td>Negative Exponential</td>
<td>A continuous probability distribution that is often used to characterize the time between events or the durations of activities. It does not assume a predetermined pattern of distribution. A Negative Exponential distribution is used when the probability decreases over time.</td>
</tr>
<tr>
<td>Normal</td>
<td>Use this option to define the symmetrical, bell-shaped distribution pattern that is often used for a simulation. This distribution pattern is determined by its mean and the standard deviation. You can use the adjoining Mean and Std-dev boxes to set the mean and standard deviation in terms of hours, minutes, and seconds. In a typical normal distribution, 70% of results fall between one standard deviation above and one standard deviation below the mean. The standard deviation is a measure of how tightly items are clustered around the mean in a set of data. A low standard deviation means that the results are tightly clustered; a high number that the distribution is widely spread. <strong>Note:</strong> If the Standard Deviation setting is more than the Work Time value for a workstep and results in the range of the deviation being a negative value, then only the absolute value of the deviation (not the negative value) is used for running the simulation.</td>
</tr>
<tr>
<td>Uniform</td>
<td>A discrete uniform distribution option that represents a uniform distribution pattern within a finite set of possible values. The possible values are set within the minimum and the maximum value specified in hours, minutes, and seconds. This is used when the process instance count (or the worktime duration of a workstep instance) is fixed over a specified range of values.</td>
</tr>
</tbody>
</table>
Specifying a date

You can enter (or modify) a date (and time) in the At time box for a Date, for instance, when specifying the simulation start and stop time for a simulation project and for process worksteps.

To specify the date and time:

1. Click the At time option (if you are specifying a date for the first time) to display the current system date and time in the adjoining text box.

2. To specify another date (or time), click the adjoining ellipsis button to open the Calendar dialog box, which display the current month’s calendar. By default, the calendar highlights today’s date and current time.

3. To select a date from the displayed month, click the desired date.

4. To display the calendar for another month, use the arrows provided next to the month. Click the arrow pointing right for the next month, or the arrow pointing left for the previous month. Alternatively, to select any other month, you can click on the current month and then select the desired month from the list.

5. Similarly, to display the calendar for another year, click the current year and then type the desired year. Alternatively, you can use the adjoining controls to increment (or decrement) the year by one. Click outside the year control to accept the changed year.

6. To change the default time from the Time box, click the hour, minute, and second boxes and type the respective values. Alternatively, you can use the adjoining controls to increment (or decrement) the respective value. You can also use these controls to switch between AM and PM.

7. Click OK to display the selected date and time in the text box adjoining the At time option.

Validating the simulation project

The Simulation perspective provides an advanced validation framework, which lists common configuration errors for selected simulation components. You cannot run the simulation unless you rectify these errors.

From the Simulation Control Editor, you can identify the erroneous simulation components, which are highlighted with a red square; for instance, Request Status.

Table 87 on page 378 lists the common validation errors, where they occur, and their resolution.
Table 87: Validation Errors

<table>
<thead>
<tr>
<th>Component</th>
<th>Error Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation Project</td>
<td>The absolute start time is not specified.</td>
<td>Specify a relative start time for the <strong>At time</strong> option in the <strong>Scenario</strong> tab of the simulation project's <strong>Properties</strong> view.</td>
</tr>
<tr>
<td></td>
<td>The absolute completion time is not specified.</td>
<td>Specify a relative stop time for the <strong>At time</strong> option in the <strong>Scenario</strong> tab of the simulation project's <strong>Properties</strong> view.</td>
</tr>
<tr>
<td>Scenario</td>
<td>A scenario configured with system start time and absolute end time.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project's <strong>Properties</strong> view for the selected scenario, select any available option other than system time (for simulation start) and <strong>At time</strong> (for simulation stop).</td>
</tr>
<tr>
<td></td>
<td>Absolute start time for a scenario is greater than absolute stop time.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project's <strong>Properties</strong> view for the selected scenario, specify a relative time for simulation stop higher than the relative time for simulation start.</td>
</tr>
<tr>
<td></td>
<td>For a process with absolute start time, the scenario is set to system start time.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project's <strong>Properties</strong> view for the selected scenario, specify an absolute time for the simulation start.</td>
</tr>
<tr>
<td></td>
<td>Absolute start time for a scenario is greater than absolute start time for any of the added processes.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project's <strong>Properties</strong> view for the selected scenario, specify an absolute time for the simulation start lesser than the absolute start time for each process.</td>
</tr>
<tr>
<td>Process</td>
<td>The absolute start time is not specified.</td>
<td>Specify a relative time for the <strong>At time</strong> option in the <strong>Instances</strong> tab of the process' <strong>Properties</strong> view.</td>
</tr>
<tr>
<td></td>
<td>Process instance count is unlimited with simulation stop time set to completion of process instances.</td>
<td>Specify a process instance count in the <strong>Instances</strong> tab of the process' <strong>Properties</strong> view.</td>
</tr>
<tr>
<td>Process / Workstep</td>
<td>For Uniform randomizing method, the maximum duration is lesser than the minimum duration.</td>
<td>Specify the maximum duration for Uniform distribution type greater than the minimum duration.</td>
</tr>
<tr>
<td>Performer / Resources</td>
<td>Cost of the performer or resource is zero.</td>
<td>From the <strong>General</strong> tab for the added performer’s (individual, group, and adapter) and for the added resource’s (consumable and non-consumable) <strong>Properties</strong> view, specify value greater than zero in the respective cost fields.</td>
</tr>
<tr>
<td>Non-consumable Resource</td>
<td>Specified count of the resource is zero.</td>
<td>From the <strong>General</strong> tab for the added non-consumable resource’s <strong>Properties</strong> view, specify count greater than zero in the <strong>Availability</strong> box.</td>
</tr>
</tbody>
</table>
Running a process simulation

After designing the process simulation in the **Progress OpenEdge BPM Simulation** perspective, you can run the simulation in the **OpenEdge BPM Run Simulation** perspective to discover potential design flaws. For example, you can now quickly identify such problems as loops that repeat too frequently or bottlenecks in the process.

Each simulation run represents a simulation for a set of resources. It could have single or multiple processes running in parallel.

<table>
<thead>
<tr>
<th>Component</th>
<th>Error Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumable</td>
<td>The resource has no defined unit of measure.</td>
<td>From the <strong>General</strong> tab for the added consumable resource's <strong>Properties</strong> view, specify a unit in the <strong>Unit</strong> box.</td>
</tr>
<tr>
<td>Resource</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Performer</td>
<td>The group performer has a virtual group size equal to zero.</td>
<td>From the <strong>Members</strong> tab for the added group's <strong>Properties</strong> view, specify the virtual member count greater than or equal to one.</td>
</tr>
<tr>
<td>Path</td>
<td>The path contains only one workstep.</td>
<td>From the <strong>General</strong> tab for the defined path's <strong>Properties</strong> view, specify the path length greater than one.</td>
</tr>
<tr>
<td>Workstep</td>
<td>The consumption count for an added non-consumable resource is greater than the available count.</td>
<td>From the <strong>Resources</strong> tab for the workstep's <strong>Properties</strong> view, specify the count of the added non-consumable resource less than its available count.</td>
</tr>
</tbody>
</table>

Running a process simulation
Figure 309: OpenEdge BPM Run Simulation Perspective

Figure 309 on page 380 indicates the commonly used panes and runtime views in the OpenEdge BPM Run Simulation perspective, and these are further described in Table 88 on page 380.

Table 88: OpenEdge BPM Run Simulation Perspective Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Simulation Control Editor (or Simulation controller) | The Simulation Control editor contains the following additional sections.  
  - **Simulation Status**, which displays the progress status of the simulation project.  
  - **Generate**, to view the results of a simulation run for a scenario and to generate a report, as described in Generating a simulation report on page 389. |
| Individuals view | Allows you to view the runtime performance of the individual human performers (including group members) during the simulation run. Performance parameters include total task count and usage time, total cost, and cost per hour for the defined performers. |
| Systems view | Allows you to view the runtime performance of the system (or adapter) performers during the simulation run. Performance parameters include cost per invocation, number of invocations, and total cost for system performers. |
| Consumables view | Allows you to view the consumable resource usage during the simulation run. |
## Running a process simulation

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NonConsumables view</td>
<td>Allows you to view the non-consumable resource usage during the simulation run.</td>
</tr>
<tr>
<td>Violations view</td>
<td>Allows you to view any violations in the defined objectives after completion of the simulation run.</td>
</tr>
<tr>
<td>Recommendations view</td>
<td>Lists any workstep bottlenecks due to non-availability of performers and resources after the completion of the simulation run, and recommends a possible solution for the same.</td>
</tr>
<tr>
<td>Processes view</td>
<td>Consists of a <strong>Process</strong> tab for each of the added processes. Each Process tab comprises of the:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Diagram</strong> view, which displays the process template diagram, and indicates the status of each workstep across all instances during the simulation run.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Details</strong> view: You need to click <strong>Details</strong> to display this view. For details, see <strong>Viewing process information</strong> on page 382.</td>
</tr>
</tbody>
</table>

### To run a process simulation:

1. From the **Scenarios** drop-down list in the **Scenarios** section (in the Simulation Control Editor), select the scenario for which you want to run the simulation.

2. From the **Controls** section of the Simulation Control Editor, click **to begin the process simulation.**

3. **If you are currently not in the** **OpenEdge BPM Run Simulation** perspective, you are prompted to switch to this perspective. Click **Yes** to run the process simulation in the **OpenEdge BPM Run Simulation** perspective. Alternatively, click **No** to run the process simulation in your current perspective. If you select the **Remember my decision** check box, Progress Developer Studio for OpenEdge does not display any prompt and executes your selected command the next time you run a process simulation.

### Note:
You can modify the above selected configuration for running the process simulation using the **Simulation > UI** page in the **Preferences** dialog box. For information, see **Using the Simulation page** on page 126.

During the simulation run, you can perform any of the following operations from the **Controls** section of the Simulation Control Editor:

### Table 89: Simulation Controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>To pause the simulation. Click <strong>to resume the simulation.</strong></td>
</tr>
<tr>
<td>Stop</td>
<td>To stop the simulation and return to the start of the simulation.</td>
</tr>
<tr>
<td>Control</td>
<td>Operation</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exit ( Esc )</td>
<td>To stop the simulation and exit from the OpenEdge BPM Run Simulation perspective. Progress Developer Studio for OpenEdge prompts you to switch to the Progress OpenEdge BPM Simulation perspective. You can click the appropriate button, similar to as described in Step 3 above.</td>
</tr>
<tr>
<td>Speed control</td>
<td>To control the simulation speed between low and high.</td>
</tr>
</tbody>
</table>

You can view the overall progress of the simulation project in the **Simulation Status** section.

**Figure 310: Simulation Status progress**

![Simulation Status](image)

The **Start** date and time displays the Simulation Start setting, as configured for this scenario in the **Scenario** tab of the **Properties** view (see [Modifying simulation settings for a scenario](#) on page 358). The **Current** date and time indicates the progress of the simulation in date and time values, with its final value calculated according to the Simulation Stop setting, as configured for this scenario in the **Scenario** tab of the **Properties** view.

During the simulation run, you can view the process-related information in the **Processes** view (as described in [Viewing process information](#) on page 382).

You can also monitor the usage of performers and resources, as well as review objective violations and performance bottlenecks (and recommendations) in their respective views. For details, see [Viewing project information](#) on page 385.

**Viewing process information**

The **Processes** View consists of a **Process** tab for each of the added process in the simulation project. Click each Process tab to view the simulation information for the process in the **Diagram** and **Details** views. By default, the **Details** view is hidden. To show (or hide) either of the views for each **Process** tab, click the respective button in the Processes view.
Running a process simulation

Figure 311: Processes View in OpenEdge BPM Run Simulation Perspective

The **Details** view displays the progress status of the completed process instances during the simulation run. It also displays the instance count (required, completed, created, terminated), the workitem cost (total, average, minimum, maximum), and the duration (total, average, minimum, maximum) of the completed process instances. The adjoining table contains the:

- **Worksteps** tab, which lists the worksteps of the current process and the number of workstep instances, which have been created, activated, completed, terminated, and timed out, along with the total, average, maximum, and minimum duration taken to complete the instances.

- **Workitems** tab, which lists the workitem tasks for each instantiated workstep, along with the number of workitems completed, the total worktime for each workitem, and the cost (total, minimum, maximum, average) for completing each workitem. Additionally, this tab displays the number of tasks waiting in queue for the performer to become available, with the total, minimum, maximum, and average waiting time.

- **Connectors** tab, which lists the workstep connectors of the current process and the number of connector traversals, which have been created, completed, and terminated, along with the total completion and termination duration taken for each connector.

- **Consumables** tab, which indicates the consumption details of consumable resources for each assigned workstep. Resource details for each workstep include cost per unit, workitem count, consumption count, and total cost.

- **Non Consumables** tab, which indicates the consumption details of non-consumable resources for each assigned workstep. Resource details for each workstep include cost per hour, workitem count, requirement, usage time, and total cost.

- **Paths** tab, which displays information for each defined path in the process. Path information includes path name, the number of times the path was traversed, and the duration (total, minimum, maximum, average) of path traversal. Additionally, this tab displays the cost (total, minimum, maximum, average) of traversing a path. For details regarding paths, see Configuring simulation parameters for a process on page 362 > For paths on page 367.

Additionally, the **Details** view displays simulation information for the current process in the following sections:
Table 90: Details View Information

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Displays the same data as in Status progress bar, but in numeric values. Additionally, it displays the number of terminated process instances.</td>
</tr>
<tr>
<td>Cost</td>
<td>Displays the cost data for workitem tasks (or instantiated worksteps). Cost includes the cost of workitem performers and resources (if any). The <strong>Total</strong> cost indicates the total completion cost of all workitems, the <strong>Average</strong> cost indicates the average cost of workitems, the <strong>Minimum</strong> cost indicates the least expensive workitem, and the <strong>Maximum</strong> cost indicates the most expensive workitem.</td>
</tr>
<tr>
<td>Completed Instance Time</td>
<td>Displays the duration of completed process instances in terms of hours, minutes, and seconds. The <strong>Minimum</strong> value indicates the shortest completion time, the <strong>Maximum</strong> box indicates the longest completion time, and the <strong>Average</strong> box indicates the average completion time for process instances. The <strong>Total</strong> value indicates the cumulative completion time for all instances.</td>
</tr>
</tbody>
</table>

Additionally, each Process tab contains the following components:

- **Show Process** drop-down list, where you can also view the runtime data for an inline subprocess by selecting the process. For information regarding inline subprocess, see Defining an inline subprocess on page 137.

- Contains the **Status** progress bar, which indicates the total number of process instances required, along with the number of instances created and completed. The total number of process instances required are depicted in light green color, those created (and in progress) in olive green, and those completed in bluish green. You can also move your pointer over the progress bar, to view the same information in numeric terms.

In the **Diagram** view (which is displayed by default), each process workstep displays a number in parenthesis, which indicates the number of activated instances.

Each workstep (and associated path) displays a color-coded heatmap, which enables you to:

- Determine the number of activations for each workstep, relative to the rest of the worksteps in the workflow.

- Identify potential bottlenecks in the process.

Table 91 on page 384 describes the color coding used for heatmaps.

Table 91: Heatmap Color Coding

<table>
<thead>
<tr>
<th>Color Gradient</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue to White</td>
<td>For workstep activations from minimum to median value(^2).</td>
</tr>
<tr>
<td>White to Red</td>
<td>For workstep activations from median to maximum value.</td>
</tr>
</tbody>
</table>

A bottleneck can be identified by a red-colored workstep immediately followed by one or more white-colored worksteps.

\(^2\) Median is calculated by dividing the sum total of all activated workstep instances by the number of worksteps.
Tip: When unexpected results occur during a simulation, such as the number of activations of a workstep not matching the number of instances, it may result in the presence of Inclusive Decisions. We recommend that you use Exclusive Decisions in this type of process.

Viewing project information

The OpenEdge BPM Run Simulation Perspective provides additional views—Individuals, Systems, Consumables, NonConsumables, Violations, and Recommendations—where you view overall simulation information, independent of the processes. Click the Individuals, Systems, Consumables, and NonConsumables views after starting the simulation run. Click the Violations and Recommendations views after completing the simulation run (as described in After completion of simulation on page 388).

- **Individuals** view: indicates the utilization of individual (or human) performers in the process, and the current task (if any) for each performer.

Figure 312: Individuals View

The Individuals view displays the following runtime information of individual performers.

Table 92: Individuals view

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the performer. A blue icon indicates that the performer is available. A grey icon indicates that the performer is unavailable.</td>
</tr>
<tr>
<td>Cost per Hour</td>
<td>Displays the cost per hour defined for each performer.</td>
</tr>
<tr>
<td>Available For</td>
<td>Displays the total duration (in terms of hours, minutes, seconds) for which this performer is available.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the performer, which is the product of the hourly cost of the performer and the total time (in hours) for which the performer is available.</td>
</tr>
<tr>
<td>Task Count</td>
<td>Displays the number of tasks currently assigned to this performer.</td>
</tr>
<tr>
<td>Total Usage Time</td>
<td>Displays the total work-time (in terms of hours, minutes, seconds) for this performer.</td>
</tr>
<tr>
<td>Heading</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Utilization %</td>
<td>Displays the percentage of the total usage time of the performer, relative</td>
</tr>
<tr>
<td></td>
<td>to the available time.</td>
</tr>
<tr>
<td>Current Tasks</td>
<td>Indicates the current task (if any) performed by this performer. The format</td>
</tr>
<tr>
<td></td>
<td>used is: &lt;processname&gt;-&lt;taskname&gt;.</td>
</tr>
</tbody>
</table>

- **Systems** view: indicates the utilization of system (or adapter) performers in the process, and the current task (if any) for each performer.

**Figure 313: Systems View**

The **Systems** view displays the following runtime information of adapter performers.

**Table 93: Systems view**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the adapter performer. A blue icon indicates that the</td>
</tr>
<tr>
<td></td>
<td>performer is available. A grey icon indicates that the performer is unavailable.</td>
</tr>
<tr>
<td>Cost per Invocation</td>
<td>Displays the cost per invocation as defined for each adapter.</td>
</tr>
<tr>
<td>Invocations</td>
<td>Displays the total number of invocations of this adapter.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the adapter, which is the product of the cost per</td>
</tr>
<tr>
<td></td>
<td>invocation and the number of invocations.</td>
</tr>
<tr>
<td>Current Tasks</td>
<td>Indicates the current task (if any) performed by this adapter. The format</td>
</tr>
<tr>
<td></td>
<td>used is: &lt;processname&gt;-&lt;taskname&gt;.</td>
</tr>
</tbody>
</table>

- **Consumables** view: displays the utilization of consumable resources in the simulation run for this scenario.

**Figure 314: Consumables View**

The **Consumables** view displays the following runtime information of consumable resources.
Table 94: Consumables view

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the resource used.</td>
</tr>
<tr>
<td>Cost per Unit</td>
<td>Displays the cost of resource as defined for this scenario.</td>
</tr>
<tr>
<td>Consumer Count</td>
<td>Displays the total number of workstep instances that have used this resource.</td>
</tr>
<tr>
<td>Consumed Count</td>
<td>Displays the total number of the resource units consumed.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the resource, which is the product of cost of the resource and the consumed count.</td>
</tr>
</tbody>
</table>

• **NonConsumables** view: displays the utilization of non-consumable resources in the simulation run for this scenario.

**Figure 315: NonConsumables View**

The **NonConsumables** view displays the following runtime information of non-consumable resources.

Table 95: NonConsumables view

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the resource used.</td>
</tr>
<tr>
<td>Units</td>
<td>Indicates the number of available resource units.</td>
</tr>
<tr>
<td>Cost per Hour</td>
<td>Displays the cost of resource as defined for this scenario.</td>
</tr>
<tr>
<td>Required in Tasks</td>
<td>Displays the number of workstep (or task) instances that require this resource.</td>
</tr>
<tr>
<td>Requirement</td>
<td>Displays the total count of the resource required.</td>
</tr>
<tr>
<td>Used in Tasks</td>
<td>Displays the number of workstep (or task) instances that have used this resource.</td>
</tr>
<tr>
<td>Total Usage Time</td>
<td>Indicates the total duration (in hours, minutes, seconds) of consumption of the resource.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the resource, which is the product of cost of the resource and the total usage time.</td>
</tr>
</tbody>
</table>
After completion of simulation

You can view the final status of the performers (individual and system) and resources (consumable and non-consumable) used during this process simulation, from the respective views. You can view any violations and recommendations by clicking the respective view, as described in this section.

- **Violations** view: lists violations (if any) in the objectives defined (see Defining objectives on page 373) in the current scenario.

    ![Violation View](image)

    The table provides the following violation information.

    **Table 96: Violation information**

    | Heading    | Description                                                                 |
    |------------|-----------------------------------------------------------------------------|
    | Source     | Indicates the source whose objective has been violated. Possible sources are the simulation project, process, workstep, performer, resource, and path. |
    | Name       | Displays the objective that was violated.                                    |
    | Condition  | Displays the condition defined in the violated objective.                   |
    | Path       | Displays the path to the source whose objective has been violated. This is applicable only for defined paths and worksteps (including worksteps of an inline subprocess). The format used is: `<processname>-<source>`. |

- **Recommendations** view: lists bottlenecks and other problems encountered during the simulation run. An example of a bottleneck can be that a particular workstep had a high waiting time, before using a particular resource or performer.
The table provides the following information.

Table 97: Recommendations view

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Indicates the source where the problem has arisen.</td>
</tr>
<tr>
<td>Problem</td>
<td>Displays the description of the problem.</td>
</tr>
<tr>
<td>Recommendation</td>
<td>Displays the statement of a possible solution to the problem. For example,</td>
</tr>
<tr>
<td></td>
<td>“Increase resources used by workstep.”</td>
</tr>
</tbody>
</table>

Generating a simulation report

After running a simulation for a scenario, you can generate a Simulation result (*.srf) and report (*.html or *.xls) files.

- **Result**: Only one result (*.srf) file is generated for each simulation run, which could have a single process or multiple processes. You can use the result file later to generate simulation reports. You can also generate comparison reports (see Comparing simulation results on page 395) by using multiple result files. For example, you can generate multiple result (*.srf) files after simulating with different scenarios.

- **Report**: You can generate a simulation report in HTML or Excel format either directly after a simulation run or later from the result (*.srf) file. You can select and create reports according to your requirement.

To generate the Simulation report:

1. From the Generate section of the Simulation Control Editor, click the Result icon (), opening the Simulation Report dialog box.
2. Modify (if required) the name of the default result file.
3. Click OK to save the result file. You can view the result file in the Project Explorer view in the `<project>esults` folder.
4. Right-click the result file (*.srf), then click Simulation Report > Generate Report.

Alternatively, from the Generate section of the Simulation Control Editor, click the Report icon (), opening the Simulation Reports dialog box, which lists the out-of-box reports and custom reports (if any). For details regarding adding custom reports, see Adding custom reports on page 394.
5. Depending on your requirement, you can generate any of the listed report types. Click each report type to view its description in the adjoining area. Select the report type to be generated.

6. From the **Output** section, select the format (HTML or Excel) from the **Format** drop-down list. Modify (if required) the name of the generated file in the **File** box.

7. Select the report type to be generated, then click **OK**. **Figure 319** on page 390 displays a Complete HTML report with all the generated information.

**Figure 319: HTML Report on Simulation Results**

The Simulation report (in HTML format) contains the main section in links, which you can click to navigate to the respective topic. Additionally, it displays the summary charts (only in HTML format) displaying the overall cost per process and cost per resource (and performer) used in the simulation project. For more information, see the following Viewing simulation report details on page 391 section.
After completion of simulation

**Note:** Simulation reports in Excel format do not display charts.

## Viewing simulation report details

The generated Simulation report contains the following main sections:

- **Process simulation result** on page 391
- **Resource usage results** on page 393
- **Violations and recommendations** on page 394
- **Setting calendar** on page 375

**Note:** The simulation report is saved directly under the simulation project folder `Workspace_Home\<project_name>\reports\`.

## Process simulation result

This section provides the following sub-sections for each of the added processes and subprocesses:

- **Instance Completion Status**: (Can be viewed in Basic, Cost, and Time reports also) Displays the total number of process instances required, created, completed, and terminated.
- **Instance Execution Time**: (Can be viewed in Basic and Time reports also) Displays the duration of the completed process instances, along with the minimum, maximum, and average time.
- **Instance Completion Cost**: (Can be viewed in Cost report also) Displays the total completion cost of all workitems, along with minimum, maximum, and average cost.
- **Workstep Execution Status and Time**: (Can be viewed in Basic and Time reports also) Displays the instance count (created, activated, completed, terminated, timed out) for each of the process worksteps, along with the duration (total, minimum, maximum, average) taken to complete all the workstep instances. You can view this information in Tabular and Chart format.

**Figure 320: Worksteps**

![Worksteps Diagram](image-url)
• **Workitems Time and Cost:** (Can be viewed in Cost and Time reports also) Displays the workitem count (created, completed, terminated) for each task, along with the completion cost (total, average, minimum, maximum) of each workitem. Additionally, this section displays the number of workitem instances, which waited in queue for the performer to become available, along with the total, minimum, maximum, and average waiting time. You can view this information in Tabular and Chart format (which displays the workitem status and total cost).

**Figure 321: Workitems**

```
<table>
<thead>
<tr>
<th>Workitems Status</th>
<th>Workitems Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

• **Workstep Connectors:** (Can be viewed in Basic, Cost, and Time reports also) Displays the instance count (created, completed, terminated) for each of the workstep connector, along with the aggregate delay duration taken to complete or terminate the connector traversals. You can view this information in Tabular format only.

**Figure 322: Connectors**

```
<table>
<thead>
<tr>
<th>Connectors</th>
<th>Name</th>
<th>Source</th>
<th>Destination</th>
<th>Type</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

• **Path Analysis Status and Execution Time:** (Can be viewed in Basic, Cost, and Time reports also) Displays the traversal count, the traversal duration (total, minimum, maximum, average), and traversal cost (total, minimum, maximum, average) for each defined path. You can view this information in Tabular and Chart format.
Resource usage results

This section provides a usage summary for both performers and resources in the following sub-sections. You can view this section in Basic, Cost, and Time reports also.

- **Human Performers**: Displays the cost (hourly, total), duration available for, assigned task count, total usage time, and utilization percentage for each human performer. You can view this information in Tabular and Chart format.

- **System Performers**: Displays the number of invocations, cost (hourly, total), duration available for, assigned task count, total usage time, and utilization percentage for each system performer. You can view this information in Tabular and Chart format.

- **Consumable Resources**: Displays cost, consumed count, and consumer count for each consumable resource. You can view this information in Tabular and Chart format.
**Figure 326: Consumable Resources**

- **Non-consumable Resources:** Displays cost, required in tasks, requirement, used in tasks, and total usage time for each consumable resource. You can view this information in Tabular and Chart format (similar in format to that of Consumable resource).

**Violations and recommendations**

This section lists all the violations and recommendations generated for the simulation run. You can view this section in the Violations and Recommendations report also.

**Calendar**

You can view this section in the Time report also. This section contains the following sub-sections:

- **Process Calendar:** Displays the calendar settings for each of the added processes. The calendar information includes calendar type, workdays, and details of the work sessions.

- **Human Performer:** Displays the calendar settings for each human performer (individual and group). The calendar information includes calendar type, as well as workdays and work sessions for simulation calendar type.

**Adding custom reports**

In addition to the out-of-box reports, you can add your own custom reports to meet specific requirements. You need to save your customized report file (in *.xslt format) in the following folders, located in the `Workspace_Home\.com.savvion.studio\simulation\reports\` folder.

- Normal: stores all the out-of-box reports (listed in Figure 318 on page 390). You can add a new report or create a copy of any of the listed reports and modify it (as required) using any XML editor. You can then add the report property in the `reports.xml` file.

- Comparison (optional): stores all the out-of-box comparison reports. You can add a new comparison report or create a copy of any of the listed comparison reports and modify it (as required) using any XML editor. You can then add the report property in the `reports.xml` file. For details, see **Comparing simulation results** on page 395.

**To add a custom report to the \Normal folder:**

1. Open the `reports.xml` file using any XML editor.
2. In the `<Reports>` tag, add the custom report parameters.

   A sample entry is provided below:

   ```xml
   <Report name="Custom Report" xslFileName="MyCustomReport.xslt"
   defaultAffix="custom">
   <Description>My customized report.</Description>
   </Report>
   ```
where the `<Report>` tag contains the following attributes and tags:

- **name** indicates the report name as it should appear in the report list (as shown in Figure 318 on page 390).
- **xslFileName** indicates the name of the saved report file (in *.xslt format).
- **defaultAffix** indicates the default affix to be contained in the generated HTML file name.
- **Description** tag provides the description of the report (as shown in Figure 318 on page 390).

3. Save the `reports.xml` file.

### Comparing simulation results

You can generate a comparison report (HTML or Excel) from multiple result (*.srf) files, each of which represent the result of a simulation run. You can also generate a real-time comparison report to compare the results of a simulation run with the real-time server data. You can select the type of the comparison report, similar to that for simulation report types (Figure 318 on page 390).

**Note:** You need to create at least two results files, before you can generate a comparison report. You can also compare result files generated across simulation projects.

#### To generate a comparison report:

1. If you are in the OpenEdge BPM Run Simulation perspective, click the Progress OpenEdge BPM Simulation perspective to switch to the Progress OpenEdge BPM Simulation perspective.
2. From the Project Explorer view, select the result (*.srf) files (located in `<project>`\results folder), which you want to compare.
3. Right-click the selected result files, then click Simulation Report > Generate Comparison Report, opening the Simulation Reports dialog box (see Figure 318 on page 390).
4. Depending on your requirement, you can generate any of the listed report types. Click each report type to view its description in the adjoining area. Select the report type to be generated.
5. From the Output section, select the format (HTML or Excel) from the Format drop-down list. Modify (if required) the name of the generated file in the File box.
6. Click OK. Figure 327 on page 396 displays a sample Complete Comparison report with all the generated information.
The comparison report includes a generated Result ID (Result 1, Result 2, and so on, depending on the number of result files being compared). Additional information includes the scenario used, the simulation run start (and stop) date and time, the simulation duration and total cost for each of the Result IDs.

Additionally, the comparison report includes all the main sections of the corresponding simulation report as described in Viewing simulation report details on page 391. Each of the main and sub-sections includes data for all the generated Result IDs in a tabular format.

**Note:** The “Violations and Recommendations” section is included only in the Violation and Recommendation comparison report.

---

### Generating real-time comparison report

You can also generate a real-time comparison report (HTML or Excel) by comparing the result of a simulation run to the real-time data from a server.

**To generate the real-time comparison report:**

1. After performing a simulation run, click the **Realtime Report** icon from the Generate section of the Simulation Control Editor, opening the first page of the Realtime Comparison wizard, which is similar to second page of the Import Scenario Data wizard (Figure 289 on page 361).

   Alternatively, you can right-click a result file (*.srf), then click **Simulation Report > Generate Realtime Comparison Report**.

2. To establish connection to your server:
   a) Specify the server IP address and port number in the respective boxes.
   b) Enter the user name and password required to connect to the server.
   c) Modify (if required) the start date and end date in the **Start Date** and **End Date** boxes by clicking the adjoining **ellipsis** button. For details, see Specifying a date on page 377.
Data of all the process instances that have been completed in this date range (between start and end date) are retrieved from the server.

d) Click **Connect** to verify the connection to the server.

3. Click **Next**, opening the second page of the **Realtime Comparison** wizard, which lists the report type that you can generate.

**Figure 328: Realtime Comparison Wizard, Page 2**

![Realtime Comparison Wizard, Page 2](image)

4. Review the available report type and its description.

5. From the **Output** section, select the format (HTML or Excel) from the **Format** drop-down list. Modify (if required) the name of the generated file in the **File** box.

6. Click **Finish** to generate the realtime comparison report, which is similar to the comparison report shown in **Figure 327** on page 396.
Configuring dashboard widgets

Progress Developer Studio for OpenEdge provides the Widgets Configuration tool, which enables you to create and configure widgets that can be used in Business Process Portal dashboards by portal users or administrators to develop customized dashboards or dashboards that can be used as a Common Resource. For information about customizing dashboards in Business Process Portal, see the *Business Process Portal User's Guide* and the *Business Process Portal Administrator's Guide*.

The Widgets Configuration tool is only available for Business Processes and Common Resource projects. When launched from a Business Process, the widget is specific to that process. When launched from a Common Resource project, the new widget can be used by all applications. After you have configured a widget, Progress Developer Studio for OpenEdge creates a top-level widgets.xml file that contains all widgets created for that application, or all widgets created for the Common Resource. The application-specific widgets.xml file is located under the application’s folder (`Workspace_Home\<Application_Name>\`). The application-independent widgets.xml file is located under the common resource’s folder.

On successful publishing of the specific application or Common Resource containing dashboard widgets, the widgets.xml file is registered with the server.

For details, see the following topics:

- Using the Widgets Configuration tool
- Enabling Google gadgets

Using the Widgets Configuration tool

To configure a dashboard widget:
Chapter 22: Configuring dashboard widgets

Note: Save the open application before using the Widgets Configuration Tool.

1. Select the Business Process (or Common Resource project) in the Project Explorer view.
2. From the Tools menu, click Widgets Configuration Tool, opening the Widgets Configuration Tool dialog box, which displays any existing widgets that have been configured for the specific process.

Figure 329: Widgets Configuration Tool

3. To configure a new widget, click Add to open the Widget Properties dialog box.

Figure 330: Widget Properties – General Tab

4. From the General tab, you can enter the following general information about the widget.
   a) Enter a name for the widget in the Name box. The name can contain only alphanumeric characters, and must not contain any blank spaces and no special characters except underscore (“_”) and dollar (“$”). Do not start the widget name with a numeric character.
   b) Type a category in the Category list in order to group widgets. The category name is case insensitive, for example, “MyCategory” and “mycategory” is grouped in the same category.
   c) Select any of the available widget types from the Type drop-down list.

   Table 98 on page 401 lists the available widget types.
Table 98: Widget Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical</td>
<td>Represent widget information in the form of a chart.</td>
</tr>
<tr>
<td>Tabular</td>
<td>Represents widget information in tabular format.</td>
</tr>
<tr>
<td>Infopad</td>
<td>Displays infopad information of the selected application.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Displays scorecard information.</td>
</tr>
<tr>
<td>Global Dataslot</td>
<td>Displays the selected global dataslots of the current project. For information regarding creating a global dataslot, see Setting the dataslot access on page 167.</td>
</tr>
<tr>
<td>Other</td>
<td>Used for creating your own widget type. For details, see the example provided in Enabling Google gadgets on page 404.</td>
</tr>
<tr>
<td>Composite UI</td>
<td>Used to define a widget for external applications. Select this option to render custom JSP files.</td>
</tr>
</tbody>
</table>

**Note:** If you select the **Graphical** type, make sure that the data used in the SQL Query (see Table 99 on page 402) is in the proper format — it must have a String field that acts as a label for each element (for example, a bar in a bar chart or a section in a pie chart) followed by a numerical field that provides the size of each element (for example, the height of a bar in a bar chart).

d) Enter the Description and Title of the widget in the appropriate boxes.
e) Enter the width and height of the widget (in terms of pixels) in the **Width** and **Height** boxes. The maximum permissible value for both parameters is 2048.

The fields in the **Properties** tab vary, depending on the widget type you have selected in the **General** tab. For example, Figure 331 on page 401 displays the **Properties** tab for **Graphical** type of widget.

**Figure 331: Widget Properties dialog box – Properties Tab**
Table 99 on page 402 describes the common property fields and the widget type-specific property fields, where you need to enter information.

Table 99: Property Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Common Fields</strong></td>
<td></td>
</tr>
</tbody>
</table>
| SQL query | Available for Graphical and Tabular types. Enter (or copy-paste) an SQL query in this box.  
Note: For an SQL query on multiple tables with identical column names in the same select clause, the resultset may be inconsistent. For consistent results, use an alias name for each of the duplicate columns. |
| Drilldown URL | Available for Graphical and Tabular types. If you want the widget to support a drill-down function, enter a URL in this box or click Add (in case of Tabular) to add multiple URLs. You can also use the following keywords to specify a parameterized URL:  
• #PARAM# to replace with the label of the chart section that the user clicks on.  
• #CATEGORY# (applicable only for Bar charts) to replace the drill-down URL parameter with the SQL query value (first column of the database query) of the clicked bar chart section.  
• #SERIES# (applicable only for Bar charts) to replace with the value (second column of the database query) of the clicked chart section. |
| Open Drilldown In / Open In | Available for Graphical and Tabular types. Used to specify where to display the target URL for a drill-down operation. Available options are Inline (to display in the same window), Browser (to display in a separate browser window), and Popup (to display in popup dialog box). |
| Custom Presentation JSP file | Available for all widget types. Used to add a customized JSP file for rendering the widget. To add your customized JSP file, click Add to open the Add box where you can define the name and value of any parameters that must be passed at runtime. |
| Application name | Available for Infopad and Global dataslot types. Used to select the application whose infopad information or global dataslots is to be represented in the widget. |
**Target URL**

Available for Other and Composite UI types. Enter the target URL in the **URL** box as any of the following values:

- **Absolute value**, for example, `http://www.progress.com` or an entire URL with the protocol, host, and port number.

- Using Server alias: to specify the URL with the server alias, as specified in the server-config.xml file. This value is only available for Composite UI type.

- **Relative value**, where you can specify the URL without the server alias. The server alias value is provided at runtime. This value is only available for Composite UI type.

Click **Add** to define parameters to the target URL.

**Widget-specific fields**

---

**Graphical widget**

Select the chart type from the **Chart type** drop-down list. Options are: Area, Line (2D and 3D), Meter, Vertical Bar (2D and 3D), Horizontal Bar (2D and 3D), Pie (2D and 3D), Doughnut (2D and 3D), Funnel, Pyramid, and Bar 3D Line.

**Infopad widget**

For the specified application, select any of the module and infopad option from the **Module name** and **Infopad name** lists. You can specify how to slice the infopad information (row or column) and the slice parameter in the **Slice on value** box. You can point to the adjoining **Help** icon for details regarding each component.

**Scorecard widget**

Select the scorecard type (Scorecard, Perspective, or KPI). Depending on your choice, you can select the scorecard, perspective, and KPI from the respective lists. To populate these lists, you need to create the scorecard components for the current application in Business Process Portal. Additionally, you need to access the same application workspace on your Business Process Server installation from Progress Developer Studio for OpenEdge or import the application project (containing the scorecard files) to your workspace.

**Global dataslot widget**

If the current project contains global dataslots, you can select the project name from the **Application name** drop-down list. From the **Global dataslots** box, select the global dataslot to be displayed in the widget. You can use the **SHIFT** key to select a range of global dataslots or use the **CTRL** key to select particular global dataslots.

5. Click **Save** to return to the **Widgets Configuration Tool** dialog box, where the widget you just defined is added to the list of available widgets.
Note: To edit an existing widget, select the widget, then click Modify to open the Widget Properties dialog box, where you can modify the widget properties. You can also click Copy to copy a selected widget, which you can then open and modify if required. To remove a widget, select it and click Remove. You can also change the position of a selected widget by using the Move Up or Move Down buttons.

6. Click Save to save the configurations you made to the widget. The widgets.xml file appears in the Project Explorer view under the BPM or Common Resource project.

Figure 332: The Widget Configuration File in Project Explorer

7. To edit the existing widget configuration file, double-click the widgets.xml file (in the Project Explorer view) to open the file in an XML editor.

Note: If you have added a graphical meter widget, you need to add the following property in the widgets.xml file to configure the range and intervals. For example,

```xml
<properties>
  <property name="range" value="0,100" />
  <property name="intervals" value="normal:0,40:#79E879|warning:40,60:#FFEA00|critical:60,100:#FF5219" />
</properties>
```

where the "range" property is used to specify the meter range and the "intervals" property is used to specify the name, range, and color (in hexadecimal value) of the individual intervals.

Alternatively, you can start the Widgets Configuration Tool dialog box (see Figure 332 on page 404), where you can select one of the available widgets and make the desired changes.

8. Publish the changes to the existing file to the server, and you can use the Refresh option in the Publish wizard to refresh the existing widgets with the changes (for more information, see Publishing an application on page 73.

Enabling Google gadgets

You can use the Widgets Configuration tool to add Google-enabled gadgets like Map, Weather, and News as widgets to your dashboard.

1. From the **General** tab of the Widgets Configuration tool (Figure 330 on page 400), select **Other** as the widget type.

2. From the **Properties** tab of the Widgets Configuration tool (Figure 331 on page 401), specify the Target URL as “http://www.gmodules.com/ig/ifr" in the **Target URL** box and parameters for each gadget type:

Table 100 on page 405 describes the parameters for each gadget type.

### Table 100: Gadget parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **url**        | Applicable for all the enabled gadgets. Specifies the individual URL for each of the Google gadgets. Value is:  
  - http://www.google.com/ig/modules/builtin_weather.xml (for Weather gadget)  
  - http://www.gstatic.com/ig/modules/tabnews/tabnews.xml (for News gadget)  |
| **up_location**| Applicable for Map and Weather gadgets. Specifies the location for which the map or weather forecast needs to be rendered, for example, Santa Clara.  |
| **up_maptype** | Specifies the type of map to be rendered. Available options are m (for map type), s (for satellite), and t (for terrain).  |
| **up_idleZoom**| Specifies the magnification level of the map. For example, 11.  |
| **up_selected text** | Specifies the location to be pointed at, when the user searches for a place in the Search box. For example, progress.  |

For **Map** widget

**Note:** You can use the Map component only if you have a valid license for the Google Maps.

For **Weather** widget

**up_scale** | Specifies the unit of temperature. Available options are C (for Celsius) and F (for Fahrenheit).  |

For **News** widget

**up_ned** | Specifies the news edition to be rendered. For example, us (for U.S. edition), in (for India edition), and so on. |
<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>up_items</td>
<td>Specifies the number of news items to be rendered.</td>
</tr>
<tr>
<td>up_show_image</td>
<td>Specifies whether to display images in the news feed. Values are 0 (false) and 1 (true).</td>
</tr>
<tr>
<td>up_font_size</td>
<td>Specifies the font size of the news feed, for example, 12 pt.</td>
</tr>
<tr>
<td>up_selected tab</td>
<td>Specifies the default tab to be displayed on rendering. The value starts with 0.</td>
</tr>
</tbody>
</table>

Shown below is a sample widgets.xml file containing the configuration details for the Google gadgets.

For Map gadget:

```xml
<other name="MapWidget">
  <description>Widget to search and display location in a map.</description>
  <category>Map</category>
  <title>Map</title>
  <width>320</width>
  <height>320</height>
  <jsp>/bpmportal/common/DefaultOtherWidget.jsp</jsp>
  <properties/>
  <param name="up_location">Santa Clara</param>
  <param name="up_mapType">m</param>
  <param name="up_idleZoom">11</param>
  <param name="up_selectedtext">savvion</param>
</other>
```

For Weather gadget:

```xml
<other name="WeatherWidget">
  <description>Displays the weather forecast for the next 5 days</description>
  <category>weather</category>
  <title>Weather</title>
  <width>200</width>
  <height>300</height>
  <jsp>/bpmportal/common/DefaultOtherWidget.jsp</jsp>
  <properties/>
  <param name="up_location">Santa Clara</param>
  <param name="up_scale">F</param>
  <param name="up_title">Santa Clara</param>
</other>
```

For News gadget:

```xml
<other name="NewsWidget">
  <description>Displays News feeds from Google</description>
  <category>news</category>
  <title>News</title>
  <width>320</width>
```
Enabling Google gadgets

<height>320</height>
<jsp>/bpmportal/common/DefaultOtherWidget.jsp</jsp>
<properties/>
<targeturl url="http://www.gmodules.com/ig/ifr">
<param name="url" http://hosting.gmodules.com/ig/gadgets/file/104342096967082496017/google-news.xml"/>
<param name="up_ned" us" />
<param name="up_items" 5"/
<param name="up_show_image" 1"/
<param name="up_font_size" 12pt"
<param name="up_selectedTab" 4"/
</targeturl>
</other>
Controls in the Form Editor use JSON (JavaScript Object Notation) as the common data format. Depending on the type of control, a different data model is used to correctly render its value.

In addition to Static and Dataslot binding for the widget data source, you can bind the widget data to a service that returns JSON formatted data. For details regarding controls in the Form Editor, see Defining the form's controls on page 272.

Progress Developer Studio for OpenEdge provides the Form Data Designer tool, which provides services that returns hard-coded data, and are available as common services for any form used in the current Business Process.

An added benefit of tying widgets to services is that it makes it possible to change the underlying data on the server-side without the need for republishing the application. Services are typically available as *.sjs files under the jsp folder of the project.

You can execute all the steps in the Form Data Designer tool to generate a JSON file (*.sjs) that is saved under the project folder (<Project_Name>\jsp) in the Project Explorer. All the services saved in this folder are available to the forms used in the Business Process, as data source for the controls.

You can now edit the service from the Form Data Designer, instead of editing hard-coded form values in the Form Editor thus eliminating the need for editing your form and subsequent republishing of the Business Process.

For details, see the following topics:

• Introducing the Form Data Designer
• Starting the Form Data Designer tool
• Managing service types
Introducing the Form Data Designer

The Form Data Designer tool provides the following types of services. Table 101 on page 410 lists the form controls supported by each of these services.

Table 101: Service Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Supported Widgets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree</td>
<td>Tree, Cascaded Combo boxes</td>
</tr>
<tr>
<td>Chart</td>
<td>Chart widgets of all types</td>
</tr>
<tr>
<td>Grid</td>
<td>Grid</td>
</tr>
<tr>
<td>List</td>
<td>List, Combo box, Radio button, Check box</td>
</tr>
<tr>
<td>Combobox</td>
<td>List, Combo box, Radio button, Check box</td>
</tr>
<tr>
<td>Radio</td>
<td>List, Combo box, Radio button, Check box</td>
</tr>
<tr>
<td>Checkbox</td>
<td>List, Combo box, Radio button, Check box</td>
</tr>
<tr>
<td>Menu</td>
<td>Menu</td>
</tr>
</tbody>
</table>

Starting the Form Data Designer tool

To start the Form Data Designer tool:

1. Open the Business Process (*.spt) or Web application (*.swt) project for which you want to generate the JSON file.
2. From the Tools menu, click Form Data Designer, opening the first page of the Form Data Designer wizard.
Managing service types

3. Select your service type from the drop-down list provided, then click Next.

The second page of the Form Data Designer wizard varies according to the selected service type.

Managing service types

From the second page of the Form Data Designer tool, you can perform the following operations:

- Click Back to return to the first page, and change the service type.
- Click Clear to reset all entered values for the selected service type.
- Click Save to save the entered values for the selected service type. By default, the name of the JSON file (*.sjs) is that of the service type (for example, tree.sjs for service type “Tree”). For Business Process, the *.sjs file is stored in the <Project_Name>\jsp folder. For Web application, the *.sjs file is stored in the <Project_Name> folder.
- Click Close to close the Form Data Designer tool, after completing all operations.

Each of the supported service types are elaborated in the following sections.

Using the Tree service

You can apply the Tree service to Tree and Cascaded combo box controls. You can bind a collection of combo box controls to the same Tree service as the data source.

1. Select Tree option as the service type in the first page (Figure 333 on page 411) of the Form Data Designer tool, then click Next.
2. To add a node, click the root node, and then click **Add Node**, opening the **Enter Value** dialog box.
   a) Type the node label in the **Label** box. The label is displayed in the tree structure.
   b) Enter the value of the node in the **Value** box.
   c) From the **Expanded** drop-down list, choose whether you want the node to appear expanded or collapsed.
   d) Click **OK** to add the node.

---

**Note:** To edit a node, click the node and then **Edit Node**, opening the **Enter Value** dialog box where you can modify the node. To remove a node, click the node and then **Remove Node**. You can also change the position of a node by clicking **Move Up** or **Move Down**.

---

Figure 335 on page 412 displays a sample completed tree (*.sjs) file.

**Figure 335: Sample Tree service**

---

**Using the Chart service**

You can apply the **Chart** service to all types of Chart controls in your form.
1. Select **Chart** option as the service type in the first page (Figure 333 on page 411) of the Form Data Designer tool, then click **Next**.

**Figure 336: Form Data Designer Wizard – Chart service**

2. To enter the domain title of the chart, which appears on the chart X-axis, click **Edit Domain Title**, opening the **Input** dialog box, where you can enter the value.

3. To enter the range title of the chart, which appears on the chart Y-axis, click **Edit Range Title**, opening the **Input** dialog box, where you can enter the value.

4. Click the following command buttons to perform chart-related operations.

<table>
<thead>
<tr>
<th>Button</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Column</td>
<td>Opens the <strong>Input</strong> dialog box, where you can enter the column name. All columns are plotted on the X-axis. You can change the position of the inserted column by dragging the column header.</td>
</tr>
<tr>
<td>Remove Column</td>
<td>Click any cell under the column to be removed, then click <strong>Remove Column</strong> to remove the column.</td>
</tr>
<tr>
<td>Edit Column Name</td>
<td>Click any cell in the column to be renamed, then click <strong>Edit Column Name</strong>, opening the <strong>Input</strong> dialog box, where you can enter the column name.</td>
</tr>
<tr>
<td>Add Row</td>
<td>Adds a row with the number of cells equal to number of added columns.</td>
</tr>
<tr>
<td>Remove Row</td>
<td>Removes the selected row.</td>
</tr>
<tr>
<td>Move Up / Move Down</td>
<td>Moves the selected row up or down.</td>
</tr>
<tr>
<td>Edit Cell</td>
<td>Click the cell where you want to enter (or modify) the value, then click <strong>Edit Cell</strong>, opening the <strong>Input</strong> dialog box, where you can enter the value. You can also enter value directly by double-clicking the cell and entering the value at the insertion point. You can also distinguish each row values in the chart with a unique row color, by clicking the cell in the <strong>Row Color</strong> column and selecting the color.</td>
</tr>
</tbody>
</table>
Using the Grid service

You can apply the **Grid** service to a Grid control in your form. To use the Grid service, select **Grid** option as the service type in the first page (**Figure 333** on page 411) of the Form Data Designer tool.

The operations to create a Grid service is similar to that for the Chart service, as described in the table provided in Step 4.

**Figure 337** on page 414 displays a sample completed Grid file.

**Figure 337: Sample Grid service**

<table>
<thead>
<tr>
<th>ISBN</th>
<th>Book Title</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-423-12445-4</td>
<td>Romeo and Juliet</td>
<td>Shakespeare</td>
</tr>
<tr>
<td>3-423-12445-5</td>
<td>Mein Kampf</td>
<td>Adolf Hitler</td>
</tr>
<tr>
<td>42-1</td>
<td>Breakfast on Pluto</td>
<td>Patrick Modere</td>
</tr>
<tr>
<td>42-2</td>
<td>The God of Small Things</td>
<td>Arundhati Roy</td>
</tr>
<tr>
<td>42-3</td>
<td>Every Man for Himself</td>
<td>Roy of Banbridge</td>
</tr>
<tr>
<td>42-4</td>
<td>The Monk's Last Sigh</td>
<td>Salman Rushdie</td>
</tr>
<tr>
<td>42-6</td>
<td>Hiding through the Galaxy 6</td>
<td>Douglas Adam</td>
</tr>
<tr>
<td>10</td>
<td>The stories of my experiment with truth</td>
<td>M.K. Gandhi</td>
</tr>
</tbody>
</table>

Using services for common controls

Form Data Designer tool provides the **List**, **Combobox**, **Radio**, and **Checkbox** services, each of which can be used for List, Combo box, Radio button, and Check box controls in your form.

The operations to create each of these services are similar, as described in this section. **Figure 338** on page 415 displays the second page of the Form Data Designer wizard for the List service, and is similar for the rest of the services.

1. Select **List**, **Combobox**, **Radio**, or **Checkbox** option as the service type in the first page (**Figure 333** on page 411) of the Form Data Designer tool, then click **Next**.
2. To add the control option, click **New**, opening the **Map** dialog box.
   a) Type the name in the **Name** box. This is displayed in the control.
   b) Enter the value of the control option in the **Value** box.
   c) Click **OK** to add the control option.

**Note:** To edit an option, click the option and then **Modify**, opening the **Map** dialog box where you can modify the entered data. To remove an option, click the option and then **Remove**. You can also change the position of an option by clicking **Move Up** or **Move Down**.

The **Preview** section displays a preview of the service, as represented by the form control.

**Using the Menu service**

You can apply the **Menu** service to menu controls in your form.

1. Select **Menu** option as the service type in the first page (**Figure 333** on page 411) of the Form Data Designer tool, then click **Next**.
2. To add a node, click the root node, and then click **Add Node**, opening the **Add Menu Item** dialog box.

a) Type the menu label in the **Label** box. The label is displayed as the menu or menu item.

b) Use the **Action** section to specify the action to be performed on clicking the menu or menu item. In the **URL** box (only available for menu items), specify the target location as a website address or a file. In the **Message** box, enter a value (if any) to be delivered to the target widget when you click the menu (or menu item) at run-time.

**Note:** To display the specified message at runtime, you must use the `eventContext.message` function in the custom script, configured for the corresponding Menu control event in Form Editor.

c) To disable the menu node, click **True** option in the **Disabled** section.

d) Click **OK** to add the menu.

**Note:** To edit a menu, click the menu and then **Edit Node**, opening the **Add Menu Item** dialog box where you can modify the menu. To remove a menu, click the menu and then **Remove Node**. You can also change the position of a menu by clicking **Move Up** or **Move Down**.
Working with User Management tool

Progress Developer Studio for OpenEdge provides the User Management tool, which allows you to add and manage users, groups, and queues, as well as view and update the organization hierarchy.

All the members created using the User Management tool, are available to newly created BPM processes and can be assigned to Activity worksteps.

The User Management tool includes a Organization Chart Viewer, that enables you to view the specified organization as a hierarchy of users and groups, similar to as shown in Figure 340 on page 417.

Figure 340: Sample Organization Chart

For details, see the following topics:

- Types of members
- Starting User Management tool
- Printing organization chart
Types of members

The User Management tool supports three types of members, as described in Table 102 on page 418.

Table 102: Member Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Represents the basic entity of the user management tool. Typical attributes of a user include user name, real name, and title.</td>
</tr>
<tr>
<td>Groups</td>
<td>Represents a set of users performing related tasks, for instance, the HR group. Attributes include leader name and group members. A group can include another group.</td>
</tr>
<tr>
<td>Queues</td>
<td>Represents a set of users and groups.</td>
</tr>
</tbody>
</table>

Starting User Management tool

You can start the User Management tool by clicking OpenEdge > Tools > Users.

Figure 341: User Management Tool

The User Management tool consists of two panes. The left pane displays a tree consisting of the member node types namely Users, Groups, and Queues. You can define members, which then appear under the respective node type (see Managing nodes on page 420).
You can also search for members using the Search box in the left pane. Click the down-arrow provided and select either of the following options:

- Flat search: This search provides a flat list of all matching members, containing the search text.
- Tree search: This search displays the result in a tree structure, indicating the node type and if present, its position in the organization hierarchy.

The right pane (as seen in Figure 341 on page 418) displays by default, the Organization Chart Viewer initially with blank tree node. After adding users and groups, the viewer is automatically updated to display the organization hierarchy. Additionally, you can expand (and collapse) parts of the organization hierarchy, thus providing views at different detail levels.

The Organization Chart Viewer (as shown in Figure 340 on page 417) has the following features:

- Each expandable (or collapsible) node displays the group and the group leader (optional). The topmost node displays the organization name and the leader (optional). The title of the added user, if defined, is also displayed.
- You can double-click any node to view the user details.
- You cannot add (or remove) nodes directly from the Chart Viewer.
- Queues are not displayed in the Chart Viewer. The Chart Viewer only displays users and groups (including groups within a group).

To customize the Organization Chart Viewer:

1. In the **Organization Name** box (in the right pane), type the name of your organization.
2. To specify the organization leader, click the **ellipsis** button next to the **Leader** box, opening the **Select User** dialog box, which displays a list of defined users (as described in Managing users on page 420).

   **Figure 342: Select User dialog box**

   ![Select User dialog box]

3. Click the user from the list, then click **OK**. You can also use the **Search** box to search for a user.
4. Click **Apply** to add the organization name and the leader name to the blank topmost node in the Organization Chart Viewer. The organization name is also displayed and represents the root node in the left pane of the User Management tool.

   **Note:** Henceforth, you can click the root node at any point of time, to view the updated Organization Chart Viewer.
Printing organization chart

You can also print the Organization chart displayed in the Organization Chart Viewer.

1. Click File > Print chart opening the Print dialog box, which displays a print preview of the organization chart.

Figure 343: Printing Chart

2. Modify the print settings, if required, then click Print.

Managing nodes

You can use the User Management tool to add users, groups, and queues as members in the respective member nodes. You can then use the defined members as performers in newly created process templates.

You can click any member node or member in the left pane to view the details screen in the right pane. Alternatively, you can double-click any node in the Organization Chart Viewer to display the member details.

Managing users

You can add (and manage) individual users from the User list.

1. Click Users node in the left pane, displaying the user list in the right pane.

   The user name and the real name is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.
2. To create a user, click **New** to open the user details screen, where you can enter the following user details.

**Figure 345: Creating User**

Table 103 on page 422 describes each user information field.
Table 103: User details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>(Required) Enter the system name of the user. The username appears as the performer in your process template. You can also search for a user by entering the username in Search box in the User List screen (see Figure 344 on page 421).</td>
</tr>
<tr>
<td>Real Name</td>
<td>Enter the full name of the user (example, David Brown). This name appears in the Organization Chart Viewer for this user. To display the user in the Chart Viewer, you need to add the user to a group.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the designation (or title) of the user in the organization. If specified, the title also appears along with the real name in the Organization Chart Viewer.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Enter a valid e-mail address of this user.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the telephone number of this user.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Click the adjoining ellipsis button to specify a calendar (if defined). This action includes the business calendar restrictions for this user.</td>
</tr>
</tbody>
</table>

3. After entering the user information, click OK to add the user to the user list. The user is also added as a member to the Users node in the left pane.

To remove a user (or multiple users) from the user list, select the users and click Remove. The User Management tool prompts you for confirmation. Click Yes to remove the selected users. To modify user details, select the user and click Modify to open the user details screen (Figure 345 on page 421), where you can modify the user information.

Managing groups

You can add (and manage) groups from the Groups list.

1. Click Groups node in the left pane, displaying the group list in the right pane.

The group name and label is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.
2. To create a group, click **New** to open the group details screen, where you can enter the following group details.

**Figure 347: Creating Group**

Table 104 on page 424 describes the group detail fields.
Table 104: Group details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>(Required) Enter the name of the group. The group name appears as the group performer in your process template. You can also search for a group by entering the group name in <strong>Search</strong> box in the Group List screen (see Figure 346 on page 423).</td>
</tr>
<tr>
<td>Group Label</td>
<td>Enter the group label (example, Human Resources). This label appears as the group label (see Figure 340 on page 417) in the Organization Chart Viewer for all added users.</td>
</tr>
<tr>
<td>Leader</td>
<td>Click the adjoining <strong>ellipsis</strong> button to select a group leader (see Figure 345 on page 421). From the <strong>Select User</strong> dialog box (see Figure 347 on page 423), click the user to be selected as the group leader, then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Click the adjoining <strong>ellipsis</strong> button to specify a calendar (if defined). This action includes the business calendar restrictions for the group members.</td>
</tr>
<tr>
<td>Group Members</td>
<td>Use this section to add the group members, as discussed in <strong>Adding group members</strong> on page 424.</td>
</tr>
</tbody>
</table>

3. Click **OK** to add the group to the groups list. The group is also added as a member to the **Groups** node in the left pane.

   To remove a group (or multiple groups) from the groups list, select the groups and click **Remove**. The User Management tool prompts you for confirmation. Click **Yes** to remove the selected groups. To modify group details, select the group and click **Modify** to open the group details screen (Figure 347 on page 423), where you can modify the group information.

### Adding group members

You can use the **Group Members** section (see Figure 347 on page 423) to add group members that can include individual users and other groups.

**To add and configure a group member:**

1. Click **Add** to open the **Select Members** dialog box, which lists all the defined users and groups.
2. Click the member to be added, then click **OK** to add the member to the list of members.
   
   You can also search for a member using the **Search** box. To remove a member from the member list, select the user and click **Remove**.

3. You can also specify a role (optional) for the group member.
   
   a) Select the added member, then click **Role**, opening the **Select Role** dialog box.
b) Select an existing role from the drop-down list provided or enter a new role.
c) Click OK to define the role for the group member.

Managing queues

You can add (and manage) queues from the Queue list.

1. Click Queues node in the left pane, displaying the queue list in the right pane.

   The queue name and label is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.

Figure 349: Queue List screen

2. To create a queue, click New to open the queue details screen, where you can enter the following queue details.
Figure 350: Creating Queue

Table 105 on page 426 describes the queue information fields.

Table 105: Queue details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Name</td>
<td>(Required) Enter the name of the queue. The queue name appears as the queue performer in your process template. You can also search for a queue by entering the queue name in Search box in the Queue List screen (see Figure 349 on page 425).</td>
</tr>
<tr>
<td>Queue Label</td>
<td>Enter the queue label. Queue labels do not appear in the Organization Chart Viewer.</td>
</tr>
<tr>
<td>Queue Members</td>
<td>You can use this section to add queue members that can include individual users and other groups. Click Add to open the Select Members dialog box, which lists all the defined users and groups. Click the member to be added, then click OK to add the member to the list of members. You can also search for a member using the Search box. <strong>Note:</strong> You cannot add another queue as the queue member. To remove a member from the member list, select the member and click Remove.</td>
</tr>
</tbody>
</table>

3. Click OK to add the queue to the queue list. The queue is also added as a member to the Queues node in the left pane.

To remove a queue (or multiple queues) from the queue list, select the queues and click Remove. The User Management tool prompts you for confirmation. Click Yes to remove the selected queues. To modify queue details, select the queue and click Modify to open the queue details screen (Figure 350 on page 426), where you can modify the queue information.
Importing users

You can also import user information from a selected server.

1. Click File > Import, opening the Import dialog box.

   Figure 351: Importing User Information

   ![Import dialog box]

2. In the Server URL box, modify the URL (if required) of the server from where you want to retrieve user information. You cannot import user information from an LDAP Realm.

3. Click OK.
Working with Business Calendar

Progress Developer Studio for OpenEdge provides the Business Calendar tool, using which you can define an organization-level calendar and assign them to workstep performers for simulation projects. For details regarding usage of business calendar in the Simulation perspective, see Configuring and running simulation on page 353.

You can start the Business Calendar by clicking OpenEdge > Tools > Calendars.
Understanding the Business Calendar

The Business Calendar (Figure 352 on page 430) provides a default out-of-box calendar, which displays the calendar for the current year. The default calendar does not display any non-working days, except on Saturday and Sunday.

You can create your own calendar using the default calendar settings, and customize the calendar according to your preferences. For example, you can create separate calendars for your offices in different countries.

The default calendar has the following working schedule:

- Working hours from 8 a.m. to 5 p.m. with 12 noon to 1 p.m. designated as lunch hour.
- Every Saturdays and Sundays are designated as non-working days.
You can also create customized working schedules using the Business Calendar tool, and then apply them to multiple calendars. You can use a customized schedule to:

- Change the default working hours.
- Change the working and non-working days of the week. For instance, mark “Saturday” as a working day or mark “Friday” as a non-working day.
- Mark a particular date (example, 25th December) as a non-working day.

Using the Business Calendar tool

You can use the Business Calendar tool to add (and manage) calendars and schedules.

Managing calendars

You can perform the following operations to manage calendars.

- To add a calendar, click the Add icon (add) from the Calendar tool, to add a calendar (example, “Calendar1”) to the Calendar drop-down list.

  Note: Each added calendar (Calendar1, Calendar2, and so on) is a copy of the configuration set in the working schedule of the default calendar.

- To rename the added calendar, click the Rename icon (rename), opening the Calendar name dialog box.

  Figure 353: Renaming a Calendar

  1. Type the modified name of the calendar.
  2. Click OK to rename the calendar.

- To delete a calendar, select the calendar in the Calendar drop-down list, then click the Remove (remove) icon. The Business Calendar tool prompts you for confirmation. Click OK to remove the selected calendar.

  Note: You cannot rename nor delete the default calendar.
Managing schedules

You can create customized working schedules, which are independent of calendars. You can then apply a schedule to a single day, or a sequence of days, or even to all the days of the year. You can also apply a schedule to multiple calendars.

To define a schedule:

1. Click a single day of your calendar, or drag across consecutive days, opening the Select Schedule dialog box, using which you can define (or select) a schedule.

   Figure 354: Select Schedule dialog box

2. Click the Add ( ) icon to add a schedule (example, “Schedule1”) to the Schedule drop-down list.

   Note: Each added schedule (Schedule1, Schedule2, and so on) contains the original settings of the default schedule. Any changes made to the default schedule are not reflected when you add a schedule.

3. Enter a description for the schedule (example, “Recruitment Schedule”) in the Description box.

   Note: You can rename the schedule by clicking the Rename ( ) icon, to open the Schedule name dialog box, where you can enter the modified name. To delete a schedule, click the Remove ( ) icon. You cannot rename nor delete the default schedule.

4. From the Workdays section, select (or clear) the appropriate checkboxes for the work days in this schedule. For the default schedule, Monday to Friday are marked as working days, with Saturday and Sunday designated as non-working days.

   Tip: To create a schedule for company holidays, clear all the checkboxes in the Workdays section.
5. The **Workhours** section displays two time segments namely, AM and PM. For the default schedule, the work-hours are 8-12 (in the AM segment) and 1-5 (in the PM segment). To manage work-hours:

- Use the slider along the starting and ending time of each segment to change the default work-hours.
- You can remove a work-hour segment by right-clicking on it, then clicking **Remove**.
- You can also insert additional work-hour segments, by right-clicking a blank portion of the **Workhours** section, then clicking **Insert**.

The work-hours that you set is applied to all the working days selected in the **Workdays** section.

6. You can set different work-hours for single (or multiple) working days in the **Exceptions** tab.

**Figure 355: Select Schedule dialog box – Exceptions tab**

![Select Schedule dialog box](image)

a) Select the checkbox for the working day whose work-hours you want to modify.
b) Modify the work-hours, as described in Step 5.

7. Click **OK** to create and apply the schedule to the selected days of your calendar.

The selected days are highlighted by a color, which is unique and randomly selected for each customized schedule. Move your pointer over any highlighted day to view the name of the customized schedule.

### Overwriting a schedule

You can overwrite a schedule for selected day (or days) with another schedule.

1. Drag across the calendar days, whose schedule is to be overwritten.
2. From the **Select Schedule** dialog box (Figure 354 on page 432), select any schedule from the **Schedule** drop-down list.
3. Click **OK** to apply the schedule to the selected days.

**Figure 356** on page 434 shows a calendar with three customized schedules, each of them highlighted with a unique color.
Note: You can apply a different schedule to each day of the calendar year. You can also use the same schedules for other calendars created using the Business Calendar tool (see Managing calendars on page 431).

Figure 356: Calendar with multiple schedules
Managing messages and channels

Progress Developer Studio for OpenEdge provides the Message Manager and the Channel Manager, which enable you to define, manage, and store messages and channels. These messages and channels can then be used when developing Message worksteps in the process workflow.

You can assign a defined message to a:

- Start workstep in a Business Process (as described in Using the Messaging tab of Start workstep properties on page 179).
- Message workstep in a Business Process (as described in Defining properties of Message worksteps on page 203).
- End workstep in a Business Process (as described in Using the Messaging tab of End workstep properties on page 206).

For details, see the following topics:

- Using the Message Manager
- Using the Channel Manager

Using the Message Manager

You can use the Message Manager to create messages and define the following message properties.

- **Message template** (or the body of the message).
• **Message header** data that can be used to identify the message, for instance, the receiver process ID or Email ID.

• **Payload** properties that specifies the actual XML message content.

• **Message correlation** mechanism to identify the workstep instance to which the message is to be delivered.

To open the Message Manager:

1. From the **Tools** menu, click **Messages**, opening the **Message Manager** dialog box, which displays messages (if any) in the Messages section.

   ![Figure 357: Message Manager](image)

2. To define a new message, click **New**, opening the **Add New Message** dialog box.

3. Enter the message name in the **Message Name** box, and a description of the message in the **Description** box.

4. Define the other properties of the message, as described in the following sections.

**Defining the message template**

You can use the **Template** tab to define the message template. From the **Template** tab, enter the XML template in the text area provided.

Alternatively, you can click **Browse** to browse to the folder where message descriptor templates (*.xml) are stored. Predefined templates are stored in the `Workspace_Home\.com.savvion.studio\messaging\messages` folder.
Defining the message header

You can use the Header tab to define the header for the message. The header contains data that can be used to identify the message. By default, Progress Developer Studio for OpenEdge provides 13 predefined headers — five of these headers are displayed in the Header tab, the remaining eight can be added to the Header tab.

To add headers:

1. From the Header tab, click Add, opening the Add Header Property dialog box (right image, Figure 359 on page 438).
2. Select the System Property checkbox to add more predefined headers to the message.

The Name box now displays a drop-down list containing eight more header types including ReceiverTaskName, ReceiverPriority, and SenderEmail. Since these headers are predefined, the Type box is disabled.
3. To define your own header, clear the System Property checkbox. Enter a name for the header in the Name box and choose a type from the Type drop-down list.
4. Click OK to add the header to the list in the Header tab.

**Note:** To remove a header, select the header in the Header tab and click Remove. You can only modify your defined header. To do so, select your header and click Modify.

**Defining payload properties**

You can use the Payload tab to provide the informational content, or the body, of the message. You must enter payload information in the Payload table. If no payload information is shown, click Add to open the Add Payload Property dialog box, where you can define the payload properties.

**Figure 360: Add Payload Property**
1. Enter the payload name in the **Name** box.
2. Depending on the type of information in the payload, select the type for the payload from the **Type** drop-down list. For example, select `java.lang.String` for textual content, and `int` for basic numerical content.
3. Enter an XPath expression in the **XPath Expression** box.
   
   Alternatively, from the **Tree View** tab, click the expression in the XPath tag to display it in the **XPath Expression** box. Click **Evaluate** to see if there are matches to the String Content.
   
   You can view the payload as a Tree View or XML Source by opening the respective tabs.
4. Click **OK** to add the payload property to the **Payload** tab. The payload properties are displayed in the section below.

**Figure 361: Message Manager – Payload Tab**

![Add New Message](image)

**Defining message correlation**

You can use the **Correlation** tab to define a correlation with the Payload Property defined in the previous tab. You need to define Message correlation to identify the workstep instance to which the message is to be delivered. Message Correlation is based on the comparison of payload data with the dataslot values.

**To add correlation properties:**

1. From the **Correlation** tab, click **Add** to open the **Add Correlation Properties** dialog box.
2. Enter a name for the Correlation in the **Name** box.

3. Select the Payload Property from the **Payload Property** drop-down list. The list displays the payload properties defined in the **Payload** tab, as well as the header defined in the **Header** tab.

4. Click **OK** to add the Correlation in the table in the **Correlation** tab.

**Note:** If required, you can use the **Namespaces** tab to define additional namespaces.

5. After defining the message properties, click **OK** to add the message to the **Message Manager** dialog box. An Information prompt appears, informing you that the *.xml* file containing the message has been saved to the *Workspace_Home\.com.savvion.studio\messaging\messages* folder and that you can export it to the server. Click **OK**.

**Note:** To modify an existing message in the Message Manager, select it and click **Edit**, opening the **Edit Message** dialog box, which is similar to the **Add New Message** dialog box. To remove a message from the Message Manager, select it and click **Delete** in the Local section.

### Exporting and importing messages

You can use Message Manager tool to export messages to the Business Process Servers, in order to share them with other Progress Developer Studio for OpenEdge users. You can also import one or more messages from the Business Process Servers in order to use them in your process templates.

### Exporting a message

**To export a message:**

1. From the **Message Manager** dialog box, select a message (single or multiple) and click **Export** in the Remote section.
2. From the List of Messages to be exported dialog box that appears:
   a) Check the server address in the Server URL box. Modify it, if required.

   Figure 364: Export Messages dialog box

   b) Enter your user name and password in the respective boxes, then click OK.

   An Information alert appears, informing you that the “MessageDescriptor(s) were successfully exported to the server.”

**Importing a message**

To import a message:

1. From the Message Manager dialog box, click Import to open the Import Messages dialog box.
2. Check the server address in the **Server URL** box. Modify it, if required.
3. Enter your user name and password in the respective boxes, then click the **Connect to Server** icon.

All the messages available for import are displayed in the table in the **Messages** section.
4. Select a message and click **OK**.

An Information alert appears, informing you that the “Selected MessageDescriptor(s) were successfully imported...”

### Using the Channel Manager

Progress Developer Studio for OpenEdge provides the Channel Manager tool to store and manage channels, which are used as a JMS-based communication medium with Message Subscriber worksteps and external softwares (for instance, SAP NetWeaver).

Business Process Server uses the default “BP Server Channel” to send and receive messages for Message Subscriber worksteps. BP Server channel uses a fixed JMS destination of type, Queue (point-to-point). For external softwares, Business Process Server uses a fixed JMS destination of type, Queue or Topic (for broadcasting).

**To open the Channel Manager:**

1. From the **Tools** menu, click **Channels**, opening the **Channel Manager** dialog box, which displays the default BPServerChannel.
2. To add a new channel, click New, opening the Add New Channel dialog box, where you can add a channel for a Local server (default) or a Remote server.

3. Enter a name and description for the channel in the respective boxes.

4. For a local channel, you can only use the "Queue" destination type, as displayed in the read-only Destination Type drop-down list.

5. Enter a Destination name in the Destination Name box.
   For a Local channel, the Destination name must be that of a topic already defined on your local server (for instance, jms/Business ProcessMessageQueue). For a Remote channel, the Destination name can be either a topic or a queue that has already been defined.

6. To create a channel for a Remote server, click the Remote option in the Server Properties section, to enable and make changes in the following fields.
   a) From the Destination Type, select either QUEUE (for messages that can be received by an individual or by any member of a group) option or TOPIC (for messages that can be received by all members of a group) option.
   b) Enter the respective JMS properties for your application server (Initial Factory, Provider URL, Principal or Credential) in the respective boxes. Refer to the
      OEBPS_Home\conf\oebpsjndi.properties for the properties. For instance, the value of the Provider URL parameter should be that of the jmsserver/jmscluster and not the
      ejbcluster property.

7. Click OK to save the new channel to the
   Workspace_Home\.com.savvion.studio\messaging\channels folder.
Exporting and importing channels

You can use Channel Manager tool to export channels to the Business Process Servers, in order to share them with other Progress Developer Studio for OpenEdge users. You can also import one or more channels from the Business Process Servers in order to use them in your process templates.

Exporting a channel

To export a channel:

1. From the Channel Manager dialog box, select one or more channels, then click Export in the Remote section.
2. From the List of Channels to be exported dialog box that appears:
   a) Check the server address in the Server URL box. Modify it, if required.
   b) Enter your user name and password in the respective boxes, then click OK.

   An Information alert appears, informing you that the “Channel(s) were successfully exported to the server.”

Importing a channel

To import a channel:

1. From the Channel Manager dialog box, click Import to open the Import Channels dialog box.
2. Check the server address in the Server URL box. Modify it, if required.
3. Enter your user name and password in the respective boxes, then click the Connect to Server icon.

   All the channels available for import are displayed in the table in the Channels section.
4. Select a channel and click **OK**.

An Information alert appears, informing you that the “Selected channel(s) were successfully imported...”
Managing business objects

Progress Developer Studio for OpenEdge provides the Business Object Manager tool, which enables you to define and manage business objects. For each business object, you can add and manage attributes, where data is stored and accessed.

Business objects are fully interoperable, plug-and-play, distributed components that encapsulate traditional lower-level objects that implement a business process. In Progress Developer Studio for OpenEdge, business objects act as a collection of dataslots that can behave as a single, reusable unit. Business Objects also supports complex nested structures, including collection of other business objects. Using business objects, you can incrementally adjust business applications to fit your changing organizational needs, use them to rapidly build new applications entirely from reusable components, and dramatically reduce your development and maintenance costs.

For details, see the following topics:

- Using the Business Object Manager
- Using business objects in applications

Using the Business Object Manager

You can use the Business Object Manager tool to create and maintain business objects in Progress Developer Studio for OpenEdge. The stored objects can be persisted internally and externally.

To create and manage a business object:

1. Open a Business Process, Web application, or a Common Resource project.
2. From the Tools menu, click Business Objects, opening the Business Object Manager dialog box, which displays the list of default business objects with category, "demo."
Figure 370: Business Object Manager dialog box

![Business Object Manager dialog box]

**Note:** To modify an existing business object, select it from the Business Object Manager dialog box, then click **Edit** to make the changes in the Edit Business Object dialog box (similar to that shown in Figure 370 on page 448).

3. To create a new business object, click **New**, opening the Create New Business Object dialog box.

Figure 371: Create New Business Object dialog box

![Create New Business Object dialog box]

4. Type the name of the business object in the **Name** box. Avoid upper-case and special characters in the name.

5. Select a category from the **Category** drop-down list. To define a category, click the ellipsis button next to the **Category** list, to open the New Category dialog box, where you can define a new category.
6. In the **Data Source Reference** box, enter the description of the datasource (if any) being referenced. In the **Description** box, enter a description of the business object. This information is optional and help users identify business objects.

7. To define attributes for the business object, click **Add** to open the **New Attribute** dialog box.

**Figure 373: New Attribute**

a) Define the attribute properties by entering relevant information in the appropriate field components.

**Table 106** on page 449 describes the field components.

**Table 106: Defining Business Object Attributes**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the attribute. Attribute name must not contain any special characters, and can have up to 64 characters. You need to preceed any upper-case character with at least two lower-case characters.</td>
</tr>
</tbody>
</table>
| Type     | The type of attribute. Options include Character, Long, Double, BigDecimal, Logical, Timestamp, and any business object that you have previously defined. 

**Note:** Progress Developer Studio for OpenEdge does not support business objects with circular reference. For example, if a business object, "bo1" contains the business object, "bo2" as an attribute, then "bo2" cannot contain "bo1" as an attribute. |
<p>| Size     | The size of the attribute. You can modify the size only for String type. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default value</strong></td>
<td>Enter (or modify) the default value for the attribute, if required. The default values are 0 (for Long), 0.0 (for Double and BigDecimal), false (for logical), and current date (for TimeStamp). To change the current date for Timestamp, click the Open Time Chooser icon.</td>
</tr>
<tr>
<td><strong>Primary Key</strong></td>
<td>Select this checkbox to make this attribute the primary key. Only one attribute can be assigned as the primary key.</td>
</tr>
<tr>
<td><strong>Read Only</strong></td>
<td>Select this checkbox to make this attribute read-only.</td>
</tr>
<tr>
<td><strong>Mandatory</strong></td>
<td>Select this checkbox to make this attribute mandatory (or required).</td>
</tr>
<tr>
<td><strong>Collection</strong></td>
<td>If you select an existing business object as the attribute type and select the Collection checkbox, then you can retrieve multiple records from the selected business object. For example, if you create a attribute called Addresses and select a business object for &quot;Employee Records,&quot; you can display the “Employee Records” attribute data.</td>
</tr>
</tbody>
</table>

**Note:** You can add a business object with "Collection" property as a Business Object Collection (BO Collection) widget to your form. For details, see Using business objects in a form on page 456.

| Description       | Description of the attribute. This is optional.                                                                                                                                                                |

---

a) Click OK to add the attribute to the Attributes list in the Create New Business Object dialog box. Figure 374 on page 450 displays a sample business object for storing employee information.

**Figure 374: Create New Business Object dialog box with Added Attributes**

8. After you have added all the required attributes, click OK.

The new business object is added to the list in the Business Object Manager dialog box (Figure 370 on page 448).
Importing business objects

You can define business objects by importing files of the following types:

- Business Object XML files, as discussed in Importing a business object from Business Object XML file on page 451.
- XSD files, as discussed in Importing a business object from an XSD file on page 451.
- Java Bean files, as discussed in Importing a business object from a Java Bean file on page 453.

Importing a business object from Business Object XML file

You can import one or more business object from an XML file, which is only available to you (or the ones that others have shared with you).

To import a business object from BO XML:

1. From the Local section of the Business Object Manager dialog box (Figure 370 on page 448), click Import. The Import dialog box appears.

2. Select BusinessObject XML and then click OK. The Open dialog box appears.

3. Select single (or multiple) XML files and click Open to display the list of business objects. By default, all business objects are selected.

4. Click Open. The details of the business object file appears in business object details dialog box.

5. Click OK. The selected business objects are added to the list in the Business Object Manager.

Importing a business object from an XSD file

An XSD file can contain multiple tags each of which can be converted to a business object. You can select the tags to be imported as business objects.

Prerequisite:

1. You must have a JDK version 5.0 or higher installed on your machine for importing business object from an XSD.

2. In the System Environment Variables for PATH variable add the JDK bin directory. For example C:\Program Files\Java\jdk1.6.0_26\bin.
This must be updated because, the XSD functionality uses the xjc utility bundled with a JDK version 5.0 or higher found in the bin directory of the JDK installation.

**Note:** Only JRE is bundled with Progress Developer Studio for OpenEdge.

To import a business object from an XSD file:

1. From the **Local** section of the **Business Object Manager** dialog box (Figure 370 on page 448), click **Import**. The **Import** dialog box appears. Refer to Figure 375 on page 451.
2. Select **XSD** and then click **OK**. The **XSD Import** dialog box appears.
3. To add an XSD file as the source, click **Add**. The **Add Source** dialog box appears.
   a) You can enter the absolute path of the XSD file in the **Location** box. Alternatively, click the **ellipsis** button beside the **Location** box to browse and select the XSD file.
   b) Select the existing Category or create a new category (Figure 372 on page 449) based on the requirement.
   c) Click **OK**.

**Figure 376: XSD Import dialog box**

In the **XSD Import** dialog box, the XSD details appear in the **Sources** section and the business objects available in the XSD are displayed in the **Types** section. Click **Modify** in the **Sources** section to select another XSD file or category. Click **Delete** in the **Sources** section to delete the selected XSD file. To modify any of the listed business objects in the **Types** section, select the business object and click **Modify**. You can modify the details including name and category.
4. Click **Generate**.

The list of business object that you can import appears in **Business Objects To Import** dialog box.

5. Select one (or more) business object and click **OK**. The selected business objects are added to the list in the Business Object Manager.

### Importing a business object from a Java Bean file

Java Beans encapsulates multiple objects into a single object (or bean).

To import a business object from a Java Bean file:

1. From the **Local** section of the **Business Object Manager** dialog box (Figure 370 on page 448), click **Import**. The **Import** dialog box appears. Refer to Figure 375 on page 451.
2. Select **JavaBean** and then click **OK**. The **Java Bean Import** dialog box appears.
3. To add a Java Bean file as the source, click **Add**. The **Add Source** dialog box appears.

   ![Add Source Dialog](image)

   a) Click the **ellipsis** button beside the **Location** box to browse and select the Java file or a folder containing multiple Java files.

   b) Select the existing Category or create a new category (Figure 372 on page 449) based on the requirement.

   c) Select **Linked Source** checkbox. If you select the **Linked Source** checkbox, then the information of linking the source is passed on to the BO type as well.

   **Note:** The Linked Source feature is available only for importing a Java file and it is unavailable if you have selected a folder which contains multiple Java files. If you generate the Java file in a common resource project, the original Java file is referenced if you have selected the **Linked Source** checkbox.

   **Note:** The Linked Source, whose value is initially set to true, loses its value if you modify the imported business object.

   d) Click **OK**.
In the **JavaBean Import** dialog box, the JavaBean details appear in the **Sources** section and the business objects available in the Java bean are displayed in the **Types** section. Click **Modify** in the **Sources** section to select another JavaBean file or category. Click **Delete** in the **Sources** section to delete the selected JavaBean file. To modify any of the listed business objects in the **Types** section, select the business object and click **Modify**. You can modify the details including name, category, and linked source attribute.

4. Click **Generate**.

The list of business objects that you can import appears in **Business Objects To Import** dialog box.

5. Select one (or more) business object and click **OK**. The selected business objects are added to the list in the Business Object Manager.

### Exporting a business object

You can use Business Object Manager tool to export business objects to a file available only to you in order to share them with other Progress Developer Studio for OpenEdge users.

**To export a business object:**

1. From the **Business Object Manager** dialog box (Figure 370 on page 448), select one or more listed business objects, then click **Export** to open the **Export** dialog box.

2. Select the **File** option to export the business objects to an XML file that is available only to you (or you can share this file with others).

   - The **Save** dialog box appears, in which you can export the business objects in XML format.

     a) Select the folder where you want to export the selected business objects.
     b) Click **Save**.
For each selected business object, a separate XML file is created, which contains the business object definitions encoded in it.

A message appears, informing you that the business object was successfully exported.

**Generating business objects**

You can use Business Object Manager tool to generate business objects, in order to use the business objects as Business Object dataslots in your process template (see *For a Business Object dataslot* on page 159) or as a Data Sources option in the Form Editor (see *Using business objects in a form* on page 456).

**To generate a business object:**

1. Create a Common Resources project (in this example, BizObjects) in Progress Developer Studio for OpenEdge. For more information, see *Using common resources* on page 52.
2. Select the BizObjects common resource project that now appears in the Project Explorer. From the **Tools** menu, click **Business Objects**.
3. From the **Business Object Manager** dialog box (Figure 370 on page 448), select the business object you want to generate, then click **Generate**.

   A message appears, indicating that a java file was generated.
4. To check that the business object was generated correctly, select the BizObjects common resource in the Project Explorer view and from **File** menu, click **Refresh**. Expand the **Business Objects** folder under the BizObjects common resource, then expand the category to display the **java** file (with the same name as the business object) and all its attributes.

   **Figure 378: Business Objects Folder in Project Explorer**

5. Publish the Common Resource project to compile the business objects to the Business Process Server. For information regarding publishing, see *Publishing an application* on page 73.
Using business objects in applications

You can use Business Objects in your process templates, as described in the following sections.

Note: Business objects are not supported on worksteps with default HTML presentation format.

Using business objects in a link

You can use business objects in links to filter for specific conditions. For information regarding links, see Defining link properties on page 211.

To use a business object in a link:

1. Open the Properties view for a conditional link, then click Advanced option to open the Advanced setting for that link.
2. Drag the business object dataslot (in this example “BOds”) from the Dataslots section to add it to the Condition section.
3. Build the condition for the business object. For business objects, you can use the AutoComplete functionality, which lists all the attributes of the business object.
4. To see if the condition is valid, click Validate.

A message stating “Validation successful” must appear.

Using business objects in a form

You can add business objects with "Collection" property as a Business Object Collection (BO Collection) widget to your form using Form Editor. The BO Collection widget supports:

- Complex rendition capabilities of the added widget in forms.
- Form Preview capability, which allows you to test the runtime rendition of the added widget.
- Configuring the individual attributes of the business object using Properties view.

Note: For information on Form Editor, see Using the Form Editor on page 259.

The following figure illustrates the structure of sample business object dataslot, "Invention" containing business objects with Collection attribute, namely "inventors," "patents," and "submitters." Business objects with Collection attribute are depicted with the 👤 icon.
To add a business object to your form:

1. Click the **Data Sources** link in the Form Editor Tasks pane (see Defining the form’s data sources on page 289).
2. Expand the **User Dataslots** folder under the **Dataslots** folder to display the available dataslots.
3. Expand the Business Object dataslot (for example, "Invention1") and drag the business object with "Collection" attribute (for example, "patents") to your form.

   The BO Collection widget is added to your form.

   **Note:** You cannot drag individual attributes of a business object with "Collection" attribute to your form.
Note: You can also add other attributes of a business object by individually dragging them to your form.

The figure above displays the BO collection widget (in this case, "patents") as a grey box. You can define (or modify) the properties of the BO collection widget using the Business Object Collection Properties view. For information on configuring the BO Collection widget, see Configuring a BO Collection widget on page 458.

Note: Similar to the other form controls, you can add the BO Collection widget to any form editor layout control including tabbed pane, table, fieldset, and panel.

4. Click File > Save to save the changes made to your form.

Configuring a BO Collection widget

You can use the Business Object Collection Properties view (Figure 380 on page 457) to configure a BO Collection widget in your form.

The left pane of the Business Object Collection Properties view displays the tree structure of the top-level collection attribute (in this case, "patents") and its individual attributes. You can perform the following operations in the Business Object Collection Properties view:

Table 107: Operations in Business Object Collection Properties

<table>
<thead>
<tr>
<th>To...</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove an attribute</td>
<td>Clear the checkbox associated with the attribute. The selected attributes are rendered in the same order as controls in your form. The attributes, which are not selected, are not rendered in your form at runtime.</td>
</tr>
<tr>
<td>Move an attribute</td>
<td>You can change the position of an attribute in the tree. Drag the attribute to another location within the tree.</td>
</tr>
<tr>
<td>Define the attribute properties</td>
<td>You can set the presentation format and other properties of each attribute (including the top-level collection attribute). Select the attribute to view its properties in the right pane of the Business Object Collection Properties view. You can define (or modify) the properties, as described in the following steps.</td>
</tr>
</tbody>
</table>

To define (or modify) the attribute properties:

1. Select the top-level collection attribute (in this case, "patents"). From the Presentation tab, you can set the presentation type to Grid (default) or Combobox.
   - For Grid presentation, all selected attributes of this collection attribute are rendered in a grid format.
   - For Combobox presentation, only one of the primitive attributes of this collection attribute can be selected and rendered in a combo box. For this example, if "patentID" is the selected attribute for "patents" widget, the IDs of all patents are rendered in the combo box. Use the Combobox presentation in your form only when the business object collection is already populated with data.

For the individual attributes, the presentation type options vary according to the attribute type. The table below list the presentation types for each attribute type.
### Table 108: Supported Presentation types for each attribute

<table>
<thead>
<tr>
<th>Attribute Type</th>
<th>Supported presentation types</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>• Text field</td>
</tr>
<tr>
<td></td>
<td>• Combo box</td>
</tr>
<tr>
<td>INTEGER or INT64 (Long, Decimal, BigDecimal)</td>
<td>• Text field</td>
</tr>
<tr>
<td></td>
<td>• Combo box</td>
</tr>
<tr>
<td>Business object with Collection attribute</td>
<td>For collection business objects nested in the &quot;parent&quot; business object.</td>
</tr>
<tr>
<td></td>
<td>• Grid</td>
</tr>
<tr>
<td></td>
<td>• Combo box</td>
</tr>
<tr>
<td>LOGICAL</td>
<td>• Check box</td>
</tr>
<tr>
<td></td>
<td>• Radio button</td>
</tr>
<tr>
<td>Timestamp</td>
<td>Date Time</td>
</tr>
</tbody>
</table>

2. Depending on the presentation type you select in the **Type** drop-down list, the list of properties in the right pane of the **Business Object Collection Properties** view vary. If required, modify the value of the **Title** property (available for all presentation types), which is the title of the attribute on your form. The properties specific to the presentation types are described below:

- For collection attributes with "Grid" presentation type, you can configure the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create Mode | The default mode is Allow Create, which allows you to add a row to the grid. To change the mode to any of the following options, click the **ellipsis** button in the **Value** column box:  
  - Custom Create: Adds a **Create** button at runtime. Clicking this button displays a customized dialog box where the user can enter the data for the new record in the grid. Repeat clicking the **Create** button to enter additional records to the grid.  
  - Disable Create: to disable the addition of rows in the grid. |
| Edit Mode | The default mode is Allow Edit, which allows you to edit the contents of the grid. To make the grid read-only, click the **ellipsis** button in the **Value** column box and select the **Disable Edit** option. |
The default value is “True” which means you can delete any row in the grid. You can change the value to “False” by clicking the Value column box.

Number Of Rows
The default value is 5, which is the number of grid rows displayed in a single page. You can edit the value by clicking the Value column box.

- For collection attributes with "Combobox" presentation type, you can configure the properties as follows.

  1. For collection attribute with "Combobox" presentation type, you can select only one attribute of the collection. Use the Choices property to select this attribute. Click the ellipsis button in the Value column box to open the Collection Properties dialog box, which lists the attributes that you can select. Select a attribute and click OK.

  Figure 381: Collection Properties dialog box

  2. Use the Sub Collection property to select the collection business object nested in the parent business object (for example, "submitters" nested in "patents"). Depending on the option you select in the Choices property field at runtime, the Sub Collection property field (in this case, "submitters") is automatically updated.

  Note: To create a cascaded set of two combo boxes, set the presentation type of the nested collection business object to "Combobox."

  Click the ellipsis button in the Value column box to open the Collection Properties dialog box, which lists the nested collection business objects that you can select.

  • For Timestamp attribute, you can use the Date Only property to display only date (in this case, the value is "True") or date and time (in this case, the value is "False").

  3. From the Validation tab (not available for business objects with collection attribute), you can apply validation rules to the corresponding controls with the attributes, as described in the table below.
Table 109: Attribute-specific validations

<table>
<thead>
<tr>
<th>Attribute Type</th>
<th>Validation property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All attributes</td>
<td>Required</td>
<td>Specifies if the corresponding form control is mandatory or not. The default value is “False.”</td>
</tr>
<tr>
<td></td>
<td>Minimum Value</td>
<td>Specifies the minimum value that can be entered in the corresponding form control. The default value varies according to the attribute.</td>
</tr>
<tr>
<td></td>
<td>Minimum Value Message</td>
<td>Specifies the message to be displayed in case an invalid minimum value is entered.</td>
</tr>
<tr>
<td></td>
<td>Maximum Value</td>
<td>Specifies the maximum value that can be entered in the corresponding form control. The default value varies according to the attribute.</td>
</tr>
<tr>
<td></td>
<td>Maximum Value Message</td>
<td>Specifies the message to be displayed in case an invalid maximum value is entered.</td>
</tr>
</tbody>
</table>

Using business objects in applications

You can use scripts (as described in Adding script to a workstep on page 214) to set the value of business object attributes. You can add the required script in the Before Activation and When Completed tabs of the workstep Properties, as well as an overdue action.

Progress Developer Studio for OpenEdge provides the getExprEval() method, which returns a ObjectGraphService object. You can use this object to set the attribute values of the specified business object.

The following code provides an example of this functionality:

```java
var empObj_DS = jst.getDataSlotValue("Employee_DS");
var exprEval = jst.getExprEval();
exprEval.setValue(empObj_DS, "firstName", "Sam");
jst.putDataSlot("Employee_DS", empObj_DS);
```

where Employee_DS is the dataslot of type, "Business Object" mapped to the "empObj_DS" business object with "firstName" attribute.
Using Managed Adapter Browser

Progress Developer Studio for OpenEdge provides the Managed Adapter Browser tool, which enables you to perform operations on managed adapters, such as creating a copy, renaming, deleting, importing an external Managed Adapter configuration file, exporting configuration information to a specified file, and opening the Adapter Configurator GUI to configure a selected managed adapter.

Note: For information regarding configuring each managed adapter, see the relevant chapters in the Managed Adapters Guide.

For details, see the following topics:

- Using the Managed Adapter Browser

Using the Managed Adapter Browser

The Managed Adapter Browser is available for both Business Processes and Web applications.

To use the Managed Adapter Browser:

1. From the Tools menu, click Managed Adapters, opening the Managed Adapter Browser tool, which lists all the managed adapters, as described in Using managed adapters on page 135.
2. Expand any adapter, then select the default generic adapter.
You can perform any of the following operations in the Managed Adapter Browser.

Table 110: Managed Adapter Browser Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make Copy</td>
<td>Creates a copy of the selected managed adapter in the same folder, with a default name that is one increment higher than the previous managed adapter in the folder. A copy of the generic adapter (example, GenericDBAdapter) is named DBAdapter_1, while a copy of user-defined adapter (example, DBAdapter_1) would be named DBAdapter_1_1.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames a user-defined adapter. You cannot rename a predefined managed adapter (example, GenericEmailAdapter).</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a user-defined adapter. You cannot remove a predefined managed adapter (example, GenericEmailAdapter).</td>
</tr>
<tr>
<td>Import</td>
<td>Imports an external Managed Adapter configuration file. From the Open dialog box that appears, select the *.aar file that you want to import.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports all configuration information to a file. You can then use this file to import the configurations to other users. You can export multiple configuration files. From the Open dialog box that appears, select one or more *.aar files that you want to export, or create a new file. Click Open to import the selected preconfigured managed adapters to the specified file.</td>
</tr>
<tr>
<td>Configure</td>
<td>Opens the Configuration user interface for the selected managed adapter type, where you can configure the Managed Adapter. For information on configuring managed adapters, see the Managed Adapter’s Guide.</td>
</tr>
</tbody>
</table>

Preconfiguring managed adapters

You can use the Managed Adapter Browser to preconfigure managed adapters. For instance, you can preconfigure information regarding the mail server in the Email adapter. Although you can enter this information every time you use the Email adapter in any of your business processes, it may be more convenient to preconfigure the adapter. By preconfiguring a managed adapter, you do not need to enter the same information every time.
To preconfigure a managed adapter:

1. Select the adapter (generic or user-defined) to be configured. In this case, select the Email adapter.

2. Click the Configure icon to display the Email Adapter Configurator dialog box.

3. Enter the preconfiguring information in any of the displayed tabs, according to your requirement. In this case, click the Configuration tab to enter the mail server information.

4. Set the Mail Host parameter to the name of your SMTP server. If your environment requires some special settings, you may enter them in the Extra Properties text area.

5. If your e-mail (SMTP) server requires authentication, enter a user name and password in the appropriate fields.

Note: In most cases, you may only need to modify the Mail Host parameter to the name of your SMTP server. For more information, see the full list of SMTP server properties found at Sun's javax.mail documentation at the URL address: http://java.sun.com/products/javamail/javadocs/index.html.

6. After entered your preconfiguring information, click OK to close the Adapter Configurator.

From now on, the configuration you set will be preset by default every time you use the Email Adapter in a business process.
Defining rules with Rule Wizards

Business Rules enable you to monitor business events and messages and to control business processes. In Business Process Server, you can use BPM Events, which is the business rule engine, to create and manage business rules. For information regarding business rules, see the BPM Events User’s Guide.

Progress Developer Studio for OpenEdge enables you to define rules for selected worksteps of a Business Process. You can define rules using the Rule Wizards (as described in this chapter) and then customize your rules (as described in the Customizing rules using Rule Editor).

**Note:** You cannot define business rules for Web applications.

Progress Developer Studio for OpenEdge provides a group of Rule Wizards with intuitive graphical user interfaces that you can use to quickly create simple or complex rules for the current process or a specific workstep.

A Rule Wizard is an intuitive graphical user interface that enables you to define a set of rules and reuse it in multiple applications.

Rule wizards provide the following benefits:

- You do not have to duplicate rules for each application.
- Customized rules can be carried over from other applications.
- Reliable and tested rule wizards speed up application development time.
- You do not necessarily need to know the rule language.

Progress Developer Studio for OpenEdge provides the following Rule Wizards arranged under the respective category:
Table 111: Rule Wizards

<table>
<thead>
<tr>
<th>Category</th>
<th>Rule Name</th>
<th>Rule Description</th>
<th>For more information, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>New Rule</td>
<td>Provides a blank, generic set of rules that can be applied to a process or an Activity workstep.</td>
<td>Using the New Rule wizard on page 470.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td></td>
<td>Enables you to automatically schedule or defer actions that must be executed on or before a particular date or time. Can be applied only to a process.</td>
<td>Using the Schedule Rule wizard on page 472.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notification</td>
<td>Process Path</td>
<td>Enables you to specify the timeout value for a process path, that is, a set of worksteps within a process template. This is an expanded version of the Time-out rule, and can be applied to a process or an Activity workstep.</td>
<td>Using the Process Path Rule wizard on page 477.</td>
</tr>
<tr>
<td></td>
<td>Time-Out</td>
<td>Provides a set of rules that is applied if a workstep has not finished by a specified time. Can only be applied to an Activity workstep.</td>
<td>Using the Time-Out Rule wizard on page 485.</td>
</tr>
<tr>
<td>Metrics</td>
<td>Monitoring</td>
<td>Provides a set of rules that enables you to set specific workstep monitoring actions. Can be applied to a process or an Activity workstep.</td>
<td>Using the Monitoring Rule wizard on page 488.</td>
</tr>
<tr>
<td></td>
<td>Business Metric</td>
<td>Enables business managers who need to monitor a business process to define a process’s business metrics. Can only be applied to an Activity workstep.</td>
<td>Using the Business Metric Rule wizard on page 492.</td>
</tr>
<tr>
<td></td>
<td>Decision Counter</td>
<td>Enables you to keep track of the number of times a particular path out of a Decision gateway has been taken for a specific process. Can only be applied to a Decision gateway.</td>
<td>Using the Decision Counter Rule wizard on page 497.</td>
</tr>
<tr>
<td>Task Management</td>
<td>Task Assignment</td>
<td>Provides a set of rules that enable you to define criteria that automatically assigns tasks. Can only be applied to an Activity workstep performed by ANY member of a group.</td>
<td>Using the Task Assignment Rule wizard on page 500.</td>
</tr>
</tbody>
</table>
The table below lists the available rule wizards, their category, rule name, description, and where to find more information:

<table>
<thead>
<tr>
<th>Category</th>
<th>Rule Name</th>
<th>Rule Description</th>
<th>For more information, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration</td>
<td>Process Control</td>
<td>Enables you to receive XML messages from external applications that trigger the execution of rules. Can only be applied to a process.</td>
<td>Using the Process Control Rule wizard on page 505.</td>
</tr>
<tr>
<td></td>
<td>File Poller</td>
<td>Enables you to poll a file system for specific events or patterns, triggering a user-defined rule to process the system event. Can only be applied to a process.</td>
<td>Using the File Poller Rule wizard on page 508.</td>
</tr>
</tbody>
</table>

**Note:** The application name (as it appears in rule module headers and in the PROCESSTEMPLATENAME attribute of BP Server events) can be up to 18 characters.

For details, see the following topics:

- Accessing Rule Wizards
- Using the New Rule wizard
- Using the Schedule Rule wizard
- Using the Process Path Rule wizard
- Using the Time-Out Rule wizard
- Using the Monitoring Rule wizard
- Using the Business Metric Rule wizard
- Using the Decision Counter Rule wizard
- Using the Task Assignment Rule wizard
- Using the Process Control Rule wizard
- Using the File Poller Rule wizard

---

**Accessing Rule Wizards**

You can access all the rule wizards, arranged under their respective categories, by clicking the Create Rules link in the Tasks pane.
You can activate the respective Rule Wizard by dragging the corresponding icon to the Content pane (to apply it to a process or to a specific workstep). Each icon represents a rule template, or a parameterized rule file consisting of a set of generic rules that meet specific requirements.

For information on each rule wizard, refer to the specific section, as described in the following sections.

**Note:** At any point in the Rule Wizard, click **Back** to go back to the previous wizard page. Click **Cancel** to exit the wizard. Click **Help** to open a Help file for more information.

---

### Using the New Rule wizard

The New Rule wizard provides a blank, generic rule set that enables you to define a new rule module for the application or to a selected Activity workstep to meet your specific requirements.

**To apply a new generic rule:**

1. From the **General** category (Figure 384 on page 470), drag the **New Rule** icon to the Content pane to apply the rule to the process or to an Activity workstep in the active process template, to open the **New Rule** wizard.
2. Click **Next** to continue.

3. From the Module Type page, select the **Rule Module** option to create rule files, rule groups and rule modules, or select the **Data Module** option to create a dynamic map structure that provides quick and easy access to values in infopads and persistent maps that are contained in this map structure. Click **Next** to continue.

4. In the **Name** box, type the name of the rule module to which the new rule will be assigned. Click **Next** to continue.
5. In the File Name box, modify (if required) the name of the rule file name or click the adjoining ellipsis button to change the location where the rule file is saved.

6. Click Finish to complete the new rule and apply it to the process or selected workstep.

Using the Schedule Rule wizard

You can use the Schedule Rule Wizard to automatically schedule and execute an action on or after a specific date or time. You can only apply this rule wizard to a process. If you try to apply it to a workstep, a Rules message appears informing you that you cannot apply this rule wizard to a workstep.

1. From the General category (Figure 384 on page 470), drag the Schedule (icon to the blank portion of the Content pane to apply the rule to the process, to open the Schedule wizard.
2. Click **Next** to continue. From the second page of the wizard, you can assign a name to the rule and define the timing of the scheduled/deferred action.

   a) Enter the name for the rule template you want to create in the **Name** box. A name must start with a letter, and can contain only alphanumeric characters and underscores. This rule template creates a set of rules designed to execute the actions for the selected process.

   ![Figure 390: Schedule Rule Wizard, Defining Name/Timing Page](image)

   b) From the **Schedule Start Period** section, select either of the following options to define when the action is activated:

   - If you select the **Duration** option, click the **ellipsis** button next to the **Duration** box, opening the **Duration** dialog box (upper right image, **Figure 390** on page 473) where you can specify the workstep duration. Enter the duration in terms of days, hours, minutes, and seconds in the respective boxes. Select the **Business time** checkbox to measure the workstep duration only during your business organization's specified business hours (if you use **Business time**, you must have a system calendar defined).
• If you select the **Deadline** option, click the adjoining **ellipsis** button, opening the **Calendar** dialog box (lower right image, **Figure 390** on page 473), which displays the current date and time. Specify the deadline year and month in the respective fields, and choose a day in the calendar. Enter the hour, minute and seconds in the boxes provided. Data entered in these three boxes start with zero; example, 00 is midnight and 01 is 1 AM. Hours are indicated from 0 - 23, example, 3:00 PM is entered as 15:00:00.

c) Click **Next** to continue.

3. From the Reschedule page, you can specify the period and manner in which the rule can be rescheduled.

**Figure 391: Schedule Rule Wizard, Reschedule Page**

![Reschedule Page](image)

a) In the **Reschedule Period** section, click the **ellipsis** button provided, opening the **Duration** dialog box where you can define the duration to which the rule can be rescheduled.

b) In the **Reschedule Till** section, choose an option that enables you to reschedule until the selected condition is satisfied. For example, if you select the number of rescheduling as three, you can only reschedule three times.

**Note:** An infopad is generated only if you select the **No of times** option. The final count displayed in the Infopad is equal to the value specified in the **No of times** box.

c) Click **Next** to continue.

4. From the Actions page, you can define the actions to occur every time a scheduled/deferred event is triggered. Select the action to be added from the drop-down list provided, then click **Add** to add each of the following actions:
Using the Schedule Rule wizard

Figure 392: Schedule Rule Wizard, Defining Action Page

- **Send Mail**: Opens the Send Mail dialog box (Figure 393 on page 475), where you can enter a valid e-mail address in the **To** and **From** boxes, as well as the Subject and Message in the respective boxes. Click **OK** to add it to as an action.

**Important**: Make sure the e-mail address you entered is valid. No action will be taken, and no errors logged, if the e-mail address is invalid.

Figure 393: Schedule Rule Wizard, Send Mail dialog box

- **Alerts**: allows you to add a defined alert. For information on defining Alerts, see Defining an alert on page 254.
Figure 394: Schedule Rule Wizard, Alerts dialog box

Note: If you add a custom alert with condition as the action, the condition is ignored at runtime. The alert is triggered on basis of the time-out condition of the rule wizard. This is applicable to any rule wizard configured with the Alerts action.

• **Install Process Template.** Installs the specified process template. You can choose to install the current process, or select another process template.

Note: To trigger this action for a process that is not deployed on Business Process Servers, you must copy the folder of the project (containing this process files) from the workspace folder to OEBPS_HOME\ebmsapps folder.

Figure 395: Schedule Rule Wizard, Install Process Template dialog box

• **Create Process Instance.** Create a process instance of the current process, or another process.

Note: For the Create Process Instance action in all supported rule wizards, the Manager box of the process template whose instance is to be created, must contain a hard coded value.

Figure 396: Schedule Rule Wizard, Create Process Instance dialog box

• **DBAdapter.** Add the DBAdapter managed adapter as an action and execute this adapter through rules or when a specified event is triggered. For more information regarding DBAdapter, see Chapter 6: “Database Managed Adapter” in Managed Adapter Guide.
Note: To edit an action, select the action in the provided list, then click Edit. To delete an action, select the action and click Remove.

5. After defining all actions, click Next to continue. Review the Summary page, which provides a summary of all the measures to be computed and the rules and actions defined with the rule wizard.

Figure 397: Schedule Rule Wizard, Summary Page

6. From the Save As page, modify (if required) the name of the rule file in the File Name box, or click the adjoining ellipsis button to change the location of the rule file. Ensure that the modified location of the rule file is at the same folder level as that of the rules folder.

Figure 398: Schedule Rule Wizard, Save As Page

7. Click Finish to create the rules folder in the location you specified. The rule file must be separately installed on the BPM Events server before it becomes active.

Using the Process Path Rule Wizard

You can use the Process Path rule wizard to specify the timeout value for a selected process path; that is, a path or branch consisting of a set of worksteps within the process template. You can also specify the actions to be taken if the path is or is not completed within the specified time.
You can invoke the Process Path rule wizard multiple times on the same process template to create and define process path policy on different worksteps.

To apply a Process Path Time-out rule to a process or to a workstep:

1. From the Notification category (Figure 384 on page 470), drag the Process Path icon to the Content pane or to the selected Activity workstep(s) to which the rule is to be applied, to open the Process Path wizard.
2. From the Description page, review the description of the rule wizard and click Next to continue. Click Cancel at any time to exit the wizard.

Figure 399: Process Path Rule Wizard, Description Page

3. From the Workstep Definition page, you can define when the timeout monitoring starts and when it ends.
   a) Enter the name for this set of rules in the Name box.
   b) Select the appropriate Rule Filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).

Figure 400: Process Path Rule Wizard, Workstep Definition Page
c) In the **Path Start** box, define the start of the timeout monitoring by clicking the adjoining **ellipsis** button, which opens the **Path Start** dialog box (upper right image, Step Figure 400 on page 478). Select a workstep from the list, then select the status of the workstep from the **Activity** drop-down list. Click **OK**.

d) In the **Path End** box, define the end of the timeout monitoring, similar to that for **Path Start**. As shown in Step Figure 400 on page 478, the timeout will occur between the activation of the **Activity 1** workstep and the completion of the **Activity 5** workstep.

e) Click **Next** to continue.

4. From the Time Definition page, you can specify the duration or set the deadline to initiate one or more actions that will be taken if the process path is or is not completed within the specified time.

**Figure 401: Process Path Rule Wizard, Time Definition Page**

![Time Definition Page](image)

a) From the **Path Timeout** section, select either of the following options to set the period of the timeout:

- If you select the **Duration** option, you can define the workstep's duration, as discussed in 2.b on page 473.
- If you select the **Deadline** option, you can enter the date and time, as discussed in 2.b on page 473.

b) Click **Next** to continue.

5. From the Actions page, you can specify the actions to be taken if the task is not completed in the specified time. You can define as many actions as required, or proceed to the next page without specifying any action.

a) Select any of the following actions from the drop-down list provided, then click **Add** to add the action:

- **Send Mail**: Opens the **Send Mail** dialog box. Type a valid e-mail address in the **To** and **From** boxes, as well as the Subject and Message in the respective boxes. You can also select the runtime values of dataslots or performers to be included in the e-mail by clicking the **Dataslots** or **Performer** option and selecting the values from the corresponding drop-down list. Click **Select** to add the dataslot or performer to the e-mail message.
• **Alerts**: allows you to add a defined alert. For information on defining Alerts, see [Defining an alert](#) on page 254.

**Figure 403: Alerts dialog box**

• **Change Priority**: allows you to change priority of the current process instance or workstep. For each selection, you can choose either the current instance (or workstep) or use dataslot to select another instance (or workstep) at runtime. Changes include selecting another priority, increasing (or decreasing) the priority, or using the dataslot to select the priority at runtime.

**Figure 404: Change Priority dialog box**
• **Change Duedate**: allows you to change due date of the process instance or workstep. For each selection, you can choose either the current instance (or workstep) or use dataslot to select another instance (or workstep) at runtime. Changes include selecting a relative date (in terms of duration) or an absolute date.

![Figure 405: Change Duedate dialog box](image)

• **Modify Dataslot(s)**: allows you to modify dataslots of the current process instance or use dataslot to select another instance at runtime. For either selection, add the dataslots to be modified.

![Figure 406: Modify Dataslot(s) dialog box](image)

• **Install Process Template**: Installs the specified process template. You can choose to install any process template from the Progress Developer Studio for OpenEdge workspace folder, or select the process from a CHARACTER dataslot.

![Figure 407: Process Path Rule Wizard, Install Process Template dialog box](image)

• **Create Process Instance**: allows you to create a process instance from the current process; or select the process from a dataslot (displays only CHARACTER dataslots); or select a process template from the Progress Developer Studio for OpenEdge workspace folder.
• **DBAdapter**: to add the DBAdapter managed adapter as an action and execute this adapter through rules or when a specified event is triggered. For more information regarding DBAdapter, see Chapter 6: "Database Managed Adapter" in Managed Adapter Guide.

• **Generate**: allows you to generate an event. You need to specify the event type and value in the respective boxes. You can add event attributes, whose values can be retrieved from dataslots.

Figure 409: Generate dialog box

• **Schedule**: allows you to schedule an event. Select either a relative date (based on duration) or an absolute date, for the specified event.

Figure 410: Schedule dialog box

• **Complete Process Instance**: This is similar to the Create Process Instance action. This action allows you to complete the current process instance or use a dataslot (displays only CHARACTER dataslots) to select another process instance at runtime.

b) Click **OK**. The added action is displayed in the list provided.
c) Select the **Monitor Timeout Occurrences** checkbox to capture information about the workitems that were completed on time as well as those that were not completed on time.

d) Click **Next** to continue.

6. From the next Actions page, you can specify the actions to be taken when the task is completed within the specified time. You can define multiple actions, or proceed to the next page without specifying any action.

**Figure 411: Process Path Rule Wizard, Actions Completed within Time Page**

   a) Select an action from the drop-down list provided, then click **Add** to add any of the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Mail</td>
<td>Sends a e-mail message. This operation is same as that for the previous wizard page.</td>
</tr>
<tr>
<td>Time Counter</td>
<td>Allows you to perform time functions (sum, maximum, minimum) on elapsed time expressed in units including hours, minutes, seconds, business hours, business minutes, and business seconds.</td>
</tr>
</tbody>
</table>

   b) Click **Next** to continue.

7. From the Report Measures Distribution page, you can define how the measures calculated by the previous worksteps are to be distributed.

**Figure 412: Process Path Rule Wizard, Distribution Definition Page**

   • Select the **No distribution** option to create an undistributed result.
• Select the **By attribute** option to define a distribution based on specified values of a selected dataslot. Click the adjoining **ellipsis** button to open the **By attribute** dialog box:

**Figure 413: Process Path Rule Wizard, By Attribute dialog boxes**

![By attribute dialog boxes](image)

a) Select one of the process dataslots from the **Attribute** drop-down list.
b) Select the **Aggregate entry** checkbox to aggregate the measures and store the sum of all the occurrences of the selected attribute's values.
c) You can select either of the following options:

- **Explicit values** option to enter explicit values that will specify the distribution. For example, if you select the CHARACTER "dsMgr" dataslot in the **Attributes** list that contains the names of managers, enter specific character values in the text box provided (Washington, Alfredo, or McMartin), then click **Add** to add each name to the list below. The rule will then only be applied to instances when one of these names occurs in the selected Attribute.

- **Scale** option to enter numeric values that will specify the distribution — this option is only valid for INTEGER dataslots. For example, if you select the INTEGER "percent" dataslot in the **Attributes** list that contains data on test results, enter values in the Start, End and Step boxes that provide a range for the distribution (example, 40 for the Start, 80 for the End, and 10 for the Step). This indicates that values will be reported that occur between 40 and 80 and at intervals of 10. Select the **In Range** checkbox to only report on values within the specified range. If it is not checked, all results are generated including those outside the specified range.

d) Click **OK** to implement the changes and return to the Distribution Definition page.
e) Click **Next** to continue.

8. From the Summary page, review the summary of the parameters you have selected for the Process Path rule wizard. Click **Next** to continue, or click **Back** if you want to return to previous pages and make corrections.
9. From the Save As page, modify (if required) the name of the rule file in the File Name box, or click the adjoining ellipsis button to change the location of the rule file.

10. Click Finish to create the new Process Path rule file in the specified location. The rule wizard also creates another rule file in the same folder with the name of Processpath_<WS_Name>_param.rtp. Progress Developer Studio for OpenEdge automatically compiles the rule file and creates a *.bpo file when you click Finish.

Using the Time-Out Rule wizard

You can use the Time-Out rule wizard, a parameterized rule file that applies specified actions if a workstep has not completed after a specified duration or by a specified deadline.

For example, you can use the Time-Out rule wizard to apply the following actions to a workstep: If a selected workstep is not completed in two days, the task will be reassigned, its priority will be changed to High, and an e-mail will be sent to a specified address.

You can only apply this rule wizard to an Activity workstep. If you try to apply it to a process, a Rules message appears informing you that you cannot apply this rule wizard to a process.

To apply a Time-Out rule to an Activity workstep:
1. From the Notification category (Figure 384 on page 470), drag the Time-Out (⏰) icon to the workstep in the process template to which the rule is to be applied, to open the Timeout wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel at any time to exit the wizard.

**Figure 416: Time-Out Rule Wizard, Description Page**

3. From the second page of the wizard, you can assign a name to the rule and specify the duration or set the deadline required to complete the workstep.

**Figure 417: Time-Out Rule Wizard, Name/Duration Definition Page**

   a) Enter a name for the rule in the Name box.
   
   b) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
   
   c) From the Timeout section, select either of the following options to set the period of the duration:
   
   - If you select the Duration option, you can define the duration of time to elapse before the action is activated. as discussed in 2.b on page 473.
   
   - If you select the Deadline option, you can set the specific date and time when the action will be activated. as discussed in 2.b on page 473.
   
   d) Click Next to continue.

4. From the Actions page, you can specify the actions to be taken in case of a workstep timeout. You need to define at least one action.
a) The procedure for all these actions are similar to as described in Step 5 on page 479 for Process Path Wizard, except for the following additional actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Re)Assign Workitem(s)</td>
<td>Allows you to reassign the workitem to the specified user. Alternatively, you can use the runtime value of a dataslot or performer to specify the assignee to whom the workstep is reassigned, by clicking the Dataslots or Performers option, selecting from the corresponding drop-down list, and clicking Select.</td>
</tr>
<tr>
<td>Complete workstep</td>
<td>Allows you to select a dataslot and define the dataslot’s value. When the workstep is completed, the values you have defined will be mapped to the selected dataslot.</td>
</tr>
</tbody>
</table>

b) Select the Monitor Timeout Occurrences checkbox to capture information about workitems that were completed on time as well as workitems that were not completed on time.

c) Click Next to continue.

5. From the Summary page, review the actions that will be applied if the selected workstep is not completed by the specified time. Click Next to continue, or click Back to return to previous pages and make corrections.

Figure 419: Time-out Rule Wizard, Summary Page

6. From the Save As page, modify (if required) the name of the rule file in the File Name box, or click the adjoining ellipsis button to change the location of the rule file.
7. Click **Finish** to create the new Time-Out rule file in the specified location.

The new rule is now applied to the selected workstep(s).

**Using the Monitoring Rule wizard**

You can use the Monitoring rule wizard, which is a parameterized rule file that enables you to monitor an entire process or a selected Activity workstep. For example, you can define the time intervals needed to monitor a specific action or the number of occurrences of a specific event. In addition, you can distribute the data according to time intervals or to dataslot values.

**To apply the Monitoring rule to a process or an Activity workstep:**

1. From the **Metrics** category (Figure 384 on page 470), drag the Monitoring ( ) icon to the Content pane or to selected Activity workstep(s) to which the rule is to be applied to open the Process Monitoring wizard.

2. From the Description page, review the description of the rule wizard, then click **Next** to continue. Click **Cancel**, at any time, to exit the wizard.

Figure 421: Monitoring Rule Wizard, Description Page

3. From the Program page, you can define when the process monitoring starts and when it ends.
Using the Monitoring Rule wizard

Figure 422: Monitoring Rule Wizard, Naming Program Page

- a) Enter the name for the rule in the Name box.
- b) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
- c) Select either of the following options to indicate if the process monitoring is time-specific or not.
  - No time constraints option to indicate that the monitoring is not time-specific.
  - Period option to specify the time period during which the monitoring is conducted. Click the ellipsis button next to the Start and End boxes to display the Calendar dialog box, where you can define the date and time. For more information, see 2.b on page 473.
- d) After making the selection, click Next to continue.

4. From the Report Measures page, you can define the counters that can be used to monitor a process or a selected workstep. Select one or more of the following counters from the drop-down list provided, then click Add. After defining the counters, click Next to continue.

Figure 423: Monitoring Rule Wizard, Report Measures Page

- **Occurrence Counter**: Used to monitor specific occurrences in a process (or a selected workstep). From the Occurrence Counter dialog box, select any of the following options to monitor the process instances:
  - Completed instances (started during monitoring period): All completed process instances started during the specified monitoring period.
  - Started instances to date: All started process instances.
• **Currently active instances (started, not completed):** All active process instances.

**Figure 424: Monitoring Rule Wizard, Occurrence Counter dialog box**

![Occurrence Counter dialog box](image1)

• **Time Counter:** Used to monitor a specific time unit in a process (or a selected workstep).

**Figure 425: Monitoring Rule Wizard, Time Counter**

![Time Counter dialog box](image2)

• From the Operation drop-down list, select the timing operation. Options include: Average, Sum, Minimum, and Maximum.

• From the Time unit drop-down list, select the time unit in which the timing operation is measured. Options include: Hours, Minutes, Seconds, Business Hours, Business Minutes and Business Seconds.

• **Value Counter:** Used to monitor specific dataslot values in a process (or a selected workstep).

**Figure 426: Monitoring Rule Wizard, Value Counter**

![Value Counter dialog box](image3)

a) From the **Dataslot** drop-down list, select the numeric dataslot to be monitored. Only numeric dataslots are displayed in this list.

b) From the **Operation** drop-down list, select the monitoring operation for the selected dataslot. Options include:

- **Average.** Provides an average of the dataslot values.

- **Sum.** Provides the total of the dataslot values.

- **Minimum.** Provides the minimum dataslot value.

- **Maximum.** Provides the maximum dataslot value.

5. From the Report Measures Distribution page, you can define how to distribute the data you have selected for monitoring.
Using the Monitoring Rule wizard

Figure 427: Monitoring Rule Wizard, Data Distribution Page

- **No distribution**: The data will not be distributed.
- **By time periods**: Distribute the data by a specified time period, based on the starting time of the instance.
  a) Click the adjoining ellipsis button to display the **By time periods** dialog box.

  Figure 428: Monitoring Rule Wizard, By Time Period dialog box

  b) Select the **Aggregate entry** checkbox to aggregate the metric and create a distributed entry that totals all prior distributed entries.
  c) From the **Period** drop-down list, choose a distribution period. Options include: **Days of the month**, **Hours of the day**, and **Months of the year**.
  d) Click **OK** to continue.

- **By attribute**: Distribute the data based on values specified for a selected dataslot. Click the adjoining ellipsis button to display the **By attribute** dialog box (Figure 427 on page 491).

  6. Click **Next** to continue.
  7. From the Summary page, review the summary of the rules that monitor the process. Click **Next** if the rules are acceptable, or click **Back** to return to previous pages if you need to modify the rules.
8. From the Save As page, modify (if required) the name of the rule file in the File name box, or click the adjoining ellipsis button to change the location of the rule file.

9. Click Finish to create the rule file in the specified folder.

The new rule is now applied to the process (or to a selected workstep).

Using the Business Metric Rule wizard

You can use the Business Metric rule wizard to enable managers (or other users with manager permissions) to define business metrics for a specific Activity workstep in a process. Business metrics are numeric values that can be computed or aggregated based on the value of a dataslot in the process template. You can carry out an aggregation over multiple instances of the process template. Examples of business metrics include “TotalSales” figures or “InventoryCount” for an item or “NumberOfDefects” for a product component. You can monitor and measure these values across process instances and distribute them over time or other criteria. You can also define certain action rules that will be executed based on the values of a specific metric.

Business metric values are stored in BPM Events Infopads and persisted in the database. Managers (or other users with manager permissions) can view these values from the Infopads viewer applications in the Management module in Business Process Portal.
You can invoke the Business Metric rule wizard multiple times on the same process template to create different metrics, but each metric must be defined on a different workstep.

To apply the Business Metric rule to an Activity workstep that contains a numeric dataslot:

1. From the Metrics category (Figure 384 on page 470), drag the Business Metric icon to the Activity workstep in the process template to which the rule is to be applied, to open the Business Metric wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

3. From the Business Metric Period Definition page, you can specify the time period when the defined rule is activated.

   a) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).

   b) Select the period when the business metric rules are active, by selecting either of the following options:
      
      - No time constraints option where the business metric monitoring starts immediately upon rule execution and continues indefinitely.
• **Period** option, where you can set the start and end date (and time) for the active period. Click the **ellipsis** button next to the **Start** and **End** boxes to display the **Calendar** dialog box, where you can define the date and time.

c) Click **Next** to continue.

4. From the Metric Definition page, you can define the business metric name as well as aggregate functions that generate rules to compute these measures.

**Figure 433: Business Metric Rule Wizard, Metric Definition Page**

a) Enter the name of the metric rule in the **Name** box.

b) Select a dataslot from the **Select Dataslot** drop-down list to be used for monitoring and computing the value of the business metric. This list contains all available numeric dataslots.

c) Select any of the following metric options from the **Compute Measures** drop-down list, then click **Add**.

- **Average**, which computes the running average of the selected dataslot across all process instances during the active time period when the selected workitem completes.

- **Sum**, which computes the additive value of the selected dataslot across all process instances during the active time period. This computation is based on the workitem completion event for the selected worksteps.

- **Maximum**, which tracks the maximum value of the selected dataslot across multiple process instances during the active time period when the selected workitem completes. Click **Add** to open the **Maximum** dialog box. Enter the maximum value and click **OK**.

- **Minimum**, which tracks the minimum value of the selected dataslot across multiple process instances during the active time period when the selected workitem completes. Click **Add** to open the **Minimum** dialog box. Enter the minimum value and click **OK**.

d) After adding all the options, click **Next** to continue.

5. From the Report Measures Distribution page, you can define how the business metric is distributed across time periods or based on the value of a dataslot in the process.
Figure 434: Business Metric Rule Wizard, Distribution Definition Page

- **No distribution**: creates an undistributed business metric.
- **By time periods**: distributes the data by a specified time period, based on the starting time of the instance. For more information, see 5 on page 490.
- **By attribute**: distributes the data based on values specified for a selected dataslot. Click the adjoining **ellipsis** button to display the **By attribute** dialog box (Figure 434 on page 495).

Click **Next** to continue.

6. From the Business Rules page, you can define business rules and conditions for the business metric.

Figure 435: Business Metric Rule Wizard, Business Rules Page

a) Click **Add** to open the **Business Rule Editor** dialog box, where you can define conditions and actions for the selected metric.
b) Enter a name for the rule in the Rule Name box.

c) To add a condition, click Add in the Condition(s) section, opening the Business Rule Conditions dialog box (upper right image, Figure 436 on page 496).

d) To define the initial clause of a condition, click the ellipsis button on the left side, to open the Business Metric Attributes dialog box (lower right image, Figure 436 on page 496). Click the Dataslot option to select a INTEGER or INT64 dataslot as the attribute, or the Metric option to select any of the available metrics (as selected in the Metric Definition page), or the Value option to enter a specific value.

e) From the Business Rule Conditions dialog box, select an operand from the drop-down list in the middle, and complete the condition by clicking the ellipsis button on the right side, to define a second clause using the Business Metric Attributes dialog box.

f) Click OK to return to the Business Rule Conditions dialog box, and click OK to add the condition to the Condition(s) panel.

g) From the Action(s) section, you can specify the actions to be taken in the case if the condition is satisfied. You need to define at least one action. The procedure for all these actions are similar to as described in Step 5 on page 479 for Process Path Wizard.

h) When you have finished defining the conditions and actions for the business rule, click OK to add the new rule condition to the Business Rules page.

i) Click Next to continue.

7. From the Summary page, review the summary of the parameters you have selected for the Business Metric rule wizard. Click Next to continue, or click Back to return to previous pages if you need to return to previous pages and make corrections.
8. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining **ellipsis** button to change the location of the rule file.

**Figure 438: Business Metric Rule Wizard, Save Rule File As Page**

9. Click **Finish** to create the new Business Metric rule file in the specified location. The rule wizard also creates another rule file in the same folder with the name of **BM_<WS_Name>_param.rtp**. Progress Developer Studio for OpenEdge automatically compiles the rule file and creates a ***.bpo** file when you click **Finish**. You must, however, separately install the compiled rule file on the BPM Events server before it becomes active.

**Using the Decision Counter Rule wizard**

You can use the Decision Counter Rule Wizard to create a set of rules that count the number of times a particular decision path from a specific Decision gateway has been taken by instances of the process template. This rule wizard creates a monitoring table that keeps a count of the total number of times the decision was executed as well as a count of the number of times each decision path was taken. The Decision Counter rule wizard also enables you to set the time when the counter is activated and its duration.
1. From the **Metrics** category (Figure 384 on page 470), drag the **Decision Counter** icon on the Decision gateway that you want to monitor, to open the Decision Counter wizard.

2. From the Description page, review the description of the rule wizard, then click **Next** to continue. Click **Cancel**, at any time, to exit the wizard.

   **Figure 439: Decision Counter Rule Wizard, Description Page**

   ![Decision Counter Rule Wizard, Description Page](image)

   **Note:** Click **Back** at any time to go back to the previous page. Click **Cancel** at any time to exit the wizard. Click **Help** to open a Help file for more information.

3. From the second page, you can assign a name and define the timing of the monitoring of the paths from the selected Decision gateway.

   a) Enter the name for the rule template you want to create in the **Name** box.

   b) Select the appropriate **Rule filter condition** option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).

   **Figure 440: Decision Counter Rule Wizard, Defining Name/Timing Page**

   ![Decision Counter Rule Wizard, Defining Name/Timing Page](image)

   c) Select either of the following options to define when the decision counter is activated.

      - **Indefinite** option to immediately activate the decision counter and to continue indefinitely.
      - **Period** option to set the specific starting and ending date (and time) for the decision counter. As discussed in 2.b on page 473.

   d) Click **Next** to continue.
4. From the Report Measures Distribution page, you can define how to distribute the computed measures across time periods or based on the value of a dataslot in the process.

**Figure 441: Business Metric Rule Wizard, Distribution Definition Page**

- **No distribution** if you do not want to distribute the computed measures.
- **By time periods**: distributes the data by a specified time period, based on the starting time of the instance. For more information, see Step 5
- **By attribute**: distributes the data based on values specified for a selected dataslot. Click the adjoining **ellipsis** button to display the **By attribute** dialog box (Figure 441 on page 499).

After defining all distributions, click **Next** to continue.

5. From the Action page, you can specify the actions to be taken every time a particular decision path is traversed. You can define as many actions as required, or proceed to the next page without specifying any action. The procedure for all these actions are similar to as described in Step 5 on page 479 for Process Path Wizard.

**Figure 442: Decision Counter Rule Wizard, Action Page**

6. From the Summary page, review the summary of all the measures to be computed and the rules and actions (if any) defined with the rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.
7. From the **Save As** page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining **ellipsis** button to change the location of the rule file.

8. Click **Finish** to create the rule file in the specified location. The rule file must be separately installed on the BPM Events server before it becomes active.

**Using the Task Assignment Rule wizard**

You can use the Task Assignment rule wizard to schedule algorithms to automatically assign tasks of Available status for worksteps performed by any of the members of a group. You can also use this rule wizard to exclude a specific performer from a work assignment, to activate a rule immediately or at a specified date, and to perform specified actions upon assignment of the task.

You can invoke this rule wizard to define task assignment policies for different worksteps in the same process template.

You can only apply the Task Assignment rule to a human-performed workstep where the performer is ANY member in a group:
1. From the **Task Management** category, drag the **Task Assignment** icon to the Activity workstep of the process template to which the rule is to be applied, to open the Task Assignment wizard.

2. From the Description page, review the description of the rule wizard, then click **Next** to continue. Click **Cancel**, at any time, to exit the wizard.

**Figure 445: Task Assignment Rule Wizard, Description Page**

3. From the Name Definition / Time Constraints page, you can assign a name and set the time constraint for the defined rule.
   a) Enter the name for the rule template you want to create in the **Name** box. Progress Developer Studio for OpenEdge creates a rule file that has the prefix "TA" appended to the workstep name.
   b) Select the appropriate **Rule filter condition** option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).

**Figure 446: Task Assignment Rule Wizard, Name/Time Constraints page**

c) Select either of the following options to set the Time Constraint for the rule, which is the period when the task assignment rules are active:

- **Indefinite** option to immediately start the task assignment on rule execution and to continue indefinitely.
- **Period** option to set the starting and ending date (and time) for the period of validity, as discussed in 2.b on page 473.

d) Click **Next** to continue.
4. From the Scheduling page, you can set parameters such as the duration of task assignment delay, and the task scheduling algorithm for the workitems.

**Figure 447: Task Assignment Rule Wizard, Scheduling Page**

a) To define the delay for task assignment, click the *ellipsis* button provided in the **Delay Task assignment by** section, opening the **Duration** dialog box. Specify the time the task will wait before being assigned to a performer, depending on the option selected in the Task Scheduling Algorithm section.

**Note:** The Delay for Task Assignment is not applicable for the Single Task algorithm.

b) From the **Task Scheduling Algorithm** section, select any of the following options from the drop-down list provided, then click **Add**.

- **Random Scheduling:** Each workitem is randomly assigned to a group member (or an individual user from multiple users).

- **Round-robin Scheduling:** Each subsequent workitem is assigned to the next user in the user list for the group. The last assigned user is stored in an Infopad for persistence.

- **Exclude User Scheduling:** Excludes a user who was the performer of another workstep or is linked to a dataslot from performing the current workitem. From the Exclude User Scheduling dialog box, you can select the workstep that the excluded user performs, or the dataslot that the excluded user is linked to. This option is based on the Four-eyes Principle and allows for peer level reviews.

**Figure 448: Exclude User Scheduling**

- **External Scheduling:** Each subsequent workitem is assigned to a user-specified class that can be invoked for scheduling. This class must implement a special interface, which will be invoked by the rules when the task becomes available. Ensure that the specified class name is a fully qualified class name.
Figure 449: External Scheduling

- **Task Load Balancing**: Business Process Portal generates a load count (a count of all the items assigned to a user) based on the total number of workitems in a user's task list, and the user with the minimum load count is assigned the next item. For new applications, the checkbox in the Task Load Balancing dialog box can remain cleared. For applications that have been running, select the checkbox to balance the task load from the current status.

Figure 450: Task Load Balancing

- **Single-Task Scheduling**: Each subsequent workitem is assigned to the next user in the group at a rate of one task at a time from the available pool of workitems. The group member only works on one task at a time. When that task is completed, another is assigned to the member. This option is not applicable to the Delay for Task Assignment.

5. From the Post Task Assignment Actions page, you can specify the actions to be taken after the task has been assigned. You can define as many actions as required, or proceed to the next page without specifying any action. The procedure for all these actions are similar to as described in Step 5 on page 479 for Process Path Wizard.

c) From the **User Information Update** section, you can provide connection options and user refresh mechanism to the user management system. Use any of the following connection options to update the user management system when a user is added or removed:

- **Direct Connection**. Connects to the user management system continuously and gets the updated list of users before performing task assignment.

- **Periodically**. Connects to the user management system and gets periodic updates of user information. You can specify the period using the **Duration** dialog box. If you select the **Business time** checkbox, ensure that a system calendar is set before publishing this process.

- **Only Once (At Deployment)** Connect to the user management system only when the rule becomes active.

d) Select the **Re-assign Removed User's Task** checkbox to reassign tasks assigned to the removed user to other group members.

e) Click **Next** to continue the rule wizard.
6. From the Summary page, review the summary of the parameters you have selected for the Task Assignment rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.

7. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining **ellipsis** button to change the location of the rule file.
8. Click Finish to create the new Task Assignment rule file in the specified location. The rule wizard also creates another rule file in the same folder with the name of TA_<WS_Name>_param.rtp. Progress Developer Studio for OpenEdge automatically compiles the rule file and creates a *.bpo file when you click Finish. You must, however, separately install the compiled rule file on the BPM Events server before it becomes active.

Using the Process Control Rule wizard

You can use the Process Control rule wizard to trigger the execution of rules using XML messages. This type of rule wizard can only be applied to a process, not a workstep. This rule wizard enables Progress Developer Studio for OpenEdge to receive XML message schema from, and interact asynchronously with, external applications.

To apply a Process Control rule to a process:

1. From the Integration category (Figure 384 on page 470), drag the ProcessControl ( ) icon to the Content pane, opening the Process Control wizard.
2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

Figure 454: Process Control Rule Wizard, Description Page
3. From the second page, you can assign the name of the rule module to which the Process Control rule will be assigned, and define the actions.

**Figure 455: Process Control Rule Wizard, Name/Actions Page**

![Process Control Rule Wizard, Name/Actions Page](image)

a) From the **Process Action(s)** section, you can select any of the following actions from the drop-down list provided, then click **Add**. You need to define at least one action.

- **Create Process Instance**: creates an instance of the process when an XML message for creating a process instance is received. From the **Create Process Instance** dialog box (Figure 456 on page 506), enter the name of the creator and an instance name prefix (optional). You can also use the **Priority** drop-down list to set the priority of the process instance. You can also add dataslots (with default values) to the process instance. Click **Add** to open the **Select Dataslots** dialog box, where you can select a dataslot and click **OK** to add the dataslot in the Name/Value table. You can add as many default dataslot values as required.

**Figure 456: Create Process Instance dialog box**

![Create Process Instance dialog box](image)

- **Complete Workstep(s)** completes the selected worksteps in the process when an XML message for completing worksteps is received. To add worksteps, click **Add**, opening the **Complete Workstep(s)** dialog box (left image, Step Figure 457 on page 507). Click **Add** to open the **Workstep Dataslot(s)** dialog box (right image, Step Figure 457 on page 507), where you can select a workstep to be added from the **Workstep** drop-down list. Optionally, you can add dataslots (with default values) to the workstep. You can add as many default dataslot values as required, and use these values when the specified workstep is completed.

**Figure 457: Complete Workstep(s) dialog box**

![Complete Workstep(s) dialog box](image)
Using the Process Control Rule wizard

Figure 457: Complete Workstep and Workstep Dataslot(s) dialog boxes

- **Update Dataslot(s)** allows you to modify the value of selected dataslots when an XML message for updating dataslot values is received. To select the dataslots to be updated, from the **Update Dataslot(s)** dialog box, click **Add**, opening the **Select Dataslots** dialog box. Select a dataslot from those listed and click **OK**. You can add as many dataslot (with default values) as required.

Figure 458: Update Dataslot dialog boxes

b) Click **Next** to continue.

4. From the Summary page, review the summary of the parameters you have selected for the Process Control rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.

Figure 459: Process Control Rule Wizard, Summary Page
5. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining **ellipsis** button to change the location of the rule file.

   **Figure 460: Process Control Rule Wizard, Save Rule File As Page**

6. Click **Finish** to create the new rule file in the specified location, and apply it to the process.

### Using the File Poller Rule wizard

You can use the File Poller rule wizard to poll a file system for a specific event or pattern of a folder or file, which triggers a user-defined rule to process that event. You can also use the file system to asynchronously interact with external applications without needing to develop application-specific adapters. This wizard also collects statistical data on the number of messages received by action type and a count of the successful processing of such events. This information is collected in Statistics and Configuration infopads. The Statistics infopad dynamically adds a row whenever a new event or folder is detected.

This type of rule wizard can only be applied to a process, not a workstep.

**To apply a File Poller rule to a process:**

1. From the **Integration** category (**Figure 384 on page 470**), drag the **FilePoller** (image) icon to the Content pane, opening the **File Poller** wizard.

2. From the Description page, review the description of the rule wizard, then click **Next** to continue. Click **Cancel**, at any time, to exit the wizard.
3. From the second page, you can enter the name of the rule group, as well as specify the Poll start time and interval.

Figure 462: File Poller Rule Wizard, Defining Name/Timing Page

- Enter the name for the rule template you want to create in the **Name** box.
- From the **Poll Start Time** section, you can define when the file polling action is activated.
  
  - If you select the **Duration** option, you can define the duration of time to elapse before the action is activated. as discussed in 2.b on page 473.
  
  - If you select the **Deadline** option, you can set the specific date and time when the action will be activated. as discussed in 2.b on page 473.
- From the **Poll Interval** section, click the **ellipsis** button provided to open the **Duration** dialog box where you can set the time interval between file polls.
- Click **Next** to continue.

4. From the Defining Folders page, you can specify the parent root of the folder that you want to poll, as well as the file name pattern and other settings.

a) To select the root folder, click the **ellipsis** button next to the **Root Folder** box, then browse to and select the root folder.

b) To specify the folder under the root folder that will be polled, click the **ellipsis** button next to the **Folder Name** box, opening the **Folder Name** dialog box (right image, Figure 463 on page 510).
  
  - Enter the name of the folder to be polled in the **Folder Name** box.
• If required, add a prefix or suffix to the polled folder, in the supported date format, by selecting the appropriate option.

**Figure 463: File Poller Rule Wizard, Defining Folders Page**

![File Poller Rule Wizard](image)

c) From the **File Name Pattern** section, you can select any of the following pattern options for the file polling.

• **RegExp Pattern** option to specify the Regular Expression pattern for files in the folder that is to be polled. For example, this pattern accepts a text representing the file name with an extension or you can enter a regular expression that the actual files need to match, example, entering `.log` matches any file name with a `log` extension.

• **Name Prefix** option to specify a file name pattern. Click the adjoining ellipsis button, opening the **Name Prefix** dialog box (similar to right image, Figure 463 on page 510), where you can specify the name of the file in the **File Name** box. Optionally, you can select an appropriate option from the **File Name Prefix/Suffix** section to poll files by the date format that is prefixed or suffixed to a String value.

• **External Filter** option to specify a user-defined Java class that implements the `java.io.FilenameFilter` interface. You must implement this class and keep its compiled version in the classpath of the BPM Events server under the `workspace/<ApplicationName>/adapters` folder.

d) From the **Sort Using** drop-down list, you can control the order in which the FileFound events are fired (in the case that multiple files have changed). The available sorting options are **Size** (file size), **Name** (file name), **Extension** (file extension), and **Modification Time** (the default selection).

e) From the **Order By** drop-down list, select either **ASC** (ascending) or **DESC** (descending) option.

f) Click **Next** to continue.

5. From the Actions page, you can select any of the following actions from the drop-down list provided, then click **Add**. You need to define at least one action.
Using the File Poller Rule wizard

**Figure 464: File Poller Rule Wizard, Actions Page**

*Create Process Instance* creates a process instance as a result of the polling of specified files.

**Figure 465: File Poller Rule Wizard, Create Process Instance Action**

a) In the **Creator** box, define the user ID (must be a valid Application User) to be used as the name of the creator of the process instance. If you use the default, "{manager}" , it is replaced by the user ID of the process manager.

b) In the **Instance Name Prefix** box, enter the name of the process instance to be created. This name is automatically assigned a suffix that contains ":#", followed by the unique system-generated ID of the process instance. If you use the default, "{docname}" , it is replaced by the file name of the incoming document that triggers this rule.

c) Select an option from the **Priority** drop-down list to specify the priority of the process instance.

d) The **DocumentDataslot(s)** drop-down list displays all the available Document dataslots in the current process template. Select the dataslot in which the incoming document is uploaded when creating the process instance. You can also initialize the Document dataslots by clicking Add to open the **SelectDataslots** dialog box. Select a Document dataslot from the list and click **OK**.

- The procedures to define the remaining actions are similar to as described in Step 5 on page 479 for Process Path Wizard. The only exception is for **Send Mail** action, you can only specify e-mail addresses in the **To** and **From** boxes, and the e-mail subject and message in the respective boxes.
6. From the Summary page, review the summary of the parameters you have selected for the File Poller rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.

**Figure 466: File Poller Rule Wizard, Summary Page**

![File Poller Rule Wizard, Summary Page](image)

7. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining **ellipsis** button to change the location of the rule file.

**Figure 467: File Poller Rule Wizard, Save Rule File As Page**

![File Poller Rule Wizard, Save Rule File As Page](image)

8. Click **Finish** to create the new rule file in the specified location and apply it to the process.
Managing changes in Business Processes

Business processes are rarely static and continually undergo changes. Progress Developer Studio for OpenEdge enables you to make changes to an active process template and apply these changes to the installed process and its running process instances.

For details, see the following topics:

- Managing changes through Process Refresh

Managing changes through Process Refresh

Progress Developer Studio for OpenEdge provides the Process Refresh feature that enables you to update an installed application. Depending upon the type of change, some of these changes are applied to its currently running process instances. Although you can manage changes in a process by creating a new version of the process, the changes you want to make may be relatively minor and it may be easier to use the Process Refresh feature.

Process Refresh replaces APIs that enabled users to update some application metadata and apply it to running process instances, but this method involved numerous API calls and was prone to error. In addition, you were not able to use the APIs to add worksteps or dataslots to the application. Process Refresh not only enables you to add worksteps or dataslots, but also to change many of the properties of worksteps and dataslots. You can then use the Refresh Process template option in the Publish wizard to seamlessly and immediately apply these changes to all running and future process instances at runtime.

**Note:** During process refresh, do not perform any activity related to the process and its instances, until the process refresh is completed.
As an example, let us consider a loan approval process that, as shown in Figure 468 on page 514, has three types of decisions: Approved, Rejected and Second Level Approval. A change in policy dictates the addition of a new type of approval called SpecialApproval, where loan approvals that exceed a specified amount require the approval of the Chief Financial Officer (this change to the existing process is shown in the dashed box in Figure 468 on page 514). With Process Refresh, you can add this special level of approval and, if the changes are valid, immediately apply them to all running process instances.

**Figure 468: Loan Approval Process Example**

![Loan Approval Process Diagram](image)

To use the Process Refresh feature:

1. Make changes to an installed application in Progress Developer Studio for OpenEdge, as shown in Figure 468 on page 514.
2. Verify that it has no errors, and publish it by selecting **Project > Publish**. For more information, see **Publishing an application** on page 73.
3. During the publishing, for the Publish Wizard page (shown in Figure 469 on page 514), select the **Refresh Process Template** option to apply the changes you made in the installed application to all its process instances.

**Figure 469: Publish Wizard Page**

![Publish Wizard Image](image)

4. Click **Next** to continue.
• If the changes you have made are valid and allowed, the publish operation is successful, and changes you have made in the installed application are adopted by all running process instances.

• If the changes you have made are not valid and not allowed, the Refresh Process Template button is disabled. Click << Details to display information about the changes that need to be corrected.

5. The final page of the Publish wizard appears. Click Finish to complete.

You can view the changes in the application in the existing process instances of the application. See the following section, Criteria for changes in Process Refresh on page 515, for a description of the changes that are allowed and not allowed in Process Refresh.

Criteria for changes in Process Refresh

The following general principles outline the types of changes that are supported or not supported during Process Refresh.

• Adding worksteps. You can add worksteps, provided the following condition is met:

  • If a rollback is enabled for the installed process, then do not add new worksteps and do not change the process flow.

  • The target of the added workstep is not an existing AND gateway with single outgoing connector (or And Join). For an illustration of And (Join), see Figure 45 on page 99.

• Modifying process properties. You can modify most of the process properties. For more information, see Process properties criteria on page 515.

• Modifying worksteps. You can modify certain properties of worksteps (for more information, see Workstep properties criteria on page 516), except in the following case:

  • You cannot modify the source worksteps for all existing AND gateways.

  • You cannot add or change a rollback point or reactivate workstep to an existing workstep.

• Deleting worksteps. You cannot delete worksteps.

• Adding dataslots. You can add instance level and global level dataslots to the process.

• Modifying dataslots. You can modify certain properties of dataslots for a Process Refresh (for more information, see Dataslot properties criteria on page 519).

• Deleting dataslots. You cannot delete dataslots.

Process properties criteria

Table 112 on page 516 lists the types of changes to process properties (see Defining process properties on page 119) that are allowed or not allowed during Process Refresh. The Properties column refers to the properties listed in the General and Description tabs of the Properties view for the process. The Changes Allowed column represents changes in workstep properties for all process instances that will take effect immediately. The Changes Effective Only for... column indicates that the changes will only take effect for process instances created after the Process Refresh, and will have no effect on currently running process instances.
### Table 112: Process Properties Modified during Process Refresh

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Effective Immediately for all Process Instances</th>
<th>Changes Effective Only for Process Instances Created After Refresh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Manager</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Version</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Duration</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Category</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Sub-category</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Author</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

### Workstep properties criteria

You can change only specific workstep properties before running a Process Refresh. Some of these changes will not take effect until after the first activation of the workstep.

Figure 470 on page 516 – Figure 472 on page 517 display tab-wise segregation of Activity workstep properties that can be modified, and indicate the fields where changes are allowed or not allowed for Process Refresh.

Figure 470: Process Refresh – General Properties
Step Table 113 on page 518 presents the types of changes to workstep properties that are allowed or not allowed during Process Refresh. The **Changes Allowed** column represents changes in workstep properties that will take effect immediately. The **Changes Effective At First...** column indicates that the changes will only take effect when a new process instance is created and the workstep is initially activated.
### Table 113: Changes Allowed/Not Allowed to Workstep Properties for Process Refresh

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Allowed</th>
<th>Changes Not Allowed</th>
<th>Changes Effective At First Activation of Workstep</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Label</td>
<td>Name</td>
<td>Performer&lt;sup&gt;3&lt;/sup&gt;, Presentation, Priority, Overdue in, Skippable, Collect Work Time, and Loop</td>
</tr>
<tr>
<td>Description</td>
<td>Description text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fields - Header panel</td>
<td>Show Instructions, Show Priority, Show start date, Show due date</td>
<td>Instructions</td>
<td></td>
</tr>
<tr>
<td>Fields - Fields section</td>
<td>Label, Editable, Required, Format, Add, Modify, Remove, Move up, Move down for input/output dataslots&lt;sup&gt;4&lt;/sup&gt;</td>
<td>Name, Type</td>
<td></td>
</tr>
<tr>
<td>Collaboration</td>
<td></td>
<td>Collaborative Tasks created before Refresh&lt;sup&gt;5&lt;/sup&gt;</td>
<td>Notes, Reassign, Email and Instant Messaging. Also Collaborative Tasks created after Refresh.</td>
</tr>
<tr>
<td>Alerts</td>
<td></td>
<td>Alert updates</td>
<td></td>
</tr>
<tr>
<td>Advanced - Before Activation</td>
<td>Wait for condition&lt;sup&gt;6&lt;/sup&gt;</td>
<td>Execute on, Activate after, Skip Condition, Execute script</td>
<td></td>
</tr>
<tr>
<td>Advanced - On Activation</td>
<td>Name, Rollback, Synchronization for Adapter and Subprocess worksteps</td>
<td>Exclude performers, Send e-mail... for Activity worksteps</td>
<td></td>
</tr>
<tr>
<td>Advanced - When Completed</td>
<td>Execute script</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<sup>3</sup> Cannot change from individual performer to group performer with ANY role. Cannot change group performer role from Any to All or All to Any.

<sup>4</sup> When a process instance is activated for the Adapter and Subprocess worksteps, the output dataslots follow the original process. When the workstep is activated, it will follow the new, changed process.

<sup>5</sup> After executing a Process Refresh, changes made in the process are not refreshed in Collaborative tasks that were created before the Process Refresh. Collaborative tasks created after a Process Refresh inherit the changes resulting from a Process Refresh.

<sup>6</sup> If you remove the precondition, the workstep is suspended and must be resumed separately from BP Server Admin.
### Dataslot properties criteria

You can change only specific dataslot properties before running a Process Refresh.

Table 114 on page 519 represents the types of changes to dataslot properties that are allowed or not allowed during Process Refresh. The **Properties** column refers to the tabs and fields seen in a New Dataslot/Modify Dataslot dialog box.

#### Table 114: Changes Allowed/Not Allowed to Dataslot Properties for Process Refresh

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Allowed</th>
<th>Changes Not Allowed</th>
<th>Changes Effective At First Activation of Workstep</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced - On Overdue</td>
<td>Overdue actions, Change performer and Complete workstep On Last Overdue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - On Error</td>
<td>Actions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - On Recovery</td>
<td>Execute script</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table 114: Changes Allowed/Not Allowed to Dataslot Properties for Process Refresh

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Allowed</th>
<th>Changes Not Allowed</th>
<th>Changes Effective At First Activation of Workstep</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Value</td>
<td>Name, Type</td>
<td></td>
</tr>
<tr>
<td>Default Format</td>
<td>Type, Label, Choices, Editable, Required</td>
<td>Scale and Precision in Numeric - DECIMAL dataslots, appendwith in CHARACTER dataslots</td>
<td></td>
</tr>
<tr>
<td>Access</td>
<td>Management Access, Tasks Column</td>
<td>Public, Global</td>
<td></td>
</tr>
<tr>
<td>Storage</td>
<td>Type, Size</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

7 If the timer action is changed, the new action set will take effect from the next invocation.

8 You are not allowed to change the default value of an Object dataslot. Changes made to a dataslot value are only effective on the next activation. The dataslot’s initial value gets activated only on the first (or next) activation.

9 Choices for CHARACTER dataslots can be added, but not edited or deleted.

10 If you change the default value for a Global dataslot, it will not take effect, and Progress Developer Studio for OpenEdge logs a warning in bpserrver.log.